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Command Syntax Conventions
The conventions used to present command syntax in this book are the same conventions used 
in the IOS Command Reference. The Command Reference describes these conventions as 
follows:

 ■ Boldface indicates commands and keywords that are entered literally as shown. In actual 
configuration examples and output (not general command syntax), boldface indicates 
commands that are manually input by the user (such as a show command).

 ■ Italics indicate arguments for which you supply actual values.

 ■ Vertical bars (|) separate alternative, mutually exclusive elements.

 ■ Square brackets [ ] indicate optional elements.

 ■ Braces { } indicate a required choice.

 ■ Braces within brackets [{ }] indicate a required choice within an optional element.
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Introduction
This book supports instructors and students in Cisco Networking Academy, an IT skills and 
career building program for learning institutions and individuals worldwide. Cisco Network-
ing Academy provides a variety of curricula choices including the very popular IT Essentials 
course. It includes 14 chapters oriented around the topics of the CompTIA A+ 220-1001 
(Core 1) and 220-1002 (Core 2) certification exams.

IT Essentials v7, Labs & Study Guide is a supplement to your classroom and laboratory expe-
rience with the Cisco Networking Academy. To be successful on the exam and achieve your 
CCNA certification, you should do everything in your power to arm yourself with a variety of 
tools and training materials to support your learning efforts. This Labs & Study Guide is just 
such a collection of tools. Used to its fullest extent, it will help you gain the knowledge as well 
as practice the skills associated with the content area of the IT Essentials v7 course. Specifi-
cally, this book will help you work on these main areas:

 ■ Select the appropriate computer components to build, repair, or upgrade personal 
computers.

 ■ Install and configure components to build, repair, or upgrade personal computers.

 ■ Perform troubleshooting on personal computers.

 ■ Explain how computers communicate on a network.

 ■ Configure devices to communicate on a network.

 ■ Explain how to troubleshoot laptops and other mobile devices.

 ■ Install a printer to meet requirements.

 ■ Describe virtualization and cloud computing.

 ■ Install Windows operating systems.

 ■ Perform management and maintenance of Windows operating systems.

 ■ Explain how to configure, secure, and troubleshoot mobile, macOS, and Linux operating 
systems.

 ■ Implement basic host, data, and network security.

 ■ Explain the roles and responsibilities of the IT professional.

Goals and Methods
The most important goal of this book is to help you pass the CompTIA A+ 220-1001 (Core 1) 
and 220-1002 (Core 2) certification exams. Passing these exams means that you have in-depth 
knowledge and skills related to personal computers, hardware, and operating systems. You 
know how various hardware and software components work and the best practices in mainte-
nance, safety, and security. You can assemble, configure, and secure computers; install operat-
ing systems and software; and troubleshoot hardware and software issues. You can perform all 
the roles and responsibilities of an IT professional.
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Each chapter of this book is divided into a Study Guide section followed by a Lab section.

The Study Guide section offers exercises that help you learn the concepts, configurations, and 
troubleshooting skills crucial to your success as a CompTIA A+ exam candidate. Each chapter 
is slightly different and includes exercises tailored to the specific content covered.

The Labs and Activities section includes all the online course labs and Packet Tracer activity 
instructions. If applicable, this section begins with a Command Reference that you will 
complete to highlight all the commands introduced in the chapter.

Audience for This Book
This book’s main audience is anyone taking the IT Essentials course of the Cisco Networking 
Academy curriculum. Many academies use this Labs & Study Guide as a required tool in the 
course, whereas other academies recommend the Labs & Study Guide as an additional resource 
to prepare for class exams and the CompTIA A+ certification.

The secondary audiences for this book include people taking CompTIA A+ classes from pro-
fessional training organizations. However, the reader should know that the content of this book 
tightly aligns with the Cisco Networking Academy course. It may not be possible to complete 
some of the Study Guide sections and Labs without access to the online course. Fortunately, 
you can purchase the IT Essentials v7 Companion Guide (ISBN: 9780135645376).

How This Book Is Organized
Because the content of the IT Essentials v7 Companion Guide and the online curriculum is 
sequential, you should work through this Labs & Study Guide in order beginning with 
Chapter 1.

The book covers the major topic headings in the same sequence as the online curriculum. 
This book has 14 chapters, with the same names as the online course chapters.

 ■ Chapter 1, “Introduction to Personal Computer Hardware”: This chapter reviews PC 
components including cases, power supplies, motherboards, CPUs, cooling systems, 
memory, adapter cards, disk drives, ports, cables, adapters, and input and output devices. 
The chapter also reviews how to disassemble a computer.

 ■ Chapter 2, “PC Assembly”: This chapter reviews general safety procedures before 
reviewing how to build a computer.

 ■ Chapter 3, “Advanced Computer Hardware”: This chapter reviews BIOS and UEFI 
settings, CPU architectures, ports, connectors, cables, monitors, as well as how to 
upgrade hardware and configure specialized computers.

 ■ Chapter 4, “Preventive Maintenance and Troubleshooting”: This chapter reviews com-
mon preventive maintenance measures, the troubleshooting process, and how to apply 
the troubleshooting process to common and advanced problems for PCs, components, 
and peripherals.
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 ■ Chapter 5, “Networking Concepts”: This chapter reviews types of networks and Internet 
connections, networking protocols, standards and services, and network devices and 
cables.

 ■ Chapter 6, “Applied Networking”: This chapter reviews how devices connect to the 
network as well as the basic troubleshooting process to solve network problems.

 ■ Chapter 7, “Laptops and Other Mobile Devices”: This chapter reviews the features and 
functions, network configuration, and basic troubleshooting process for laptops and 
mobile devices.

 ■ Chapter 8, “Printers”: This chapter compares printer types and reviews how to install and 
configure them. The chapter also reviews the basic troubleshooting process for printers.

 ■ Chapter 9, “Virtualization and Cloud Computing”: This chapter reviews the concepts 
of virtualization and cloud computing. It also compares different cloud computing 
concepts.

 ■ Chapter 10, “Windows Installation”: This chapter reviews operating system requirements, 
disk management, and the installation procedure for Windows.

 ■ Chapter 11, “Windows Configuration”: This chapter reviews all the various Windows 
tools and utilities, including Windows Desktop, File Explorer, Control Panels, Admin-
istrative Tools, System Utilities, Disk Management Utility, command-line tools, 
and Windows networking. The chapter also reviews basic and advanced Windows 
troubleshooting.

 ■ Chapter 12, “Mobile, Linux, and macOS Operating Systems”: This chapter reviews 
mobile operating systems, including Android and iOS, and how to secure these devices. 
The chapter also reviews the Linux and macOS operating systems including features, 
best practices, and basic CLI commands. Troubleshooting mobile, Linux, and macOS 
operating systems is also reviewed.

 ■ Chapter 13, “Security”: This chapter reviews common security threats, procedures to 
mitigate those threats including how to secure Windows workstations, wireless security, 
and basic troubleshooting for secure implementations.

 ■ Chapter 14, “The IT Professional”: This chapter reviews the roles and responsibilities of 
the IT professional, including good communication skills, documentation procedures, 
appropriate responses for legal and ethical situations, and the call center environment.
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CHAPTER 1

Introduction to Personal Computer Hardware

A computer consists of hardware and software components. Hardware is the physical equipment. It 
includes the case, keyboard, monitor, cables, storage drives, motherboard, and power supply.  Software 
includes the operating system and programs. The operating system, or OS, manages computer opera-
tions such as identifying, accessing, and processing information. Programs or applications perform 
different functions. Programs vary widely depending on the type of information that is accessed or 
generated.

This chapter reviews the definition of a computer, safety guidelines, computer components, and the 
process for disassembling a computer.
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Study Guide

Personal Computers
Assembling a computer requires following general safety guidelines and includes a variety of 
components, tasks, and skills.

What Is in a Computer?
Computers include input devices, output devices, and internal components.

In Table 1-1, indicate whether the computer component is an input device, output device, or 
internal component.

Table 1-1 Identify the Computer Component

Computer Component Input Device Output Device Internal Component

Mouse X

Optical drive X

Camera X

Keyboard X

Memory sticks X

Speakers X

Monitor X

Network card X

Storage drive X

CPU X

Headphones X

Printer X

Microphone X

Motherboard X

Power supply X

Graphics card X

Electrical and ESD Safety
Computer technicians must follow electrical and ESD safety guidelines to prevent damage to 
sensitive components, electrical fires, injuries, and fatalities.

Match the definition on the left with a term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. This buildup of an electric charge 
exists on a surface that comes into 
contact with another, differently 
charged surface.

 b. It takes this many volts to damage a 
computer component.

 c. It takes this many volts for a person to 
feel an electrostatic discharge.

 d. This device should be attached to 
you when working with computer 
components.

Terms

 b. 30 volts

 c. 3000 volts

 a. Static electricity

 d. Antistatic wrist strap

PC Components
This section reviews computer components, which include input devices, output devices, and 
internal components.

Cases and Power Supplies
Desktop cases and power supplies are available in a variety of form factors. Power supplies 
include many different connectors for powering internal components.

Identify the Case Form Factor

Match the definition on the left with a form factor on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This case is typically located on the 
floor under, or beside, a desk or table.

 b. This is a smaller version of the full-size 
tower and can be located on the user’s 
desk.

 c. This computer case often had the 
monitor positioned on top and was 
popular with early computers.

 d. In this case, all of the computer com-
ponents are integrated into the display.

Form Factors

 c. Horizontal case

 a. Full-size tower

 b. Compact tower

 d. All-in-one

Identify the Power Supply Form Factor

Power supplies are responsible for converting alternating current (AC) to direct current (DC). 
Match the definition on the left with the power supply form factor on the right. This exercise 
is a one-to-one matching.
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Definitions

 a. The most common power supply 
in use today and includes a second 
motherboard connector.

 b. Updated but obsolete Advanced Tech-
nology power supply.

 c. Original power supply that is now 
considered obsolete.

 d. Power supply commonly used in high-
end desktop models.

Form Factors

 d. EPS12V

 b. AT Extended (ATX)

 a. ATX12V

 c. Advanced Technology (AT)

Label the Power Supply Connector

A power supply includes several different connectors to power various internal components, 
such as the motherboard and disk drives. Label each power supply connector in Figure 1-1.

Figure 1-1 Power Supply Connector

Answer: Top row left to right: Molex keyed connector, 4-pin to 8-pin auxiliary power 
 connector, 20-pin or 24-pin slotted connector

Bottom row left to right: Berg keyed connector, 6/8-pin PCIe power connector, SATA keyed 
connector

Identify the Power Supply Connector

A power supply includes several different connectors used to power various internal computer 
components. Match the definition on the left with the power supply connector on the right. 
This exercise is a one-to-one matching.
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Definitions

 a. Connects to legacy floppy drives.

 b. Connects storage drives, optical 
drives, or other devices.

 c. Connects to the motherboard.

 d. Supplies power to internal 
components.

 e. Supplies power to different areas of 
the motherboard.

 f. Connects disk drives but is wider than 
Molex.

Form Factors

 c. 20-pin or 24-pin slotted connector

 d. 6/8-pin PCIe power connector

 a. Berg keyed connector

 b. Molex keyed connector

 e.  4-pin to 8-pin auxiliary power 
connector

 f. SATA keyed connector

Check Your Understanding—Cases and Power Supplies

Check your understanding of cases and power supplies by answering the following questions.

 1. This power supply is the only choice that does not allow for +3.3 V.

 a. AT

 b. ATX

 c. ATX12V

 2. This power supply was originally designed for network servers but is now commonly 
used in high-end desktop models.

 a. AT

 b. ATX12V

 c. EPS12V

 3. This power supply is the most commonly used on the market today. It includes a second 
motherboard connector to provide dedicated power to the CPU. Several versions of this 
power supply are available.

 a. AT

 b. ATX12V

 c. EPS12V

 4. This connector has two rows of three to four pins and supplies power to internal 
components.

 a. Molex

 b. 6/8-pin PCIe power connector

 c. 4-pin to 8-pin auxiliary power connector

 5. This device connects hard drives, optical drives, or other devices.

 a. Molex

 b. 6/8-pin PCIe power connector

 c. 4-pin to 8-pin auxiliary power connector

Answers: 1 A, 2 C, 3 B, 4 B, 5 A
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Motherboards
The motherboard, also known as the main board, is the backbone of the computer. Match the 
definition on the left with the term on the right. This exercise is a one-to-one matching.

Definitions

 a. This older version of software is used to 
help boot the computer and manage the 
flow of data between the storage drive, 
video card, keyboard, mouse, and more.

 b. This is the most common motherboard 
form factor.

 c. This is considered the brain of the 
computer.

 d. This is a temporary location to store 
data and instructions.

 e. This device controls high-speed access 
to the RAM and video card and the 
speed at which the CPU communicates 
with all of the other components in the 
computer.

 f. This older standard interface was used to 
connect disk drives to the motherboard.

 g. This specifies a different software inter-
face for boot and runtime services but 
still relies on BIOS for POST and setup.

 h. This small motherboard form factor uses 
very little power, so fans are not needed 
to keep it cool.

 i. This consists of the integrated circuits 
on the motherboard that control how 
system hardware interacts with the CPU 
and motherboard.

 j. These provide locations to connect addi-
tional components.

 k. This smaller motherboard form factor 
has fewer expansion slots.

 l. This 19-pin connector is used to connect 
the external ports on the computer case 
to the motherboard.

 m. This allows the CPU to communicate 
with slower speed devices including 
storage drives, USB ports, and expansion 
slots.

 n. This disk drive interface is used for con-
necting optical drives, hard drives, and 
solid-state drives to the motherboard.

Terms

 b. ATX

 a. BIOS

 i. Chipset

 c. CPU

 j. Expansion slots

 f. IDE

 l. Internal USB

 h. ITX

 k. Micro-ATX

 e. Northbridge

 d. RAM

 n. SATA

 m. Southbridge

 g. UEFI
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CPUs and Cooling Systems
The CPU is responsible for interpreting and executing instructions. Cooling systems are 
required because the flow of current between electronic components generates heat. Match 
the definition on the left with the term on the right. This exercise is a one-to-one matching.

Definitions

 a. In this CPU architecture, the pins are in 
the socket instead of on the processor.

 b. This is an example of passive cooling 
that is added to computer chips.

 c. This term refers to the amount of force 
needed to install a CPU into the mother-
board socket or slot.

 d. This device is the connection between 
the motherboard and the processor.

 e. This is an example of active cooling 
because it requires power.

 f. In this CPU architecture, the pins are on 
the underside of the processor package.

Terms

 e. Case fan

 d. CPU socket

 b. Heat sink

 a. LGA

 f. PGA

 c. ZIF

Memory
Two basic types of computer memory include ROM and RAM. ROM chips are located on the 
motherboard and other circuit boards and include instructions such as booting the computer 
and loading the operating system. RAM is the temporary working storage for data and instruc-
tions that are being accessed by the CPU. Unlike ROM, RAM is volatile memory, which means 
that the contents are lost every time the computer is powered off.

Identify the Type of ROM

Match the definition on the left with the ROM type on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This nonvolatile memory chip can be 
erased by exposing it to strong ultra-
violet light.

 b. Information on this chip can be elec-
trically erased or “flashed” without 
removing it from the computer.

 c. Information is written on this chip 
after it is manufactured but cannot 
then be erased.

 d. This is an obsolete chip on which 
information was written when manu-
factured and could not be erased.

ROM Type

 b. EEPROM

 a. EPROM

 c. PROM

 d. ROM
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Identify the Type of RAM

Match the definition on the left with the RAM type on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This DRAM operates in synchroniza-
tion with the memory bus and is able 
to process overlapping instructions in 
parallel.

 b. This RAM transfers data twice as fast 
as SDRAM, supports two writes and 
two reads per CPU clock cycle, uses a 
184-pin connector, and uses 2.5 volts.

 c. This RAM requires constant power to 
function, is used for cache memory, 
and is much faster than DRAM.

 d. This RAM doubles the clock rate of 
DDR2 while using only 1.5 volts.

 e. This older technology, popular until 
the mid-1990s, gradually discharges 
energy, so it must be constantly 
refreshed with pulses of electricity in 
order to maintain the data stored in 
the chip.

 f. This RAM for video graphics is used 
with a dedicated GPU to process mas-
sive amounts of data.

 g. This RAM transfers data twice as 
fast as SDRAM, decreases noise and 
crosstalk, uses a 240-pin connector, 
and uses 1.8 volts.

 h. This RAM quadruples the DDR3 
 maximum clock rate while using 
only 1.2 volts, uses a 288-pin con-
nector, and includes advanced error 
correction.

RAM Type

 b. DDR SDRAM

 g. DDR2 SDRAM

 d. DDR3 SDRAM

 h. DDR4 SDRAM

 e. DRAM

 f. GDDR SDRAM

 a. SDRAM

 c. Static RAM

Identify the Memory Module Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. This smaller, more condensed version 
of DIMM provides random-access data 
storage that is ideal for use in laptops, 
printers, and other devices where con-
serving space is desirable.

 b. This memory module can detect mul-
tiple bit errors in memory and correct 
single bit errors.

 c. This circuit board holds SDRAM, 
DDR SDRAM, DDR2 SDRAM, DDR3 
SDRAM, and DDR4 SDRAM chips.

 d. This memory module uses 8 bits for 
data and 1 bit for error checking.

 e. This memory module has dual rows 
of pins used to attach it to the 
motherboard.

 f. This cache is used for high-end work-
stations and servers.

 g. This cache originally mounted on the 
motherboard close to the CPU but is 
not integrated into the CPU.

 h. This memory module does not check 
for errors and is the most common 
RAM used for home and business 
computers.

 i. This small circuit board holds several 
memory chips and comes in 30-pin or 
72-pin configurations.

 j. This cache is integrated into the CPU.

Terms

 c. DIMM memory

 e. DIP

 b. ECC

 j. L1

 g. L2

 f. L3

 h. Nonparity

 d. Parity

 i. SIMM

 a. SODIMM

Check Your Understanding—Memory

Check your understanding of memory by answering the following questions.

 1. A user complains that her computer is running very slowly. What solution would help to 
speed it up?

 a. Add more ROM.

 b. Switch to L1 cache.

 c. Add more RAM.

 d. Use error correction code memory.

 e. Erase and refresh the code in ROM.
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 2. Which memory module can support both 32-bit and 64-bit transfers of data?

 a. DIP

 b. SIMM

 c. SODIMM

 3. Error Correction Code memory can correct multiple bit errors.

 a. True

 b. False

 4. Which statement best describes EPROM?

 a. Data can be erased using a strong ultraviolet light.

 b. Data is programmed on it when it is manufactured.

 c. It is a type of volatile memory.

 d. It is a type of RAM.

 e. It can be programmed only once.

 5. Which RAM from the list provides the fastest performance?

 a. GDDR SDRAM

 b. DDR3 SDRAM

 c. DDR4 SDRAM

 d. SDRAM

 e. SRAM

Answers: 1 C, 2 C, 3 B, 4 A, 5 C

Adapter Cards and Expansion Slots
Adapter cards increase the functionality of a computer by adding controllers for specific 
devices or by replacing malfunctioning ports. Adapter cards are installed in expansion slots on 
the motherboard.

Label the Adapter Card

Adapter cards come in many varieties, shapes, and sizes. They include sound adapters, NICs, 
video adapters, capture cards, eSATA cards, and more. Label each adapter card in Figure 1-2.
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Figure 1-2 Adapter Cards

Answer: Top row, left to right: eSATA card, Video adapter 

Bottom row, left to right: Sound adapter, NIC

Identify the Expansion Slot

Match the definition on the left with the expansion slot on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This PCI extended slot updated the stan-
dard PCI. It uses a 32-bit bus and is up to 
four times faster than PCI, but these slots 
have become mostly obsolete.

 b. This PCI Express slot has higher through-
put and comes in x1, x4, x8, and x16 
slots, which vary in length from shortest 
to longest, respectively.

 c. Found in some laptops, these slots come 
in three different form factors: Type I, 
Type II, and Type III.

 d. This provides additional expansion slots 
for more expansion cards.

 e. These 32-bit or 64-bit expansion slots are 
mostly obsolete.

 f. This is an obsolete high-speed slot for 
attaching a video card; it is now super-
seded by PCIe.

Expansion Slot

 f. AGP

 c. Mini-PCI

 e. PCI

 b. PCIe

 a. PCI-X

 d. Riser card
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Check Your Understanding—Adapter Cards and Expansion Slots

Check your understanding of adapter cards and expansion slots by answering the following 
questions.

 1. This adapter sends a video signal to a computer so that the signal can be recorded.

 a. Capture card

 b. Video adapter

 c. eSATA card

 2. This card adds additional expansion slots to a computer.

 a. USB

 b. Riser

 c. SATA

 3. This interface uses a 40-pin connector.

 a. IDE

 b. PCI

 c. SATA

 4. This interface supports hot swapping of storage drives.

 a. IDE

 b. PCI

 c. SATA

 5. This version of the PCI expansion slot is used in laptops.

 a. PCIe

 b. PCI-x

 c. Mini-PCI

Answers: 1 A, 2 B, 3 A, 4 C, 5 C

Hard Disk Drives and SSDs
Storage devices include hard disks, solid-state drives, optical drives, tape drives, and more.

Label the Storage Device

Label each storage device in Figure 1-3.
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Figure 1-3 Storage Devices

Answer: Top row, left to right: Tape drive, Solid-state drive

Bottom row, left to right: Hard disk drive, Optical drive

Check Your Understanding—Storage Devices

Table 1-2 provides three descriptions of storage device types. Fill in the table with the type 
and examples of each.

Table 1-2 Storage Device Types and Examples

Type Examples Description

Optical CD

Uses laser light to record or read data.Blu-ray

DVD

Magnetic HDD
Records bits as magnetized areas.

Tape drive

Solid State Flash Drive
Uses nonvolatile memory chips to save data. 

2.5" SSD

Optical Storage Devices
Optical drives are a type of removable media storage device that uses lasers to read and write 
data on optical media.
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Check Your Understanding—Optical Storage Devices

Table 1-3 describes three types of optical media. Fill in the table with the format and capacity 
options of each.

Table 1-3 Optical Storage Format and Capacity Options

Media Format Options Description Capacity Options

CD -ROM Prerecorded audio, software, or data

700 MB-R Write once

-RW Write many

DVD -ROM Prerecorded video, software, or data
4.7 GB SL

8.5 GD DL
+/-R Write once

+/-WR Write many

BD -ROM Prerecorded HD video, software, or data
25 GB SL

50 GB DL
-R Write once

-RE Write many

Ports, Cables, and Adapters
Ports, cables, and adapters are used to connect various input and output devices.

Identify the Video Port and Cable

Match the definition on the left with the connector on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This standard that came after HDMI 
was designed to connect high-end 
graphics-capable PCs and displays, as 
well as home theater equipment and 
displays.

 b. This analog video connector has 3 rows 
and 15 pins; it is also called a DE-15 or 
an HD-15 connector.

 c. This was developed specifically for 
high-definition televisions but was also a 
good candidate for computers.

 d. This is a high-speed connection of 
peripherals, such as storage drives, RAID 
arrays, and network interfaces, and it can 
transmit high-definition video.

 e. This is often found in groups of three, 
where a yellow connector carries video 
and a pair of red and white connectors 
carries left and right audio channels.

 f. This consists of 24 pins (3 rows 
of 8 pins) for digital signals, 4 pins 
for analog signals, and a flat pin called 
a ground bar.

Video Port and Cable

 a. DisplayPort

 f. DVI

 c. HDMI

 e. RCA

 d. Thunderbolt

 b. VGA
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Label the Video Port and Cable

Label each video port and cable combination in Figure 1-4.

Figure 1-4 Video Ports and Cables

Answer: Top row, left to right: RCA, Thunderbolt, VGA

Bottom row, left to right: HDMI, DVI, DisplayPort

Identify the Other Ports and Cables

Match the definition on the left with the port and cable on the right. This exercise is a 
 one-to-one matching.
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Definitions

 a. This has an L-shaped slot and 7-pin 
data cable; it includes a separate 
power cable.

 b. This includes an analog port to connect 
to an external source, a microphone 
port, and line-out ports, and a port to 
connect to a joystick or MIDI-interfaced 
device.

 c. This ribbon cable is used to connect 
storage drives inside the computer; 
floppy drives use a 34-pin cable; HDDs 
and optical drives use a 40-pin cable.

 d. This 8-pin Ethernet port has a maximum 
cable length of 100 m (328 ft.).

 e. This is a standard hot-swappable inter-
face for connecting peripheral devices 
to a computer.

 f. This is a 6-pin mini-DIN female con-
nector for the keyboard and mouse. If 
the ports are not color-coded, look for 
a small figure of a mouse or keyboard 
next to each port.

Port and Cable

 b. Audio and gameport

 c. IDE

 d. Network

 f. PS/2

 a. SATA

 e. USB

Label the Other Port and Cable

Label each port and cable combination in Figure 1-5.
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Figure 1-5 Other Ports and Cables

Answer: Top row, left to right: IDE, Audio and gameport, Network

Bottom row, left to right: PS/2, SATA, USB

Label the Adapter or Converter

Adapters and converters connect different standards that are interoperable. An adapter physi-
cally connects one technology to another. A converter performs the same function as an 
adapter but also translates the signals from one technology to the other.

Label each port and cable combination in Figure 1-6. Indicate whether it is an adapter or a 
converter.

Book 1.indb   17Book 1.indb   17 01/10/19   9:27 PM01/10/19   9:27 PM



18  IT Essentials Version 7, Labs & Study Guide

Figure 1-6 Other Ports and Cables

Answer: Top row, left to right: Molex to SATA adapter, USB to PS/2 adapter, USB to  Ethernet 
converter

Bottom row, left to right: HDMI to VGA converter, DVI to HDMI adapter, DVI to VGA 
adapter

Input Devices
Many different types of input devices allow the user to communicate with a computer.

Identify the Input Device

Match the definition on the left with the input device on the right. This exercise is a one-to-one 
matching.

Book 1.indb   18Book 1.indb   18 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 1: Introduction to Personal Computer Hardware  19

Definitions

 a. This device uses a light source to 
read the information affixed to most 
products and translate the image into 
 computer-readable content.

 b. This device allows the user to control 
more than one computer while using the 
same input devices.

 c. This pen allows the user to create 3D 
models by performing actions in mid-air.

 d. This device digitizes a physical photo-
graph or document that is then stored 
as a file that can be displayed, printed, 
emailed, or altered.

 e. This device may be the size of a credit 
card with an embedded microprocessor 
for user authorization.

 f. This biometric input device requires the 
user to speak into it for access.

 g. This device allows users to speak into a 
computer and have their voice digitized.

 h. This device is typically used with com-
puter games, simulators, and training 
applications; it provides separate images 
for each eye.

 i. This biometric input device requires the 
user to touch the device to log in.

 j. This device uses a stylus to electroni-
cally capture a written authorization for 
purchases, agreements, or contracts.

 k. This biometric input device scans user 
features to authorize access.

 l. This device allows the user to control 
movement and views with sticks and 
multiple buttons.

 m. These are the two most commonly used 
input devices for creating text and navi-
gating GUIs.

 n. This device captures images and videos 
that can be stored, displayed, printed, or 
altered.

 o. These devices are used for tap-to-pay 
devices, such as credit cards or 
smartphones.

 p. This device is typically used to stream 
live images onto the Internet.

 q. This pressure-sensitive screen is used to 
input computer instructions.

 r. This device reads information encoded 
on the back of plastic cards.

Input Devices

 d. Flatbed scanner

 a. Barcode scanner

 n. Digital camera

 k. Facial recognition scanner

 i. Fingerprint scanner

 l. Joystick and gamepad

 m. Keyboard and mouse

 b. KVM switch

 r. Magnetic stripe reader

 g. Microphone

 o. NFC devices and terminals

 j. Signature pad

 e. Smart card

 c. Stylus

 q. Touch screen

 h. Virtual reality headset

 f. Voice recognition scanner

 p. Webcam
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Output Devices
An output device takes binary information from the computer and converts it into a form that 
is easily understood by the user.

Check Your Understanding—Output Devices

Match the characteristic on the left with the visual or auditory output device on the right. This 
exercise is a one-to-one matching.

Characteristic

 a. These devices may be wired 
or wireless. Some are Wi-Fi or 
Bluetooth-enabled.

 b. All these devices have hardware that 
must be maintained, and most also 
have software, in the form of drivers, 
that must be kept up to date.

 c. These devices may have a variety of 
sensors including motion, external 
visual positioning, cameras, motion 
tracking, accelerometer, gyroscope, 
and magnetometer. Resolution and 
refresh rates vary.

 d. In these devices, LED is an LCD dis-
play that uses LED backlighting. LED 
has lower power consumption than 
standard LCD backlighting, so the 
panel can be thinner, lighter, brighter, 
and have better contrast.

 e. Most computers and mobile devices 
have audio support for these devices 
either integrated into the motherboard 
or on an adapter card. Audio support 
includes ports that allow input and 
output of audio signals.

 f. These devices usually do not close off 
ambient light to users, allowing them 
to see their real-life surroundings.

 g. For these devices, DLP stands for 
Digital Light Processing. DLP uses a 
spinning color wheel with an array of 
mirrors. Each mirror corresponds to a 
pixel and reflects light toward or away 
from the optics, creating an image of 
up to 1,024 shades of gray. The color 
wheel then adds the color data to 
complete the image.

Visual or Auditory Output Device

 f. AR headsets

 a. Headphones

 d. Monitors

 b. Printers

 g. Projectors

 e. Speakers

 c. VR headsets
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Computer Disassembly
A great way to learn about computers is to disassemble and rebuild one. This section reviews 
the tools you need to take on this fun task. The one lab for this chapter walks you through 
 disassembling a computer.

The Technician’s Toolkit
The technician’s toolkit includes an antistatic wrist strap and mat, compressed air, an extraction 
tool, a Philips head screwdriver, a torque screwdriver, a cable tester, and crimpers.

Label the Adapter or Converter

Label each tool in Figure 1-7.

Figure 1-7 Technician’s Tools

Answer: Top row, left to right: Antistatic wrist strap, Extraction tool, Torque screwdriver

Bottom row, left to right: Crimpers, Cable tester

Computer Disassembly
Watch the video for this section, Video Demonstration - Computer Disassembly, and 
 complete the lab.
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Labs and Activities

Chapter 1, “Introduction to Personal Computer Hardware,” does not include new commands.
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1.3.2.2 Lab–Disassemble a Computer 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

In this lab, you will disassemble a computer using safe lab procedures and the proper tools. 
Use extreme care and follow all safety procedures. Familiarize yourself with the tools you will 
be using in this lab. 

Note: If you cannot locate or remove the correct component, ask your instructor for help.

Instructor Note: It is only necessary to complete this lab if the lab computers are already built. 
The goal of this lab is to have the components separated and ready for assembly in Chapter 3, 
and for the students to demonstrate proper tool use. The students will also apply proper tool 
use in the Chapter 3 labs, where they will assemble a computer.

This lab does not include removing the motherboard, CPU, and cooling device from the com-
puter due to the replacement cost of these items. If possible, allow students to remove these 
components from spare or broken computers that are kept in the classroom for part identifica-
tion and demonstration.

Recommended Tools

Safety glasses Part retriever

Antistatic wrist strap Thermal compound

Antistatic mat Can of compressed air

Flat head screwdrivers Cable ties

Phillips head screwdrivers Parts organizer

Torx screwdrivers Containers for storing computer parts

Hex driver Antistatic bags for electronic parts

Instructions

Part 1: Preparation
Step 1: Power Off the Computer.

Turn off the power to the computer and disconnect the power cable from the wall 
and the power supply.

Step 2: Open the Computer Case.

Instructor Note: Explain to each student or group of students how a particular case is opened. 
Many have a simple catch, the front panel must come off first, or they simply slide apart. Show 
them which screws are holding the power supply in place before they begin.
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Locate all the screws that secure the side panels to the back of the computer. Use 
the proper size and type of screwdriver to remove the side panel screws. Do not 
remove the screws that secure the power supply to the case. Put all of these screws 
in one place, such as a compartment in the parts organizer or small cup. Label the 
compartment or cup with a piece of masking tape on which you have written ‘side 
panel screws’. Remove the side panels from the case.

If you have a camera or smartphone, take a picture of the inside of the computer 
case to be used as a reference when reassembling the computer.

Note: Some manufacturers do not use screws to fasten components inside of the computer 
case. Some may use plastic or metal clips that fasten components to the computer chassis. Be 
careful to remove only screws that are holding components in place, and not the screws that 
hold components together.

Questions:

What type of screwdriver did you use to remove the screws?

 ________________________________________________________________________

A Phillips screwdriver and hex drivers are the most commonly used screwdrivers to 
remove case panels.

How many screws secured the side panels?

 ________________________________________________________________________

Answers may vary. Normally there are two screws for each panel on a mid-tower 
case.

Step 3: Antistatic Wrist Strap.

Put on an antistatic wrist strap. Connect one end of the conductor to the wrist 
strap. Clip the other end of the conductor to an unpainted, metal part of the case.

If you have an antistatic mat, place it on the work surface and put the computer case 
on top of it. Ground the antistatic mat to an unpainted, metal part of the case.

Part 2: Parts Removal
Step 1: Remove the Hard Drive.

a. Locate the hard drive. Carefully disconnect the power and data cables from the 
back of the hard drive.

Question:

Which type of data cable did you disconnect?

 ________________________________________________________________________

Answers may vary.

b. Locate all of the screws that hold the hard drive in place. Use the proper size 
and type of screwdriver to remove the hard drive screws. Put all of these screws 
in one place and label them.
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Question:

What type of screws secured the hard drive to the case?

 ________________________________________________________________________

Answers may vary. Normally, crosshead screws secure hard drives in place.

How many screws secured the hard drive to the case?

 ________________________________________________________________________

Answers may vary. Most cases allow for up to four screws per hard drive.

Is the hard drive connected to a mounting bracket? If so, what type of screws 
secure the hard drive to the mounting bracket?

 ________________________________________________________________________

Answers may vary. Most hard drive manufacturers use a flush, crosshead screw.

Caution: Do NOT remove the screws that hold the hard drive together.

c. Gently remove the hard drive from the case. Look for a jumper reference chart 
on the hard drive. If there is a jumper installed on the hard drive, use the jumper 
reference chart to see if the hard drive is set for a Master, Slave, or Cable Select 
(CS) drive. Place the hard drive in an antistatic bag. 

Question:

What is the jumper setting of the hard drive?

 ________________________________________________________________________

Master, Slave, or Cable Select (CS)

Step 2: Remove the Optical Drive.

a. Locate the optical drive (Blu-ray, DVD, etc.). Carefully disconnect the power 
and data cables from the optical drive. Remove the audio cable from the optical 
drive if there is one connected.

Question:

What kind of data cable did you disconnect?

 ________________________________________________________________________

Answers may vary.

Is there a jumper on the optical drive? What is the jumper setting?

 ________________________________________________________________________

Master, Slave, or Cable Select (CS) drive.

b. Locate and remove all of the screws that secure the optical drive to the case. 
Put all of these screws in one place and label them. Place the optical drive in an 
antistatic bag.
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Question:

How many screws secured the optical drive to the case?

 ________________________________________________________________________

Answers may vary.

Step 3: Remove the Power Supply.

a. Locate the power supply. Find the power connection(s) to the motherboard.

b. Gently remove the power connection(s) from the motherboard.

Question:

How many pins are there in the motherboard connector?

 ________________________________________________________________________

Answers may vary.

c. Disconnect the power cables from any case fans.

d. Disconnect the power cable from the video card if it requires one. 

e. Disconnect any other power supply cables from where they were connected.

Question:

If there were additional cables disconnected, to what were they connected?

 ________________________________________________________________________

Answers may vary.

f. Locate and remove all of the screws that secure the power supply to the case. 
Put all of these screws in one place and label them.

Question:

How many screws secure the power supply to the case?

 ________________________________________________________________________

Answers may vary.

g. Carefully remove the power supply from the case. Place the power supply with 
the other computer components.

Step 4: Remove Adapter Cards.

a. Locate any adapter cards that are installed in the computer, such as a video, 
NIC, or sound card.

b. Locate and remove the screw that secures the adapter card to the case. Put the 
adapter card screws in one place and label them.

c. Carefully remove the adapter card from the slot. Be sure to hold the adapter 
card by the mounting bracket or by the edges. Place the adapter card in an anti-
static bag. Repeat this process for all of the adapter cards.

Note: Be very careful when removing video adapters. There is often a locking tab on the slot 
that must be released before the card can be removed.
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d. List the adapter cards and the slot types below.

Adapter Card Slot Type

Answers may vary: Video, NIC, Modem Answers may vary: PCI, PCIe, or CNR

Step 5: Remove Memory Modules.

a. Locate the memory modules on the motherboard.

Questions:

What type of memory modules are installed on the motherboard?

 ________________________________________________________________________

Answers may vary.

How many memory modules are installed on the motherboard?

 ________________________________________________________________________

Answers may vary.

b. Remove the memory modules from the motherboard. Be sure to release any 
locking tabs that may be securing the memory module. Hold the memory mod-
ule by the edges and gently lift out of the slot. Put the memory modules in an 
antistatic bag.

Step 6: Remove Data Cables.

a. Remove all data cables from the motherboard. Make sure to note the connec-
tion location of any cable you disconnect.

Question:

What types of cables were disconnected?

 ________________________________________________________________________

Answers may vary.

b. You have completed this lab. The computer case should contain the 
 motherboard, the CPU, and any cooling devices. Do not remove additional 
components.
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CHAPTER 2

PC Assembly

As a technician, you might have to determine whether a component for a customer’s computer needs 
to be upgraded or replaced. It is important that you develop skills in installation procedures, trouble-
shooting techniques, and diagnostic methods.

This chapter reviews the importance of component compatibility. It also reviews the need for adequate 
computer resources to efficiently run the customer’s hardware and software.
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Study Guide

Assemble the Computer
Technicians must first adhere to safety best practices. They can then begin to assemble the 
computer. This includes installing a power supply, motherboard, drives, adapter cards, and 
any additional needs for the specific situation. The technician must then install any necessary 
cables to power the devices and connect them to the motherboard, if necessary.

General and Fire Safety
General safety precautions include the following:

 ■ Removing watches and jewelry

 ■ Turning off and unplugging equipment

 ■ Removing clutter from the workspace

 ■ Covering sharp edges inside the computer

 ■ Wearing safety goggles

 ■ Practicing proper lifting procedures

 ■ Checking that a fire extinguisher is available, properly rated, and charged

Identify PASS

You should be familiar with the procedures to operate a fire extinguisher, which can be remem-
bered using the acronym PASS. In Table 2-1, fill in the corresponding instruction for each letter 
in PASS.

Table 2-1 PASS

Letter Description

P Pull the pin.

A Aim at the base of the fire.

S Squeeze the lever.

S Sweep from side to side.

Open the Case and Connect the Power Supply
Steps for installing a power supply are as follows:

Step 1. Open the computer case.

Step 2. Align the screw holes on the power supply with the screw holes on the 
computer case.

Step 3. Screw the power supply into place.
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Identify the Computer Case Characteristics

The choice of motherboard and external components influences the selection of the case and 
power supply. The motherboard form factor must be matched with the correct type of com-
puter case and power supply.

Match the description on the left with a characteristic on the right. This exercise is a one-to-one 
matching.

Description

 a. LED indicators that are mounted on 
the outside of the case can tell you 
if the computer is receiving power, 
when the hard drive is being used, 
and when the computer is in sleep or 
hibernate mode.

 b. This is the esthetic design of a case.

 c. The type of motherboard you choose 
determines this because the size and 
shape must match exactly.

 d. The power rating and connection type 
of this device must match the type of 
motherboard you have chosen.

 e. If a computer has many components, 
it will need more room for airflow to 
keep the computer cool.

 f. This allows fans to draw air into or out 
of the computer.

Characteristic

 b. Appearance

 c. Model type

 d. Power supply

 e. Size

 a. Status display

 f. Vent

Identify the Case and Fans Selection Factors

In Table 2-2, list the factor to consider when selecting a case and fans.

Table 2-2 Selecting a Case and Fans

Factors Consider…

Case size Larger cases often require larger fans because smaller 
fans cannot create enough air flow.

Fan speed Larger fans can spin more slowly than smaller fans to 
move the same amount of air, which reduces fan noise.

Number of components Multiple components in a computer create additional 
heat, which requires more fans, larger fans, or faster 
fans.

Physical environment The case fans must be able to disperse enough heat to 
keep the interior of the case cool.

Number of mounting places 
available

Different cases have different numbers of mounting 
places for fans.
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Factors Consider…

Location of mounting places 
available

Different cases have different locations for mounting 
fans.

Electrical connections Some case fans are connected directly to the mother-
board, whereas others are connected directly to the 
power supply.

Identify the Power Supply Selection Factors

In Table 2-3, list the factor to consider when selecting a power supply.

Table 2-3 Selecting a Power Supply

Factors Consider…

Type of motherboard The power supply must be compatible with the 
motherboard.

Required wattage Add the wattage for each component. If the wattage is 
not listed on a component, calculate it by multiplying 
its voltage and amperage. If the component requires 
different levels of wattage, use the higher requirement.

Number of components Make sure the power supply provides enough wattage 
to support the number and types of components plus 
another 25 percent at a minimum.

Type of components Make sure the power supply provides the right types 
of power connectors.

Type of case Make sure the power supply can be mounted in the 
desired case.

Install the Motherboard Components
Installing the motherboard includes installing the CPU, installing the RAM, and then mounting 
the motherboard in the case.

Order the Steps to Install the CPU

In Table 2-4, label the steps in the correct order from 1 to 6.

Table 2-4 Steps to Install the CPU

Step Description

4 Apply thermal paste to the CPU.

6 Secure the heatsink.

1 Orient the CPU to the CPU socket.

5 Install the heatsink.

3 Lock the CPU in place.

2 Place the CPU into the CPU socket.
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Order the Steps to Install the RAM

In Table 2-5, label the steps in the correct order from 1 to 4.

Table 2-5 Steps to Install the RAM

Step Description

2 Orient the RAM module to the motherboard slot.

1 Open the RAM slot levers.

3 Lower the RAM stick into the slot.

4 Press down firmly to lock in the RAM stick.

Order the Steps to Install the Motherboard

In Table 2-6, label the steps in the correct order from 1 to 6.

Table 2-6 Steps to Install the Motherboard

Step Description

2 Install standoffs in the case.

3 Align the I/O plate to the back of the computer case and press into 
place.

6 Install the screws into the standoffs.

5 Lower the motherboard into place.

4 Align the motherboard in the correct direction.

1 Locate standoff positions in the case.

Identify the CPU Cooling System Selection Factors

In Table 2-7, list the factor to consider when selecting a CPU cooling system.

Table 2-7 Selecting a CPU Cooling System

Factors Consider…

Socket type The heat sink or fan type must match the socket type 
of the motherboard.

Motherboard physical specifications The heat sink or fan must not interfere with any com-
ponents attached to the motherboard.

Case size The heat sink or fan must fit within the case.

Physical environment The heat sink or fan must be able to disperse enough 
heat to keep the CPU cool.

Install Internal Drives
Steps for installing a drive are as follows:

Step 1. Position the drive so that it aligns with the drive bay opening. The power and inter-
face connectors should be facing toward the motherboard.

Step 2. If necessary, attach the adapter to the 2.5-inch drive so it will fit into the 3.5-inch 
drive bay.

Step 3. Insert the drive into the drive bay so that the screw holes in the drive line up with 
the screw holes in the case.

Step 4. Secure the drive to the case using the proper screws.
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Steps for installing an optical drive are as follows:

Step 1. From the front of the case, choose the drive bay that you want to hold the drive. 
Remove the faceplate from the bay, if necessary.

Step 2. Position the optical drive so that it aligns with the 5.25-inch (13.34 cm) drive bay 
opening at the front of the case.

Step 3. Insert the optical drive into the drive bay so that the screw holes in the drive line up 
with the screw holes in the case.

Step 4. Secure the optical drive to the case using the proper screws.

Check Your Understanding—Installing Drives

In Table 2-8, indicate whether the statement about installing drives is true or false.

Table 2-8 Installing Drives

True or False Characteristic

True It is recommended to hand-tighten drive-mounting screws prior to using a 
screwdriver.

False When you are installing an HDD or SSD, the connectors should face the 
front of the case.

True Optical drives are installed from the front of the case.

False Modern motherboards provide the IDE interface for internal storage 
devices.

False In installations in which CPU cooling is important, HDDs are preferred for 
storage.

True The SATA interface can be used to connect HDDs, SSDs, and optical drives.

Install the Adapter Cards
Steps for installing adapter cards are as follows:

Step 1. Find an empty PCIe x16 slot on the case and remove the small metal cover.

Step 2. Align the adapter card to the appropriate expansion slot on the motherboard.

Step 3. Press down gently on the adapter card until it is fully seated.

Step 4. Secure the adapter card mounting bracket to the case with the appropriate screw.

Identify the Expansion Slot

In Figure 2-1, draw an arrow from the label to the slot that corresponds to the expansion 
slot type.
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Figure 2-1 Expansion Slots

PCI PCIe x1PCIe x16

Figure 2-1a Expansion Slots (Answer)

 

PCI PCIe x1PCIe x16
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Identify Selection Factors for Adapter Cards

In Table 2-9, list at least three factors that influence the purchasing decision for each type of 
adapter card. Slot type is already listed and does not count as one of your three factors.

Table 2-9 Factors to Consider When Purchasing Adapter Cards

Type Factors 

Graphics card ■ Slot type
 ■ Amount and speed of video RAM (VRAM)
 ■ Graphics processor unit (GPU)
 ■ Maximum resolution

Sound card ■ Slot type
 ■ Digital signal processor (DSP)
 ■ Port and connection types
 ■ Signal-to-noise ratio

Storage controller 
card

■ Slot type
 ■ Connector quantity
 ■ Internal or external connectors
 ■ Card size
 ■ Controller card RAM
 ■ Controller card processor
 ■ RAID type

I/O card ■ Slot ratio
 ■ I/O port type
 ■ I/O port quantity
 ■ Additional power requirements

NIC ■ Slot type
 ■ Speed
 ■ Connector type
 ■ Wired or wireless connection
 ■ Standards compatibility

Capture card ■ Slot type
 ■ Storage
 ■ Resolution and frame rate
 ■ I/O port
 ■ Format standards

Select Additional Storage
Many digital devices such as cameras, smartphones, and tablets use media cards to store 
 information, music, pictures, videos, data, and more.
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Identify the Media Card Format

Match the description on the left with a media card format on the right. This exercise is a 
one-to-one matching.

Description

 a. This is an older format but still in wide 
use because of its high speed and high 
capacity (up to 128 GB is common).

 b. Also known as Picture Card, this for-
mat was used in some digital cameras.

 c. This media card format is commonly 
used in smartphones and tablets.

 d. This is a proprietary flash memory 
created by Sony and is used in 
cameras, MP3 players, hand-
held videogame systems, mobile 
phones, cameras, and other portable 
electronics.

 e. This media card format was developed 
for mobile phones.

 f. This media card format was designed 
for use in cameras, MP3 players, and 
laptops; these cards can hold as much 
as 2 TB of data.

Media Card Format

 a. CompactFlash

 d. Memory Stick

 c. MicroSD

 e. MiniSD

 f. Secure digital (SD)

 b. xD

Install the Cables
The last step in assembly before booting up your computer is to connect all the components.
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Label the Power Connectors

Label each power supply connector in Figure 2-2.

Figure 2-2 Power Supply Connectors

Answer: Top row, left to right: ATX auxiliary, SATA

Bottom row, left to right: Molex, ATX motherboard

Check Your Understanding—Identify the Front Panel Connectors

In Table 2-10, indicate the correct front panel connector for each description.
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Table 2-10 Front Panel Connectors

Description Audio Drive Activity 
LEDs

Power 
Button

Power 
LED

Reset 
Button

System 
Speaker

USB

Turns the computer 
on or off.

X

Remains lit when the 
computer is on and 
often blinks when the 
computer is in sleep 
mode.

X

Often consists of nine 
or ten pins arranged in 
two rows, but can also 
have four or five pins 
or individual groups of 
four or five pins.

X

Remains lit or blinks 
when the computer is 
reading or writing data.

X

Connects ports for 
jacks on the outside to 
connect microphones 
or external equipment, 
such as signal proces-
sors, mixing boards, 
and instruments.

X

Restarts the computer 
without turning it off.

X

Indicates the com-
puter’s status audibly. 
If there is a hardware 
problem, a series of 
diagnostic beeps is 
issued to indicate the 
type of problem.

X
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Label the External Connectors

Label each external connector in Figure 2-3.

Figure 2-3 External Connectors

Answer: Top row, left to right: USB, mouse

Bottom row, left to right: Monitor, Keyboard
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Labs and Activities

Command Reference
Chapter 2, “PC Assembly,” does not include new commands.
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2.1.2.5 Lab–Install the Power Supply 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install a power supply in a computer case.

Recommended Equipment
 ■ Power supply with a compatible form factor to the computer case

 ■ Computer case

 ■ Tool kit

 ■ Power supply screws

Instructions
Step 1: Open the Computer Case.

a. Remove the screws from the side panels.

b. Remove the side panels from the computer case.

Step 2: Install the Power Supply.

a. Align the screw holes in the power supply with the screw holes in the case.

b. Secure the power supply to the case with the power supply screws.

c. If the power supply has a voltage selection switch, set this switch to match the 
voltage in your area.

Questions:

What is the voltage in your area?

  ________________________________________________________________________

Answers may vary. Either 110/115v or 220/230v.

How many screws secure the power supply in the case?

  ________________________________________________________________________

Answers may vary. Usually 4.

What is the total wattage of the power supply?

  ________________________________________________________________________

Answers may vary.

d. This lab is complete. Please ask the instructor to verify your work.
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2.1.3.10 Lab–Install the Motherboard in a Computer 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install a CPU, a heat sink/fan assembly, and RAM module(s) on the mother-
board. You will then install the motherboard into the computer case.

Recommended Equipment
 ■ Computer case with power supply installed

 ■ Motherboard

 ■ CPU

 ■ Heat sink/fan assembly 

 ■ Thermal compound

 ■ RAM module(s)

 ■ Motherboard standoffs and screws

 ■ Antistatic wrist strap and antistatic mat

 ■ Tool kit

 ■ Motherboard manual

Instructor Note: If you do not wish to have your students install the components in this lab, 
due to the expense and fragility of these components, perform the steps with a classroom 
demonstration.

Instructions
Step 1: Install the CPU.

a. Place the motherboard, the CPU, the heat sink/fan assembly, and the RAM 
module on the antistatic mat.

Instructor Note: These are general instructions for an LGA1155 socket. Your moth-
erboard may be different. Follow all instructions provided by your CPU and moth-
erboard manufacturers.

b. Put on your antistatic wrist strap and attach the grounding cable to the anti-
static mat.

c. Locate Pin 1 on the CPU. Locate Pin 1 on the socket.

Note: The CPU may be damaged if it is installed incorrectly.
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d. Align Pin 1 on the CPU with Pin 1 on the socket.

e. Place the CPU into the CPU socket.

f. Close the CPU load plate and secure it in place by closing the load lever and 
moving it under the load lever retention tab.

g. Apply a small amount of thermal compound to the CPU.

Note: Thermal compound is only necessary when it is not included on the heat sink. Follow 
all instructions provided by the manufacturer for specific application details.

h. Align the heat sink/fan assembly retainers with the holes in the motherboard 
around the CPU socket.

i. Place the heat sink/fan assembly onto the CPU and the retainers through the 
holes in the motherboard.

j. Tighten the heat sink/fan assembly retainers to secure it.

k. Plug the fan connector into the motherboard. Refer to the motherboard manual 
to determine which set of fan header pins to use.

Step 2: Install the RAM.

a. Locate the RAM slots on the motherboard.

Questions:

In what type of slot(s) will the RAM module(s) be installed?

  ________________________________________________________________________

Answers may vary.

How many notches are found on the bottom edge of the RAM module?

  ________________________________________________________________________

Answers may vary.

b. Align the notch(es) on the bottom edge of the RAM module to the notches in 
the slot.

c. Press down until the side tabs secure the RAM module.

d. Ensure that none of the RAM module contacts are visible. Reseat the RAM 
module if necessary.

e. Check the latches to verify that the RAM module is secure.

f. Install any additional RAM modules using the same procedure.
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Step 3: Install the Motherboard.

a. Install the motherboard standoffs.

b. Install the I/O connector plate in the back of the computer case.

c. Align the connectors on the back of the motherboard with the openings in the 
back of the computer case.

d. Place the motherboard into the case and align the holes for the screws with the 
stand-offs. You may need to adjust the motherboard to line up the holes for the 
screws.

e. Attach the motherboard to the case using the appropriate screws.

This lab is complete. Please have the instructor verify your work.
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2.1.4.7 Lab–Install the Drives (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install the hard disk and optical drives.

Instructor Note: Ensure that the optical drive is installed right side up.

Recommended Equipment
 ■ Computer case with power supply and motherboard installed

 ■ Antistatic wrist strap and antistatic mat

 ■ Tool kit

 ■ Hard disk drive

 ■ Hard disk drive screws

 ■ Optical drive

 ■ Optical drive screws

 ■ Motherboard manual

Instructions
Step 1: Install the Hard Disk Drive.

a. Align the hard disk drive with the 3.5-inch drive bay.

b. Slide the hard disk drive into the bay from the inside of the case until the screw 
holes line up with the holes in the 3.5-inch drive bay.

c. Secure the hard disk drive to the case using the proper screws.

Step 2: Install the Optical Drive.

Note: Remove the 5.25-inch cover from one of the 5.25-inch external drive bays if necessary.

a. Align the optical drive with the 5.25-inch drive bay.

b. Insert the optical drive into the drive bay from the front of the case until the 
screw holes line up with the holes in the 5.25-inch drive bay and the front of the 
optical drive is flush with the front of the case.

c. Secure the optical drive to the case using the proper screws.

This lab is complete. Please have the instructor verify your work.
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2.1.5.6 Lab–Install Adapter Cards 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install a NIC, a wireless NIC, and a video adapter card.

Recommended Equipment
 ■ Computer with power supply, motherboard, and drives installed

 ■ NIC

 ■ Wireless NIC

 ■ Video adapter card

 ■ Adapter card screws

 ■ Antistatic wrist strap and antistatic mat

 ■ Tool kit

 ■ Motherboard manual

Instructions
Step 1: Install the wired NIC.

Question:

What type of expansion slot is compatible with the NIC?

  ________________________________________________________________________

PCI or PCIe.

a. Locate a compatible expansion slot for the NIC on the motherboard.

b. Remove the slot cover from the back of the case, if necessary.

c. Align the NIC to the expansion slot.

d. Press down gently on the NIC until the card is fully seated.

e. Secure the NIC by attaching the PC mounting bracket to the case with a screw.

Step 2: Install the wireless NIC.

Question:

What type of expansion slot is compatible with the wireless NIC?

  ________________________________________________________________________

PCI or PCIe.
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a. Locate a compatible expansion slot for the wireless NIC on the motherboard.

b. Remove the slot cover from the back of the case, if necessary.

c. Align the wireless NIC to the expansion slot.

d. Press down gently on the wireless NIC until the card is fully seated.

e. Secure the wireless NIC by attaching the PC mounting bracket to the case with 
a screw.

Step 3: Install the video adapter card.

Question:

What type of expansion slot is compatible with the video adapter card?

  ________________________________________________________________________

PCI, AGP, or PCIe.

a. Locate a compatible expansion slot for the video adapter card on the 
motherboard.

b. Remove the slot cover(s) from the back of the case, if necessary.

c. Align the video adapter card to the expansion slot.

d. Press down gently on the video adapter card until the card is fully seated.

e. Secure the video adapter card by attaching the PC mounting bracket(s) to the 
case with a screw.

This lab is complete. Please have the instructor verify your work.
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2.1.7.4 Lab–Install Internal Cables 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, install the internal power and data cables in the computer.

Recommended Equipment
 ■ Computer with power supply, motherboard, drives, and adapter cards installed

 ■ Hard disk drive data cable

 ■ Optical drive data cable

 ■ Antistatic wrist strap and antistatic mat

 ■ Tool kit

 ■ Motherboard manual

Instructions
Step 1: Connect the motherboard power supply connector.

a. Align the motherboard power supply connector to the socket on the 
motherboard.

b. Gently press down on the connector until the clip clicks into place.

Step 2: Connect the auxiliary power connector.

a. Align the auxiliary power connector to the auxiliary power socket on the 
motherboard.

b. Gently press down on the connector until the clip clicks into place.

Note: This step is necessary only if your computer has an auxiliary power connector.

Step 3: Connect the internal disk drive power connectors.

Plug a power connector into the hard disk drive and the optical drive.

Step 4: Connect the video adapter card power cable.

Plug the PCIe power connector into the video adapter card.

Note:  This step is necessary only if your video adapter card has a PCIe power connector.
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Step 5: Connect the fan power connector.

Connect the fan power connector into the appropriate fan header on the 
motherboard.

Note: This step is necessary only if your computer has a fan power connector.

Step 6: Connect the hard disk data cable.

a. Align and plug the hard disk drive data cable into the motherboard connector.

b. Align and plug the other end of the hard disk drive data cable into the hard disk 
drive connector.

Note: SATA cables are keyed to ensure correct orientation with the connector.

Step 7: Connect the optical drive data cable.

a. Align and plug the optical drive data cable into the motherboard connector.

b. Align and plug the other end of the optical drive data cable into the optical 
drive connector. 

Step 8: Verify the connections.

This lab is complete. Please have the instructor verify your work.
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2.1.7.8 Lab–Install Front Panel Cables 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, install the front panel cables in the computer.

Instructor Note: Front panel cables should be aligned correctly before inserting. The pins on 
these connectors are easily bent or broken.

Recommended Equipment
 ■ Computer with power supply, motherboard, drives, and adapter cards installed

 ■ Antistatic wrist strap and antistatic mat

 ■ Tool kit

 ■ Motherboard manual

Instructions
Step 1: Connect the reset switch connector.

Gently press down on the reset switch connector until the pins are fully inserted.

Step 2: Connect the power switch connector.

Gently press down on the power switch connector until the pins are fully inserted.

Step 3: Connect the power LED connector.

Gently press down on the power LED connector until the pins are fully inserted.

Step 4: Connect the HDD LED connector.

Gently press down on the HDD LED connector until the pins are fully inserted.

Step 5: Connect the speaker connector.

Gently press down on the speaker connector until the pins are fully inserted.

Step 6: Connect the USB and front audio jacks.

If your case also has front USB and front audio jacks, gently press down on the 
 connector until the clip clicks into place or the pins are fully inserted.

Step 7: Verify the connections.

Note:  If any LED or switch does not work when the computer is first started, remove the 
connector for that item, turn it around, and reconnect it.
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2.1.7.11 Lab–Complete the Computer Assembly 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install the side panels and the external cables on the computer.

Recommended Equipment
 ■ Computer with power supply, motherboard, drives, and adapter cards installed, and 

internal cables connected

 ■ Monitor cable (HDMI, DVI, or VGA)

 ■ Keyboard

 ■ Mouse

 ■ Network cable

 ■ Wireless antenna

 ■ Power cable

 ■ Tool kit

 ■ Motherboard manual

Instructions
Step 1: Attach the side panels.

a. Attach the side panels to the computer case.

b. Secure the side panels to the computer using the panel screws.

Step 2: Attach the monitor cable.

a. Attach the monitor cable to the video port.

b. Secure the cable by tightening the screws on the connector.

Step 3: Attach the keyboard cable.

Plug the keyboard cable into the USB or PS/2 keyboard port.

Step 4: Attach the mouse cable.

Plug the mouse cable into the USB or PS/2 mouse port.

Step 5: Attach the Ethernet cable.

Plug the Ethernet cable into the Ethernet port.
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Step 6: Attach the wireless antenna.

Connect the wireless antenna to the antenna connector.

Step 7: Attach the power cable.

Plug the power cable into the power socket of the power supply.

Step 8: Verify connections.

This lab is complete. Please have the instructor verify your work.
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CHAPTER 3

Advanced Computer Hardware

After building a computer, you will need to employ a variety of tasks to configure, modify, and pos-
sibly upgrade the computer to meet customer requirements. This chapter reviews basic input/output 
system and Unified Extensible Firmware Interface (BIOS/UEFI) configuration; wattage and voltage; 
central processing units (CPUs) and cooling systems; Redundant Array of Independent Disks (RAID); 
ports, connectors, and cables; monitors; hardware upgrades; specialized computer configurations; and 
ways to protect the environment.

Book 1.indb   55Book 1.indb   55 01/10/19   9:27 PM01/10/19   9:27 PM



56  IT Essentials Version 7, Labs & Study Guide

Study Guide

Boot the Computer
When a computer is booted, the BIOS performs a hardware check on the main components 
of the computer. This check is called a power-on self-test (POST). BIOS settings are saved 
in a Complementary Metal Oxide Semiconductor (CMOS) memory chip. Most comput-
ers today run UEFI, which provides additional features and addresses security issues with 
legacy BIOS.

POST, BIOS, CMOS, and UEFI
Watch Video Demonstration - BIOS - UEFI Menus in the online course to view a demonstra-
tion of how to configure a BIOS program.

Identify BIOS Beep Code Meaning and Causes

BIOS manufacturers use different codes to indicate hardware problems. Fill in Table 3-1 with 
the missing meanings and causes for each AMI BIOS beep code.

Table 3-1 Common Beep Codes

Beep Code Meaning Cause

1 Beep (No Video) Memory refresh failure Bad memory

2 Beeps Memory parity error Bad memory

3 Beeps Base 64 mem failure Bad memory

4 Beeps Timer not operational Bad motherboard

5 Beeps Processor error Bad processor

6 Beeps 8042 Gate A20 failure Bad CPU or motherboard

7 Beeps Processor exception Bad processor

8 Beeps Video memory error Bad video card or memory

9 Beeps ROM checksum error Bad BIOS

10 Beeps CMOS checksum error Bad motherboard

11 Beeps Cache memory bad Bad CPU or motherboard

Check Your Understanding—BIOS and UEFI Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. A program that performs a hardware 
check on the main components to 
check whether the computer hardware 
is functioning properly.

 b. An updated system for booting com-
puters that includes support for 64-bit 
computers.

 c. A memory chip that stores the boot 
settings.

 d. A legacy system for booting 
computers.

Term

 d. BIOS

 c. CMOS

 a. POST

 b. UEFI

BIOS/UEFI Configuration
Watch Video Demonstration - Configure BIOS - UEFI Settings to view a demonstration of 
how to configure a BIOS program.

Identify the Access Level

In Table 3-2, fill in the type of access level that is described.

Table 3-2 Access Levels

Access Level Level Description

Full Access All screens and settings are available to standard users, except the super-
visor password setting.

Limited Access Changes can be made by standard users to certain settings only, such as 
the time and date.

View Only Access All screens are available to standard users, but no settings can be 
changed.

No Access No access is provided to the BIOS setup utility to standard users.

Check Your Understanding—BIOS and UEFI Configuration Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. A UEFI standard that specifies the OS 
that is trusted by the manufacturer.

 b. A security feature that reports device 
information and location to a monitor-
ing center.

 c. The process of changing drive data into 
code so that the computer cannot be 
booted without the correct password.

 d. A chip designed to secure hardware 
by storing encryption keys, digital 
certificates, passwords, and data.

 e. A name for the BIOS/UEFI software 
that is stored in an EEPROM chip.

 f. The process of updating the EEPROM 
chip without opening the computer 
case.

Term

 c. Drive encryption

 e. Firmware

 f. Flashing the BIOS

 b. LoJack

 a. Secure boot

 d. TPM

Electrical Power
Computer power supplies are rated in watts, which is a measure of the work required to move 
electrons through a circuit (voltage) multiplied by the number of electrons going through that 
circuit per second (current).

Wattage and Voltage
A basic equation, known as Ohm’s Law, expresses how voltage is equal to the current multi-
plied by the resistance: V = IR. In an electrical system, power is equal to the voltage multiplied 
by the current: P = VI. In Table 3-3, identify whether the definition is for Current (I), Power (P), 
Resistance (R), or Voltage (V). Each power term is used more than once.

Table 3-3 Wattage and Voltage

Power Term Definition

Resistance A good fuse with almost 0 ohms is low in this.

Current This is measured in amperes, or amps (A). 

Resistance Lowering this allows more current to flow through a circuit.

Current This is a measure of the number of electrons moving through a circuit per second. 

Power This is a measure of the work required to move electrons through a circuit 
(voltage) multiplied by the number of electrons going through that circuit per 
second (current).

Resistance This refers to the opposition to the flow of current in a circuit.

Power This is measured in watts (W). 

Voltage A computer power supply usually produces several different types.

Voltage This is a measure of work required to move a charge from one location to 
another.

Resistance This is measured in ohms (O).
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Power Fluctuation and Protection
When the voltage in a computer is not accurate or steady, computer components might not 
operate correctly. Unsteady voltages are called power fluctuations. Use power fluctuation and 
protection devices to help shield against these anomalies.

Check Your Understanding—Power Fluctuation Terms

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definitions

 a. A device that diverts extra electri-
cal voltage that is on the line to the 
ground.

 b. A complete loss of AC power.

 c. Interference from generators and 
lightning.

 d. A situation that occurs when the 
power line voltage drops below 
80 percent of the normal voltage 
level or when electrical circuits are 
overloaded.

 e. A device that supplies a consistent 
level of electrical power to a computer 
or other device.

 f. A device that provides a backup bat-
tery to supply power when the incom-
ing voltage drops below the normal 
level.

 g. A dramatic increase in voltage above 
the normal flow of electrical current.

 h. A sudden increase in voltage exceed-
ing 100 percent of the normal voltage 
on a line.

Term

 b. Blackout

 d. Brownout

 c. Noise

 g. Power surge

 h. Spike

 f. Standby power supply (SPS)

 a. Surge protector

 e.  Uninterruptible power supply 
(UPS)

Advanced Computer Functionality
CPUs come in a variety of architectures and requirements to keep them cool. CPUs can be 
configured to enhance performance. RAID technology provides a way to store data across mul-
tiple storage devices for availability, reliability, capacity, and redundancy and/or performance 
improvement. Ports, connectors, and cables are used to connect internal and external compo-
nents to the computer. Monitors come in a variety of standards and require specific configura-
tions to operate properly with the computer.
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CPU Architectures and Operation
A program is a sequence of stored instructions. A CPU executes these instructions by follow-
ing a specific instruction set.

Identify CPU Architecture Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definitions

 a. A feature that enables a single proces-
sor to act as multiple processors so 
that multiple operating systems can 
run in parallel on the same computer 
as if they were running on completely 
independent computers.

 b. An Intel technology that enhances 
CPU performance by executing mul-
tiple threads simultaneously.

 c. An AMD technology that enhances 
CPU performance by enabling a high-
speed connection between the CPU 
and the Northbridge chip.

 d. The amount of data that a CPU can 
process at one time depends on the 
size of this.

 e. A technique used to make a processor 
work at a faster speed than its original 
specification.

 f. A CPU architecture that uses a 
relatively small set of instructions 
designed to execute these instructions 
very rapidly.

 g. A device in which two or more CPUs 
are integrated into one chip.

 h. A CPU architecture that uses a broad 
set of instructions, resulting in fewer 
steps per operation.

Term

 h.  Complex Instruction Set 
 Computer (CISC)

 a. CPU virtualization

 d. Front-side bus (FSB)

 b. Hyperthreading

 c. HyperTransport

 g. Multicore processor

 e. Overclocking

 f.  Reduced Instruction Set 
 Computer (RISC)

Label the CPU Cooling Mechanism

Several cooling mechanisms are employed to reduce heat generated by the CPU. Label each 
CPU cooling mechanism in Figure 3-1.
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Figure 3-1 CPU Cooling Mechanism

Answer: Top row, left to right: Graphics card cooling system, Water cooling system, Case fan

Bottom row, left to right: CPU heat sink, CPU fan

Check Your Understanding—Cases and Power Supplies

Check your understanding of cases and power supplies by answering the following questions.

 1. What can be used to draw the heat away from the CPU and is installed directly on top 
of the CPU?

 a. Fan

 b. Heat sink

 c. A CISC

 d. A RISC

 2. What is overclocking?

 a. This sets your CPU to run at speeds higher than originally designed by the 
manufacturer.

 b. This incorporates more than one CPU core into a single chip.

 c. This is used by AMD to enhance the performance of their CPUs.

 d. This is when a single CPU performs as if there are two CPUs when multiple threads 
are processed.
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 3. If the computer has an extremely fast CPU and produces more heat than can currently 
be dispelled, what type of cooling system would you use in the computer?

 a. CPU fan

 b. Graphics card cooling system

 c. CPU heat sink

 d. Water cooling system

Answer: 1 B, 2 A, 3 D

RAID
Storage devices can be grouped and managed to create large storage volumes with enhanced 
speed, redundancy, or both. To do so, computers can implement RAID technology.

Identify RAID Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one matching.

Definitions

 a. This capability provides fault toler-
ance for up to two failed drives.

 b. This capability enables data to be 
distributed across multiple drives, but 
the failure of a single drive means that 
all data is lost.

 c. This is the rate at which tasks can be 
performed. For storage devices, it is 
usually the read and write rates in MB/s.

 d. This capability stores duplicate data 
on one or more other drives so that 
the failure of one of the drives does 
not cause the loss of data.

 e. This is the amount of data that can be 
stored.

 f. This provides basic error checking and 
fault tolerance by storing checksums 
separately from data.

 g. This is when devices function as intended 
for a predicable amount of time.

 h. This is the relative cost of a solution 
based on its benefit. These things cost 
less than other things for the capabili-
ties that they offer.

 i. These IT resources can be accessed 
by those who need them at all times.

 j. This involves having backup resources 
that can rapidly replace failed devices 
and lost data or connectivity.

Term

 h.  Complex Instruction Set 
Computer (CISC)

 i. Availability

 e. Capacity

 a. Double parity

 h. Economy

 d. Mirroring

 f. Parity

 c. Performance

 j. Redundancy

 g. Reliability

 b. Striping

Book 1.indb   62Book 1.indb   62 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 3: Advanced Computer Hardware  63

Check Your Understanding—RAID Levels

In Table 3-4, indicate whether the RAID level uses striping, mirroring, parity, double parity, or 
some combination of the four features.

Table 3-4 RAID Levels

RAID Level Striping Mirroring Parity Double Parity

RAID 0 X

RAID 1 X

RAID 5 X X

RAID 6 X X

RAID 10 X X

Ports, Connectors, and Cables
Computers include a variety of ports, connectors, and cables, including legacy ports, video and 
graphic ports, universal serial bus (USB) cables and connectors, Serial AT Attachment (SATA) 
cables and connectors, twisted-pair cables and connectors, coax cables and connectors, and 
Small Computer System Interface (SCSI) and Integrated Drive Electronics (IDE) cables and 
connectors.

Label the Legacy Ports

Computers have many different types of ports to connect the computer to external peripheral 
devices. As computer technology has evolved, so have the types of ports used to connect 
peripheral devices. Legacy ports are typically found on older computers and have been mostly 
replaced by newer technologies such as USB. Label each legacy port in Figure 3-2.

Figure 3-2 Legacy Ports
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Answer: Top row, left to right: Serial, Game, Parallel

Bottom row, left to right: PS/2, Audio ports

Identify the Legacy Port

In Table 3-5, indicate the type of legacy port.

Table 3-5 Legacy Ports

Description PS/2 Audio Ports Serial Parallel Game Port

This 6-pin DIN connector is used for 
connecting a keyboard and mouse.

X

Analog ports typically include a 
line-in port to connect to an exter-
nal source, a microphone port, and 
line-out ports to connect speakers or 
headphones.

X

These ports are sometimes used for 
making console connections to net-
work devices to perform initial con-
figuration. There are two form factors 
of these ports: a 9-pin DB-9 port and 
a 25-pin port.

X

This port has a 25-pin receptacle used 
to connect various peripheral devices. 
It sends data in multiple bits at once.

X

This 15-pin port was used as a con-
nector for joystick input.

X

Label the Video and Graphic Ports

Graphic ports are used to connect monitors and other external video display types to desktop 
computers and laptops. Standards include the following:

■ Video Graphics Array (VGA)

■ Digital Visual Interface (DVI)

■ High-Definition Multimedia Interface (HDMI)

■ DisplayPort

Label each graphic port in Figure 3-3.

Book 1.indb   64Book 1.indb   64 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 3: Advanced Computer Hardware  65

Figure 3-3 Video and Graphic Ports

Answer: Top row, left to right: DVI, DisplayPort

Bottom row, left to right: VGA, HDMI

Identify the Video and Graphic Ports

In Table 3-6, indicate the type of video or graphic port.

Table 3-6 Video and Graphic Ports

Description VGA DVI HDMI DisplayPort

This is the oldest graphics port likely still used 
on some PCs although it is quickly becoming a 
legacy technology. It uses a 15-pin connector, 
with the pins arranged in three rows.

X

This standard can carry video, digital audio, and 
control signals. It uses a 19-pin connector.

X

Designed to replace older standards, this port 
uses a 20-pin connector for video and audio 
signals.

X

The emergence of digital display such as LCD 
monitors and TVs led to the development of this 
standard for transmitting uncompressed digital 
video. Variants are configured to support mul-
tiple transmission modes, including analog (-A), 
digital (-D), and integrated for both digital and 
analog (-I).

X
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Label the USB Cables and Connectors

Over the years, the USB protocol has evolved. USB 1.0 provided a low-speed transfer rate at 
1.5 Mbps for keyboards and mice and a full-speed channel at 12 Mbps. USB 2.0 made a signifi-
cant leap, increasing transfer rates up to High Speed at 480 Mbps. USB 3.0 increased the trans-
fer rate to SuperSpeed 5 Gbps. USB 3.2 supports speeds of up to SuperSpeed+ 20 Gbps. USB4, 
ratified in 2019, supports 40 Gbps. Label each connector in Figure 3-4.

Note: One cable in Figure 3-4 is not USB, but a proprietary standard.

Figure 3-4 USB Cables and Connectors

Answer: Top row, left to right: USB-C, USB Micro B, USB Mini A

Bottom row, left to right: USB Type B, Mini-USB, Lighting

Identify the USB Connector

In Table 3-7, indicate the type of video or graphic port.

Note: One connector in Table 3-7 is not USB, but a proprietary standard.
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Table 3-7 USB Connectors

Description USB Mini A Mini-USB USB Micro B USB Type B USB-C Lightning

This connector is 
rectangular with a 
small indentation on 
each side. It is being 
phased out and 
replaced.

X

Found on smart-
phones, tablets, and 
other devices, this 
USB 2.0 connec-
tor has two corners 
pushed in at an 
angle.

X

This small propri-
etary 8-pin connec-
tor is used by Apple 
mobile devices such 
as iPhones, iPads, 
and iPods for both 
power charging and 
data transfer. 

X

This is the newest 
USB interface; it is 
rectangular with four 
rounded corners.

X

This rectangular 
connector is found 
on virtually every 
desktop PC and lap-
top, as well as TV, 
game console, and 
media player. USB 
1.1, 2.0, and 3.0 ver-
sions are physically 
compatible.

X

This connector has 
a square shape with 
beveled exterior 
corners and an extra 
notch at the top. It 
was commonly used 
to connect printer 
and external storage 
drives.

X
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Label the SATA Components

SATA cables are long (up to 1 meter) and thin with a flat and thin 7-pin connector on each end. 
One end plugs into a SATA port on the motherboard and the other end into the back of an 
internal storage device such as a SATA hard drive. The SATA connecter has an “L” keyed shape 
so that it can be installed only one way. The SATA cable does not provide power, so an addi-
tional cable is needed to supply power to SATA drives.

External SATA drives use an eSATA connector, which is keyed to prevent inadvertent insertion 
of a USB connector. An expansion card may be needed to provide eSATA ports.

Label each SATA component in Figure 3-5.

Figure 3-5 SATA Components

Answer: Top row, left to right: SATA data cable, SATA power and data cables

Bottom row, left to right: eSATA cable, eSATA adapter

Twisted-Pair Cables and Connectors Review

Twisted-pair cable is used in wired Ethernet networks and in older telephone networks. The 
twisting of wire pairs helps reduce crosstalk and electromagnetic induction. In Ethernet net-
works, an 8-pin Register Jack 45 (RJ-45) connector terminates the cable that is plugged into 
an Ethernet port. The cable can be unshielded twisted pair (UTP) cabling or shielded twisted 
pair (STP). UTP is more common. STP is insulated with foil or braiding to reduce crosstalk 
and noise.

UTP and STP cables are reviewed in more detail in Chapter 5, “Networking Concepts.”
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Coaxial Cables and Connectors Review

Coaxial (coax) cable has an inner center conductor, usually made from copper or copper-clad 
steel, which is surrounded by a nonconductive dielectric insulating material. The dielectric 
is surrounded by a foil shield that forms the outer conductor and shields against electromag-
netic interference (EMI). The outer conductor/shield is encased in a PVC outer jacket. Radio 
Guide (RG) cables and connectors include the following:

■ RG-6 cable is heavy gauge and has insulation and shielding tuned for high-bandwidth, 
high-frequency applications such as Internet, cable TV, and satellite TV signals.

■ RG-59 cable is thinner and is recommended in low-bandwidth and lower-frequency appli-
cations such as analog video and CCTV applications.

■ Bayonet Neill–Concelman (BNC) connectors connect coaxial cables to devices using a 
quarter-turn connection scheme. BNC is used with digital or analog audio, or video.

Coax cables are reviewed in more detail in Chapter 5.

SCSI and IDE Cables and Connectors Review

SCSI is a standard for connecting peripheral storage devices. SCSI is a bus technology, meaning 
that all devices connect to a central bus and are daisy-chained together. The cabling/connector 
requirements depend on the location of the SCSI bus.

Figure 3-6 shows a Centronics connector used for connecting older external SCSI devices such 
as scanners and printers.

Figure 3-6 External SCSI Cable

Figure 3-7 shows a SCSI connector for internal hard drives.

Figure 3-7 Internal SCSI Cable

Integrated Drive Electronics (IDE) is a standard interface used to connect some hard drives and 
optical drives to each other and to the motherboard. IDE ribbon cables (Figure 3-8) look simi-
lar to internal SCSI cables, but IDE uses 40-pin connectors.
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Figure 3-8 IDE Cable

Monitors
Many types of computer monitors are available. Some are designed for casual use, whereas 
others are for specific requirements, such as those used by architects, graphic designers, or 
gamers.

Identify the Monitor Terminology

Match the definition on the left with the term on the right. This exercise is a one-to-one matching.

Definitions

 a. This is a measurement of the brightest 
white to the darkest black that a moni-
tor can display.

 b. This measures how long it takes for 
a pixel to change properties (that is, 
color or brightness).

 c. This is an abbreviation for “picture ele-
ment,” which is a tiny dot capable of 
displaying the color shades.

 d. This is the distance between pixels on 
the screen. Lower values produce a 
better image.

 e. This creates the image by scanning the 
screen, one line at a time from top to 
bottom.

 f. This is expressed in Hertz (Hz) and 
refers to how often per second the 
image is rebuilt.

 g. This is the horizontal to vertical mea-
surement of the viewing area of a 
monitor.

 h. This creates the image by scanning the 
screen two times. The first scan covers 
the odd lines, top to bottom, and the 
second scan covers the even lines.

 i. This term describes the luminance 
of a monitor measured in candelas 
per square meter (cd/m2). Between 
250 cd/m2 and 350 cd/m2 is typically 
recommended.

Term

 g. Aspect ratio

 i. Brightness

 a. Contrast ratio

 d. Dot pitch

 h. Interlaced

 e. Noninterlaced

 c. Pixel

 f. Refresh rate

 b. Response time
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Identify the Resolution and Aspect Ratio for Display Standards

Over the years, many different display standards have been developed. In Table 3-8, fill in the 
missing resolution and aspect ratio information.

Table 3-8 Display Standards

Standard Resolution Aspect Ratio Comment

CGA 320 × 200 16:10  ■ Color Graphics Adapter
 ■ Introduced by IBM in 1981
 ■ Obsolete

VGA 640 × 480 4:3  ■ Video Graphics Array
 ■ Introduced in 1987
 ■ Legacy

SVGA 800 × 600 4:3  ■ Super Video Graphics Array
 ■ Introduced in 1989
 ■ Still supported on some platforms

HD 1280 × 720 16:9  ■ High Definition
 ■ Also known as 720p

FHD 1920 × 1080 16:9  ■ Full High Definition
 ■ Also known as 1080p
 ■ Good setting for typical user

QHD 2560 × 1440 16:9  ■ Quad High Definition
 ■ Also known as 1440p
 ■ Suggested resolution for high-end users and 

gamers

UHD 3840 × 2160 16:9  ■ Ultra High-Definition
 ■ Also known as 4K

Computer Configuration
After assembling a computer and using it for a while, you may find it necessary to upgrade one 
or more components. In addition, specialized computers require advanced configurations.

Upgrade Computer Hardware
Upgrading your computer hardware might include the motherboard, CPU, storage devices, 
peripherals, and power supply.

Steps to Upgrade a Motherboard Review

To upgrade a motherboard from a computer case, follow these steps:

Step 1. Record how the power supply, case fans, case LEDs, and case buttons attach to the 
old motherboard.

Step 2. Disconnect the cables from the old motherboard.

Step 3. Disconnect and remove the expansion cards from the case.

Step 4. Carefully record how the old motherboard is secured to the case.

Step 5. Remove the old motherboard from the case.
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Step 6. Examine the new motherboard and identify where all of the connectors are, such as 
power, SATA, fan, USB, audio, front panel connector, and any others.

Step 7. Examine the I/O shield located at the back of the computer case. Replace the old 
I/O shield with the I/O shield that comes with the new motherboard.

Step 8. Insert and secure the motherboard into the case.

Step 9. Connect the power supply, case fans, case LEDs, front panel, and any other required cables.

Step 10. Install and secure the expansion cards.

Steps to Upgrade Fans Review

To install additional fans in the case to help cool the computer, follow these steps:

Step 1. Align the fan so that it faces the correct direction to either draw air in or blow air out.

Step 2. Mount the fan using the predrilled holes in the case.

Step 3. Connect the fan to the power supply or the motherboard, depending on the case 
fan plug type.

Steps to Upgrade Storages Devices Review

Follow these general guidelines to install a new storage device:

Step 1. Place the device in an empty drive bay and tighten the screws to secure it.

Step 2. Connect the device to the motherboard using the correct cable.

Step 3. Attach the power cable to the device.

Configurations for Specialized Computers
Specialized computers include computer-aided design or computer-aided manufacturing (CAx) 
workstations, audio video editing workstations, virtualization workstations, and gaming PCs.

Check Your Understanding—CAx Workstation Components

In Table 3-9, fill in the correct component type for each CAx workstation component.

Table 3-9 CAx Workstation Components

Component Correct Component Type

Video card High-end

RAM Maximum

Storage SSD
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Check Your Understanding—Audio and Video Editing Workstation 

Components

In Table 3-10, fill in the correct component type for each audio and video editing workstation 
component.

Table 3-10 Audio and Video Editing Workstation Components

Component Correct Component Type

Audio card Specialized

Video card Specialized

Storage Large and Fast

Monitor Multiple

Check Your Understanding—Virtualization Workstation Components

In Table 3-11, fill in the correct component type for each virtualization workstation 
component.

Table 3-11 Virtualization Workstation Components

Component Correct Component Type

Processor Multi-core

RAM Maximum

Check Your Understanding—Gaming PC Components

In Table 3-12, fill in the correct component type for each gaming PC component.

Table 3-12 Gaming PC Components

Component Correct Component Type

Video card High-end

Audio card Specialized

Storage SSD

Cooling High-end

Thick Client, Thin Client, and NAS Review

Thick clients are standard computers that were reviewed in this chapter. These computers have 
their own operating system, a multitude of applications, and local storage. They are standalone 
computers and do not require a network connection to operate. All of the processing is per-
formed locally on the computer.

Thin clients are typically low-end networked computers that rely on remote servers to perform 
all data processing. Typically, thin clients do not have internal storage and have very little local 
resources.

Network-attached storage (NAS) devices are servers that are connected to a network to pro-
vide file-level data storage to clients. The NAS typically offers high-speed networking through 
the use of a gigabit network interface card (NIC). NAS drives are specially built to endure the 
always-on environment of the device. It is very common to find multiple drives within a NAS 
to provide additional storage and RAID.
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Protecting the Environment
As a technician, you must be familiar with safety data sheets (SDSs) and safe disposal methods.

Safe Disposal of Equipment and Supplies
Parts that no longer work must be disposed of responsibly.

■ Batteries—Batteries often contain rare earth metals that can be harmful to the environ-
ment. All batteries are subject to disposal procedures that comply with local environ-
mental regulations.

■ Toner Kits, Cartridges, and Developers—Used printer toner kits and printer cartridges 
must be disposed of properly in compliance with environmental regulations. They can 
also be recycled. Some toner cartridge suppliers and manufacturers take empty car-
tridges for refilling.

■ Chemical Solvents and Aerosol Cans—Contact the local sanitation company to learn 
how and where to dispose of the chemicals and solvents used to clean computers.

■ Cell Phones and Tablets—Check with local health and sanitation agencies for their pre-
ferred way to depose of electronics such as cell phones, tablets, and computers. Most 
computer equipment and mobile devices contain hazardous materials.

Hazardous materials are sometimes called toxic waste. An SDS is a fact sheet that sum-
marizes information about material identification, including hazardous ingredients that can 
affect personal health, fire hazards, and first-aid requirements. To determine if a material is 
classified as hazardous, consult the manufacturer’s SDS. The Registration, Evaluation, Autho-
rization and restriction of Chemicals (REACH) regulation in the EU has regulations that are 
similar to SDS.
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Labs and Activities

Command Reference
Chapter 3, “Advanced Computer Hardware,” does not include new commands.
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3.1.1.6 Lab–Investigate BIOS or UEFI Settings 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will boot the computer, explore the firmware setup utility program, and change 
the boot order sequence. 

Instructor Note: Before allowing a student to power on a computer, verify that all components 
are installed correctly.

If students are unable to find the key(s) to enter the firmware setup utility program, you can 
try the following popular keys: F1, F2, F8, F10, F12, ESC, DEL, CTRL-ALT-ESC, or CTRL-
ALT-ENTER. Older motherboards may require additional research to determine the key(s) 
necessary to enter the BIOS setup utility program. In some cases, the key sequence will be 
displayed during POST.

Recommended Equipment
■ Computer with or without operating system

■ Motherboard manual

Instructions

Part 1: Enter BIOS or UEFI
Step 1: Power on the computer.

a. Plug the power supply cable into an AC wall outlet.

b. If there is a power switch on the power supply, set the switch to “1” or “on.”

c. Turn on the computer with the power button on the front panel.

Note: If the computer beeps more than once, or if the power does not come on, notify your 
instructor.

Step 2: Enter the firmware setup program.

During POST, press the firmware setup key or key combination. The firmware setup 
utility program screen will appear.

Questions:

What is the key or combination of keys used to enter the firmware setup utility 
program?

 ________________________________________________________________________

Answers may vary.
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Who manufactures the BIOS or UEFI system for your computer?

 ________________________________________________________________________

Answers may vary.

What is the BIOS or UEFI version?

 ________________________________________________________________________

Answers may vary.

Part 2: Explore the Settings
Step 1: List the main menu options.

Question:

List the main menu options and describe what is monitored in each menu.

 ________________________________________________________________________

Answers may vary.

Step 2: Find the security settings.

Navigate through each screen to find the security settings.

Question:

What security settings and features are available?

 ________________________________________________________________________

Answers may vary.

Step 3: Find the CPU settings.

Navigate through each screen to find the CPU settings.

Questions:

What is the CPU speed?

 ________________________________________________________________________

Answers may vary.

What other information is listed for the CPU?

 ________________________________________________________________________

Answers may vary.

Step 4: Find the RAM settings.

Navigate through each screen to find the RAM settings.

Questions:

What is the RAM speed?

 ________________________________________________________________________

Answers may vary.
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What other information is listed for the RAM?

 ________________________________________________________________________

Answers may vary.

Step 5: Find the hard drive settings.

Navigate through each screen to find the hard drive settings.

Question:

What information is listed for the hard drive?

 ________________________________________________________________________

Answers may vary.

Step 6: Find the boot order sequence.

Navigate through each screen to find the boot order sequence.

Questions:

What is the first boot device in the boot order sequence?

 ________________________________________________________________________

Answers may vary.

How many additional devices can be assigned in the boot order sequence?

 ________________________________________________________________________

Answers may vary.

Step 7: Set the device boot order settings.

a. Ensure that the first boot order device is the optical drive.

b. Ensure that the second boot order device is the hard disk drive.

Questions:

Why would you change the first boot device to the optical drive?

 ________________________________________________________________________

To allow the computer to boot from the optical drive if it contains a bootable disk.

What happens when the computer boots and the optical drive does not contain 
bootable media?

 ________________________________________________________________________

The computer will boot from the hard drive.
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Step 8: Find the power management setup or ACPI screen.

Navigate through each screen to find the power management setup screen, or 
ACPI screen.

Question:

What power management settings are available?

 ________________________________________________________________________

Answers may vary.

Step 9: Find the PnP settings.

Navigate through each screen to find the PnP settings.

Question:

What PnP settings are available?

 ________________________________________________________________________

Answers may vary.

Step 10: Find the splash screen settings.

Navigate through each screen to find the splash screen settings.

Question:

What splash screen settings are available?

 ________________________________________________________________________

Answers may vary.

Step 11: Save and exit the setup utility program.

Save the new BIOS/UEFI settings and exit the setup utility program. The computer 
should restart automatically.

Note: An error message stating that an OS cannot be found (or a similar error) will appear on 
the screen after the computer boots. An operating system must now be installed to prevent 
this error. It is safe to turn off the computer at this time.

This lab is complete. Please have the instructor verify your work.
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3.1.2.5 Lab–Search for BIOS or UEFI Firmware 
Updates (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will identify the current BIOS or UEFI version and then search for BIOS or 
UEFI update files.

Recommended Equipment
■ Classroom computer with an operating system installed

■ Internet access

Instructions
Step 1: Boot your computer.

During POST, BIOS information is displayed on the screen for a short period of time.

Do not log on to Windows.

Instructor Note: You may need to provide your students with the correct method 
for entering Setup on the lab computers.

Question:

What key or combination of keys is used to run Setup on your computer?

 ________________________________________________________________________

Answers may vary.

Step 2: Restart your computer and enter Setup.

The BIOS Setup Utility or UEFI screen appears.

Questions:

Who is the manufacturer of the BIOS?

 ________________________________________________________________________

Answers may vary.
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Which BIOS version is installed in your computer?

 ________________________________________________________________________

Answers may vary.

Step 3: Search the Internet to find the most current version of BIOS for the motherboard.

Instructor Note: As a class, choose a motherboard model from the lab computers. 
Search the Internet to find the most current version of BIOS available for the moth-
erboard. This screen is an example of the type of information you would look for to 
answer the questions below.

Use the information from the previous step to search the Internet to find the 
most current version of the BIOS for the motherboard in your computer. The 
 following screen is an example of the type of information you would look for to 
answer the questions below.

Caution: Do not update your BIOS at this time.

Questions:

What is the current BIOS version available for the motherboard? 

 ________________________________________________________________________

Answers may vary.

What features, if any, have been added to the new BIOS version?

 ________________________________________________________________________

Answers may vary.
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What changes, if any, have been made to the new BIOS version to fix problems?

 ________________________________________________________________________

Answers may vary.

What are the instructions to update the new BIOS version?

 ________________________________________________________________________

Answers may vary.
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3.1.2.6 Lab–Install Windows (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will install Windows 10.

Background/Scenario
In order to complete many of the remaining labs in this course, you will need to use Windows. 
This lab provides a basic installation in order to get Windows up and running on the lab PC.

Required Resources
■ A computer with a blank hard disk drive

■ Windows 10

Instructor Note: Complete an installation before class to ensure that the process goes 
smoothly. If installing from a USB flash drive, copy the Windows install files from an ISO disc 
image to the USB flash drive. Check each student computer to make sure that the BIOS boot 
sequence is set to boot from the DVD or USB first. To set the BIOS boot sequence, enter the 
BIOS using the Del key while POST is running. Your computer may use a different key to enter 
the BIOS. Check the manufacturer’s documentation. Find the screen that displays the boot 
sequence. If the DVD ROM or USB drive is not listed as the first boot device, add it to the list 
as the first device or move it to the top of the list. Press F10 to save and exit the BIOS.

Instructions
Step 1: Starting the Installation Media

a. Insert the Windows 10 installation DVD into the DVD-ROM drive or plug the 
USB flash drive into a USB port.

b. When the computer starts up, watch for the message Press any key to boot 
from CD or DVD.

If the message appears, press any key on the keyboard to boot the computer from 
the DVD. If the press any key message does not appear, the computer automati-
cally starts loading files from the DVD.

Instructor Note: The computer may boot the DVD without this message.

The computer starts loading files from the DVD or USB flash drive.

Step 2: Configuring Initial Settings

a. The Windows Setup window opens. Click Next to continue unless you need to 
change the default settings.

b. Click Install now to continue the installation.
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Step 3: Collecting Information

a. In the Enter the product key to activate Windows window, enter the 
product key.

Note: You can find the product key on the case or sleeve in which the Windows DVD was 
packaged, or you can get it from your instructor.

b. In the License terms window, read and confirm that you accept the license by 
selecting the box I accept the license terms. Click Next.

c. In the Which type of installation do you want? window, click Custom: Install 
Windows only (advanced).

d. In the Where do you want to install Windows? window, select the hard drive 
or partition on which Windows will be installed. In this example, click to select 
Disk 0 Unallocated Space. Click Next to continue. Setup has finished collect-
ing information for the installation.

Step 4: Installing Windows

a. The Installing Windows window opens. Windows will take some time to copy 
the files and install the OS on your computer. During the setup, the computer 
will restart several times.

b. When the Windows needs to restart to continue window opens, your 
 computer will automatically restart or you can click Restart now.

c. If you get the message Press any key to boot from CD or DVD…, do not press 
any key, and Windows will boot from the hard disk to continue the installation.

Step 5: Basics Setup

In this step, you will select your region and your keyboard layer.

Note: The personalization sub steps may be different depending on your Windows version.

a. Verify the region and select yes. If not, choose your region and select yes.

b. Verify the keyboard layout and select yes. If not, choose your keyboard layout 
and select yes.

c. Click Skip if you are not adding a second keyboard layout. Otherwise, click 
Add layout and answer the prompts to add a second layout.

Step 6: Network Setup

In this step, the installation may continue without your input. If prompted, provide 
the installation with the necessary information.

Select Set up for personal use. Click Next to continue. Your instructor may ask you 
to choose to select Set up for an organization.

Step 7: Account Setup

In this step, you will set up a local account to access the computer. You will not be 
creating a Microsoft account for this exercise. If you already have an account or 
choose to do so, you may use your Microsoft account for this step.

Note: The account setup sub steps may be different depending on your Windows version.
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a. Click Offline account to create a local account. If you already have a Microsoft 
account and choose to use it, enter the required information and click Next to 
continue.

b. Click No to continue using a local account, instead of Microsoft account.

c. Enter a username and click Next to continue.

d. Create a password and confirm the password when prompted. Click Next to 
continue.

e. Answer all the security questions and click Next to continue.

Step 8: Services Setup

In this step, you can give permission to use Cortana and select your privacy settings.

a. You can choose to use Cortana as your personal assistant. Click Yes or No to 
continue.

b. Read the privacy settings and click Learn More to find out more details. Then 
decide which features to use and click Accept to continue.

Step 9: Finishing the Installation

a. When you are finished with the installation, Windows continues to finalize your 
settings.

b. After the installation is completed, the Desktop displays and you are logged 
into Windows for the first time.
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3.1.2.7 Lab–Install Third-Party Software in Windows 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install and remove a third-party software application supplied by your 
instructor. You will install the Packet Tracer Windows application.

Recommended Equipment
The following equipment is required for this exercise: 

■ A computer with Windows installed

■ A flash drive or CD with the latest Packet Tracer Windows install package

To download the latest version of Packet Tracer software, log in to www.netacad.com. Click 
Resources > Download Packet Tracer. Select the appropriate Packet Tracer version for your 
classroom.

Instructions

Part 1: Installing Third-Party Software
Step 1: Locate the installer.

a. Log on to the computer with the Administrator account and use Windows 
Explorer to navigate to the folder where the Packet Tracer installer is located. 
This folder could be on the local hard drive, on an external flash drive, or on 
a CD.

b. Unzip the file as necessary. Locate the Packet Tracer application. The filename is 
in the form of PacketTracer??_##bit_setup.exe, where ?? is the version number 
and ## is either 32 or 64.

Step 2: Run the Installer to install Packet Tracer.

a. Start the installation process of the Packet Tracer application. When prompted, 
click Yes to allow this app to make changes to your device.

b. The License Agreement window opens. Select I accept the agreement, and 
then click Next.

c. The Select Destination Location window opens. Keep the default settings and 
click Next.

Questions:

What is the default installation location for Packet Tracer?

 ________________________________________________________________________

C:\Program Files\Cisco Packet Tracer 7.2. Answers may vary.
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d. The Select Start Menu Folder window opens. Keep the default settings. Click 
Next.

e. The Select Additional Tasks window opens. Keep the default settings. Click 
Next.

f. The Ready to Install window opens. Click Install.

g. The Installing progress window opens to show the progress of the installation.

h. If an information window regarding PTSBA opens, click OK to continue.

i. The Completing the Cisco Packet Tracer Wizard window opens. Click Finish.

j. Be ready to provide your netacad.com credentials when Packet Tracer opens for 
the first time.

k. If the You are running Packet Tracer for the first time window appears, click 
OK to continue.

l. If the Windows Security Alert window opens, click Allow access after verify-
ing that you have selected Private networks or domain networks as directed by 
your instructor.

Part 2: Uninstalling Third-Party Software
 a. To uninstall a program, click Control Panel > Programs and Features. Choose Cisco 

Packet Tracer in the list and right-click Uninstall.

 b. The Cisco Packet Tracer Uninstall window opens. Click Yes to confirm the removal.

 c. When the successfully removed from your computer message opens, click OK.

 d. Verify the application was removed. After the application removal process, the Programs 
and Features window no longer shows Cisco Packet Tracer in the list. Close all open 
windows.

 e. Future activities in this course will require the use of Packet Tracer. Reinstall Packet 
Tracer.

Reflection Question
Why does Microsoft recommend using Uninstall or change a program to remove an installed 
application?

 

Sometimes, the uninstall software does not fully remove all of the files and settings created by 
the application during installation. The Microsoft Windows Uninstall or change a program util-
ity removes the application completely.
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3.2.1.3 Lab–Ohms Law (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Answer the following questions based on electricity and Ohm’s Law. Show all steps when 
 solving problems.

Instructor Note: Many of the formulas in this activity are beyond the scope of this course for 
many students. It is recommended to guide students through this activity if it will be used.

 a. What are the four basic units of electricity? Provide the variable name and symbol, and 
unit name and symbol.

 

Voltage (V), Volt (V)

Current (I), Amps (A)

Resistance (R), Ohms (Ω)

Power (P), Watts (W)

 b. Write the equation for Ohm’s Law.

 

V = IR

 c. Rearrange the Ohm’s Law equation to solve the following:

I =  

R =  

I = V/R R = V/I

d. Power is equal to voltage multiplied by current. Add the missing information in 
each of the following power equations.

P = V  

P = R  

P = V2  

P = VI P = RI2 P = V2/R

 e. The yellow wire connected to a power supply carries 12V. If the power supply provides 
60W of power to the yellow wire, how much current is passing through the yellow wire?

 

I = P/V = 60W/12V = 5A

Book 1.indb   88Book 1.indb   88 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 3: Advanced Computer Hardware  89

 f. There are 3.3V passing through an orange power supply cable, and there are 0.025 ohms 
of resistance in the orange wire. How much power is supplied to the orange wire by the 
power supply?

 

P = V2/R = 3.3V X 3.3V/.25Ω = 43.56W

 g. A wire from the power supply is carrying 120W of power and 24A of current. Which 
color(s) of cable is the wire?

 

V = P/I = 120W/24A = 5V

The wire color is either red or white.
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3.4.1.7 Lab–Research a Hardware Upgrade 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
Use the Internet, a newspaper, or a local store to gather information about hardware 
 components. Your customer’s computer currently has one module of 2 GB of RAM, a 500 GB 
hard disk drive, and a PCIe video adapter card with 256 MB of RAM. Your customer wants 
to be able to play advanced video games.

Instructor Note: Check to make sure students have chosen parts that are compatible with the 
current configuration and meet the needs of the customer. 

Instructions
Step 1: Research memory options.

Shop around, and in the table below list the brand, model number, features, and cost 
for two different 8 GB modules of DDR3.

Brand and Model Number Features Cost

Kingston KCP316ND8/8 8 GB 240-Pin DDR 3 DIMM CAS 
Latency 11 Voltage 1.5V Non-ECC

$64.99

Kingston

KVR16R11S4/8

8 GB 240-Pin DDR 3 DIMM Program-
mable CAS Latency: 11, 10, 9, 8, 7, 6 
Voltage 1.5V ECC

$81.41

Questions:

Based on your research, which RAM would you select? Be prepared to discuss your 
decisions regarding the RAM you select.

 ________________________________________________________________________

Answers may vary.

Step 2: Research hard disk drive options.

Shop around, and in the table below list the brand, model number, features, and cost 
for a 3 TB 7200 rpm SATA 3 hard disk drive and a 500 GB or 1 TB solid state drive 
(SSD).
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Brand and Model Number Features Cost

Seagate ST2000DM006 2 TB 7200 RPM 64 MB Cache 
SATA 3 3.5"

1 TB: $44.99

2 TB: $59.99

3 TB: 84.99

4 TB: 98.15

6 TB: 165.99

Western Digital 
WDS500G2B0A

SATA 3 6 GB/s 2.5" / 7 mm

Also need a mounting bracket: 
2.5" to 3.5"

250 GB: $52.99

500 GB: $79.99

1 TB: $144.99

Questions:

Based on your research, which hard disk drive would you select? Be prepared to dis-
cuss your decisions regarding the hard disk drive you select.

 ________________________________________________________________________

Answers may vary.

Step 3: Research video adapter card options.

Shop around, and in the table below list the brand, model number, features, and cost 
for two different PCIe video adapter cards with at least 1 GB of RAM.

Brand and Model Number Features Cost

XFX Radeon HD6850 PCIe 2.1

1 GB GDDR5 900 MHz GPU
256-bit Interface

2 x DVI, 1 x HDMI,
1 x DisplayPort

$199.99

PowerColor AXRX 570 
4 GB D5-3DHD/OC

PCIe 3.0

4 GB GDDR5 1250 MHz GPU

256-bit Interface

3x DisplayPort, 1 x DVI

$144.99

Questions:

Based on your research, which video adapter card would you select? Be prepared to 
discuss your decisions regarding the video adapter card you select.

 ________________________________________________________________________

Answers may vary.
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CHAPTER 4

Preventive Maintenance and Troubleshooting

Preventive maintenance is the regular and systematic inspection, cleaning, and replacement of worn 
parts, materials, and systems. Troubleshooting is the systematic process used to locate the cause of a 
fault in a computer and correct the relevant hardware and software issues. Both skills are foundational 
to your job as a computer technician.

This chapter reviews general guidelines for troubleshooting and creating preventive maintenance 
programs.
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Study Guide

Preventive Maintenance
Preventive maintenance plans are developed based on at least two factors:

 ■ Computer location or environment

 ■ Computer use

PC Preventive Maintenance Overview
Regular preventive maintenance reduces potential hardware and software problems, computer 
downtime, repair costs, and the number of equipment failures. It also improves data protection, 
along with equipment life and stability, and saves money.

A technician should have tools that include

 ■ Antistatic mats or wrist bands to prevent static discharges that might damage 
sensitive components

 ■ Cans of compressed air and lint-free cloths to clean dust and dirt from external and 
internal components

 ■ A magnetic-tip screwdriver to tighten, replace, or pick up loose or dropped screws

Technicians often have extra cables, connectors, and expansion slot covers with them when replac-
ing components. It is important to keep all food and drinks far away from the active workspace.

A technician typically checks cables to ensure that pins are not bent or broken. Cables can also 
become crimped, pinched, or severely bent so that the cables or the signals are compromised. 
The technician should also ensure that the cables are snug inside their ports.

The proactive nature of regular preventive maintenance keeps components cleaner so that the 
components are less likely to fail, and they will usually last longer. Updating your software 
with the latest security patches will ensure your PCs have better protection against viruses, 
 spyware, and hacking attempts.

Dust and dirt seeping into cases and keyboards is an environmental concern in many 
 workplaces. Humidity may also be an issue in some workplaces. A technician must be able to 
customize preventive maintenance tasks for different environments.

If it is impractical or impossible to get an antistatic mat, the technician should wear shoes and ensure 
that any static electrical buildup on the body is equalized by touching the PC chassis or power supply.

Check Your Understanding—Preventive Maintenance

Check your understanding of preventive maintenance by answering the following questions.

 1. Which three benefits result from doing frequent preventive maintenance on desktop PCs?

 a. Longer equipment life

 b. Elimination of hardware component failures

 c. Elimination of updating operating software

 d. Fewer spam emails

 e. Less computer downtime

Book 1.indb   94Book 1.indb   94 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 4: Preventive Maintenance and Troubleshooting  95

 f. Fewer security breaches

 g. System access to more RAM

 2. A mining employee spends much of the time working with a laptop down in the mines. 
What three factors would be of most concern to a technician when doing preventive 
maintenance on the employee’s laptop?

 a. Loose cables

 b. Loose connectors

 c. Dirty keyboard

 d. Unseated adapter cards

 e. Humidity

 f. Dust

 g. Crimped cables

 3. What four tools would be required by a technician doing preventive maintenance on a 
desktop PC?

 a. Cotton swabs

 b. Industrial vacuum cleaner

 c. Hammer

 d. Lint-free cloth

 e. Can of compressed air

 f. Antistatic wrist strap

 g. Screwdriver

 4. A technician forgot an antistatic mat for doing preventive maintenance on a PC in the 
reception area. Because the reception area does not have carpet, it is an acceptable solu-
tion to take off shoes and work in socks instead of wasting valuable time returning to 
the office for the mat.

 a. True

 b. False

 5. What two issues are primarily related to cables inside a PC?

 a. Crimping

 b. Humidity

 c. Animal hair

 d. Dust

 e. Bent pins

 f. Missing screws

Answer: 1 A, E, F; 2 C, E, F; 3 D, E, F, G; 4 B; 5 A, E

Troubleshooting Process
Troubleshooting requires an organized and logical approach to problems with computers and 
other components. Sometimes issues arise during preventive maintenance. At other times, a 
customer may contact you with a problem.
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Troubleshooting Process Steps
A logical approach to troubleshooting allows you to eliminate variables and identify causes of 
problems in a systematic order.

Review the Troubleshooting Process Steps

In Table 4-1, list the six troubleshooting steps.

Table 4-1 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive measures.

Step 6 Document findings, actions, and outcomes.

Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the right hardware, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or a no answer. In Table 4-2, indicate 
whether the technician’s question is open-ended or closed-ended.

Table 4-2 Open-Ended and Closed-Ended Questions

Question Open-Ended Closed-Ended

What were you doing when the problem was identified? X

Have you changed your password recently? X

What hardware changes have been made recently to your 
computer?

X

Can you reproduce the problem? X

What software has been installed on your computer 
recently?

X

Are you currently logged in to the network? X

Has anyone else used your computer recently? X

What problems are you experiencing with your computer or 
network?

X

Have you received any error messages on your computer? X

Common Problems and Solutions for PCs
Computer problems can be attributed to hardware, software, networks, or some combination 
of the three.
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Check Your Understanding—Possible Solutions for PCs

Check your understanding of common problems and solutions for PCs by choosing the BEST 
answer to the following questions.

 1. The computer does not recognize a removable external drive.

 a. Reset the jumpers.

 b. Replace the CMOS battery.

 c. Replace the power supply.

 d. Enable the ports in the BIOS settings.

 e. Reboot the computer.

 2. The computer will not eject an optical disc because it is locked by software.

 a. Ensure that only one disc is inserted in the drive.

 b. Reset the jumpers.

 c. Reboot the computer.

 d. Insert a pin in the small hole to open the drive.

 e. Replace the optical drive.

 f. Update the BIOS.

 3. Retrieving or saving data from the USB flash drive is slow.

 a. Reset the jumpers.

 b. Enable the ports in the BIOS settings.

 c. Remove and reinsert the flash drive.

 d. Set the port speed in the BIOS settings to high speed.

 4. The computer will not turn on.

 a. Reboot the computer.

 b. Replace the CMOS battery.

 c. Replace the power supply.

 d. Reset the jumpers.

 e. Update the BIOS.

 5. The computer does not recognize a storage device.

 a. Reconnect the hard drive LED cable to the motherboard.

 b. Replace the power supply.

 c. Secure the battery.

 d. Update the BIOS.

 e. Secure the data cable.

 6. The computer displays incorrect CPU information when the computer boots.

 a. Reboot the computer.

 b. Replace the CMOS battery.

 c. Replace the power supply.

 d. Reset the jumpers.

 e. Update the BIOS.
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 7. A media reader cannot read a memory card that works properly in the camera because 
the reader does not support the memory card.

 a. Install a known good media reader.

 b. Use a different memory card type.

 c. Reconfigure the media reader in the BIOS settings.

 d. Ensure the media reader is connected correctly in the computer.

 8. The clock on the computer is no longer keeping the correct time.

 a. Reboot the computer.

 b. Replace the CMOS battery.

 c. Replace the power supply.

 d. Reset the jumpers.

 e. Update the BIOS.

Answer: 1 D, 2 C, 3 D, 4 C, 5 E, 6 E, 7 B, 8 B

Apply Troubleshooting Process to Computer Components 
and Peripherals
Personal reference tools include troubleshooting guides, manufacturer manuals, quick refer-
ence guides, and repair journals. In addition, the Internet is an excellent source of information 
about specific hardware problems and possible solutions.

Identify the Reference Tool

Match the description on the left with the reference tool on the right. This exercise is a 
one-to-one matching.

Descriptions

 a. Refer to these to avoid repeating steps 
and to determine what needs to be 
done next.

 b. This allows a technician to determine 
what work has been performed on a 
specific computer in the past.

 c. This includes descriptions of the prob-
lem, possible solutions that have been 
tried to correct the problem, and the 
steps taken to repair the problem.

 d. These are places to view questions 
and answers to specific computer-
related technical issues technicians 
have encountered.

Reference Tool

 b. History of repairs

 c. Journal

 a. Notes

 d. Online forums and chat sites

Book 1.indb   98Book 1.indb   98 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 4: Preventive Maintenance and Troubleshooting  99

Check Your Understanding—Advanced Possible Solutions for PCs

Check your understanding of advanced problems and solutions for PCs by choosing the BEST 
answer to the following questions.

 1. The computer reboots without warning, locks up, or displays error messages or the 
BSOD.

 a. Check the power connections.

 b. Contact the motherboard manufacturer to obtain a new CMOS chip.

 c. Download the correct drivers.

 d. Install additional RAM.

 e. Reset to the factory default settings of the motherboard.

 2. The computer exhibits slow performance.

 a. Check the power connections.

 b. Contact the motherboard manufacturer to obtain a new CMOS chip.

 c. Download the correct drivers.

 d. Install additional RAM.

 e. Reset to the factory default settings of the motherboard.

 3. The computer does not recognize a removable external drive.

 a. Check the power connections.

 b. Contact the motherboard manufacturer to obtain a new CMOS chip.

 c. Download the correct drivers.

 d. Install additional RAM.

 e. Reset to the factory default settings of the motherboard.

 4. The operating system cannot find RAID.

 a. Check the power connections.

 b. Contact the motherboard manufacturer to obtain a new CMOS chip.

 c. Download the correct drivers for the drive.

 d. Install additional RAM.

 e. Reset to the factory default settings of the motherboard.

 5. After the CMOS firmware is updated, the computer will not start.

 a. Check the power connections.

 b. Contact the motherboard manufacturer to obtain a new CMOS chip.

 c. Download the correct drivers.

 d. Install additional RAM.

 e. Reset to the factory default settings of the motherboard.

Answer: 1 E, 2 D, 3 C, 4 A, 5 B
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Labs and Activities

Command Reference
Chapter 4, “Preventive Maintenance and Troubleshooting,” does not include new commands.
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4.2.3.5 Lab–Use a Multimeter and a Power Supply 
Tester (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will learn how to use and handle a multimeter and a power supply tester.

Recommended Equipment
 ■ A digital multimeter 

 ■ The multimeter manual

 ■ A battery to test

 ■ A power supply tester

 ■ A manual for the tester

 ■ A power supply

Note: The multimeter is a sensitive piece of electronic test equipment. Do not drop it or handle it care-
lessly. Be careful not to accidentally nick or cut the red or black wires or leads, called probes. Because it 
is possible to check high voltages, take extra care to avoid electrical shock.

Instructions

Part 1: Multimeter
Step 1: Set up the multimeter.

a. Insert the red and black leads into the jacks on the meter. The black probe 
should go in the COM jack and the red probe should go in the + (plus) jack.

b. Turn on the multimeter (consult the manual if there is no ON/OFF switch).

Questions:

What is the model of the multimeter?

 ________________________________________________________________________

Answers may vary.

What action must be taken to turn the meter on?

 ________________________________________________________________________

Turn switch to a setting. Answers may vary.
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Step 2: Explore the different multimeter measurements.

a. Switch or turn to different measurements. For example, the multimeter can be 
adjusted to measure Ohms.

Questions:

How many different switch positions does the multimeter have?

 ________________________________________________________________________

Answers may vary.

What are they?

 ________________________________________________________________________

Voltage, current, resistance, etc. Answers may vary.

b. Switch or turn the multimeter to the DC voltage measurement.

Question:

What symbol is shown for this?

 ________________________________________________________________________

DCV

Step 3: Measure the voltage of a battery.

a. Place the battery on the table. Touch the tip of the red (positive) probe to the 
positive (+) side of a battery. Touch the tip of the black (negative) probe to the 
other end of the battery.

Question:

What is shown on the display?

 ________________________________________________________________________

Answers may vary, but the number should reflect the voltage of the battery. For 
example, a 1.5 V battery should display a number such as 1.47 V or 1.52 V.

b. If the multimeter does not display a number close to the battery voltage, check 
the multimeter setting to ensure it is set to measure voltage, or replace the bat-
tery with a known good battery. If the number is negative, reverse the probes.

Questions:

Name one thing you should not do when using a multimeter.

 ________________________________________________________________________

Plug the multimeter probes in a wall outlet. Answers may vary.

Name one important function of a multimeter.

 ________________________________________________________________________

A multimeter measures whether voltage is passing through or getting to a compo-
nent. Answers may vary.
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c. Disconnect the multimeter from the battery. Switch the multimeter to OFF. 
Part 1 of the lab is complete. Have your instructor verify your work.

Question:

Why is a digital multimeter an important piece of equipment for a technician? 
Explain your answer.

 ________________________________________________________________________

Answers may vary.

Part 2: Power Supply Tester
Complete only the steps for the connectors supported by the power supply tester that you 
are using.

Step 1: Check the testing ports for the power supply tester.

Many power supply testers have connector ports to test the following power supply 
connectors:

 ■ 20-pin/24-pin motherboard connector

 ■ 4-pin Molex connector

 ■ 6-pin PCI-E connector

 ■ P4 +12V connector

 ■ P8 +12V EPS connector

 ■ 4-pin Berg connector

 ■ 15-pin SATA connector

Question:

Which connectors does the power supply tester you are using have?

 ________________________________________________________________________

Answers may vary; see list above.

Step 2:  Test the power supply motherboard connector.

Complete the following steps for the connectors supported by the power supply 
 tester that you are using.

a. Set the power supply switch (if available) to the OFF (or 0) position.

b. Plug the 20-pin or 24-pin motherboard connector into the tester.

c. Plug the power supply into an AC outlet.

d. Set the power supply switch (if available) to the ON (or 1) position.

If the power supply is working, LEDs will illuminate and you might hear a beep. If 
the LED lights do not illuminate, it is possible the power supply could be damaged 
or the motherboard connector has failed. In this instance, you must check all con-
nections, ensure the power supply switch (if available) is set to ON (or 1), and try 
again. If the LEDs still do not illuminate, consult your instructor.
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Possible LED lights include +5 V, –5 V, +12 V, +5 VSB, PG, –12 V, and +3.3 V.

Question:

Which LED lights are illuminated?

 ________________________________________________________________________

Answers may vary but may include: +5 V, –5 V, +12 V, +5 VSB, PG, –12 V, +3.3 V.

Step 3: Test the power supply Molex connector.

Plug the 4-pin Molex connector into the tester. The LED illuminates on +12 V and 
+5 V. (If the power output fails, the LEDs will not illuminate.)

Question:

Which LED lights are illuminated?

 ________________________________________________________________________

+5 V, +12 V

Step 4: Test the 6-pin PCI-E connector.

Plug the 6-pin PCI-E connector into the tester. The LED will illuminate on +12 V. 
(If the power output fails, the LED will not illuminate.)

Question:

Does the LED light illuminate?

 ________________________________________________________________________

Answers may vary.

Step 5: Test the 5-pin SATA connector.

Plug the 5-pin SATA connector into the tester. The LED will illuminate on +12 V, 
+5 V, and +3.3 V. (If the power output fails, the LEDs will not illuminate.)

Question:

Which LED lights are illuminated?

 ________________________________________________________________________

+5 V, +12 V, +3.3 V.

Step 6: Test the 4-pin Berg connector.

Plug the 4-pin Berg connector into the tester. The LED will illuminate on +12 V and 
+5 V. (If the power output fails, the LEDs will not illuminate.)

Question:

Which LED lights are illuminated?

 ________________________________________________________________________

+5 V, +12 V
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Step 7: Test the P4/P8 connectors.

a. Plug the P4 +12 V connector into the tester. The LED will illuminate on +12 V. 
(If the power output fails, the LEDs will not illuminate.)

b. Plug the P8 +12 V connector into the tester. The LED will illuminate on +12 V. 
(If the power output fails, the LEDs will not illuminate.)

Question:

Which LED lights are illuminated?

 ________________________________________________________________________

+12 V

c. Switch the power supply to OFF (or 0) if available. Disconnect the power sup-
ply from the AC outlet. Disconnect the power supply from the power supply 
tester. The lab is complete. Have your instructor verify your work.

Question:

Why is a power supply tester an important piece of equipment for a technician? 
Explain your answer.

 ________________________________________________________________________

Answers may vary.
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4.2.3.6 Lab–Troubleshoot Hardware Problems 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will diagnose the cause of various hardware problems and solve them.

Recommended Equipment
 ■ A computer with an operating system installed.

■ Additional hardware that is either broken or in a working condition. You may wish to use 
working hardware, but sabotage it in some way.

Scenario
You must solve hardware problems for a customer. You might also need to troubleshoot hard-
ware connected to the computer. Make sure you document all the problems and the solutions.

There are several possible errors. Follow through the lab, solving one problem at a time until 
you can successfully start the computers and all devices are fully functional. You may need to 
ask the instructor for hardware when needed.

Lab Setup

Instructor Note: This lab requires setup by the instructor to create multiple hardware problems 
for each student. Include at least two of the problems listed per student. Students working in 
pairs will alternate between troubleshooting the problems until they have solved all the prob-
lems. You will need to inform students of the number of problems applied to each computer.

Important: Test each of the problems you implement before assigning the lab to the students.

Instructor Note: Students may not solve problems in the same order shown in the instruc-
tor document. Students might notice more than one problem at a time while troubleshooting. 
Remind students to correct and document one problem at a time.

List of Problems:

 1) Hard drive power cable disconnected.

 2) No RAM installed.

 3) Power supply not connected to motherboard.

 4) CPU not installed.

 5) Power cord unplugged from wall outlet.

 6) Case fan power disconnected.

 7) Front panel power button connectors reversed or disconnected.

 8) Nonfunctional parts are installed.
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 Problem 1: Disconnect power cable from the hard drive.

 Problem 2: Remove the RAM from the motherboard.

Problem 3: Unplug the power cable from the motherboard.

Problem 4: Remove the CPU from the motherboard.

Problem 5: Unplug the power cord from the wall outlet.

Problem 6: Unplug power cable for case fan(s).

Problem 7: Install the power button motherboard connector backward, or disconnect.

Problem 8: Nonfunctional parts are installed.

Plug component(s) that do not function into the computer. Examples include: mouse, key-
board, hard drive, video card, RAM, power supply, etc. This lab will use a power supply as 
an example. Each station could have the same or different components that do not work. The 
instructor will need good working parts available.

Instructions
Step 1: Start and log in to the computer.

Instructor Note:  Students work all the way through the lab for each problem, 
returning to this step after each problem has been fixed and documented. After all 
problems have been fixed, the lab will end at the end of this step.

a. Start the computer.

Question:

Did the computer boot successfully?

 ________________________________________________________________________

Answers may vary.

b. If the computer started, log on with an account with administrative privileges. 
Test all internal and external hardware devices.

Question:

Did all devices operate properly?

 ________________________________________________________________________

Answers may vary.

c. If the computer successfully started and all devices are fully functional, you 
have successfully solved all hardware problems. Hand the lab to your instructor.
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Step 2: Troubleshoot the hardware problem.

If you could not successfully start the computer and all devices are not fully func-
tional, continue troubleshooting the problem.

Answer the following questions after each problem is solved.

Question:

 1. What problem did you find? 

 ________________________________________________________________________

 1) Answers may vary, for example: No HDD LED lights on or  “No operating 
 system found” error.

 2) Answers may vary, for example: POST error message or beep sequence, the 
computer fails to boot.

 3)  Answers may vary, for example: No front panel LEDs on; the computer will not start.

 4)  Answers may vary, for example: Front panel LEDs on; the computer will not start. 

 5) Answers may vary, for example: No front panel LEDs on; the computer will 
not start.

 6) Answers may vary, for example: Case fan(s) not turning.

 7) Answers may vary, for example: Computer will not turn on.

 8) Answers may vary, for example: Computer will not turn on.

 2. What steps did you take to determine the problem?

 ________________________________________________________________________

 1) Examine the power connection to the hard drive.

 2) Examine the motherboard for loose and missing components.

 3) Examine the power connection: wall outlet and motherboard.

 4) Examine the motherboard for loose and missing components.

 5) Examine the power cord connection to the wall outlet.

 6) Examine the power connection to the fan(s).

 7) Examine the front panel case connections to the motherboard.

 8) Examine the power cord connection to the wall outlet. Also, examine switch 
on power supply.

 3. What is causing the problem? 

 ________________________________________________________________________

 1) Power cable is disconnected from the hard drive.

 2) No RAM is installed.

 3) Power is not connected to the motherboard.

 4) No CPU is installed.

 5) Power cord is unplugged from the wall outlet.
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 6) Case fan(s) is unplugged from the motherboard.

 7) Front panel power button connection is reversed or disconnected.

 8) Dead power supply.

 4. List the steps taken to fix the problem.

 ________________________________________________________________________

 1) Disconnect the power and remove the case cover.

 (a) Locate and plug the power cable into the hard drive.

 (b) Put the computer case together.

 (c) Connect the power supply to the wall outlet.

 (d) Start the computer.

 2) Disconnect the power and remove the case cover.

 (a) Press outward on the clips that hold the sides of the RAM.

 (b) Align the notch of the RAM with the RAM socket.

 (c) Gently press down until the clips lock.

 (d) Put the computer case together.

 (e) Connect the power supply to the wall outlet.

 (f) Start the computer.

 3) Disconnect the power and remove the case cover.

 (a) Locate and plug the power cable into the motherboard.

 (b) Put the computer case together.

 (c) Connect the power supply to the wall outlet.

 (d) Start the computer.

 4) Disconnect the power and remove the case cover.

 (a) Open the ZIF lever.

 (b) Align pin 1 of the CPU with the CPU socket.

 (c) Place the CPU gently in the socket.

  (d) Close the ZIF lever.

 (e) Apply thermal grease to the CPU.

 (f) Attach the CPU heat sink and fan assembly

 (g) Put the computer case together.

 (h) Connect the power supply to the wall outlet. 

 (i) Start the computer.

 5) Plug the power cord into the wall outlet.
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 6) Disconnect the power and remove the case cover.

 (a) Locate and plug the fan power cable into the motherboard.

 (b) Put the computer case together.

 (c) Connect the power supply to the wall outlet.

 (d) Start the computer.

 7) Disconnect the power and remove the case cover.

 (a) Disconnect the incorrectly installed front panel power button 
connections.

 (b) Install the connectors the correct way.

 (c) Put the computer case together.

 (d) Connect the power supply to the wall outlet.

 (e) Start the computer.

 8) Disconnect the power and remove the case cover.

 (a) Remove the power supply.

 (b) Install a working power supply.

 (c) Put the computer case together.

 (d) Connect the power supply to the wall outlet.

 (e) Start the computer.
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CHAPTER 5

Networking Concepts

To meet the expectations and needs of your customers and network users, technicians must be familiar 
with networking concepts. This knowledge will help you successfully design, implement, and trouble-
shoot networks. This chapter reviews network principles, standards, and purposes. It also reviews the 
basics of network design and how some components affect the flow of data on a network.
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Study Guide

Network Components and Types
Network components and types include network icons, topologies, and all the ways users con-
nect to networks and the Internet.

Types of Networks
Networking engineers use a variety of icons and topologies to represent network devices and 
architectures.

Identify the Network Icon

In Figures 5-1, 5-2, and 5-3, label the network icons.

Figure 5-1 Host Device Icons

Answer: From left to right. TOP: Desktop computer, Laptop computer, Server;
MIDDLE: Tablet, Smartphone, Printer; BOTTOM: Camera, IP phone, Scanner
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Figure 5-2 Intermediary Device Icons

Answer: From left to right: TOP: Switch, Router; MIDDLE: Access point, Wireless router; 
BOTTOM: Modem

Figure 5-3 Network Media Icons

Answer: From top to bottom: LAN media, WAN media, Wireless media, Cloud
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Check Your Understanding—Types of Networks

Match the definition on the left with the network type on the right. This exercise is a 
one-to-one matching.

Definitions

 a. This network typically uses wire cable 
to connect devices to a switch in a 
small geographical area.

 b. This network spans across a large 
campus or city.

 c. This network can extend beyond tra-
ditional LANs and group users based 
on administratively defined boundar-
ies instead of physical boundaries.

 d. This network connects devices in 
close proximity to the user, usually 
using Bluetooth.

 e. This network allows users to securely 
connect to another network across 
unsecure networks.

 f. This network connects networks 
across a large geographical distance, 
such as the Internet.

 g. Wireless APs connect to extend the 
reach of this wireless network.

 h. This LAN wirelessly connects devices 
to the network.

Network Type

 a. LAN

 b. MAN

 d. PAN

 c. VLAN

 e. VPN

 f. WAN

 h. WLAN

 g. WMN

Internet Connection Types
Connecting to the Internet has evolved from analog telephone to broadband. Analog telephone 
Internet access, also known as dialup, transmits data over standard voice telephone lines. Inte-
grated Services Digital Network (ISDN) uses multiple channels to send voice, video, and data 
over normal telephone wires. ISDN bandwidth is larger than traditional dialup and is consid-
ered a type of broadband. Broadband uses different frequencies to send multiple signals over 
the same medium. Some common broadband network connections include cable, digital sub-
scriber line (DSL), ISDN, satellite, and cellular.

Check Your Understanding—Internet Connection Types

Match the definition on the left with the Internet connection type on the right. This exercise is 
a one-to-one matching.
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Definitions

 a. This increasingly popular choice for 
Internet connections to homes and 
businesses uses light to transmit 
data.

 b. This connection uses coaxial cables 
to deliver a variety of content, 
including video, Internet, and voice 
calls.

 c. This is the process of connecting 
another device to a cell phone so that 
the connected device can access the 
Internet.

 d. This is a popular choice for rural mar-
kets that do not have a DSL or cable 
provider.

 e. These technologies use different fre-
quencies to send multiple signals over 
the same medium.

 f. This digital phone service can 
also provide a connection to the 
Internet.

 g. This connection uses towers distrib-
uted throughout a user’s coverage 
area to provide seamless access to 
phone and Internet services.

 h. Using this connection, a cell phone is 
configured to allow other devices to 
connect via Wi-Fi.

Term

 e. Broadband

 b. Cable

 g. Cellular

 f. DSL

 a. Fiber

 h. Mobile hotspot

 d. Satellite

 c. Tethering

Networking Protocols, Standards, and Services
Networks use a variety of protocols, standards, and services to enable devices to communicate 
with each other.

Transport Layer Protocols
Network communication involves a suite of protocols known as the Transmission Control 
 Protocol/Internet Protocol (TCP/IP) suite. Transport layer protocols include TCP and User 
Datagram Protocol (UDP).

Check Your Understanding—Transport Layer Protocols

In Table 5-1, indicate whether the transport characteristic is unique to TCP or UPD.
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Table 5-1 TCP or UDP?

Characteristic TCP UDP

Delivers data in sequenced order X

Does not resend lost data X

Is analogous to sending a tracked package X

Acknowledges data X

Is fast X

Delivers data as it arrives X

Is a best-effort delivery protocol X

Does not require acknowledgments X

Numbers and tracks data segments X

Resends lost data X

Is analogous to sending a letter in the mail X

Has low overhead X

Is reliable X

Application Port Numbers
TCP and UDP use source and destination port numbers to keep track of application conver-
sations. The source port number is associated with the originating application on the local 
device. The destination port number is associated with the destination application on the 
remote device. These are not physical ports. They are numbers that are used by TCP and UDP 
to identify the applications that should handle the data.

Identify the Application Protocol Information

In Table 5-2, fill in the transport protocol (TCP, UDP, or both), the acronym, and the applica-
tion name for each port number and description.

Table 5-2 Application Protocols

Port Transport 
Protocol

Acronym Name Description

20 TCP FTP File Transfer 
Protocol

This protocol is used to transfer files 
between computers. It is considered 
insecure.

21 TCP FTP File Transfer 
Protocol

This protocol is used between the client and 
server to start a data transfer session.

22 TCP SSH Secure Shell This protocol provides a strong authentica-
tion and encrypted data for command-line 
access to a remote computer.

23 TCP Telnet Telnet This insecure remote-access protocol pro-
vides command-line access to a remote 
computer.

25 TCP SMTP Simple Mail 
Transfer 
Protocol

This protocol is used to send email from cli-
ents to an email server.
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Port Transport 
Protocol

Acronym Name Description

53 TCP,
UDP

DNS Domain Name 
Service

This protocol finds the IP address associated 
with a registered Internet domain for web, 
email, and other Internet services. It uses 
UDP for requests and information transfer 
between DNS servers. TCP is used for DNS 
responses if required.

67/68 UDP DHCP Dynamic Host 
 Configuration 
Protocol

This protocol automatically provides IP 
addresses to network hosts and provides a 
way to manage those addresses. The DHCP 
server uses UDP port 67, and the client host 
uses UDP port 68.

69 UDP TFTP Trivial File 
Transfer 
Protocol

This simple file transfer protocol uses less 
overhead than FTP.

80 TCP HTTP Hypertext 
Transfer 
Protocol

This protocol provides a set of rules for 
exchanging text, graphic images, sound, 
video, and other multimedia files on 
the web.

110 TCP POP3 Post Office 
Protocol 3

This protocol is used by email clients to 
retrieve messages from an email server.

137–
139

UDP,
TCP

NetBIOS 
(NetBT)

NetBIOS This protocol provides a system through 
which older computer applications can 
communicate over large TCP/IP networks. 
Different NetBT functions use different pro-
tocols and ports in this range.

143 TCP IMAP Internet Mes-
sage Access 
Protocol

This more advanced protocol is used for 
retrieving email messages from a server.

161/
162

UDP SNMP Simple Net-
work Manage-
ment Protocol

This protocol enables network administra-
tors to monitor network operations from 
centralized monitoring stations.

389 TCP,
UDP

LDAP Lightweight 
Directory 
Access 
Protocol

This protocol is used to maintain user iden-
tity directory information that can be shared 
across networks and computers.

427 UDP, 
TCP

SLP Service Loca-
tion Protocol

This protocol allows computers and other 
devices to locate services on a LAN without 
previous configuration.

443 TCP, 
UDP

HTTPS HTTP Secure Using this protocol, the browser uses 
encryption and authenticates your connec-
tion with the web server.

445 TCP SMB Server Mes-
sage Block

This protocol is also called Common Inter-
net File System (CIFS); it allows for shar-
ing of files, printers, and other resources 
between nodes on a network.
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Port Transport 
Protocol

Acronym Name Description

548 TCP, 
UDP

AFP Apple Filing 
Protocol

This proprietary protocol is used to enable 
file services for macOS and classic Mac OS.

3389 TCP, 
UDP

RDP Remote 
Desktop 
Protocol

This protocol was developed by Microsoft 
to provide remote access to the graphical 
desktop of a remote computer.

Wireless Protocols
The Institute of Electrical and Electronics Engineers (IEEE) standards for Wi-Fi are specified in 
the 802.11 collective group of standards that specify the radio frequencies, speeds, and other 
capabilities for WLANs.

Identify the IEEE 802.11 Characteristics

In Table 5-3, fill in the maximum speed and frequency for each 802.11 standard.

Table 5-3 Comparing 802.11 Standards

IEEE Standard Maximum Speed Maximum 
Indoor Range

Frequency Backward 
Compatible

802.11a 54 Mb/s 115 ft (35 m) 5 GHz —

802.11b 11 Mb/s 115 ft (35 m) 2.4 GHz —

802.11g 54 Mb/s 125 ft (38 m) 2.4 GHz 802.11b

802.11n 600 Mb/s 230 ft (70 m) 2.4 GHz and 
5 GHz

802.11a/b/g

802.11ac 1.3 Gb/s 115 ft (35 m) 5 GHz 802.11a/n

Identify Cellular Speeds

Cellular technology uses a cell phone network to connect to the Internet. Performance is lim-
ited by the capabilities of the phone and the cell tower to which it is connected. Cellular tech-
nology has evolved through multiple generations (the “G” in abbreviation). Click each cellular 
technology for a brief description.

In Table 5-4, fill in the speed ranges for each cellular generation.

Table 5-4 Cellular Generations

Cellular 
Technology

Description Speeds

1G/2G First generation (1G) cell phones were analog voice calls only. 
2G introduced digital voice, conference calls, and caller ID.

9.6 Kb/s

2.5G 2.5G supports web browsing, short audio and video clips, 
games, and downloads of applications and ring tones.

9.6 Kb/s to 
237 Kb/s

3G 3G supports full-motion video, streaming music, 3D gam-
ing, and faster web browsing.

144 Kb/s to 
2 Mb/s

3.5G 3.5G supports high-quality streaming video, high-quality 
videoconferencing, and Voice over IP (VoIP).

400 Kb/s to 
16 Mb/s
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Cellular 
Technology

Description Speeds

4G 4G supports IP-based voice, gaming services, high-quality 
streamed multimedia, and Internet Protocol version 6 (IPv6). 

5.8 Mb/s to 
672 Mb/s

LTE Long Term Evolution (LTE) is a designation for a 4G tech-
nology that meets the 4G speed standards.

50 Mb/s to 
1 Gb/s

5G The 5G standard was ratified in June 2018 and is currently 
being implemented in select markets. 5G supports a wide 
variety of applications, including augmented reality (AR), 
virtual reality (VR), smart homes, smart cars, and any sce-
nario where data transfer occurs between devices. 

400 Mb/s to 
3 Gb/s download

500 Mb/s to 
1.5 Gb/s upload

Check Your Understanding—Wireless Protocols

Match the characteristic on the left with the wireless protocol on the right. This exercise is a 
one-to-one matching.

Characteristic

 a. A legacy WLAN standard with a 
maximum speed of 54 Mb/s.

 b. A wireless PAN technology that sup-
ports up to seven connected devices.

 c. A proprietary smart home standard 
that can support up to 232 connected 
devices in the same wireless mesh 
network.

 d. A technology that meets the stan-
dards for 4G mobile phones.

 e. The standard that all WLANs should 
use when implementing new devices.

 f. A secure close proximity transaction 
system typically used for wireless 
payments.

 g. A wireless service for mobile devices 
that provides up to 3 Gb/s download 
speeds while traveling in a car.

 h. A smart home standard with some 
open-source code that uses IEEE 
802.15.4.

 i. A tag and reader system that can 
accommodate ranges up to 25 meters 
for passive tags and up to 100 meters 
for active tags.

Wireless Protocol

 g. 5G

 e. 802.11ac

 a. 802.11g

 b. Bluetooth

 d. LTE

 f. NFC

 i. RFID

 h. Zigbee

 c. Z-Wave
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Network Services
Network services require a server. Devices that access the server are called clients. Each service 
requires separate server software. For example, a server requires web server software in order 
to provide web services to clients. A computer with server software can provide services simul-
taneously to one or many clients. Additionally, a single computer can run multiple types of 
server software.

Clients need software installed in order to request and display the information obtained from 
the server. An example of client software is a web browser, like Chrome or FireFox. A single 
computer can also run multiple types of client software. For example, a user can check email 
and view a web page while instant messaging and listening to Internet radio.

Check Your Understanding—Network Services

Match the definition on the left with the server type on the right. This exercise is a 
one-to-one matching.

Definitions

 a. Provides the ability to cache web 
pages for quick access.

 b. Provides IP addresses to hosts on the 
network.

 c. Provides a method for storing system 
messages from networking devices.

 d. Uses protocols such as SMTP and 
POP3 to send messages.

 e. Translates a domain name, such as 
cisco.com, to an IP address.

 f. Typically uses a AAA server.

 g. Uses protocols such as FTPS, SFTP, 
and SCP.

 h. Uses protocols such as HTTP and 
HTTPS to display information in a 
browser.

Server

 f. Authentication

 b. DHCP

 e. DNS

 g. File

 d. Email

 a. Proxy

 c. Syslog

 h. Web

Network Devices
Network devices include a variety of devices used to connect host devices to each other, secu-
rity devices to authenticate access and protect user data, and legacy devices and cloud-based 
devices.

Basic Network Devices
Basic network devices include network interface cards (NICs), repeaters, bridges, hubs, 
switches, wireless access points (APs), and routers.
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Check Your Understanding—Basic Network Devices

Match the definition on the left with the network device on the right. This exercise is a 
one-to-one matching.

Definitions

 a. This device regenerates weak network 
signals.

 b. This device connects networks and 
forwards data based on the IP address.

 c. This legacy device was used to divide 
a LAN into segments.

 d. This legacy device extended the 
number of devices that could be con-
nected to the LAN.

 e. This device microsegments a LAN 
and forwards data based on the MAC 
address.

 f. This device connects devices to the 
network.

 g. This device uses radio waves to extend 
the distance of a network.

Network Device

 c. Bridge

 d. Hub

 f. NIC

 a. Repeater

 b. Router

 e. Switch

 g. AP

Security Devices
Security devices include firewalls, intrusion detection systems (IDSs), intrusion prevention sys-
tems (IPSs), unified threat management (UTM), and endpoint management servers.

Check Your Understanding—Security Devices

Match the definition on the left with the security device on the right. This exercise is a one-to-
one matching.

Definitions

 a. A device that offers stateful packet 
inspection along with other advanced 
security features.

 b. A device placed between an internal and 
external network to filter traffic based 
on rules defined in an ACL.

 c. A device that centralizes the view 
of all devices in the network so that 
administrators can manage them from 
one interface.

 d. A device that is installed inline on the 
network to evaluate traffic before for-
warding it to the destination.

 e. A device that copies traffic and 
forwards it to a management station 
for evaluation.

Security Device

 c. Endpoint management server

 b. Firewall

 e. IDS

 d. IPS

 a. UTM
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Other Network Devices
Other network devices include legacy and embedded systems, patch panel, Power 
over  Ethernet (PoE) devices, Ethernet over Power devices, and cloud-based network 
controllers.

Check Your Understanding—Other Network Devices

Match the definition on the left with the network device on the right. This exercise is a 
one-to-one matching.

Definitions

 a. These special-purpose microchips 
are programmed to carry out specific 
functions.

 b. This term refers to sending low-voltage 
electricity down a network cable to 
provide power to devices.

 c. This is a collection point for cable 
runs from network devices.

 d. This term refers to sending data 
down power lines to network 
devices.

 e. This system can no longer be 
upgraded or patched.

 f. This device allows administrators 
to remotely manage many devices 
through one dashboard interface.

Other Network Device

 f. Cloud-based network controller

 a. Embedded

 d. Ethernet over Power

 e. Legacy

 c. Patch panel

 b. Power over Ethernet

Network Cables
Cables used to connect network devices include copper cables and fiber cables. Various tools 
are used to install, repair, and test network cables.

Network Tools
Network technicians typically have a fully stocked toolkit.
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Check Your Understanding—Network Tools

Match the definition on the left with the network tool on the right. This exercise is a 
one-to-one matching.

Description

 a. Checks for wiring shorts, faults, and 
wires connected to the wrong pins.

 b. Is used to attach RJ-45 and RJ-11 
 connectors to cables.

 c. Tests the functionality of the send and 
receive signals on computer ports.

 d. Is primarily used to determine signal 
strength so that access points can be 
positioned for maximum coverage.

 e. Terminates wires in a termination 
block.

 f. Is used to trace the remote end of a 
cable.

 g. Typically comes with a variety of 
notches for different wire gauges.

 h. Measures electrical characteristics to 
test the characteristics of circuits.

 i. Is designed to snip aluminum and 
 copper wire.

Network Tools

 a. Cable tester

 b. Crimper

 c. Loopback adapter

 h. Multimeter

 e. Punch-down tool

 f. Tone generator and probe

 d. Wi-Fi analyzer

 i. Wire cutter

 g. Wire stripper

Copper Cables and Connectors
Coaxial and twisted-pair cables use electrical signals over copper to transmit data. Fiber-optic 
cables use light signals to transmit data. These cables differ in bandwidth, size, and cost.

Identify the Cable Type

In Figure 5-4, label each network cable.
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Figure 5-4 Network Cables

Answer: TOP: Twisted-pair, Coaxial; BOTTOM: Fiber-optic

Identify the Twisted-Pair Category Speeds

The distance limitation of unshielded twisted-pair (UTP) cabling used for data is 100 meters 
(330 feet). Each category also comes in plenum-rated versions, which are installed inside 
plenum areas of buildings. A plenum is any area that is used for ventilation, such as the area 
between the ceiling and a dropped ceiling. Plenum-rated cables are made from a special plastic 
that retards fire and produces less smoke than other cable types.

In Table 5-5, fill in the speed for each twisted-pair category.

Table 5-5 Twisted-Pair Categories

Category Speed Features

Cat 5 UTP 100 Mb/s at 100 MHz  ■ This is the first widely adopted 4-pair UTP 
that replaced Cat 3 UTP in Ethernet LANs.

 ■ It is manufactured with a higher standard 
than Cat 3 to allow for higher data transfer 
rates.
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Category Speed Features

Cat 5e UTP 1 Gb/s at 100 MHz  ■ It is manufactured with a higher standard 
than Cat 5 to allow for higher data transfer 
rates.

 ■ It has more twists per foot than Cat 5 to 
better prevent EMI and RFI from outside 
sources.

Cat 6 UTP 1 Gb/s at 250 MHz 
(Cat 6a - 500 MHz)

 ■ It is manufactured with a higher standard 
than Cat 5e to allow for higher data transfer 
rates.

 ■ It has more twists per foot than Cat 5e to 
better prevent EMI and RFI from outside 
sources.

 ■ It may have a plastic divider to separate 
pairs of wires inside the cable to better 
 prevent EMI and RFI.

 ■ This is a good choice for customers using 
applications that require large amounts of 
bandwidth, such as videoconferencing or 
gaming.

 ■ Cat 6a has better insulation and perfor-
mance than Cat6.

Label the Twisted-Pair Wiring Scheme

There are two different patterns, or wiring schemes, called T568A and T568B. Each wiring 
scheme defines the pinout, or order, of wire connections at the end of the cable.

On a network installation, one of the two wiring schemes (T568A or T568B) should be chosen 
and followed. It is important that the same wiring scheme is used for every termination in that 
project. If you are working on an existing network, use the wiring scheme that already exists.

In Figure 5-5, use the color labels in Table 5-6 to label the wiring scheme for the T568A and 
T568B standards.

Table 5-6 Color Labels

Label Description

BN Brown

W/BN Brown with white stripe

BL Blue

W/BL Blue with white stripe

G Green

W/G Green with white stripe

O Orange

W/O Orange with white stripe
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Figure 5-5 Network Cables

T568A T568B

Answers from left to right: T568A: W/G, G, W/O, BL, W/BL, O, W/BN, BN; T568B: W/O, O, 
W/G, BL, W/BL, G, W/BN, BN

Fiber Cables and Connectors
Fiber-optic cable is not affected by EMI or RFI. All signals are converted to light pulses as 
they enter the cable and converted back into electrical signals when they leave it. This means 
that fiber-optic cable can deliver signals that are clearer, can go farther, and have greater band-
width than cable made of copper or other metals. Optical fiber is durable and is deployed in 
harsh environmental conditions in networks all around the world.

Label the Parts of a Fiber-Optic Cable

In Figure 5-6, label the parts of a fiber-optic cable.

Figure 5-6 Fiber-Optic Cable Cross-Section

Answers top to bottom: Jacket, Strengthening material, Buffer, Cladding, Core
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Identify the Fiber-Optic Connectors

An optical fiber connector terminates the end of an optical fiber. Various optical fiber con-
nectors are available. The main differences among the types of connectors are dimensions and 
methods of coupling. Businesses decide on the types of connectors that will be used, based on 
their equipment.

In Table 5-7, fill in the type for each connector.

Table 5-7 Fiber-Optic Connectors

Type Example Description

Straight-Tip (ST) 
Connectors

One of the first connector 
types used. The connector locks 
securely with a “twist-on/twist-
off” bayonet-style mechanism.

Subscriber Connector (SC) 
Connectors

Sometimes referred to as square 
connector or standard connector. 
This widely adopted LAN and 
WAN connector uses a push-pull 
mechanism to ensure positive 
insertion. This connector type is 
used with multimode and single-
mode fiber.

Lucent Connector (LC) 
Simplex Connectors

A smaller version of the fiber-
optic SC connector. It is some-
times called a little or local 
connector and is quickly growing 
in popularity due to its smaller 
size.

Duplex Multimode LC 
Connectors

Similar to an LC simplex connec-
tor but uses a duplex connector.

Check Your Understanding—Fiber Cables and Connectors

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. This uses a laser and is popular for 
long-distance runs spanning hundreds 
of kilometers.

 b. This technology is used to send and 
receive on a single strand of fiber.

 c. This protects the fiber against 
abrasion, moisture, and other 
contaminants.

 d. This is a fiber standard for cables in 
which light travels in one direction.

 e. This is the element in a fiber-optic 
cable through which light pulses 
travel.

 f. This is the fiber standard for cables 
in which light can travel in both 
directions.

 g. This acts like a mirror reflecting light 
to keep it traveling down the fiber.

 h. This uses LED emitters, is popular for 
LANs, and runs up to 550 meters.

Term

 f. BX

 g. Cladding

 e. Core

 d. FX

 c. Jacket

 h. Multimode fiber

 a. Single-mode fiber

 b. WDM
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Labs and Activities

Command Reference
Chapter 5, “Networking Concepts,” does not include new commands.
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5.4.2.8 Lab–Build and Test a Network Cable 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will build and test a straight-through Unshielded Twisted-Pair (UTP) Ethernet 
network cable.

Note: With a straight-through cable, the color of wire used by pin 1 on one end is the same color used 
by pin 1 on the other end, and similarly for the remaining seven pins. The cable will be constructed using 
either TIA/EIA T568A or T568B standards for Ethernet. This determines which color wire is to be used 
on each pin. Straight-through cables are normally used to connect a host directly to a switch or a wall 
plate in an office area.

Recommended Equipment
 ■ One 2 to 3 ft. (0.6 to 0.9 meter) lengths of UTP cable, Category 5 or 5e

 ■ A minimum of two RJ-45 connectors (more may be needed if wiring mistakes occur)

 ■ An RJ-45 crimping tool

 ■ Two computers with operating systems installed

 ■ Wire cutters

 ■ Wire stripper

 ■ Ethernet wire map tester

 ■ Ethernet cable meter (optional)

 ■ Ethernet certification meter (optional)

Wire Diagrams
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T568A Wiring Standard

Pin No. Pair No. Wire Color Function

1 3 Green/White Transmit

2 3 Green Transmit

3 2 Orange/White Receive

4 1 Blue Not used

5 1 Blue/White Not used

6 2 Orange Receive

7 4 Brown/White Not used

8 4 Brown Not used

T568B Wiring Standard

Pin No. Pair No. Wire Color Function

1 2 Orange/White Transmit

2 2 Orange Transmit

3 3 Green/White Receive

4 1 Blue Not used

5 1 Blue/White Not used

6 3 Green Receive

7 4 Brown/White Not used

8 4 Brown Not used
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Instructions
Step 1: Obtain and prepare the cable.

a. Determine the length of cable required. This could be the distance from a 
computer to a switch or between a device and an RJ-45 outlet jack. Add 12 in. 
(30.5 cm.) to the total distance. The TIA/EIA standard states the maximum 
length is 16.4 ft. (5 m). Standard Ethernet cable lengths are usually 2 ft (0.6 m.), 
6 ft. (1.8 m.), or 10 ft. (3m).

Question:

Which length of cable did you choose, and why did you choose this length?

 ________________________________________________________________________

Answers may vary.

b. Cut a piece of UTP cable to the desired length.

c. Using wire strippers, remove 2 in (5 cm.) of the cable jacket from both ends of 
the cable.

Step 2: Prepare and insert the wires.

a. Determine which wiring standard will be used. Circle the standard.

T568A T568B

b. Locate the correct table or figure from the Wire Diagrams based on the wiring 
standard used.

c. Spread the cable pairs and arrange them roughly in the desired order based on 
the standard chosen.

d. Untwist a short length of the pairs and arrange them in the exact order needed 
by the standard, moving left to right starting with pin 1. It is very important to 
untwist as little as possible. The twists are important because they provide 
noise cancellation.

e. Straighten and flatten the wires between your thumb and forefinger.

f. Ensure the cable wires are still in the correct order as the standard.

g. Cut the cable in a straight line to within 0.5 to .75 in. (1.25 to 1.9 cm.) from the 
edge of the cable jacket. If it is longer than this, the cable will be susceptible to 
crosstalk (the interference of bits from one wire with an adjacent wire).

h. The key (the prong that sticks out from the RJ-45 connector) should be on the 
underside pointing downward when inserting the wires. Ensure the wires are in 
order from left to right starting with pin 1. Insert the wires firmly into the RJ-45 
connector until all wires are pushed to the end of the connector. 
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Step 3: Inspect, crimp, and reinspect the connector.

a. Visually inspect the cable and ensure the right colors are aligned to the correct 
pins.

b. Visually inspect the end of the connector. The eight wires should be pressed 
firmly against the end of the RJ-45 connector. Some of the cable jacket should 
be inside the first portion of the connector. This provides strain relief for the 
cable. If the cable jacket is not far enough inside the connector, it may eventu-
ally cause the cable to fail.

c. If everything is correctly aligned and inserted properly, place the RJ-45 connec-
tor and cable into the crimper. The crimper will push two plungers down on the 
RJ-45 connector. 

d. Visually reinspect the connector. If improperly installed, cut the end off and 
repeat the process.

Step 4: Terminate the other cable end.

a. Attach an RJ-45 connector to the other end of the cable using the previous 
steps.

b. Visually reinspect the connector. If it is improperly installed, cut the end off 
and repeat the process.

Question:

Which standard is used for the cables in your school?

 ________________________________________________________________________

Answers may vary.
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Step 5: Test the cable with a cable tester.

Turn on the tester and plug the cable into the jacks labeled with the wiring standard 
you used. 

Note: If the cable tester does not have different jacks for different standards, refer to the 
documentation of the cable tester to determine how to test your cable.

All green lights on both parts of the cable tester should sequence to indicate that 
each wire is terminated correctly and in the proper order.

Any other lights indicate a wiring fault. Refer to the documentation of the cable tes-
ter to find which type of fault the cable has.

Question:

What did the lights indicate when you connected your cable? Write down the faults 
and pairs where the faults occurred if your cable did not pass.

 ________________________________________________________________________

Answers may vary: good, open, short, reversal, transposed pairs, etc.

Step 6: Test the cable using a cable meter or cable certification meter (Optional).

Instructor Note: If you have a cable meter or certification meter, you may choose 
to demonstrate how these devices are used. 

If your lab has a cable meter or cable certification meter, use it to validate your find-
ings from the cable tester. If possible, use the meter to determine the exact length of 
the cable.

Question:

What were the findings from the cable meter or cable certification meter?

 ________________________________________________________________________

Answers may vary.

Step 7: Connect a computer using the cable.

a. Connect a PC to another computer, router, or switch.

b. Visually check the LED status lights on the NIC. If they are on (usually green or 
amber), the cable is functional.

c. Open a command prompt on one of the computers by clicking Start and enter-
ing a command prompt.
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d. Type ipconfig at the prompt.

C:\Users\ITEUser> ipconfig

 

Windows IP Configuration

 

Ethernet adapter Ethernet:

 

    Connection-specific DNS Suffix  . : example.com

    Link-local IPv6 Address . . . . . : fe80::3dfb:37ab:4bd5:4d07%5

    IPv4 Address. . . . . . . . . . . : 192.168.1.73

    Subnet Mask . . . . . . . . . . . : 255.255.255.0

    Default Gateway . . . . . . . . . : 192.168.1.1

Question:

Write down the default gateway IP address.

 ________________________________________________________________________

Answers may vary.

e. From the command prompt, type ping default gateway IP address. If the cable 
is functional, the ping should be successful (provided that no other network 
problem exists and the default gateway router is connected and functional).

Question:

Was the ping successful?

 ________________________________________________________________________

The ping should be successful. If not, verify the default gateway IP address and 
repeat the lab as necessary.

If the ping fails, repeat the lab.
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CHAPTER 6

Applied Networking

This chapter reviews network addressing, how to install and configure network interface cards (NICs), 
how to connect devices to a wireless router, and how to configure a wireless router for network 
connectivity. You also review firewall settings for a home router and the emerging field of Internet of 
Things (IoT). Finally, you review how to apply a systemic method for troubleshooting.
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Study Guide

Device-to-Network Connections
Device-to-network connections include understanding how devices use addressing, connecting 
devices to the network, configuring the network, applying firewall settings, and configuring 
any IoT devices.

Network Addressing
The two network addresses include the Media Access Control (MAC) address and the Internet 
Protocol (IP) address. IP has two versions: IP version 4 (IPv4) and IP version 6 (IPv6). Review 
the three videos in the course on MAC addressing, IPv4 addressing, and IPv6 addressing.

Check Your Understanding—Network Addressing

Match the definition on the left with the term on the right. The terms may be used for more 
than one definition. Choose IP address when the definition applies to both IPv4 and IPv6 
addresses.
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Definitions

 e.  This 128-bit address is represented 
in hexadecimal format.

 d.  This 32-bit address is represented 
in dotted-decimal format.

 e.  This link-local address is always 
assigned to the device.

 f. 0050.56BE.D787

 g.  This statically assigns IP addressing 
to a device.

 c.  This address typically changes 
when a device moves to another 
network.

 h.  This is used to identify the 
network on which the computer is 
connected.

 f.  This address does not change when 
a device moves to another network.

 b.  This automatically assigns 
IP addressing to a device.

 d. 192.168.200.8

 c.  This address is analogous to a 
mailing address.

 a.  This identifies the router that 
the device will use to access the 
Internet or another network.

 e.  2001:db8:1111:d787

 d.  This link-local address is assigned 
when a device cannot get an IPv4 
address.

 f.  This address is analogous to a 
fingerprint.

Terms

 a. Default gateway

 b. DHCP

 c. IP address

 d. IPv4 address

 e. IPv6 address

 f. MAC address

 g. Network administrator

 h. Subnet mask

Configure a NIC
Every host that connects to a network requires some type of hardware to interface with the 
network. For wired networks, this hardware is called a network interface card (NIC). For 
wireless networks, it is called a wireless NIC. Today, wired and wireless network interfaces are 
often integrated directly into the motherboard.

Check Your Understanding—Configure a NIC

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definitions

 a. This is the default for Windows com-
puters and many other devices.

 b. This may need to be disabled when 
installing updates.

 c. This sends ICMP echo requests to the 
specified IP address.

 d. This is a wireless device that clients 
connect to in order to gain access to 
the wireless network.

 e. This is an internal or external wired or 
wireless device clients use to connect 
to a network.

 f. Close all applications before installing 
this.

Terms

 d. AP

 f. Driver

 a. Dynamic addressing

 e. NIC

 c. Ping

 b. Virus protection

Configure Wired and Wireless Networks
Configuring wired and wireless networks includes a variety of tasks including the following:

 ■ Connecting cables

 ■ Accessing the router’s web page

 ■ Changing passwords

 ■ Modifying WAN settings

 ■ Modifying LAN settings

 ■ Modifying wireless settings

 ■ Connecting to the wireless network

Review the video in the course for a demonstration of how to configure wired and wireless 
networks.
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Check Your Understanding—Configure Wired and Wireless Networks

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This security mode can use AES or 
TKIP encryption.

 b. This translates a publicly routable IPv4 
address into private IPv4 addresses.

 c. This wireless frequency is used by 
the router to avoid interference with 
other APs.

 d. This WAN port setting allows the ISP 
to specify the IP address.

 e. This guarantees that certain traffic 
types are prioritized over others.

 f. This is created by extending the 
WLAN with additional APs.

 g. This wireless setting allows multiple 
802.11 standards.

 h. This is the name of a wireless network.

Terms

 c. Channel

 d. DHCP

 g. Mixed

 b. NAT

 e. QoS

 h. SSID

 f. WMN

 a. WPA2

Order the Steps for Basic Network Setup

In Table 6-1, label the steps in the proper order from 1 to 6.

Table 6-1 Basic Network Setup

Step Number Step

4 Change the default DHCP settings.

3 Log in with the new administrative password.

5 Renew the IP address.

6 Log in using the router's new IP address.

1 Log in to the router's default IP address from a web browser.

2 Change the default administrative password.

Firewall Settings
Configuring a firewall includes configuring the demilitarized zone (DMZ) and firewall rules. 
Review the video in the course for a demonstration of how to configure a firewall.
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Check Your Understanding—Firewall Settings

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definitions

 a. This allows a router to temporarily 
forward data through inbound ports 
to a specific device.

 b. This enables devices to dynamically 
add themselves to a network without 
the need for user intervention.

 c. This allows access to specific web-
sites permitted by the router’s 
administrator.

 d. This network is open to the public 
that exists behind the firewall.

 e. This is a rule-based method of direct-
ing traffic between devices on sepa-
rate networks.

 f. This blocks access to specific websites 
denied by the router’s administrator.

 g. This specifies exactly which devices 
are allowed or blocked regardless of 
the devices’ IP addresses.

Terms

 f. Blacklisting

 d. DMZ

 g. MAC address filtering

 e. Port forwarding

 a. Port triggering

 b. UPnP

 c. Whitelisting

IoT Device Configuration
The evolving Internet is becoming an Internet of Things (IoT). The sensor-equipped, Internet-
ready devices of tomorrow will include everything from automobiles and biomedical devices to 
household appliances and natural ecosystems.

Complete the activity titled Packet Tracer–Configure IoT Devices to review a simulation of 
IoT device configuration.

Network Troubleshooting
Although the problems and solutions are unique to networks, the troubleshooting methodol-
ogy is the same.

Network Troubleshooting Process
Use open-ended and closed-ended questions to identify a customer’s problem. Then proceed 
through the rest of the troubleshooting steps to fix the problem and document the solution.

A logical approach to troubleshooting allows you to eliminate variables and identify causes of 
problems in a systematic order.
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Review the Troubleshooting Process Steps

In Table 6-2, list the six troubleshooting steps.

Table 6-2 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive measures.

Step 6 Document findings, actions, and outcomes.

Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the right hardware, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or no answer. In Table 6-3, indicate 
whether the technician’s question is open-ended or closed-ended.

Table 6-3 Open-Ended and Closed-Ended Questions

Question Open-Ended Closed-Ended

Are you currently logged in to the network? X

What problems are you experiencing with your device? X

Is anyone else having this problem? X

What software has been installed on your device recently? X

What were you doing when the problem was identified? X

Can you see any shared files or printers? X

What type of network connection is the device using? X

Can you access the Internet? X

Have you changed your password recently? X

What error message have you received? X

Has anyone else used your device recently? X

Network Problems and Solutions
Network problems can be attributed to hardware, software, or configuration issues, or to some 
combination of the three.
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Check Your Understanding—Possible Solutions for Networks

Check your understanding of common and advanced problems and solutions for networks by 
choosing the BEST answer to the following questions.

 1. A device cannot detect the wireless router.

 a. Configure the wireless router with a compatible protocol for the laptop.

 b. Configure the remote device for SSH access.

 c. Replace the NIC.

 d. Reconnect the network cable.

 e. Set the firewall to enable the ping protocol.

 2. A Windows computer has an IPv4 address of 169.254.x.x.

 a. Configure the wireless router to broadcast the SSID.

 b. Change the wireless router to a different channel.

 c. Set the firewall to enable the ping protocol.

 d. Ensure the router is powered on and is properly connected to the network. Then 
release and renew the IPv4 address on the computer.

 e. Ensure the correct gateway address is assigned to the NIC.

 3. A user can access the local network but cannot access the Internet.

 a. Reconnect the network cable.

 b. Configure the wireless router to broadcast the SSID.

 c. Ensure the correct gateway address is assigned to the NIC.

 d. Configure the wireless router with a compatible protocol for the laptop.

 e. Replace the NIC.

 4. The network is fully functional, but the wireless device cannot connect to the network.

 a. Call the ISP to report the outage.

 b. Replace the NIC.

 c. Enable wireless capability of the device.

 d. Ensure the correct gateway address is assigned to the NIC.

 e. Re-enter the host name.

 5. A device can connect to a network device by the IP address but not by the host name.

 a. Re-enter the IP address of the DNS server.

 b. Restart the DHCP server.

 c. Enable the computer to obtain an IP address automatically.

 d. Enable the wireless NIC.

 e. Configure each device with a unique IP address.

Book 1.indb   144Book 1.indb   144 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 6: Applied Networking  145

 6. The device does not obtain or renew the IP address on the network.

 a. Enable the wireless NIC.

 b. Restart the DHCP server.

 c. Restart the DNS server.

 d. Configure each device with a unique IP address.

 e. Re-enter the IP address of the DNS server.

 7. A device on one network cannot ping a device on another network.

 a. Use tracert to locate which link is down and fix the broken link.

 b. Configure Windows firewall to allow ICMP echo requests and echo replies.

 c. Move the access point and ensure it is centrally located.

 d. Restart the DNS server.

 e. Configure the remote computer to accept Telnet connections.

Answer: 1 A, 2 D, 3 C, 4 C, 5 A, 6 B, 7 B
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Labs and Activities

Command Reference
In Table 6-4, record the command that fits the description. Fill in any blanks with the appropri-
ate missing information.

Table 6-4 Commands for Chapter 6, “Applied Networking”

Command Description

ipconfig /all A command that will display all the addressing information 
for a Windows PC including the IP addresses, MAC address, 
DNS server address, and default gateway.

ipconfig /renew A command that will send a new request to the DHCP server.

ping A command used to verify connectivity.

ping /? A command that shows all the available options that are used 
to verify connectivity.
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6.1.2.1 Packet Tracer–Add Computers to an Existing 
Network (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
 ■ Configure the computers to use DHCP

 ■ Configure static addressing on the server

 ■ Use ipconfig to retrieve host IP information

 ■ Use ping to verify connectivity

Hint: To ensure that the instructions always remain visible during an activity, click the Top check box in 
the lower left-hand corner of this instruction window.

Introduction
In this activity, you will investigate the topology, configure DHCP and static addressing, and 
use commands to verify addressing and test connectivity.

Instructions
Step 1: Study the Topology.

The topology shows two PCs, a switch, a server, a router, and a cloud.

a. Notice the PCs are connected to BranchSwitch using straight-through cables.

b. Notice the green triangles on each side of the straight-through links (next to 
each PC and next to BranchSwitch). Green triangles on both sides of a link 
indicate the correct cable type was used to connect those devices.

Note: There should be green triangles at both ends of each cable connection. If you do not 
see the green triangles, navigate to Options > Preferences from the Packet Tracer menu and 
check the Show Link Lights check box.

Step 2: Configure DHCP on the PCs.

a. Click PC0.

b. In the PC0 window, select the Desktop tab.

c. Click IP Configuration and select DHCP to enable the PC to act as a DHCP 
client. You should see the following message after clicking the DHCP button: 
DHCP request successful.

d. Close the PC0 configuration window by selecting the X in the upper right-hand 
corner.

e. Repeat steps 2a through 2d for PC1.

Packet Tracer 

  Activity
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Step 3: Observe the IP Configuration Information Assigned to Each PC.

a. Click PC0. Click the Desktop tab.

b. Click Command Prompt. At the PC> prompt, enter the ipconfig /all command. 
Press the space bar to see all the output.

c. Record the IP address, subnet mask, default gateway, and DNS server address 
information that was dynamically assigned via DHCP to PC0.

d. Repeat steps 3a through 3c for PC1.

e. Using the ping command, test connectivity between the PCs and the default 
gateway (BranchOffice FastEthernet 0/0 interface IP address).

 1) At the PC0> prompt, enter ping PC1’s IP address.

 2) At the PC0> prompt, enter ping default gateway IP address.

 3) At the PC1> prompt, enter ping PC0’s IP address.

 4) At the PC1> prompt, enter ping default gateway IP address.

Step 4: Switch to Static Addressing.

Despite all the benefits of dynamic addressing schemes such as DHCP, sometimes a 
static scheme is required. Configure Server0 to use static addressing.

a. Click Server0 to open the configuration window.

b. Click the Desktop tab. Click IP Configuration.

c. Verify that it is using static IP addressing.

Enter the IP information as follows:

IP Address: 172.16.1.100

Subnet Mask: 255.255.255.0

Default Gateway: 172.16.1.254

DNS: 209.165.200.226

d. Server0 is now configured with a static address. Close IP Configuration.

e. Click PC1 to open its configuration window.

f. In the command prompt, ping Server0. The pings should be successful.

Check your score. It should be 100%.
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6.1.2.7 Lab–Configure a NIC to Use DHCP in 
Windows (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will configure an Ethernet NIC to use DHCP to obtain an IP address and test 
connectivity between two computers.

Recommended Equipment
 ■ Wireless router

 ■ Two computers running Windows

 ■ Ethernet patch cables (straight-through cable)

Instructor Note: Set the PCs to static addressing with no addresses assigned so that the stu-
dents can see the impact of DHCP.

Instructions
Step 1: Connect the hosts to the router.

a. For Host A, plug one end of the Ethernet patch cable into Port 1 of the router.

b. For Host A, plug the other end of the Ethernet patch cable into the network 
port on the computer.

c. For Host B, plug one end of the Ethernet patch cable into Port 2 on the back of 
the router.

d. For Host B, plug the other end of the Ethernet patch cable into the network 
port on the computer.

e. Plug in the power cable of the router, if it is not already plugged in.

f. Turn on both computers and log on to Windows on Host A using administra-
tive privileges.

Step 2: Set Host A’s NIC to use DHCP.

a. Click Control Panel > Network and Sharing Center.

b. Click Change adapter settings, and then double click Ethernet or other appro-
priate network adapters. The Ethernet Status window opens.

c. In the Ethernet Status window, select Properties.

Questions:

In the Ethernet Properties window, what is the name and model number of the NIC 
in the Connect using: field?

 ________________________________________________________________________

Answers may vary.
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Which items listed in the This connection uses the following items: field apply 
to IP addressing?

 ________________________________________________________________________

Internet Protocol Version 4 (TCP/IPv4) and Internet Protocol Version 6 (TCP/IPv6).

d. Select Internet Protocol Version 4 (TCP/IP) and click Properties.

e. In the Internet Protocol Version 4 (TCP/IPv4) Properties window, verify that 
Obtain an IP address automatically is selected.

f. Select the Obtain DNS server address automatically radio button, if it is not 
already selected. Click OK to continue.

g. Click Close to close the Ethernet Properties and Ethernet Status windows.

Step 3: Record Host A’s IP address information.

a. Check the lights on the back of the NIC. These lights will blink when there is 
network activity. 
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b. Open a command prompt window. At the prompt, enter ipconfig /all.

C:\Users\ITEUser> ipconfig /all

Windows IP Configuration

   Host Name . . . . . . . . . . . . : DESKTOP-LV5FF1R

   Primary Dns Suffix  . . . . . . . :

   Node Type . . . . . . . . . . . . : Hybrid

   IP Routing Enabled. . . . . . . . : No

   WINS Proxy Enabled. . . . . . . . : No

   DNS Suffix Search List. . . . . . : example.com

Ethernet adapter Ethernet:

   Connection-specific DNS Suffix  . : example.com

   Description . . . . . . . . . . . : Intel(R) Ethernet Connection 
I219-LM

   Physical Address. . . . . . . . . : 08-00-27-AF-71-CB

   DHCP Enabled. . . . . . . . . . . : Yes

   Autoconfiguration Enabled . . . . : Yes

   Link-local IPv6 Address . . . . . : fe80::3dfb:37ab:4bd5:4d07%5
(Preferred)

   IPv4 Address. . . . . . . . . . . : 192.168.1.73(Preferred)

   Subnet Mask . . . . . . . . . . . : 255.255.255.0

   Lease Obtained. . . . . . . . . . : Monday, December 10, 2018 
7:27:29 AM

   Lease Expires . . . . . . . . . . : Monday, December 10, 2018 
8:27:48 AM

   Default Gateway . . . . . . . . . : 192.168.1.1

   DHCP Server . . . . . . . . . . . : 192.168.1.1

   DHCPv6 IAID . . . . . . . . . . . : 67633191

   DHCPv6 Client DUID. . . . . . . . : 
00-01-00-01-23-9F-46-CF-08-00-27-AF-71-CB

   DNS Servers . . . . . . . . . . . : 192.168.1.1

   Primary WINS Server . . . . . . . : 192.168.1.1

   NetBIOS over Tcpip. . . . . . . . : Enabled

   Connection-specific DNS Suffix Search List : example.com

Questions:

What is the IP address of the computer?

 ________________________________________________________________________

Answers may vary.

What is the subnet mask of the computer?

 ________________________________________________________________________

Answers may vary.

What is the default gateway of the computer?

 ________________________________________________________________________

Answers may vary.
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What are the DNS servers for the computer?

 ________________________________________________________________________

Answers may vary.

What is the MAC address of the computer?

 ________________________________________________________________________

Answers will vary.

Is DHCP enabled?

 ________________________________________________________________________

Yes

What is the IP address of the DHCP server?

 ________________________________________________________________________

Answers will vary.

On what date was the lease obtained?

 ________________________________________________________________________

Answers may vary.

On what date does the lease expire?

 ________________________________________________________________________

Answers may vary.

c. Type ping your IP address. For example, ping 192.168.1.73.

C:\Users\ITEUser>ping 192.168.1.73

Pinging 192.168.1.73 with 32 bytes of data:

Reply from 192.168.1.73: bytes=32 time<1ms TTL=128

Reply from 192.168.1.73: bytes=32 time<1ms TTL=128

Reply from 192.168.1.73: bytes=32 time<1ms TTL=128

Reply from 192.168.1.73: bytes=32 time<1ms TTL=128

Ping statistics for 192.168.1.73:

    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milli-seconds:

    Minimum = 0ms, Maximum = 0ms, Average = 0ms

If the ping was not successful, ask the instructor for assistance.
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Step 4: Record Host B’s IP address information.

a. Log in to Host B using an account with administrative privileges. Ensure the 
Obtain an IP address automatically and the Obtain DNS server address 
 automatically radio buttons are selected. 

b. Open a command prompt window. At the prompt, enter ipconfig /all.

Questions:

What is the IP address of the computer?

 ________________________________________________________________________

Answers may vary.

What is the subnet mask of the computer?

 ________________________________________________________________________

Answers may vary.

What is the default gateway of the computer?

 ________________________________________________________________________

Answers may vary.

What are the DNS servers for the computer?

 ________________________________________________________________________

Answers may vary.

What is the IP address of the DHCP server?

 ________________________________________________________________________

Answers will vary.

Step 5: Set static IP address information.

a. Select the radio buttons Use the following IP address and Use the following 
DNS server address.

b. Enter in the IP address information for the NIC from the previous step. Click 
OK > OK to continue.

c. Open a command prompt window. At the prompt, enter ping IP address for 

Host B.

 If the ping was not successful, ask the instructor for assistance.
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Step 6: Verify Connectivity.

a. From Host B, type ping IP address for Host A.

Question:

Was the ping successful?

 ________________________________________________________________________

Yes

b. From Host A type ping IP address for Host B.

Question:

Was the ping successful?

 ________________________________________________________________________

Yes

Note: If the pings were not successful, the sharing settings need to be changed to allow 
pings. Click Start > Type Control Panel > Select Network and Sharing Center > Click 
Change advanced sharing settings > Select Turn on file and printer sharing for the current 
profile. This needs to be done for both Hosts A and B.

c. Return all network configurations to their original settings, unless stated 
otherwise by the instructor. Set the NIC to Obtain an IP address automatically 
and Obtain DNS server address automatically. Click OK > OK.
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6.1.3.9 Packet Tracer–Connect to a Wireless 
Network (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
 ■ Connect to a wireless router

 ■ Configure the wireless router

 ■ Connect a wired device to the wireless router

 ■ Connect a wireless device to the wireless router

 ■ Add an AP to the network to extend wireless coverage

 ■ Update default router settings

Introduction
In this activity, you will configure a wireless router and an access point to accept wireless 
clients and route IP packets. Furthermore, you will update some of the default settings.

Instructions

Part 1: Connect to a Wireless Router
Step 1: Connect Admin to WR.

a. Connect Admin to WR using a straight-through Ethernet cable through the 
Ethernet ports. Select Connections, represented by a lightning bolt, from the 
bottom-left side of Packet Tracer. Click Copper Straight-Through, represented 
by a solid black line.

b. When the cursor changes to connection mode, click Admin and choose 
FastEthernet0. Click WR and choose an available Ethernet port to connect the 
other end of the cable.

WR will act as a switch to the devices connected to the LAN and as a router to 
the Internet. Admin is now connected to the LAN (GigabitEthernet 1). When 
Packet Tracer displays green triangles on both sides of the connection between 
Admin and WR, continue to the next step.

Note: If no green triangles are shown, make sure to enable Show Link Lights under 
Options > Preferences. You may also click Fast Forward Time just above the Connections 
selection box in the yellow bar.

Packet Tracer 

  Activity
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Step 2: Configure Admin to Use DHCP.

To reach the WR management page, Admin must communicate on the network. 
A wireless router usually includes a DHCP server, and the DHCP server is usually 
enabled by default on the LAN. Admin will receive IP address information from the 
DHCP server on WR.

a. Click Admin, and select the Desktop tab.

b. Click IP Configuration and select DHCP.

Questions:

What is the IP address of the computer?

 ________________________________________________________________________

192.168.0.100

What is the subnet mask of the computer?

 ________________________________________________________________________

255.255.255.0

What is the default gateway of the computer?

 ________________________________________________________________________

192.168.0.1

c. Close the IP Configuration window.

Note: Values can vary within the network range due to normal DHCP operation.

Step 3: Connect to the WR Web Interface.

a. In the Desktop tab on Admin, choose Web Browser.

b. Enter 192.168.0.1 in the URL field to open the web configuration page of the 
wireless router.

c. Use admin for both the username and the password.

d. Under the Network Setup heading on the Basic Setup page, notice the IP 
address range for the DHCP server.

Question:

Is the IP address for Admin within this range? Is it expected? Explain your answer.

 ________________________________________________________________________

Yes. Admin has 192.168.0.100/24, which belongs to 192.168.0.0/24 and in the range 
of 192.168.0.100 to 192.168.0.149. It is expected because Admin acquired its IP 
information from WR via DHCP.

Step 4: Configure the Internet Port of WR.

In this step, WR is configured to route the packets from the wireless clients to 
the Internet. You will configure the Internet port on WR to connect to the Internet.

a. Under the Internet Setup at the top of the Basic Setup page, change the Internet 
IP address method from Automatic Configuration – DHCP to Static IP.
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b. Type the IP address to be assigned to the Internet interface as follows:

Internet IP Address:  209.165.200.225

Subnet Mask:  255.255.255.252

Default Gateway:  209.165.200.226

DNS Server:  209.165.201.1

c. Scroll down the page and click Save Settings.

Note: If you get a Request Timeout message, close the Admin window and wait for the 
orange lights to turn into green triangles. Click the fast forward button to make this happen 
faster. Then reconnect to WR from Admin’s browser using the process explained in Step 3.

d. To verify connectivity, open a new web browser and navigate to www.cisco.pka server.

Note: It may take a few seconds for the network to converge. Click Fast Forward Time or 
Alt+D to speed up the process.

Part 2: Configure the Wireless Settings
In this activity, you will only configure the wireless settings for 2.4 GHz.

Step 1: Configure the WR SSID.

a. Navigate to the WR GUI interface at 192.168.0.1 in a web browser on Admin.

b. Navigate to Wireless > Basic Wireless Settings.

c. Change Network Name (SSID) to aCompany for only 2.4 GHz. Notice that 
SSIDs are case-sensitive.

d. Change the Standard Channel to 6 - 2.437GHz.

e. For this activity, disable both 5 GHz frequencies. Leave the rest of the settings 
unchanged.

f. Scroll to the bottom of the window and click Save Settings.

Step 2: Configure wireless security settings.

In this step, you configure the wireless security settings using WPA2 security mode 
with encryption and passphrase.

a. Navigate to Wireless > Wireless Security.

b. Under the 2.4 GHz heading, select WPA2 Personal for the Security Mode.

c. For the Encryption field, keep the default AES setting.

d. In the Passphrase field, enter Cisco123! as the passphrase.

e. Click Save Settings.

f. Verify that the settings in the Basic Wireless Settings and Wireless Security 
pages are correct and saved.
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Step 3: Connect the Wireless Clients.

a. Open Laptop1. Select the Desktop tab. Click PC Wireless.

b. Select the Connect tab. Click Refresh as necessary. Select the Wireless 
Network Name aCompany.

c. Enter the passphrase configured in the previous step. Enter Cisco123! in the 
pre-shared key field and click Connect. Close the PC Wireless window.

d. Open a web browser and verify that you can navigate to www.cisco.pka server.

e. Repeat the above steps to connect Laptop2 to the wireless network.

Part 3: Connect Wireless Clients to an Access Point
An access point (AP) is a device that extends the wireless local area network. An access point is 
connected to a wired router using an Ethernet cable to project the signal to a desired location.

Step 1: Configure the Access Point.

a. Connect Port 0 of AP to an available Ethernet port of WR using a straight-
through Ethernet cable.

b. Click AP. Select the Config tab.

c. Under the INTERFACE heading, select Port 1.

d. In the SSID field, enter aCompany.

e. Select WPA2-PSK. Enter the passphrase Cisco123! in the Pass Phrase field.

f. Keep AES as the default Encryption Type.

Step 2: Connect the Wireless Clients.

a. Open Laptop3. Select the Desktop tab. Click PC Wireless.

b. Select the Connect tab. Click Refresh as necessary. Select the Wireless Network 
Name aCompany with the stronger signal (Channel 1) and click Connect.

c. Open a web browser and verify that you can navigate to www.cisco.pka server.

Part 4: Other Administrative Tasks
Step 1: Change the WR Access Password.

a. On Admin, navigate to the WR GUI interface at 192.168.0.1.

b. Navigate to Administration > Management and change the current Router 
Password to cisco.

c. Scroll to the bottom of the window and click Save Settings.

d. Use the username admin and the new password cisco when prompted to log in 
to the wireless router. Click OK to continue.

e. Click Continue and move on to the next step.
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Step 2: Change the DHCP address range in WR.

In this step, you will change the internal network address from 192.168.0.0/24 to 
192.168.50.0/24. When the LAN network address changes, the IP addresses on the 
devices in the LAN and WLAN must be renewed to receive new IP addresses before 
the lease is timed out.

a. Navigate to Setup > Basic Setup.

b. Scroll down the page to Network Setup.

c. The IP address assigned to Router IP is 192.168.0.1. Change it to 192.168.50.1. 
Verify that the IP address still starts at .100, and there are 50 available IP 
addresses in the DHCP pool.

d. Add 209.165.201.1 as the DNS server with the DHCP settings.

e. Scroll to the bottom of the window and click Save Settings.

f. Note that the DHCP range of addresses has been automatically updated to 
reflect the interface IP address change. The Web Browser will display a Request 
Timeout after a short time. 

Question:

Why?

 ________________________________________________________________________

Because the Admin IP address is no longer within the same network as the router. 
The IP address of Admin is outside the new range of the DHCP server.

g. Close the Admin web browser.

h. In the Admin Desktop tab, click Command Prompt.

i. Type ipconfig /renew to force Admin to re-acquire its IP information via DHCP.

Question:

What is the new IP address information for Admin?

 ________________________________________________________________________

Your answer may vary. The IP address for Admin is within 192.168.50.100 - 149.

IP Address: 192.168.50.100

Subnet Mask:  255.255.255.0

Default Gateway:  192.168.50.1

DNS Server:  209.165.201.1

j. Verify that you can still navigate to www.cisco.pka server.

k. Renew the IP address on other laptops to verify that you can still navigate to 
www.cisco.pka server.

l. Notice that Laptop1 connected to the AP instead of WR.

Question:

Why?

 ________________________________________________________________________

The AP had a better signal for Laptop1.
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6.1.3.10 Lab–Configure a Wireless Network 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will configure basic settings on a wireless router and connect a PC to router 
wirelessly.

Recommended Equipment
 ■ A Windows computer with wired and wireless network cards installed

 ■ Wireless router

 ■ Ethernet patch cable

Note: All wireless settings in this lab are for a 2.4 GHz wireless connection. Follow the same steps for 
setting up a 5 GHz wireless connection or when setting up both 2.4 GHz and 5 GHz connections.

Instructor Note: You will need to provide unique router address settings, DHCP server 
settings, an SSID for each router in the classroom, and a router access password.

Instructions

Part 1: Log into the Wireless Router
Step 1: Connect the computer to the router.

a. Ask the instructor for the following information that is used during the lab.

Instructor Note: You will need to provide the student with the following informa-
tion for the router:

IP address, subnet mask, DHCP start IP address and maximum number of users, 
router password, and router name#, where # is a different number assigned to each 
router. 

For example:

Router Address Information:

IP address:

 ________________________________________________________________________

Example: 192.168.50.1

Subnet mask:

 ________________________________________________________________________

Example: 255.255.255.0
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Router name:

 ________________________________________________________________________

Example: ITE

DHCP Server Setting Information:

Start IP address:

 ________________________________________________________________________

Example: 192.168.50.100

Maximum number of users:

 ________________________________________________________________________

Example: 50

Default Router Access:

Router Username/Password:

 ________________________________________________________________________

Example: admin/password

Assigned SSID:

Your Assigned SSID:

 ________________________________________________________________________

The instructor assigns your router's SSID.

Note: Only use configurations assigned by the instructor.

b. Plug in the power for the wireless router. Boot the computer and log in as an 
administrator.

c. Connect the computer to one of the Ethernet ports on the wireless router with 
an Ethernet patch cable.

Note: If this is the first time connecting to the lab router, follow these instructions to set a 
network location. This will be explained later in the course.

d. If prompted by the Set Network Location window, select Public network. 
Click Close to accept the network location Public.

e. Open a command prompt and type ipconfig to determine the IP address of the 
default gateway, which should be the IP address of your wireless router. If it is 
necessary to renew the IP address, enter ipconfig /all at the prompt.

Question:

What is the default gateway for the computer?

 ________________________________________________________________________

Answers may vary; 192.168.1.1 is one possibility.
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Step 2: Log in to the router.

a. Open Microsoft Edge or other web browsers. Enter the IP address of your 
default gateway in the Address field, and then press Enter.

b. In the Windows Security window, enter administrative user credentials 
provided by your instructor.

Part 2: Configure Basic Wireless Settings
In this lab, you will not be configuring the wireless router to the Internet. You will configure 
the SSID or network name and security in the wireless settings, configure DHCP settings, and 
set a new administrative password.

Step 1: Configure the SSID.

a. Locate the wireless settings. In the SSID or network name field, enter your 
assigned SSID.

b. Save the settings.

Step 2: Configure wireless security.

a. Locate the wireless security settings.

b. Select the WPA2 security option. Select AES cipher and personal if available.

c. Enter a passphrase or password as assigned by your instructor or use Cisco456! 
as an example.

d. Save the settings.

Step 3: Configure the DHCP settings.

a. Locate the LAN settings.

b. Configure the router device name if available.

c. Configure the router's IP address and subnet mask as assigned by your 
instructor.

d. Verify that the wireless router is used as the DHCP server.

e. Configure the LAN information for your assigned subnet. If possible, you may 
be providing the starting and end IP addresses or the maximum number of IP 
addresses available for connecting hosts wirelessly.

f. Save the settings.

g. The router may need to reboot at this time. If necessary, reboot the router.

Step 4: Change the default administrative password.

a. Locate the password settings for the administrative account.

b. Provide the current password and the new password as assigned by your 
instructor or Cisco123!.

c. Save the settings.

d. Log into the wireless using the new credentials: admin / Cisco123! or the 
credentials that were assigned to you.

e. At this time, you can disconnect the Ethernet cable if desired.
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Part 3: Connect a Wireless Client
a. Click Start, and enter wireless. Select Change Wi-Fi Settings.

b. In the Wi-Fi settings window, select Show available networks.

c. Select the configured SSID that you configured in a previous step.

d. Enter the password or passphrase configured in a previous step.

e. Open a command prompt. Type ipconfig and record the following information.

Computer IP information:

IP address:

 ________________________________________________________________________

Answers will vary. But the IP address should be within the range configured in the 
previous step.

Subnet mask:

 ________________________________________________________________________

Answers will vary. But the subnet mask should be within the range configured in the 
previous step.

Default gateway:

 ________________________________________________________________________

Answers will vary. But the default gateway should be within the range configured in 
the previous step.

Part 4: Connect an Access Point (Optional)
In this part, you will add a wireless access point (AP) to the network. An AP is connected 
directly to a wireless router using an Ethernet cable. The purpose of an AP is to extend the 
wireless LAN where the wireless users cannot reach the wireless router otherwise.

In this part, you may need to partner with another group with a wireless router that can be 
converted to an access point. Or your instructor may also provide an access point. Unless 
instructed to connect the wireless router to the Internet, you do not need to connect the Inter-
net port of the wireless router to a cable or DSL connection.

Note: If you are converting a wireless router to an AP, please follow the instructions provided by your 
instructor or manufacturer's documentations.
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Step 1: Connect the access point to the wireless network.

a. Connect the wireless router via the Ethernet port. Navigate to the wireless 
router using a web browser using the IP address of the default gateway and log 
in as the administrator.

b. To prevent interference, navigate to the wireless settings. Change the wireless 
channel from the default channel 1 to channel 6 or 11 on the wireless router. 
Save the new settings.

c. Connect the Internet port of the access point to one of the LAN ports on the 
existing wireless router.

Step 2: Configure access point wireless settings.

a. In the web page of the wireless router, navigate to the LAN settings to 
determine the IP address of the access point. The IP address of the access point 
can be listed in the address reservation table or DHCP client list.

b. In another web browser, navigate to the IP address of the access point.

c. In the access point settings, navigate to the wireless settings and configure the 
AP with the same wireless SSID and security options as the wireless router. For 
example, configure ITE as the SSID and WPA2 Personal AES with Cisco456! as 
the passphrase.

d. Verify that the wireless router and AP are not using the same wireless channels.

e. Attempt to connect a wireless client to the wireless network.
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Step 3: Turn off wireless radio on the wireless router.

After you have successfully connected to the wireless network, you will attempt to 
disable the wireless router radio, and a wireless client will attempt to connect to the 
wireless network through the AP.

Depending on the wireless router model, you may be able to switch off the wireless 
radio using the on/off switch.

a. Navigate to the wireless router using a web browser. If necessary, connect to the 
wireless router using a wired Ethernet connection.

b. Navigate to the wireless settings, and turn off the wireless router radio if avail-
able. The option to enable wireless radio may be in the advanced wireless 
settings.

c. Save the settings.

d. Attempt to connect a wireless client to the AP.

Part 5: Reset to the Original Configuration
Unless stated otherwise by the instructor, restore the router back to factory default if the 
option is available.

Note: Some wireless models have a reset button to reset the router to its default factory settings.

 a. Locate the Maintenance or System settings.

 b. Click the selection to revert to factory default settings.

 c. Provide your administrative credentials if prompted.

 d. Wait for your router to finish reboot before shutting down the wireless router.
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6.1.4.7 Packet Tracer–Configure Firewall Settings

Objectives
 ■ Configure MAC Filtering on a wireless router.

 ■ Configure DMZ on a wireless router.

 ■ Configure Single Port Forwarding on a wireless router.

Introduction
In this activity, you will configure a wireless router to:

 ■ Rely on MAC filtering to increase security

 ■ Allow access to a server in the DMZ

 ■ Disable the DMZ and configure support for Single Port Forwarding

Instructions
Step 1: Connect to the wireless router.

a. Connect to the wireless router configuration web page at 192.168.0.1 from 
PC0.

b. Use admin for both the user name and the password.

c. Navigate to wireless settings to determine the SSID and passphrase for 
connection to WRS1. Record the SSID and passphrase below.

Questions:

SSID:

 ________________________________________________________________________

Passphrase:

 ________________________________________________________________________

Step 2: Configure laptop as the wireless client.

a. Connect Laptop0 to the WRS1 wireless network using the security settings 
configured on the wireless router. Click Desktop > PC Wireless. Select the 
Connect tab. Click Refresh. Select the desired SSID and click Connect. Provide 
the passphrase and select Connect.

b. Close the PC Wireless window and click Command Prompt.

c. At the prompt, enter ipconfig /all and record the IP and MAC addresses of 
Laptop0 below.

Questions:

Laptop0 IP Address:

 ________________________________________________________________________

Packet Tracer 

  Activity
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MAC address:

 ________________________________________________________________________

d. Repeat the above steps to connect Laptop1 to WRS1.

Step 3: Configure WRS1 to support MAC filtering.

a. On PC0, go to the wireless router’s configuration page at 192.168.0.1.

b. Navigate to Wireless > Wireless MAC Filter.

c. Select Enabled and Permit PCs listed below to access wireless network.

d. Type in the MAC address for Laptop0 in the MAC 01: field. Notice the MAC 
address must be in the XX:XX:XX:XX:XX:XX format. Click Save Settings.

e. To verify connectivity, open a command prompt. Issue the ping command to the 
default gateway to 192.168.0.1 from Laptop0 and Laptop1.

 C:\> ping 192.168.0.1

Question:

Were both laptops able to connect to the WRS1 network? Why are you unable to 
associate with the access point?

 ________________________________________________________________________

Step 4: Test connectivity through the Telco Cloud.

a. Open a Command Prompt on Laptop0.

b. In Laptop0, test connectivity to Remote PC by issuing the ping 
209.165.201.29 command. The first few pings may fail while the network 
converges. Issue the command again if you did not get successful replies. 

c. Open Remote PC and then browse to the address of the internal web page 
hosted at Server0, which is www.acompany.com. A Request Timeout message 
should display. A webpage request from Remote PC to Server0 is not success-
ful because WRS1 does not know which internal device should receive it. Port 
forwarding must be configured on WRS1.

Step 5: Configure DMZ.

A demilitarized zone (DMZ) is where a portion of the company network is exposed 
to an untrusted external network, such as the Internet.

a. On PC0, reconnect to the wireless router’s configuration page. 

b. Navigate to Application & Gaming > DMZ.

c. Click Enabled.

d. In the Destination: field, enter 20 for the IP address 192.168.0.20.

e. Scroll to the bottom and save the settings.

f. Browse to www.acompany.com from Remote PC. You should now see the web 
page hosted by Server0.

g. After you have verified that you were able to reach the webpage, disable DMZ 
and save the settings.
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Step 6: Configure WRS1 to forward a single port to Server0.

Depending on the router model, the open ports of a server in the DMZ can be 
exposed to an untrusted external network. To limit the number of exposed ports, 
single port forwarding can be configured on the router.

a. On PC0, reconnect to the wireless router’s configuration page. Navigate to 
Application & Gaming > Single Port Forwarding.

b. On the left-hand menu, choose HTTP from the first drop-down box. Change 
the To IP Address to match Server0’s IP address, 192.168.0.20. Also, check 
the Enabled checkbox at the end of the row.

c. Scroll to the bottom of the window and click Save Settings.

d. You should now be able to reach the webpage hosted on Server0. Browse to 
www.acompany.com on Remote PC. You should now see the web page hosted 
by Server0.
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6.1.4.8 Lab–Configure Firewall Settings 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will configure firewall settings to use MAC address filtering, a DMZ, and single 
port forwarding on a wireless router to manage the connections and traffic through the wire-
less router.

Background/Scenario
You recently purchased a wireless router for your home and want to configure MAC filtering 
to limit the number of devices connecting to the network wireless. Furthermore, you would 
like to allow your game console to be connected from the Internet by enabling DMZ. As an 
alternative to enabling DMZ, you will manually forward the specific ports for the desired 
games.

Instructor Note: You will need to provide unique router address settings, DHCP server set-
tings, an SSID for each router in the classroom, and a router access password.

Required Resources
 ■ A Windows computer with wired and wireless network cards installed

 ■ Wireless router

 ■ Ethernet patch cable

Instructions

Part 1: Log into the Wireless Router
Step 1: Connect the computer to the router.

a. Ask the instructor for the following information that is used during the lab and 
record the information below.

Instructor Note: You will need to provide the student with the following informa-
tion for the router:

IP address, subnet mask, DHCP start IP address and the maximum number of users, 
router password, and router name#, where # is a different number assigned to each 
router. 
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For example:

Questions:

Router Address Information:

IP address:

 ________________________________________________________________________

Example: 192.168.50.1

Subnet mask:

 ________________________________________________________________________

Example: 255.255.255.0

Router name:

 ________________________________________________________________________

Example: ITE

DHCP Server Setting Information:

Start IP address:

 ________________________________________________________________________

Example: 192.168.50.100

Maximum number of users:

 ________________________________________________________________________

Example: 50

Default Router Access:

Router Username/Password:

 ________________________________________________________________________

Example: admin/password

Assigned SSID:

Your Assigned SSID:

 ________________________________________________________________________

The instructor assigns your router's SSID.

Note: Only use configurations assigned by the instructor.
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b. Plug in the power for the wireless router. Boot the computer and log in as an 
administrator.

c. Connect the computer to one of the Ethernet ports on the wireless router with 
an Ethernet patch cable.

Note: If this is the first time connecting to the lab router, follow these instructions to set a 
network location. This will be explained later in the course.

d. If prompted by the Set Network Location window, select Public network. 
Click Close to accept the network location Public.

e. Open a command prompt and type ipconfig to determine the IP address of the 
default gateway, which should be the IP address of your wireless router. If it is 
necessary to renew the IP address, enter ipconfig /renew at the prompt.

What is the default gateway for the computer?

 ________________________________________________________________________

Answers may vary; 192.168.50.1 is an example.

Step 2: Log in to the router.

a. Open Microsoft Edge or other web browsers. Enter the IP address of your 
default gateway in the Address field, and then press Enter.

b. In the Windows Security window, enter the administrative user credentials 
provided by your instructor.

Part 2: Configure Firewall Settings
In this part, you will configure the firewall settings on the router. You will configure MAC 
filtering to control the devices that could connect to the local network wirelessly. You will 
also configure the DMZ and single port forwarding to allow forwarding of external traffic to a 
device in the local private network.

Note: The steps outlined in this part may not be the same for your router. Please refer to the manufac-
turer’s instruction manual for your specific router.

Step 1: Configure MAC filtering.

MAC filtering requires the router to check if the devices are allowed to connect the 
network. This could prevent malicious network activities from unauthorized devices. 
Although it is difficult to spoof the MAC address because it is hardware-encoded, 
determined hackers can still circumvent this security feature.

a. The MAC filtering setting, if available, is generally associated with the 
advanced, wireless, security or firewall settings.

b. Enable MAC filtering.

c. Deny or allow access for the listed MAC addresses.

d. Add the MAC addresses to the MAC filter list.

e. Save the settings.
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Step 2: Configure DMZ.

A wireless router can block attempts by devices from an external network, such as 
the Internet, to connect to the devices on a private local network. If there is a need 
for a device to connect to devices on the local network, the DMZ can be enabled on 
the router. When the DMZ is enabled, all traffic originating from an external source 
is forwarded to a single device on the local network.

Note: When a DMZ is used to forward all the inbound traffic to a device on the local 
network, the local device is no longer protected by the router’s firewall.

a. The DMZ setting, if available, is generally associated with the advanced, 
security, or firewall settings.

b. Enable DMZ.

c. Specify a range of IP address or any source IP address.

d. Provide the IP address or MAC address of the host in the DMZ.

e. Save the settings.

Step 3: Use single port forwarding.

Port forwarding allows remote computers to connect to specific services on a spe-
cific device within a private local network based on the source IP address, destina-
tion TCP port number, and other characteristics of the traffic.

Depending on the router model, more than one port forwarding rule could be con-
figured. With more than one rule configured, the order of the rule on the screen 
determines the order in which the packets are checked against the rules.

a. The single port forwarding setting, if available, is generally associated with the 
application/game or firewall settings.

b. Enable single port forwarding and input the desired applications, internal and 
external ports, protocol, and IP address.

c. Save the settings.

Reflection Question
For your router model, what are other available firewall configurations? List them and describe 
their functions below.

 

Answers will vary depending on the router model. For example, access rules or access control 
can control the Internet activities of the hosts in the local private network using access control 
policies based on IP addresses and time of day.
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6.1.5.3 Packet Tracer–Configure IoT Devices 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this activity, you have just installed various IoT devices around the house and wish to 
configure them as a home security system.

 ■ Configure the Home Gateway to use a Motion Sensor

 ■ Test and reset security features

 ■ Set the air conditioning

Instructions
Step 1: Configure the Home Gateway to use a Motion Sensor.

a.  From the Desktop tab on Tablet, click Web Browser.

b. Type in the IP address of the home gateway 192.168.25.1 and press Enter.

c.  Log in to Home Gateway. When asked for the username and password, use 
admin for both. This is the default.

d. Click Conditions after logging in. Add a new rule and name it 
MotionDetectorOn.

e.  From the pull-down menu under If: choose Motion Detector. To the right of 
that menu, select on and to the right again, select true.

f.  From the pull-down menu under Then set: choose Security Camera. To the 
right of that menu, select on and to the right again, select true.

g. Add another Action. From the second pull-down menu under Then set: choose 
Smart Door. To the right of that menu, select Lock and to the right again, 
select Lock.

h.  Add another Action. From the third pull-down menu under Then set: choose 
Smart Lamp. To the right of that menu, select Status and to the right again, 
select Dim.

i.  Click OK to save this Action and return to the Conditions page.

j.  Add another rule named MotionDetectorOff.

k.  From the pull-down menu under If: choose Motion Detector. To the right of 
that menu, select on and to the right again, select false.

l.  From the pull-down menu under Then set: choose Security Camera. To the 
right of that menu, select on and to the right again, select false.

m. Click OK to save this Action and return to the Conditions page.

Packet Tracer 

  Activity
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Step 2: Test and reset security features.

a. From the Browser on Tablet, return to the home page of the Home Gateway at 
http://192.168.25.1/home.html.

b. Click the arrows to the left of the Smart Door, Smart Lamp, Motion Detector, 
and Security Camera to open their interfaces.

c. With the website visible, hold down the Alt key and click the Motion Detector.

Question:

What is happening on the website and in the Logical Interface of Packet Tracer?

 ________________________________________________________________________

The light on the motion detector turned on, the light on the security camera turned 
on, the door locked, the lamp turned to dim setting, and the website showed a 
video.

d. When the motion detector turns off, so does the security camera. Unfortunately, 
you have managed to lock yourself out of the house.

Question:

How can you easily unlock the door?

 ________________________________________________________________________

Unlock the door using the Unlock button on the Home Gateway home page.

e. Alt-click the unlocked Smart Door to open it.

f. Alt-click the Switch to turn the dim Smart Lamp fully on. Alt-click the Switch 
again to turn the Smart Lamp off. The Smart Lamp can also be controlled 
remotely through the Home Gateway home page.

g. Examine the Python script, which manages the Smart Lamp under the 
Programming tab of the MCU.

Step 3: Set the air conditioning.

a. While you were outside, a cold front moved in. Alt-click the Temperature 
Control to cool the house, twice, to heat the house, and three times to 
automatically cool or heat to a comfortable temperature.

b. Open the Temperature Control Programming tab from the Advanced menu to 
examine the JavaScript that controls the unit.

c. The Home Gateway home page, Temperature Control and Temperature 
Meter, display different numbers.

Question:

What line of code in the Temperature Meter could be responsible for this 
discrepancy?

 ________________________________________________________________________

Line 38 in the Temperature Meter code converts from Celsius to Fahrenheit.
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6.2.2.5 Lab–Troubleshoot Network Problems 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will diagnose the causes of network problems and solve them.

Recommended Equipment
 ■ Two computers running Windows

 ■ A wireless router

 ■ Two Ethernet cables

 ■ Internet access

Scenario
You must solve network problems for a customer. You may need to troubleshoot both the 
router and two computers. Make sure you document and solve the problems, and then 
document the solutions.

There are several possible errors. Solve one problem at a time until you can successfully 
establish a connection between the two computers.

To better identify which steps should be done on which computer, the lab will refer to them as 
computer01, computer02, or both.

Lab Setup

Instructor Note: Set up the wireless router and computers with two or more problems from 
the list below. To validate that all problems have been solved, the student must demonstrate a 
successful connection between the two computers.

Note: If you set up more than one troubleshooting problem for accessing shared resources, 
you will need to create a different folder and file for each troubleshooting problem.

Instructor Note: Students might not solve problems in the order shown in the instructor 
document. Students might notice more than one problem at a time while troubleshooting. 
Remind students to correct and document one problem at a time.

List of Problems:

 1) Computer01 has TCP/IP disabled.

 2) Computer02 cannot connect to the wireless router. The DHCP server has been disabled.

 3) Disconnected cable between both computers and router.

 4) Incorrect static IP address on computer01. 

Book 1.indb   175Book 1.indb   175 01/10/19   9:27 PM01/10/19   9:27 PM



176  IT Essentials Version 7, Labs & Study Guide

 5) Disabled NIC.

 6) Configure the router to block computer02 MAC address.

 7) Set router DHCP to provide only one IP address.

Problem 1: Disable TCP/IP on computer01.

To disconnect TCP/IP on computer01:

Click Start, type control panel in the search field, and press Enter. Click Network and 
Sharing Center > click Change adapter settings > double-click the desired network adap-
tor > click Properties. Unselect Internet Protocol Version 4 (TCP/IPv4) > OK.

Problem 2: Computer02 cannot connect to the network.

 a. Disable the DHCP server on the wireless router.

 b. Configure computer01 with a static IP address, subnet mask, and default gateway 
within the same network as the wireless router. For example, if the wireless router has 
an IP address of 192.168.1.1 and a subnet mask of 255.255.255.0, set the computer01 
to have an IP address of 192.168.1.10 with a subnet mask of 255.255.255.0 and a gate-
way address of 192.168.1.1.

 c. Release and renew the IP address on computer02 so computer02 has 169.254.x.x for 
the IP address.
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Problem 3: Disconnect the Ethernet cable between the computers and wireless router. To 
make this harder to diagnose, pull out the connector only far enough to disconnect, 
but not all the way out.

Problem 4: Set a static IP address to a different subnet range for computer01.

To set a static IP address on computer01:

Click Start and type control panel in the search field and press Enter. Click Network 
and Sharing Center > click Change adapter settings > double-click the desired net-
work adaptor > click Properties. Click Internet Protocol Version 4 (TCP/IPv4) > click 
 Properties > enter the static IP address and default gateway > click OK.

Problem 5: Disable the computer NIC.

To disable the computer NIC:

Click Start, type control panel in the search field, and press Enter. Click Network and 
Sharing Center > Change adapter settings > right-click the desired network adaptor > 
select disable.

Problem 6: Configure the router to block the MAC address for the computer. It may be 
necessary to turn on MAC address filtering and enter the MAC address of only one 
computer. This depends on the wireless router configuration options.

Problem 7: Configure the router to assign only one DHCP address.

Problem 8: Duplicate the IP address.

Determine the IP address on computer01 assigned by the DHCP server. Then configure 
computer02 with the same IP address as computer01.

Step 1: Log on to the computers.

a. List the computer name used for computer01 and computer02. Use these names 
whenever the lab refers to computer01 and computer02.

Computer01 name:

 ________________________________________________________________________

Answers may vary.

Computer02 name:

 ________________________________________________________________________

Answers may vary.

b. Log on to computer01 and computer02 with accounts that have administrative 
privileges.

Step 2: Troubleshoot network problems.

Use a command prompt to display IP address information, open the network control 
panel and review the adapter configuration, and log on to the router and review all 
of the configuration options to troubleshoot the router or computers for problems. 
Answer the following questions after each problem is solved.
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a. What problem did you find?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Answers may vary, for example: Computers cannot ping each other.

 2) Computer02 has a link local block 169.254.x.x address.

 3) Link lights not lit for used LAN ports.

 4) Cannot ping the default gateway.

 5) No network access.

 6) No network access.

 7) No network access.

 8) No network access for computer02.

b. What is a possible cause?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) The TCP/IP configuration is not configured correctly on computer01.

 2) Computer02 is not obtaining an IP address via DHCP.

 3) The cable connections can be the issue.

 4) The TCP/IP configuration is not configured correctly on computer01.

 5) The network is not connected.

 6) The network is not connected.

 7) The network is not connected.

 8) The network is not connected for computer02.

c. What steps did you take to determine the problem?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________
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 1) Examine the computer01 NIC settings.

 2) Examine the router settings. 

 3) Examine cable connections between computers and wireless router. 

 4) Examine computer01 NIC settings.

 5) Tried to access the network. 

 6) Ping the other computer or the default gateway on the network.

 7) Tried to access the network.

 8) Examine the IP addresses of both computers.

d. What is causing the problem?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Computer01 has TCP/IP disabled.

 2) The router has DHCP disabled; computer02 has 169.254.x.x address.

 3) Disconnected cable between both computers and router.

 4) Computer01 has an incorrect static IP address and default gateway.

 5) Disabled NIC. 

 6) MAC address block for the network. 

 7) Router DHCP provides only one IP address.

 8) Computer02 has a link local block 169.254.x.x address.

e. List the steps taken to fix the problem.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Enable TCP/IP for computer01.

 2) Enable DHCP for the wireless router; renew computer02 IP address.

 3) Reconnect cables between computers and wireless router. 

 4) Change IP address on computer01. 

 5) Enable the computer’s NIC.
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 6) Remove blocked MAC address from the router.

 7) Increase router to hand out more IP addresses via DHCP.

 8) Change the static IP address to an available IP address or obtain the IP address 
via a DHCP server.

f. If you can verify end-to-end connectivity, you have successfully solved all the 
networking problems.

Ping from Computer01 to Computer02 successfully?   yes

Ping from Computer02 to Computer01 successfully?  yes

Ping from Computer01 to Default Gateway successfully?   yes

Ping from Computer02 to Default Gateway successfully?   yes
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CHAPTER 7

Laptops and Other Mobile Devices

Improvements in technology have allowed the laptop to become lightweight, powerful, and much more 
affordable. Because of this, laptops are found in just about every setting today.

Mobile devices are hand-held, lightweight, and typically have a touchscreen for input. Like a desktop 
or laptop computer, mobile devices use an operating system to run applications (apps) and games and 
to play movies and music. Mobile devices also have different CPU architecture, designed to have a 
reduced instruction set when compared to laptop and desktop processors.

This chapter reviews many features of laptops, mobile devices, and their capabilities.
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Study Guide

Characteristics of Laptops and Other Mobile Devices
This section reviews the characteristics and components of laptops and other mobile devices.

Mobile Device Overview
Examples of mobile devices are laptops, tablets, smartphones, smartwatches, and wearables.

Check Your Understanding—Mobile Devices

Mobility in information technology means the ability to access information electronically from 
different locations outside the home or office. Examples of mobile devices are laptops, smart-
phones, smartwatches, and wearables.

Match the mobility requirement on the left with the mobile device on the right. This exercise is 
a one-to-one matching.

Requirement

 a. A woman hiking in the park does 
not have a smartwatch but wants to 
upload data from her fitness tracker to 
the Internet.

 b. This special-purpose wearable device 
monitors heart function and physical 
activity.

 c. You are offline but need to work with 
full copies of a spreadsheet and word 
processor program.

 d. A mother wants to keep her child 
entertained with a game while she 
talks to a friend on her smartphone.

 e. You want to read a book while you 
are at the beach but don’t want to 
bring your more expensive computing 
devices.

 f. A sports fan leaves his smartphone 
at home but still wants to be alerted 
to the scores of some football games 
while he is out jogging.

Mobile Device

 e. E-reader

 b. Fitness tracker

 c. Laptop

 a. Smartphone

 f. Smartwatch

 d. Tablet

Laptop Components
Laptops are made up of internal and external components.
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Laptop Components Videos

Watch the two videos for a review of laptop components including external features, common 
input devices, and LEDs.

Label the Laptop Internal Component

Laptop internal components are designed to fit into the confined spaces of the laptop form 
factor. Label each laptop internal component in Figure 7-1.

Figure 7-1 Laptop Internal Components

Answer: Top row, left to right: SODIMM, CPU

Bottom row, left to right: SATA drive, Solid-state drive

Laptop Display Components
There are three types of laptop displays:

 ■ Liquid-crystal display (LCD)

 ■ Light-emitting diode (LED)

 ■ Organic light-emitting diode (OLED)
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Check Your Understanding—Laptop Displays

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definition

 a. This converts direct current to 
alternating current.

 b. This display technology is used by 
many mobile device manufacturers 
because of its longer lifespan.

 c. This converts the touch actions into 
digital signals processed by the 
device.

 d. This display technology uses a 
fluorescent backlight.

 e. This display technology uses pixels 
that produce their own light.

Term

 c. Digitizer

 a. Inverter

 d. LCD

 b. LED

 e. OLED

Laptop Configuration
Configuring the hardware for a laptop includes power settings and wireless connections.

Power Settings Configuration
Many batteries can power a laptop for 10 hours or more. Configuring laptop power settings to 
better manage power usage is important to ensure that the battery is used efficiently.

Describe the ACP Power Settings

The Advanced Configuration and Power Interface (ACPI) creates a bridge between the hard-
ware and the operating system and allows technicians to create power management schemes to 
get the best performance from a laptop. The ACPI states are applicable to most computers, but 
they are particularly important when managing power in laptops.

In Table 7-1, fill in the description for each ACPI power state.

Table 7-1 ACPI Power States

State Description

S0 The computer is on, and the CPU is running.

S1 The CPU and RAM are still receiving power, but unused devices are powered down.

S2 The CPU is off, but the RAM is refreshed. The system is in a lower mode than S1.

S3 The CPU is off, and the RAM is set to a slow refresh rate. This mode is often called 
“save to RAM.” This state is known as suspend mode.

S4 The CPU and RAM are off. The contents of RAM have been saved to a temporary 
file on the hard disk. This mode is also called “save to disk.” This state is known as 
hibernate mode.

S5 The computer is off.

Book 1.indb   184Book 1.indb   184 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 7: Laptops and Other Mobile Devices  185

Wireless Configuration
Wireless configuration includes configuring Bluetooth, cellular, and Wi-Fi devices.

Wireless Configuration Videos

Watch the two videos for a review of configuring a laptop or mobile device for Bluetooth and 
Wi-Fi connectivity.

Laptop Hardware and Component Installation 
and Configuration
Working on laptops may include expanding its functionality or capacity or replacing 
components.

Expansion Slots
Expansion slots include expansion cards, flash memory, and SODIMM memory.

Label the Expansion Module

Label each expansion module in Figure 7-2.

Figure 7-2 Expansion Modules

Answer: Top row, left to right: Flash drive, SODIMM

Bottom row, left to right: Express card, Flash memory card
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Replacing Laptop Components
Some parts of a laptop, typically called customer-replaceable units (CRUs), can be replaced 
by the customer. CRUs include components such as the laptop battery and RAM. Parts that 
should not be replaced by the customer are called field-replaceable units (FRUs). FRUs include 
components such as the motherboard, LCD display, and keyboard.

Replacing Laptop Components Videos

Watch the nine videos in this topic for a review of the following laptop components:

 ■ Keyboard replacement

 ■ Screen replacement

 ■ Battery and DC jack replacement

 ■ Internal storage and optical drive replacement

 ■ Wireless card replacement

 ■ Speaker replacement

 ■ CPU replacement

 ■ Motherboard replacement

 ■ Plastic frames

Check Your Understanding—Replacing Laptop Components

In Table 7-2, indicate whether the statement is true or false.

Table 7-2 Replacing Laptop Components

Statement True False

Thermal paste should be applied after installing the CPU heat sink. X

Laptop motherboards have a standard form factor and will fit most all 
laptops.

X

The laptop manual should be consulted before removing any 
components.

X

Component replacement steps are the same for all laptops. X

Laptop batteries and RAM modules are considered customer-
replaceable units (CRUs).

X

Before laptop components are replaced, both the battery and the 
power cable should be removed.

X

Other Mobile Device Hardware Overview
Other mobile device hardware includes field-replaceable parts of a cell phone such as memory, 
SIM card, and battery. It also includes the various wireless and wired connections mobile 
devices use to connect to other devices and the network. In addition, there are various spe-
cialty mobile devices such as fitness trackers, e-readers, and virtual reality headsets.

Book 1.indb   186Book 1.indb   186 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 7: Laptops and Other Mobile Devices  187

Other Mobile Device Hardware
Because of their small size, mobile devices usually do not have field-serviceable parts. Mobile 
devices consist of several compact components integrated into a single unit. When a mobile 
device malfunctions, it is usually sent to the manufacturer for repair or replacement.

Check Your Understanding—Connection Types

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definition

 a. Mobile devices communicate with 
each other when they are touched 
together.

 b. This connection allows mobile devices 
to remotely control devices, such as a 
TV or audio equipment.

 c. This wireless connection allows data 
exchange over a distance of up to 
33 feet (10 m).

 d. This uses your cellular phone as a 
modem for another device, such as 
a tablet or laptop. The connection is 
made over a USB cable or Bluetooth.

 e. This wired connection allows Apple 
devices to connect to host computers 
and other peripherals.

 f. This device is used to authenticate a 
mobile device to the mobile network.

 g. This device is used to add memory to 
many mobile devices.

 h. Devices charge and transfer data using 
this wired connection.

Term

 c. Bluetooth

 b. Infrared

 e. Lighting

 h. Micro/Mini USB

 a. NFC

 g. Micro SD card

 f. SIM card

 d. Tether

Specialty Mobile Devices
Specialty mobile devices include wearables, smartwatches, VR/AR headsets, GPS devices, and 
e-readers.

Check Your Understanding—Specialty Mobile Devices

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definition

 a. A device that provides the user with 
a complete immersion experience 
shutting out the physical world.

 b. A device that overlays digital ele-
ments to a live view of the physical 
world.

 c. A satellite-based navigation device.

 d. A device that measures and collects 
activity data and can connect with 
other devices to upload data.

 e. A device optimized for display-
ing electronic versions of books, 
newspapers, magazines, and other 
documents.

 f. A device that combines the functions 
of a watch with some functions of 
mobile devices.

Term

 b. AR headset

 e. E-reader

 d. Fitness monitor

 c. GPS receiver

 f. Smartwatch

 a. VR headset

Network Connectivity and Email
Mobile devices are just about useless without wireless connectivity to a network that provides 
access to other resources and services. One of the most important services mobile devices con-
nect to is email.

Wireless and Cellular Data Networks
Mobile devices typically have two wireless Internet connectivity options: Wi-Fi and cellular. 
They typically also include Bluetooth wireless technology for connecting to peripheral devices 
such as headphones, a keyboard, and a mouse.

Check Your Understanding—Wireless Technology

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definition

 a. Standard enables speeds of 100 Mb/s 
and up to 1 Gb/s, supports gaming 
services, and is often implemented 
using LTE.

 b. This is currently the most secure stan-
dard for wireless home networks.

 c. This setting turns off all cellular, as 
well as Wi-Fi and Bluetooth radios.

 d. These networks require towers and 
satellites to create a mesh of global 
coverage.

 e. A wireless connection option is pre-
ferred because it is typically free.

 f. Introduced in the 1990s, this standard 
enabled speeds up to 2 Mb/s to 
support mobile Internet access.

 g. This standard introduced in 2019 
supports speeds up to 20 Gb/s.

 h. This setting enables a cellular device 
to be used as a Wi-Fi access point 
that connects devices to the Internet 
using the cellular carrier’s network.

 i. This standard supports speeds up to 
1 Mb/s and introduced SMS for text 
messaging and MMS for sending and 
receiving photos and videos.

Term

 i. 2G

 f. 3G

 a. 4G

 g. 5G

 c. Airplane mode

 d. Cellular

 h. Hotspot

 e. Wi-Fi

 b. WPA2

Configuring Email
Email clients and servers use various protocols and standards to exchange emails. Email servers 
require email software such as Microsoft Server Exchange. Email clients have to be installed on 
a mobile device. Many clients are configurable using a wizard. However, you still need to know 
key information to set up an email account.

Check Your Understanding—Email Protocols

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.
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Definition

 a. This protocol allows the user to orga-
nize email on the network email server 
and to download copies of email. The 
original email remains on the network 
email server. The default port is 143.

 b. This protocol extends the email for-
mat to include text in ASCII standard 
as well as other formats, such as pic-
tures and word processor documents.

 c. This protocol retrieves emails from a 
remote server over TCP/IP. Normally, 
it does not leave a copy of email on 
the server. The default port is 110.

 d. This email server, contact manager, 
and calendaring software was created 
by Microsoft.

 e. This text-based protocol transmits 
emails across a TCP/IP network. The 
default port is 25.

 f. This protocol was developed to trans-
mit files securely. All data exchanged 
between the email client and the email 
server is encrypted.

Term

 d. Exchange

 a. IMAP

 b. MIME

 c. POP3

 e. SMTP

 f. SSL

Preventive Maintenance and Troubleshooting 
Laptops and Other Mobile Devices
Caring for laptops and other mobile devices includes preventive maintenance tasks and 
troubleshooting issues when they arise.

Scheduled Maintenance for Laptops and 
Other Mobile Devices
The preventive maintenance schedule for a laptop may include practices that are unique to a 
particular organization but should also include the standard procedures of cleaning, hard drive 
maintenance, and software updates.

Preventative maintenance for mobile devices requires only three basic tasks: cleaning, backing 
up data, and keeping the operating system and applications up to date.

Laptop Preventive Maintenance Program Review

Routine maintenance includes the monthly cleaning of these laptop components:

 ■ Exterior case—Wipe the case with a soft, lint-free cloth that is lightly moistened with 
water or mild cleaning solution.

 ■ Cooling vents and I/O ports—Use compressed air or a nonelectrostatic vacuum to 
clean out the dust from the vents and from the fan behind the vent. Use tweezers to 
remove any debris.
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 ■ Display—Wipe the display with a soft, lint-free cloth that is lightly moistened with a 
computer-screen cleaner.

 ■ Keyboard—Wipe the keyboard with a soft, lint-free cloth that is lightly moistened with 
water or mild cleaning solution.

 ■ Touchpad—Wipe the surface of the touchpad gently with a soft, lint-free cloth that is 
moistened with an approved cleaner. Never use a wet cloth.

Mobile Device Preventive Maintenance Program Review

Preventive maintenance for mobile devices requires only three basic tasks: cleaning, backing up 
data, and keeping the operating system and applications up to date.

 ■ Cleaning—Use a soft, lint-free cloth and a cleaning solution designed for a touchscreen 
to keep the touchscreen clean. Do not use ammonia or alcohol to clean the touchscreen.

 ■ Backing up the data—Keep a backup copy of the information on the mobile device to 
another source, such as a cloud drive. The information includes contacts, music, photos, 
videos, apps, and any customized settings.

 ■ Updating the system and applications—When a new version of the operating system 
or applications is available, the device should be updated to ensure that it is working at 
its best. An update can include new features, fixes, or improvements to performance and 
stability.

Basic Troubleshooting Process for Laptops and 
Other Mobile Devices
Fixing problems with laptops and other mobile devices includes following the troubleshooting 
process to locate the problem and implement a solution.

Applying the Troubleshooting Process to Laptops and 
Other Mobile Devices
The technician uses the troubleshooting process to identify and resolve problems.

Review the Troubleshooting Process Steps

In Table 7-3, list the six troubleshooting steps.

Table 7-3 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive 
measures.

Step 6 Document findings, actions, and outcomes.

Book 1.indb   191Book 1.indb   191 01/10/19   9:27 PM01/10/19   9:27 PM



192  IT Essentials Version 7, Labs & Study Guide

Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the right hardware, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or no answer. In Table 7-4, indicate 
whether the technician’s question is open-ended or closed-ended.

Table 7-4 Open-Ended and Closed-Ended Questions

Question to Identify the Problem for Laptops Open-Ended Closed-Ended

Is the laptop currently using the battery? X

What were you doing when the problem was identified? X

What error messages have you received? X

Can the laptop boot and show the operating system 
desktop?

X

Is the laptop under warranty? X

What problems are you experiencing with your laptop? X

What software has been installed recently? X

Can the laptop operate using the AC adapter? X

Question to Identify the Problem for Mobile Devices Open-Ended Closed-Ended

What is the problem you are experiencing? X

What is the make and model of your mobile device? X

Has anyone else used the mobile device? X

Has this problem happened before? X

What service provider do you have? X

Is your mobile device under warranty? X

Check Your Understanding—Possible Solutions for Laptops and 

Other Mobile Devices

Check your understanding of common problems and solutions for laptops and other mobile 
devices by choosing the BEST answer to the following questions.

 1. The laptop’s battery is supporting the system for less than the normal period of time.

 a. Plug the laptop into AC power.

 b. Remove and reinstall the battery.

 c. Modify the power plan to decrease battery usage.

 d. Use the Fn key along with the multipurpose key to toggle to the external display.

 e. Adjust the screen refresh rate.
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 2. The laptop is powered on, but nothing is displayed on the screen when the laptop lid is 
reopened.

 a. Remove unneeded peripherals and disable the wireless NIC if possible.

 b. Replace the battery.

 c. Plug the laptop into AC power.

 d. Press a key on the keyboard to bring the computer out of sleep mode.

 e. Disassemble the laptop to check the display connections.

 3. The image on the screen appears to flash lines or patterns of different color and size 
(artifacts).

 a. Contact the manufacturer.

 b. Disassemble and clean the computer, checking for dust and debris.

 c. Adjust the screen refresh rate.

 d. Set the display to native resolution.

 e. Check the laptop repair manual for instructions about calibrating the LCD backlight.

 4. A smartphone cannot connect to the carrier's network.

 a. Install the SIM card.

 b. Move to within the boundaries of a Wi-Fi network.

 c. Pair the device.

 d. Modify the power plan to decrease battery usage.

 e. Use the AC adapter that came with the smartphone.

Answer: 1 C, 2 D, 3 B, 4 A

Book 1.indb   193Book 1.indb   193 01/10/19   9:27 PM01/10/19   9:27 PM



194  IT Essentials Version 7, Labs & Study Guide

Labs and Activities

Command Reference
Chapter 7, “Laptops and Other Mobile Devices,” does not include new commands.
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 7.1.1.10 Lab–Mobile Device Information 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this activity, you will use the Internet, a technical journal, or a local store to gather infor-
mation about an Android and an iOS device. You will document the specifications of each 
Android and iOS device onto this worksheet. Be prepared to discuss your decisions regarding 
the devices you select.

Recommended Equipment
PC with Internet Connection

Step 1: Select an Android and iOS device to research. Record the hardware specifications in 
the boxes below.

Instructor Note: You may choose another Android and iOS device to research. The answers 
below are specific to the Samsung Galaxy S9 and the Apple iPhone XR.

Specifications Android Device iOS Device

Model Galaxy S9 iPhone XR

Manufacturer Samsung Apple

Operating 
System

Android 8 (Oreo) iOS 12

Available 
Memory

4 GB RAM, 64/128/256 GB, microSD card slot 3GB RAM, 64/128/256 GB

Camera Front: 8 MP

Rear: 12MP

Video: 4K

Front: 7 MP

Rear: 12 MP

Video: 4K

Wi-Fi 
Connectivity

802.11a/b/g/n/ac 802.11a/b/g/n/ac

Battery 
Information

Li-ion, 3000 mAh Li-ion, 2716 mAh

Screen 
Size and 
Resolution

5.8-inch screen

2960 × 1440 resolution

6.1-inch screen

1792 × 828 resolution

Size and 
Weight

147.7 × 68.7 × 8.5 mm 

(5.81 × 2.70 × 0.33 in)

Weight: 163 g (5.75 oz)

150.9 × 75.7 × 8.3 mm

(5.94 × 2.98 × 0.33 in)

Weight: 194 g (6.84 oz)
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Step 2: Based on your research, which mobile device would you select? Be prepared to dis-
cuss your decisions regarding the mobile device you select.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary.
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7.1.2.8 Lab–Research Docking Stations and Port 
Replicators (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
A docking station uses proprietary connectors that turn laptops into a desktop system by con-
necting to other peripheral devices, such as mice, keyboards, and external monitors. A port 
replicator can provide some or all of the functionality of a docking station; however, it usually 
connects to the laptops via USB or Thunderbolt connection.

In this lab, you will research the specifications for a proprietary laptop docking station and 
a generic port replicator for a specific laptop model. Be prepared to discuss your decisions 
regarding your choices.

For the proprietary docking stations, navigate to the major computer brands’ websites to search 
for their recommendations. For the generic port replicators, they can be found on websites of 
major computer brands or computer electronic stores.

Instructor Note: You may choose another laptop docking station to research. The answers 
below are specific to the Lenovo P51s. Laptops can use the manufacturer’s proprietary docking 
stations or port replicators that are connected via USB.

Step 1: Choose a laptop with an associated docking station.

The major computer brands that target the business market will most likely sell 
laptop models that use proprietary docking stations.

Navigate to the website of a major computer brand. Search for a propriety docking 
station suitable for your laptop model. Review the provided information and answer 
the following questions.

a. What is the model or part number of the docking station?

 ________________________________________________________________________

Answers may vary. The model is ThinkPad Pro Docking Station – 90W. The part 
number is 40A10090US.

b. What is the approximate cost?

 ________________________________________________________________________

The cost is $215.

c. What are the dimensions of the docking station?

 ________________________________________________________________________

 ________________________________________________________________________

Height: 2.19 in (55.6 mm)

Width: 13.58 in (345 mm)

Depth: 6.40 in (162.5 mm)
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d. How does the laptop connect to the docking station?

 ________________________________________________________________________

 ________________________________________________________________________

The laptop has a docking station connector on the underside of the laptop, which 
attaches to a connector on the docking station.

e. List some of the features available with this docking station.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

3x USB 2.0, one supports always-on USB charging, 3x USB 3.0

10/1000 Gigabit Ethernet, supports enterprise manageability

1x DisplayPort 1.2 (Exclusive use with DVI-D), 1x DVI-D (Exclusive use with 
DisplayPort), 1x VGA

Driver-free, perfect video quality

1x Stereo/Mic Combo Audio Port

Security lock hole

Convenient eject button for one-step system removal

Charges your ThinkPad

f. Is this docking station compatible with other laptop models?

 ________________________________________________________________________

 ________________________________________________________________________

Yes, this docking station works with ThinkPad T, L, X, and X1 Series laptops. 
For a specific laptop model, some of the manufacturers may have a finder: 
https://www.lenovo.com/us/en/docksSearch/

Step 2: Choose a port replicator.

In this step, search and review the technical specification for a port replicator that is 
compatible with your laptop model. Answer the following questions.

a. What is the model or part number of the port replicator?

 ________________________________________________________________________

Answers may vary. The model is ThinkPad USB-C Dock. The part number is 
40A90090US.

b. What is the approximate cost?

 ________________________________________________________________________

The cost is $190.

Book 1.indb   198Book 1.indb   198 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 7: Laptops and Other Mobile Devices  199

c. What are the dimensions of the port replictor?

 ________________________________________________________________________

 ________________________________________________________________________

Height: 1.28 in (32.5 mm)

Width: 6.73 in (171 mm)

Depth: 3.15 in (80 mm)

d. How does the laptop connect to the port replicator?

 ________________________________________________________________________

 ________________________________________________________________________

The port replicator supports any laptops with full function USB-C port.

e. List some of the features available with this port replicator.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

2 × DP

1 × VGA

3 × USB 3.0 – 1 provides always-on mobile device charging

2 × USB 2.0

1 × USB-C (data only, provides 5V, 3A power)

1 × Gigabit Ethernet

1 × Stereo/Mic Combo Port

1 × Security Lock Slot

f. Is this port replicator compatible with other laptop models?

 ________________________________________________________________________

Yes, it supports laptops with full function USB-C port, not just Lenovo laptops.

Book 1.indb   199Book 1.indb   199 01/10/19   9:27 PM01/10/19   9:27 PM



200  IT Essentials Version 7, Labs & Study Guide

Reflection
Now that you have chosen a docking station and a port replicator for your laptop model, which 
is your choice? Explain your choice and list some advantages and disadvantages.

 

 

 

The docking station is only compatible with specific vendors and models and usually slightly 
more expensive. The port replicator can be used with laptops of different brands or models, as 
long as the laptops have the correct connections. For choosing either docking station or port 
replicator, verify that the monitor has the correct connections, such as VGA, DVI, or HDMI.
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7.3.1.6 Lab–Research Laptop RAM 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

In this lab, you will use the Internet or a local store to gather information about expansion 
memory for a laptop. 

Instructor Note: You may choose another laptop to research. The answers below are specific 
Lenovo ThinkPad P51s.

 1. Research the manufacturer specifications for the memory in a laptop. List the specifica-
tions in the table below.

Memory Specifications Laptop Expansion Memory

Form Factor SODIMM

Type DDR4

Size (GB) 32 GB maximum

Manufacturer Lenovo

Speed 2400 MHz

Slots 2

 2. Shop around, and in the table below list the features and costs for expansion memory for 
a laptop.

Memory Specifications Expansion Memory

Form Factor SODIMM

Type DDR4

Size (GB) 16 GB

Manufacturer Patriot

Speed 2400 MHz

Retail Cost $130

 3. In your research, did you find any reason to select a particular type of expansion 
memory over another?

 

 

Answers will vary based on price, warranty, and preference.

 4. Is the new expansion memory compatible with the existing memory installed in the 
laptop? Why is this important?

 

 

Yes. If the expansion memory speed is less than the manufacturer’s specifications, the laptop 
may not work at its optimal performance and may crash the computer.
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7.3.2.4 Lab–Research Laptop Screens 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

In this activity, you will use the Internet or a local store to gather information and then record 
the specifications for a laptop display onto this worksheet. 

Instructor Note: You may choose another laptop screen to research. The answers below are 
specific to the Lenovo P51s.

 1. Research and list the specifications for a replacement laptop screen. Please ask your 
instructor for the laptop model to research. 

Screen Specifications Display Screen

Type Active Matrix TFT Color LCD

Size 15.6" (396 mm)

Resolution FHD (1920 × 1080) or 4K (3840 × 2160)

Backlight Type LED

 2. When replacing a laptop screen, the replacement screen must match many, if not all, 
specifications of the original screen. Research and list which specifications must match 
the original display screen.

 

 

These specifications must match the original display screen: size, resolution, and backlight.

 3. Shop around, and in the table below list the features and cost of two replacement screens 
for a laptop.

Screen Specifications Replacement #1 Replacement #2

Type LCD LCD

Size 15.6" 15.6"

Resolution FHD (1920 × 1080) 4K (3840 × 2160)

Backlight Type LED LED

Approximate cost $56 $100

Warranty Lifetime 12-month

 4. Based on your research, which replacement screen would you select? Be prepared to 
discuss your decisions regarding the screen you select.

 

 

The student may choose a specific resolution but must be prepared to explain his/her decision.
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7.3.2.7 Lab–Research Laptop Batteries 
(Instructor Version)
In this lab, you will use the Internet or a local store to gather information and then record the 
specifications for a laptop battery.

Instructor Note: You may choose another laptop battery to research. The answers below are 
specific to the Lenovo P51s.

Laptop batteries are removable, rechargeable Lithium ion battery packs. Most laptop batter-
ies are available in 6-, 9-, or 12-cell versions. The more cells in the battery pack, the longer the 
battery charge will last. Lithium ion batteries should not be allowed to fully discharge because 
this will reduce their battery life. They should be regularly charged. For safety reasons do not 
leave a battery charger close to flammable materials, and be sure there is plenty ventilation 
around the charger. It is also a good idea to not leave a battery unattended during charging. 
Because different battery types require different charging regimes, you should always consult 
manufacturer's instructions for maintaining optimal battery life. 

When replacing or installing a laptop battery, the laptop should be turned off and the power 
cable disconnected from the AC power source. Most laptops have latches on the back or bot-
tom of the cassis that release to remove the battery. Make sure latches are fully engaged after 
installing a battery.

 1. List the specifications for a laptop battery. Please ask your instructor for the laptop 
model to research. 

 

The battery included with the ThinkPad P51s is a standard 3-Cell Lithium Ion rechargeable battery. 

Li-ion 3-Cell External Battery Pack (11.40 - 11.55V / 2.08 – 2.10 Ah) P/N: 4X50M08810

Li-ion 6-Cell External Battery Pack (10.8V / 4.8AH) P/N: 4X50M08812

Manufacturer: Lenovo

Depending on usage, the 3-cell external and 4-cell internal batteries will operate approximately 
up to 13.5 hours. The 6-cell external and 4-cell internal batteries will operate approximately up to 
26.4 hours. Depending on your laptop model, you can buy an extended life 6- or 9-cell battery.

Book 1.indb   203Book 1.indb   203 01/10/19   9:27 PM01/10/19   9:27 PM



204  IT Essentials Version 7, Labs & Study Guide

 2. Shop around, and in the table below list the features and cost for a generic and a laptop 
battery from the manufacturer of the laptop.

Battery Specifications Generic Manufacturer

Output voltage 10.8 V 10.8 V – 11.25 V

Battery cell 
configuration

ex: 6-cell, 9-cell

3-cell or 6-cell 3-cell (61)

6-cell (61++)

Dimensions 3-cell: 264 mm (10.4 in) × 53 mm 
(2.1 in) × 107 mm(4.2 in)

6-cell: 265 mm (10.43 in) × 110 
mm (4.33 in) × 50 mmm (1.97 in)

3-cell: 264 mm (10.4 in) × 53 mm 
(2.1 in) × 107 mm (4.2 in)

6-cell: 265 mm (10.43 in) × 
110 mm (4.33 in) × 50 mmm 
(1.97 in)

Hours of life 2.5 hours for 3-cell

5.5 hours for 6-cell

Approximate cost ~ $50 for 3-cell

~ $90 for 6-cell

$110 for 3-cell

$118 for 6-cell

 3. Based on your research, which battery would you select? Be prepared to discuss your 
decisions regarding the battery you select.

 

The student may choose an extended life battery if available but must be prepared to explain 
the decision.
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7.3.2.10 Lab–Research Laptop Drives 
(Instructor Version)
In this lab, you will use the Internet or a local store to gather information about storage and 
optical drives for a laptop.

Instructor Note: You may choose another laptop to research. The answers below are specific 
to the Lenovo P51s.

 1. Research the manufacturer specifications for the storage drive in the laptop. List the 
specifications in the table below: 

Drive Specifications Drive

Form Factor 2.5"

Type SSD

Size (GB) 512 GB

Port Type SATA

Drive Speed 8 GB/s

 2. Shop around, and in the table below list the features and costs of two storage replace-
ment storage drives for a laptop.

Drive Specifications Replacement Drive #1 Replacement Drive #2

Form Factor 2.5" 2.5"

Type SSD SSD

Size (GB) 2 TB 500 GB

Manufacturer Crucial Crucial

Port Type SATA SATA

Retail Cost $289.99 $70

 3. In your research, did you find any reason to select a particular drive over another?

 

Answers will vary based on price, warranty, and preference.

 4. Is the new storage drive compatible with other components in the laptop? Why is this 
important?

 

Yes. If the drive does not have the same form factor, port, or power specifications, then it will 
not function with the other components in the laptop.

 5. The laptop may or may not have an internal optical drive. Do a search for an internal and 
external optical drive. How do they compare in price and drive speed?

 

An internal optical drive is about $20–$30, and an external USB optical drive is priced compa-
rable to the internal optical. 
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7.5.1.2 Lab–Mobile Wi-Fi (Instructor Version)

Introduction
In this lab, you will turn the Wi-Fi radio on and off, forget a found Wi-Fi network, and find 
and connect to a Wi-Fi network.

Recommended Equipment
Android tablet or smartphone running Android version 5.0 or higher

iOS tablet or smartphone running iOS version 7.0 or higher

Instructor Note: This lab must be completed by students even if the recommended equipment 
is not available. This lab is designed to provide students with familiarity with Android and iOS 
features.

Instructor Note: Due to the variety of Android and iOS devices and operating systems, some 
of the paths and locations of items may be different from those in this lab. Consult the manual 
of the Android and iOS device to determine the correct instructions for your device.

You may also perform a web search for “android emulator” or “iOS emulator.” These emulators 
may provide the platform interface for practice.

If your students own Android or iOS devices, they may be able to demonstrate how to use the 
devices to the other students.

Step 1: Configure Wi-Fi on an Android device.

In this step, you will configure Wi-Fi on an Android device.

a. Turn on the device and log in with the password, pin code, or another passcode, 
if necessary.

b. Go to All apps > Settings > Connections.

c. Touch the Wi-Fi slider to turn it off.

d. Touch the Wi-Fi slider again to turn it on.

e. Wait until the device is connected to a wireless network before moving on to 
the next step.

f. Touch Wi-Fi and then the name of the network to which the device is 
connected. The Wi-Fi details window appears.

g. Touch FORGET. What happens?

 ________________________________________________________________________

The network to which the device was connected is in the list of available networks, 
but the device is no longer connected to it.

h. Touch the network to which the device used to be connected.

i. Type the Wi-Fi password. Touch CONNECT. What happens?

 ________________________________________________________________________

The device connects to the Wi-Fi network.
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Step 2: Configure Wi-Fi on an iOS device.

In this step, you will configure Wi-Fi on an iOS device.

a. Turn on the device and log in with the password, PIN code, or another 
passcode, if necessary.

b. Go to Settings > Wi-Fi.

c. Touch the Wi-Fi slider to turn it off.

d. Touch the Wi-Fi slider to turn it on.

e. Touch the name of the network to which the device should connect. The Wi-Fi 
details window opens.

f. Touch Forget This Network. Confirm the deletion of the network by selecting 
Forget. What happens?

 ________________________________________________________________________

The network to which the device was connected is in the list of available networks, 
but the device is not connected to it.

g. Touch the network to which the device used to be connected.

h. Type the Wi-Fi password.

i. Touch Join. What happens?

 ________________________________________________________________________

The device connects to the Wi-Fi network.
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7.7.2.4 Lab–Research Laptop Problems 
(Instructor Version)
Laptops often use proprietary parts. To find information about the replacement parts, you may 
have to research the website of the laptop manufacturer. 

Before you begin this lab, you need to know some information about the laptop. 

Instructor Note: This activity is designed to help the students find information on laptops. 
Provide students with the required information so they can work individually or in small 
groups. To prevent lost lab time, instructors are encouraged to send students to sites that are 
known by the instructor. Instructors may want to pre-screen websites to reflect equipment that 
is present on campus.

Your instructor will provide you with the following information:

Laptop manufacturer: 

Laptop model number: 

Amount of RAM: 

Size of the hard drive: 

Use the Internet to locate the website for the laptop manufacturer. What is the URL for the 
website?

Answers will depend on the laptop manufacturer provided by the instructor.

Locate the service section of the website and look for links that focus on your laptop. It is 
common for a website to allow you to search by the model number. 

List the links you found specific to the laptop and include a brief description of the informa-
tion in that link.

 

 

 

 

Answers will depend on the laptop manufacturer provided by the instructor.

Briefly describe any service notices you found on the website. A service notice example is a 
driver update, a hardware issue, or a recall notice for a laptop component.

 

 

 

 

Answers will depend on the laptop manufacturer provided by the instructor.
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Open forums may exist for your laptop. Use an Internet search engine to locate any open 
forums that focus on your laptop by typing in the name and model of the laptop. Briefly 
describe the websites (other than the manufacturer website) that you located.

 

 

 

 

Answers will depend on the laptop manufacturer provided by the instructor.
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7.7.2.5 Lab–Gather Information from the Customer 
(Instructor Version)
In this lab, you will act as a call center technician and create closed-ended and open-ended 
questions to ask a customer about a laptop problem.

A customer complains that the network connection on the laptop is intermittent. The customer 
states that he is using a wireless PC card for network connectivity. The customer believes that 
the laptop may be too far from the wireless access point; however, he does not know where the 
wireless access point is located.

As a technician, you need to be able to ask questions that will be recorded on a work order. In 
the table below, record closed-ended questions and open-ended questions that you would ask a 
customer. 

Closed-End Questions Open-Ended Questions

How long has the network connection been 
malfunctioning?

What are the problems that you are experi-
encing with the laptop?

What is the manufacturer and model of the 
laptop?

What system changes have you made on the 
laptop recently?

Which operating system is installed on the 
laptop?

What were you doing when the problem 
occurred?

Have you installed any new drivers or 
updates recently?

What new drivers or updates have you 
installed recently?

Does your laptop have a wireless network 
connection?

Explain how to reproduce the problem or 
error for me now.

Please open your wireless network connec-
tion status window and tell me the connec-
tion information.
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7.7.2.6 Investigate Support Websites and Repair 
Companies (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

In this lab, you will investigate the services provided by a local laptop repair company or a 
laptop manufacturer’s support website. Use the Internet or a local phone directory to locate a 
local laptop repair company or laptop manufacturer’s support website. Answer the following 
questions: 

Local Laptop Repair Company

Instructor Note: The information below was obtained from a national computer repair center 
company.

You can use any local repair company to complete this activity. Your answers may vary from 
the answers below.

 1. What different types of services does the repair company offer? 

 

 

 

Answers may vary: Mail-in repairs, help and FAQ, warranty and returns.

 2. What brand(s) of laptop computers can be repaired at this repair company?

 

 

 

Answers may vary: Toshiba, IBM, HP, Compaq, and Sony.

 3. What type of warranty is offered at this repair company?

 

 

 

Answers may vary: They are an authorized service and warranty repair center for Toshiba, 
IBM, HP, Compaq, and Sony. As an authorized service and warranty repair center, they repair 
in-warranty laptops or notebooks. There are no parts or labor charges for in-warranty work. 
They also provide extended-warranty repairs for these brands.
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 4. Does the staff have industry certifications? If so, what are the certifications?

 

 

 

Answers may vary: The company maintains a staff of A+ certified and manufacturer-certified 
technicians who receive service updates from the manufacturers.

 5. Is there a guaranteed completion time for repairs? If so, what are the details?

 

 

 

Answers may vary: Yes, a 24-hour completion time if the parts are in stock. If the part must be 
ordered, they offer a 3-business-day completion guarantee.

 6. Does the repair company offer remote technical services?

 

 

 

Answers may vary: Yes. There is a minimum fee for all remote technical services.

Laptop Manufacturer Support Website

Instructor Note: The information below was obtained from a national computer repair center’s 
website (http://www.dell.com/).

You can use other websites to complete this activity. Your answers may vary from the answers 
below.

 1. What steps are required for locating device drivers for a laptop?

 

 

 

Answers may vary: Search for drivers > select model > select product family Laptops > select 
product line XPS Laptop > select product model M1530 > confirm.

 2. What type(s) of support are offered for troubleshooting laptops?

 

 

 

Answers may vary: FAQ, search database, chat, forums, and discussion groups.
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 3. Does the manufacturer website offer remote technical services? If so, what type(s)?

 

 

 

Answers may vary: Chat with technical support and on-site service.

 4. What method(s) are used to locate parts?

 

 

 

Answers may vary: Dell System Analyzer and Service Tag search.

 5. What steps are required for locating manuals for a laptop?

 

 

 

Answers may vary: Select model > select product family laptops > select product line 
Precision Laptop > select product model M90 > confirm > get manuals > English > 
select manual > download.
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CHAPTER 8

Printers

Printers produce paper copies of electronic files. Many situations, such as government regulations, 
require physical records; therefore, hard copies of computer documents are often as important today as 
they were when the paperless revolution began several years ago.

This chapter reviews information about printers, including how printers operate, what to consider when 
purchasing a printer, and how to connect printers to an individual computer or to a network.
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Study Guide

Common Printer Features
Printers can be characterized by their features and capabilities. Printers can be connected in a 
variety of ways.

Characteristics and Capabilities
Printer characteristics include speed, quality, and color. Total cost of ownership (TCO) includes 
the following factors:

 ■ Initial purchase price

 ■ Cost of consumable supplies, such as paper and ink

 ■ Pages per month

 ■ Price per page

 ■ Maintenance costs

 ■ Warranty costs

When calculating the TCO, consider the amount of printing required and the expected lifetime 
of the printer.

Check Your Understanding—Characteristics and Capabilities

Match the printer characteristic or capability on the left with the term on the right. This 
exercise is a one-to-one matching.

Characteristic or Capability

 a. This printer commonly found in retail 
uses impact technology to make a 
carbon copy.

 b. This device is used by laser printers to 
create the image.

 c. This term refers to a feature of some 
laser and inkjet printers that also have 
copy-machine capabilities.

 d. This is used by inkjet printers to 
create the image.

 e. These are the colors of ink used in 
color printing.

 f. This is the length of time the printer 
should work before a failure.

 g. This term refers to the quality of the 
image resolution.

 h. This term refers to the speed at which 
the printer can create a print.

Term

 c. ADF

 e. CMYK

 a. Dot matrix

 g. dpi

 d. Electrostatic spray

 b. Imaging drum

 f. MTBF

 h. ppm
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Printer Connections
Printers are connected to other devices and the network in a variety of ways, including 
wireless.

Label the Printer Connections

In Figure 8-1, label the printer connector and port.

Figure 8-1 Printer Connections

Answer: Top row left to right: Serial connector, Serial port, Parallel connector, Parallel port

Middle row left to right: USB connector, USB port, FireWire connector, FireWire port 
Bottom row left to right: Ethernet connector, Ethernet port

Printer Type Comparison
You can choose from a variety of printers based on your needs and resources, including inkjet, 
laser, thermal, virtual, and 3D printers.
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Inkjet Printers
Inkjet printers are easy to use and usually less expensive than laser printers. Some advantages 
of an inkjet printer are initial low cost and high resolution; plus, they are quick to begin 
printing. Some disadvantages of an inkjet printer are that the nozzles are prone to clogging, ink 
cartridges can be expensive, and the ink is wet for a few seconds after printing.

Check Your Understanding—Inkjet Printers

Match the printer part on the left with its purpose on the right. This exercise is a one-to-one 
matching.

Printer Part

 a. Inkjet printers use these, which spray 
ink onto a page through tiny holes.

 b. As rollers pull paper in from the 
feeder, the belt moves this back and 
forth across the paper to spray ink on 
the page.

 c. This device holds multiple documents 
so that they can be fed page by page 
onto the scanner bed for copying.

 d. This is located on the carriage, which 
is attached to a belt and motor.

 e. These are located in the ink reservoir 
at the back of each nozzle. A charge is 
applied to cause them to vibrate. This 
vibration controls the flow of ink onto 
the paper.

 f. A pulse of electrical current is applied 
to heating chambers around the 
nozzles. The heat creates a bubble 
of steam in the chamber. The steam 
forces ink out through the nozzle and 
onto the paper.

 g. This device turns a page that is already 
printed on one side so that it can be 
printed on the other side.

 h. These are the tiny holes in the print 
head.

Purpose

 c. ADF

 b. Carriage

 g. Duplexing assembly

 a. Ink cartridge

 h. Nozzles

 e. Piezoelectric crystals

 d. Print head

 f. Thermal

Book 1.indb   218Book 1.indb   218 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 8: Printers  219

Laser Printers
A laser printer is a high-quality, fast printer that uses a laser beam to create an image. Some 
advantages of a laser printer are low cost per page, high ppm, and high capacity; plus, prints 
come out dry. Some disadvantages of a laser printer are that startup costs are high and toner 
cartridges can be expensive.

Check Your Understanding—Laser Printers

Match the printer part on the left with its purpose on the right. This exercise is a one-to-one 
matching.

Printer Part

 a. These move the sheet of paper out of 
the tray or cassette, then through the 
printer during the printing process.

 b. This turns a page that is already 
printed on one side so that it can be 
printed on the other side.

 c. This is coated with a light-sensitive 
insulating material.

 d. This assists in transferring the toner 
from the imaging drum to the paper.

 e. This is one of the primary consumable 
items in a laser printer.

 f. This is made up of hot rollers, which 
melt the toner into the paper.

Purpose

 b. Duplexing assembly

 f. Fuser assembly

 c. Imaging drum

 a. Pickup rollers

 e. Toner cartridge

 d. Transfer roller

Laser Printing Process
The laser printing process involves seven steps to print information onto a single sheet of 
paper:

 1. Processing

 2. Charging

 3. Exposing

 4. Developing

 5. Transferring

 6. Fusing

 7. Cleaning
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Check Your Understanding—Laser Printing Process

Match the laser printing process on the left with its step on the next page. This exercise is a 
one-to-one matching.

Laser Printing Process

 a. The toner is permanently placed on 
the paper. The printing paper is rolled 
between a heated roller and a pressure 
roller. As the paper moves through the 
rollers, the loose toner is melted and 
combined with the fibers in the paper. 
The paper is then moved to the output 
tray as a printed page.

 b. The data from the source must be 
converted into a printable form. The 
printer converts data from common 
languages, such as PS or PCL, to a 
bitmap image stored in the printer’s 
memory.

 c. The image on the drum is removed 
and the drum is conditioned for the 
new image. A wire, grid, or roller 
receives approximately –600 volts DC 
uniformly across the surface of the 
drum. The electrified wire or grid is 
called the primary corona. The roller 
is called a conditioning roller.

 d. The toner is applied to the latent image 
on the drum. A control blade holds the 
toner at a microscopic distance from 
the drum. The toner then moves from 
the control blade to the more positively 
charged latent image on the drum.

 e. To write the image, the photosensitive 
drum is scanned with the laser beam. 
Every portion of the drum that is 
scanned with the light has the surface 
charge reduced to about –100 volts 
DC. This electrical charge has a lower 
negative charge than the rest of the 
drum. As the drum turns, an invisible 
image is created on the drum.

 f. The toner attached to the latent image 
is conducted to the paper. A corona 
wire places a positive charge on the 
paper. Because the drum was charged 
negatively, the toner on the drum is 
attracted to the paper. The image is 
now on the paper and is held in place 
by the positive charge.

 g. When an image has been deposited on 
the paper and the drum has separated 
from the paper, the remaining toner 
must be removed from the drum. A 
printer might have a blade that scrapes 
off the excess toner. Some printers use 
an AC voltage on a wire that removes 
the charge from the drum surface and 
allows the excess toner to fall away 
from the drum. The excess toner is 
stored in a used toner container that is 
either emptied or discarded.
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Purpose

 b. Step 1. Processing

 c. Step 2. Charging

 e. Step 3. Exposing

 d. Step 4. Developing

 f. Step 5. Transferring

 a. Step 6. Fusing

 g. Step 7. Cleaning

Thermal Printers and Impact Printers
Many retail cash registers and some older fax machines contain thermal printers. Some 
advantages of thermal printers are that they last a long time because there are few moving 
parts, their operation is quiet, and there is no cost for ink or toner. However, thermal paper 
is expensive, it must be stored at room temperature, and it can degrade over time. Thermal 
printer images are poor quality, and color printing is not available.

Impact printers have print heads that strike an inked ribbon, causing characters to be imprinted 
on the paper. Dot matrix and daisy wheel are examples of impact printers. Some advantages 
of impact printers are that the ink is less expensive than inkjet cartridges or laser printer 
toner cartridges. They use continuous-feed paper and can print carbon copies. Disadvantages 
include the fact that they are noisy, the graphics are low resolution, and they have limited 
color-printing capabilities.

Check Your Understanding—Thermal Printers and Impact Printers

In Table 8-1, indicate whether the definition or characteristic applies to a thermal printer or an 
impact printer.

Table 8-1 Thermal and Impact Printers

Definition or Characteristic Thermal Printer Impact Printer

An electrical current is sent to the print head. X

Two types include daisy wheel and dot matrix. X

These printers use continuous-feed paper and can 
print carbon copies.

X

The heated areas of the print head make the image 
on the paper.

X

The paper must be stored at room temperature and 
can degrade over time.

X

The ribbon strikes the paper, imprinting the character 
on the paper.

X

There is no cost for ink or toner. X

Perforated strips on the side are used to feed the paper 
and to prevent skewing or shifting.

X
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Virtual Printers
Virtual printing does not send a print job to a printer within your local network. Instead, the 
print software either sends the job to a file or transmits the information to a remote destination 
in the cloud for printing.

Check Your Understanding—Virtual Printers

Match the virtual printer term on the left with its definition or characteristic on the right. This 
exercise is a one-to-one matching.

Term

 a. To prevent others from easily copying 
the content in a document, you can 
choose to print this type of file 
format, such as JPG or TIFF.

 b. The .prn file could be quickly printed 
at any time without opening the 
original document.

 c. This allows you to connect your 
printer to the web. After it is 
connected, you can send print jobs to 
your printer from anywhere that has 
Internet access.

 d. Print software either sends the job to 
a file or transmits the information to 
a remote destination in the cloud for 
printing.

 e. Introduced by Microsoft, the XML 
Paper Specification format was meant 
to be an alternative to PDF.

Definition or Characteristic

 c. Google Cloud

 b. Print to File

 a. Print to Image

 e. Print to XPS

 d. Virtual Printing

3D Printers
Three-dimensional, or 3D, printers are used to create three-dimensional objects. These objects 
are first designed using a computer. The most commonly used 3D printers use plastic filament. 
The plastic filament is added in layers to create the object that was programmed on the 
computer.
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Check Your Understanding—3D Printers

Match the 3D printer part on the left with its purpose on the right. This exercise is a 
one-to-one matching.

3D Printer Part

 a. This pulls down the filament to be 
heated and to exit through the hotend 
nozzle.

 b. This is the platform onto which the 
heated filament will form the object.

 c. This is the material used in 3D printers 
to create objects.

 d. This can be vertical or horizontal so 
that the hotend nozzle can be located 
within a specified location in a 3D 
environment to “print” the object.

 e. When the filament is heated to the 
correct temperature, it is extracted 
from this.

Purpose

 d. Axis

 a. Feeder

 c. Filament

 e. Hotend nozzle

 b. Print bed

Installing and Configuring Printers
As an information technology technician, you are often responsible for installing and 
configuring printers.

Installing and Updating a Printer
A printer’s installation and configuration information is usually found on the manufacturer’s 
website. If the printer has a USB, FireWire, or parallel port, connect the corresponding cable 
to the printer port. Connect the other end of the data cable to the corresponding port on the 
back of the computer. If you are installing a network printer, connect the network cable to the 
network port.

After the data cable has been properly connected, attach the power cable to the printer. 
Connect the other end of the power cable to an available electrical outlet. When you turn on 
the power to the device, the computer determines the correct device driver to install.

Configuring Options and Default Settings
Each printer may have different configurations and default options. Check the printer 
documentation for specific information about its configuration and default settings.
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Check Your Understanding—Configuration Options

In Table 8-2, indicate whether the option applies to configuration, media control, or printer 
output.

Table 8-2 Configuration Options

Common Printer Settings Configuration Media Control Printer Output

Print quality X

Color management X

Collate X

Output path selection X

Paper weight selection X

Print speed X

Grayscale printing X

Duplex X

Optimizing Printer Performance
Printers are calibrated and optimized using the printer driver software. Calibration makes sure 
that the print heads are aligned and that they can print on different kinds of media, such as 
cardstock, photographic paper, and optical discs. Some inkjet print heads are fitted to the ink 
cartridge, so you might have to recalibrate the printer each time you change a cartridge.

Some printers can be upgraded to print faster and to accommodate more print jobs by adding 
hardware. The hardware may include additional paper trays, sheet feeders, network cards, and 
expansion memory.

Check Your Understanding—Optimizing Printer Performance

Match the term on the left with its description on the right. This exercise is a one-to-one 
matching.

Term

 a. These updates do not occur 
automatically.

 b. These are used to cancel or pause 
current print jobs in the printer queue.

 c. You can select landscape or portrait 
image layout.

 d. Adding more of this increases the 
printing speed and enhances complex 
print job performance.

 e. This enables you to adjust settings to 
match the colors on the screen to the 
colors on the printed sheet.

Description

 e. Color calibration

 a. Firmware

 c. Paper orientation

 b. Print spool settings

 d. Printer memory

Book 1.indb   224Book 1.indb   224 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 8: Printers  225

Sharing Printers
Sharing printers, even in a home network, reduces the total cost of ownership because multiple 
devices can connect to the same printer.

Operating System Settings for Sharing Printers
Printers are shared with other users on the network. Users who cannot connect to the shared 
printer might not have the required drivers installed. They might also be using different 
operating systems than the computer that is hosting the shared printer.

Wireless printers allow hosts to connect and print wirelessly using Bluetooth or a Wi-Fi 
connection.

Print Servers
Print servers let multiple computer users, regardless of device or operating system, access a 
single printer. A print server has three functions:

 ■ Provide client access to print resources.

 ■ Administrate print jobs by storing them in a queue until the print device is ready for 
them and then feeding or spooling the print information to the printer.

 ■ Provide feedback to users about the state of the printer.

Check Your Understanding—Print Servers

In Table 8-3, indicate whether the print server feature applies to software print servers, 
hardware print servers, or dedicated print servers.

Table 8-3 Print Server Features

Print Server Feature Software Hardware Dedicated

The server accepts incoming print jobs from computers, 
thereby freeing the computers for other tasks.

X

Apple’s Bonjour Print Server is built into the macOS 
and available for Windows.

X

The server handles client print jobs in the most efficient 
manner and can manage more than one printer at a 
time.

X

Apple’s AirPort Extreme uses the AirPort service to 
share printers.

X

The server is capable of managing the printing needs of 
users on multiple LANs.

X

The server must have a powerful processor, adequate 
storage space, and memory to meet the requests of 
print clients.

X

The computer sharing the printer uses its own resources 
to manage the print jobs coming to the printer.

X
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Maintaining and Troubleshooting Printers
A good preventive maintenance program helps to ensure good-quality prints and uninterrupted 
operation. The printer documentation contains information on how to maintain and clean 
the equipment. Read the information manuals and follow the recommended maintenance 
instructions. Use the supplies listed by the manufacturer.

To complete your review for this section, be sure you watch all the videos and complete 
the labs.

Printer Preventive Maintenance
Some printer preventive maintenance is common sense. If you do not know how to maintain 
printing equipment, consult with a manufacturer-certified technician.

Check Your Understanding—Printer Preventive Maintenance

In Table 8-4, indicate whether the statement is true or false.

Table 8-4 Printer Preventive Maintenance

Statement True False

Toner is not affected by humidity. X

Printers are affected by temperature, humidity, and electrical 
interference.

X

Toner cartridges should be kept in their original wrappers. X

Paper is not affected by its environment. X

Dust is an environmental problem for all printers. X

Inkjet Printer Preventive Maintenance
For inkjet printers, the type and quality of paper and ink used can affect the life of the printer. 
The printer manufacturer might recommend which type of paper to use for best results with 
the brand and type of ink used. If the wrong type of ink is installed, the printer might not 
work, or the print quality might deteriorate.

When an inkjet printer produces blank pages, the ink cartridges might be empty. Some ink-
jet printers may not print pages if one of the ink cartridges is empty. You can set the printer 
software to draft quality to reduce the amount of ink that the printer uses. These settings also 
reduce the quality, as well as the time it takes to print a document.

On inkjet printers, clean the paper-handling machinery with a damp cloth.

Laser Printer Preventive Maintenance
Laser printers do not usually require much maintenance unless they are in a dusty area or 
are very old. When cleaning a laser printer, use only a vacuum cleaner with High Efficiency 
Particulate Air (HEPA) filtration. HEPA filtration catches microscopic particles within the 
filters.
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Most manufacturers sell maintenance kits for their printers. For laser printers, the kit might 
contain replacement parts that often break or wear out, such as the fuser assembly, transfer 
rollers, and pickup rollers.

Laser printers do not normally produce blank pages. Instead, they begin to print poor-quality 
prints. You can set the printer software to toner save or draft quality to reduce the amount of 
toner that the printer uses. These settings also reduce the quality of laser prints.

Thermal Printer Preventive Maintenance
To extend the life of a thermal printer, regularly clean the heating element with a cotton swab 
dampened with isopropyl alcohol. While the printer is open, use compressed air or a lint-free 
cloth to remove any debris.

Impact Printer Preventive Maintenance
An impact printer is similar to a typewriter because the print head strikes an inked ribbon 
to transfer ink to the paper. When the impact printer produces faded or light characters, the 
ribbon is worn out and needs to be replaced. If a consistent flaw is produced in all characters, 
the print head is stuck or broken and needs to be cleaned or even replaced.

3D Printer Preventive Maintenance
Preventive maintenance for 3D printers includes the following:

 ■ Replacing the filament

 ■ Cleaning the print bed

 ■ Replacing the hotend nozzle

Troubleshooting Printer Issues
As with all hardware and software, you should use a methodological process to troubleshoot 
printer issues.

Review the Troubleshooting Process Steps

In Table 8-5, list the six troubleshooting steps.

Table 8-5 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive measures.

Step 6 Document findings, actions, and outcomes.
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Problems and Solution
Printer problems can be attributed to hardware, software, networks, or some combination of 
the three. You will resolve some types of problems more often than others.

Check Your Understanding—Possible Solutions for Laptops and 

Other Mobile Devices

Check your understanding of problems and solutions for printers by choosing the BEST 
answer to the following questions.

 1. The print queue is functioning properly, but the printer does not print.

 a. Uninstall the current print driver and install the correct print driver.

 b. Manually resume the printer from standby, or power cycle the printer.

 c. Clean the printer.

 d. Replace the toner cartridge.

 2. The printer is printing unknown characters or does not print a test page.

 a. Secure printer cables.

 b. Clean the printer.

 c. Uninstall the current print driver and install the correct print driver.

 d. Remove the wrinkled paper from the print tray.

 3. The paper jams when printing.

 a. Replace paper with the manufacturer’s recommended paper type.

 b. Check the printer status and correct any errors.

 c. Change paper size in print settings.

 d. Replace the printer cartridge.

 4. A laser printer prints vertical lines or streaks on every page.

 a. Replace the fuser.

 b. Clean or replace the pickup rollers.

 c. Secure the printer cables.

 d. Remove and shake the toner cartridge.

Answer: 1 B, 2 C, 3 A, 4 D
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Labs and Activities

Command Reference
Chapter 8, “Printers,” does not include new commands.
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8.3.1.2 Lab–Install a Printer in Windows 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install a printer. You will find, download, and update the driver and the 
software for the printer.

Recommended Equipment
 ■ A computer running Windows

 ■ Internet connection

 ■ Printer

Step 1: Connect a printer.

Connect a printer to a computer directly or connect the printer to a local network. 
Plug the printer power cord into an AC outlet if necessary. Unlock the printer if it 
is locked. Refer to the instruction manual if you do not know how to unlock the 
printer. Printer heads are often locked to prevent damage during shipment.

Step 2: Install the printer driver.

A printer driver is a software program that enables the computer and the printer to 
communicate with each other. The driver also provides an interface for the user to 
configure printer options. Each printer model has a unique driver.

a. After you have powered on the printer, the operating system may discover the 
printer and install the driver if the printer is directly connected to the computer 
via a USB cable.

b. If the installation process does not start automatically, navigate to the Control 
Panel > Devices and Printers. Click Add a printer. 

Windows 7

 1. Choose Add a local printer or Add a network wireless or Bluetooth 
printer.

 2. If you selected Add a local printer, select a printer port that allows your 
printer to exchange information with the computer and choose your 
printer from the list. You could also use the CD or download the printer 
software from the printer manufacturer. Provide a name for the printer. 
You may choose to share the printer or set it as a default printer. Follow 
the on-screen information to complete the installation.

Book 1.indb   230Book 1.indb   230 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 8: Printers  231

 3. If you select Add a network, wireless or Bluetooth printer, choose your 
printer in the results. If it is not found, you can provide the necessary 
information to locate the printer. Follow the on-screen information to 
complete the installation.

 Windows 8.x and 10

 Select your printer in the results. If it is not found, click The printer that 
I want isn’t listed and provide the necessary information to locate the 
printer. Follow the on-screen information to complete the installation.

Step 3: Install and download an up-to-date printer driver.

To ensure that your computer has the most current driver, find the manufacturer and 
the model number of the printer.

Visit the manufacturer’s website and navigate to the product downloads or support 
page. Download the most recent driver and software for the model of printer 
device that you have installed. The software and driver must be compatible with 
your operating system. Make sure that you download the driver with a matching 
architecture for your computer (x64 or x32), if necessary.

a. Download the driver. The driver is often found in archive format.

b. Extract the driver to a temporary folder on your desktop, if necessary.

c. The installation wizard may start automatically after file extraction. If not, 
double-click the .exe file or .msi file.

d. Follow the installation wizard instructions until the software and driver have 
been installed.

e. Reboot your computer if necessary.

Step 4: Print a test page.

a. To verify printer functionality, navigate to Control Panel > Devices and 
Printers.

b. Right-click the printer and select Printer Properties.

c. Click Print Test Page in the General tab to print a test page.

Reflection
Why would you download and install software and drivers when Windows already installs 
them for you?

 

 

 

Answers vary. Manufacturers will have the most up-to-date drivers and software. These files 
may provide enhancements or features that the Windows drivers do not provide.
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8.4.1.3 Lab–Share a Printer in Windows 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will share a printer, configure the printer on a networked computer, and print a 
test page from the remote computer.

Recommended Equipment
 ■ Two computers directly connected or connected through a switch

 ■ Windows installed on both computers

 ■ A printer installed on one of the computers

Part: Share a Directly Connected Printer
Step 1: Configure the printer to share.

a. Log on to the computer that has the printer connected. Navigate to Control 
Panel > Folder Options. In the View tab, deselect Use Sharing Wizard 
(Recommended). Click OK to continue.

b. Navigate to Control Panel > Network and Sharing Center > Change advanced 
sharing settings on the left side of the window.

c. In the Change sharing options for different network profiles screen, expand 
the All Networks profile. Turn off password protected sharing for the All 
Networks profile. Select Turn off password protected sharing and click Save 
changes. 

d. Navigate to Control Panel > Devices and Printers.

e. Right-click the printer > Printer properties.

f. In the Sharing tab, select Share this printer. Name the printer, and click OK.

Step 2: Add a shared printer.

a. Log on to the computer with no printer connected.

b. Navigate to Control Panel > Devices and Printers.

c. In the Devices and Printers window, click Add a printer.

d. When all printers are discovered, select Printer on ComputerName in the 
Select a printer screen, where ComputerName is the name of the computer 
with the connected printer and Printer is the name of the printer. Click Next to 
continue. 
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Note: If the desired printer is not listed, click The printer that I want isn’t listed. In the 
Find a printer by other options screen, click Select a shared printer by name and type 
\\computername\printer. Click Next.

e. If prompted to install drivers, allow the driver installation.

f. When the You’ve successfully added a printer screen appears, click Next and 
then Finish to close the Add Printer window.

Step 3: Print a test page.

a. In the Devices and Printers window, right-click and select printer > Printer 
properties.

b. In the General tab, click Print Test Page to verify that the printer is working 
properly.
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8.5.2.3 Lab–Perform Preventive Maintenance 
on an Inkjet Printer (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will perform preventive maintenance on an inkjet printer.

Note: The lab instructions are for general reference only. Refer to the manufacturer’s printer manual for 
instructions to perform preventive maintenance on your inkjet printer model.

Recommended Resources
 ■ 1 inkjet printer

 ■ Printer manual or Internet access to view the printer manual

Step 1: Locate the printer manual.

The printer manual may be provided by your instructor, or you can navigate to the 
printer manufacturer’s website to download a copy of the printer manual for your 
printer model.

Step 2: Clean the print head.

You can print a pattern to check for clogged print heads.

a. Make sure there is paper in the paper tray.

b. Navigate to the maintenance menu either on the printer control panel or from 
the printer application on the computer.

c. Print a print head pattern.

d. Use the manufacturer’s guidelines to determine if the print head needs cleaning.

e. Clean the print head as necessary via the printer control panel or from the 
printer application on the computer.

Step 3: Replace the ink cartridge.

a. Check that power is on.

b. Open the cartridge access door. Wait for print cartridges to stop moving.

c. Lift up the cartridge tab and remove the cartridge from the slot.

d. Remove the new cartridge from the packaging and any protective tape from the 
ink cartridge head.

e. Place the new cartridge in the slot and carefully press the cartridge into place.

f. Repeat the above steps as necessary.

g. When all the cartridges have been replaced, close the cartridge access door.
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Step 4: Clear a paper jam.

a. Check the paper tray for any paper that was not fed into the paper path 
correctly.

b. Check the automatic document feeder for paper left from the previous job.

c. If the above step did not clear the paper jam, open the cartridge access door.

d. Look for any paper in the paper path and remove it according to the 
manufacturer’s instructions.

Reflection
Refer to the printer manual. What other preventive maintenance can be performed on the 
printer?

 

 

 

Answers will vary. Some of the examples are: cleaning the paper path, aligning the print head, 
and performing a printer software update.
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8.5.3.2 Lab–Perform Preventive Maintenance 
on a Laser Printer (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will perform preventive maintenance on a laser printer.

Note: The lab instructions are for general reference only. Refer to the manufacturer’s printer manual for 
instructions to perform preventive maintenance on your laser printer model.

Recommended Resources
 ■ 1 laser printer

 ■ Printer manual or Internet access to view the printer manual

Step 1: Locate the printer manual.

The printer manual may be provided by your instructor, or you can navigate to the 
printer manufacturer’s website to download a copy of the printer manual for your 
printer model.

Step 2: Replace the toner cartridge.

a. Check that power is off.

b. Open the cartridge access door.

c. Lift up the toner cartridge and remove it from the slot.

d. Remove the new cartridge from the packaging. 

e. You may need to shake the toner cartridge a few times to distribute the toner 
evenly inside the cartridge.

f. Remove any tabs, sealing tapes, or drumprotective covers as necessary.

g. Place the new cartridge in the slot and carefully press the cartridge into place.

h. When all the cartridges have been replaced, close the cartridge access door.

Step 3: Replace the fuser unit.

a. Turn off the printer and make sure it is cool before proceeding.

b. Open the access door to the fuser unit.

c. Grab the handle of the fuser unit and remove it from the printer. CAUTION: IT 
MAY BE HOT.

d. Remove the new fuser from its packaging and replace the fuser.

e. Close the access door.
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Step 4: Replace the rollers.

If after changing the paper it is not feeding properly, the paper path rollers may be 
dirty.

a. Turn off the printer.

b. Pull out the paper tray.

c. Locate the rollers.

d. Wipe the rollers with a clean dampened cloth or replace them.

e. Push in the paper tray.

Reflection
Refer to the printer manual. What other preventive maintenance can be performed for the 
printer?

 

 

 

Answers will vary. Some of the examples are: replace the photoconductor unit and replace the 
waste toner collector.
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CHAPTER 9

Virtualization and Cloud Computing

This chapter reviews cloud computing and virtualization, which enable individuals and organizations to 
store and access large amounts of data without worrying about the physical components.
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Study Guide

Virtualization
Virtualization separates the operating system (OS) from the hardware. The system resources 
of a computer are used to create virtual computers called virtual machines (VMs). A VM is a 
computer that exists within a computer. Virtualization is the foundation that supports cloud 
computing.

Traditional Servers and Virtualized Servers
Server deployment used to involve dedicated servers with large amounts of RAM, powerful 
processors, and multiple large storage devices. Today, servers are typically virtualized and 
deployed on-demand when needed.

Server Virtualization Advantages

Review the following advantages of server virtualization:

 ■ Better use of resources—Virtualization reduces the number of physical servers, 
networking devices, supporting infrastructure, and maintenance costs.

 ■ Less space required—Server consolidation with virtualization reduces the overall 
footprint of the data center. Fewer servers, network devices, and racks reduce the 
amount of required floor space.

 ■ Less energy consumed—Consolidating servers lowers the monthly power and cooling 
costs. Reduced consumption helps enterprises achieve a smaller carbon footprint.

 ■ Reduced cost—Less equipment is required, less energy is consumed, and less space is 
required.

 ■ Faster server provisioning—Creating a virtual server is far faster than provisioning a 
physical server.

 ■ Maximized server uptime—Most server virtualization platforms now offer advanced 
redundant fault-tolerance features, such as live migration, storage migration, high 
availability, and distributed resource scheduling. They also support the ability to move a 
virtual machine from one server to another.

 ■ Improved disaster recovery—Virtualization offers advanced solutions to keep business 
continuing during a disaster. VMs can be copied to other hardware platforms that may 
even be in a different data center.

 ■ Support for legacy systems—Virtualization can extend the life of OSs and applications, 
providing more time for organizations to migrate to newer solutions.
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Client-Side Virtualization
Client-side virtualization is beneficial for IT staff, IT support people, software developers, and 
testers. It’s also beneficial for educational reasons. It provides users with resources to test new 
operating systems or software or to run older software. It can also be used to sandbox and 
create a secure, isolated environment to open or run a suspicious file.

Identify the Type 1 and Type 2 Hypervisor Components

In Figure 9-1, label each hypervisor type using the following names. Some components are 
used more than once.

 ■ Hardware

 ■ Host

 ■ Hypervisor

 ■ Operating System

 ■ OS

 ■ Server

 ■ Type 1 Native

 ■ Type 2 Hosted

Figure 9-1 Type 1 and Type 2 Hypervisors

Figure 9-1a Type 1 and Type 2 Hypervisors

Type 2 HostedType 1 Native

OS

Hypervisor

Hardware

Server

Host

Hardware

Operating System

Hypervisor

OS OS OS OS OS
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Check Your Understanding—Virtualization

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definition

 a. This term is used when describing 
hypervisors used in client-side hosted 
virtualization.

 b. This is the operating system that is 
running on the VM.

 c. This term is typically used when 
describing hypervisors used in server 
virtualization.

 d. This is the operating system of the 
host computer.

 e. This is the physical computer 
controlled by a user.

 f. This is a computer that exists within a 
computer.

 g. This manages VMs and provides 
access host computer resources.

Term

 b. Guest OS

 e. Host computer

 d. Host OS

 g. Hypervisor

 c. Type 1 hypervisor

 a. Type 2 hypervisor

 f. VM

Cloud Computing
Cloud computing separates the applications from the hardware. It provides organizations 
with on-demand delivery of computing services over the network. Service providers own and 
manage the cloud infrastructure that includes the networking devices, servers, and storage 
devices and is usually housed in a data center.

Cloud Computing Applications
Cloud computing provides users with on-demand delivery of computing services over the 
Internet. Cloud computing services are owned and hosted by service providers.
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Check Your Understanding—Cloud Computing Applications

Match the description on the left with the cloud computing application on the right. This 
exercise is a one-to-one matching.

Description

 a. An organization can use this 
technology to deploy entire desktop 
environments from a server in a data 
center to clients. All computing 
is done on servers. Images can be 
persistent and saved for future use, 
or they can be nonpersistent, which 
reverts back to their initial state when 
a user logs out.

 b. Examples include Google Drive, 
OneDrive, iCloud Drive, Box, and 
Dropbox.

 c. This application provides a virtualized 
Windows 10 experience that is always 
up to date and available on any device.

 d. An example includes Microsoft 
Office 365, which provides online 
versions of Microsoft Word, Excel, 
and PowerPoint. The client pulls 
additional code from the cloud server 
as required.

 e. Examples include Office 365, Gmail, 
iCloud Mail, Outlook, Yahoo, and 
Exchange Online.

Cloud Computing Application

 b. Cloud file storage solutions

 e. Cloud-based email

 d.  Virtual application streaming/
cloud-based applications

 a.  Virtual desktop infrastructure 
(VDI)

 c. Windows Virtual Desktop (WVD)

Cloud Services
Cloud service providers can provide various services tailored to meet customer requirements. 
However, most cloud computing services can be categorized into three main types.
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Identify the Cloud Service

In Table 9-1, fill in the name of the described cloud service.

Table 9-1 Cloud Services

Cloud Service Description

Software as a Service (SaaS) Users access these cloud services using a browser. Advantages 
include minimal upfront costs for customers and immediate 
application availability. Examples include Salesforce customer 
relationship management (CRM) software, Microsoft Office 
365, MS SharePoint software, and Google G Suite.

Platform as a Service (PaaS) This type of cloud service provides access to operating 
systems, development tools, programming languages, and 
libraries used to develop, test, and deliver applications. The 
cloud provider manages the underlying network, servers, and 
cloud infrastructure. Examples include Amazon Web Service, 
Oracle Cloud, Google Cloud Platform, and Microsoft Azure.

Infrastructure as a Service 
(IaaS)

This type of cloud service manages the network and provides 
organizations access to network equipment, virtualized 
network services, storage, software, and supporting network 
infrastructure. Examples include Amazon Web Service, 
DigitalOcean, and Microsoft Azure.

Identify the Cloud Model

In Table 9-2, fill in the name for the described cloud model.

Table 9-2 Cloud Models

Cloud Model Description

Public cloud These cloud-based applications and services are made available to the 
general population. Services may be free or are offered on a pay-per-use 
model, such as paying for online storage.

Private cloud This cloud model is dedicated to an organization or entity. It can be 
created using the organization’s private network, or it can be managed by 
an outside organization with strict access security.

Community 
cloud

This cloud model is created for exclusive use by specific entities or 
organizations that have similar needs and concerns. It may require special 
authentication and confidentiality. 

Hybrid cloud This cloud model is made up of two or more different cloud models where 
each part remains a distinctive object, but both are connected using a 
single architecture. Individuals using this cloud model would be able to 
have degrees of access to various services based on user access rights. It 
could be used by an organization to provide services during short-term 
spikes.
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Identify the Cloud Characteristics

The cloud computing model is composed of five essential characteristics. In Table 9-3, fill in 
the name for the described cloud characteristic.

Table 9-3 Cloud Characteristics

Cloud Characteristic Description

On-demand Individuals can provision or make changes to computing services 
as needed without requiring human interaction with the service 
provider.

Rapid elasticity Services can be provisioned when needed and then released 
quickly when no longer required. In some cases, the demand can 
be met and scale automatically based on the user demand.

Resource pooling The provider uses a multitenant model to serve multiple 
consumers with shared storage, processing, memory, and network 
bandwidth.

Measured and metered 
service

Cloud systems provide service performance statistics that can 
be used to automatically control and optimize resources. This 
is done by using a mechanism to set thresholds to ensure that 
a customer is always provided with satisfactory service levels. 
These services also provide reports for both the provider and 
the service consumer.

Broad network access Capabilities are available over the network and can be accessed 
using smartphones, tablets, laptops, and workstations.
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Labs and Activities

Command Reference
Chapter 9, “Virtualization and Cloud Computing,” does not include new commands.
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9.1.2.5 Lab–Install Linux in a Virtual Machine 
and Explore the GUI (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
Part 1: Prepare a Computer for Virtualization

Part 2: Install a Linux OS on the Virtual Machine

Part 3: Explore the GUI

Background/Scenario
Computing power and resources have increased tremendously over the past 10 years. A benefit 
of multi-core processors and large amounts of RAM is the ability to install multiple operating 
systems through the use of virtualization on a computer. 

With virtualization, one or more virtual computers can operate inside one physical computer. 
Virtual computers that run within physical computers are called virtual machines. Virtual 
machines are often called guests, and physical computers are often called hosts. Anyone with a 
modern computer and operating system can run virtual machines.

In this lab, you will install a Linux OS in a virtual machine using a desktop virtualization 
application, such as VirtualBox. After completing the installation, you will explore the GUI 
interface. Later in this course, you will also explore the command line interface using this vir-
tual machine in a lab.

Required Resources
 ■ Computer with a minimum of 2 GB of RAM and 10 GB of free disk space

 ■ High-speed Internet access to download Oracle VirtualBox and Linux OS image, such as 
Ubuntu Desktop
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Part 1: Prepare a Computer for Virtualization
In Part 1, you will download and install desktop virtualization software and a Linux OS image. 
Your instructor may provide you with a Linux OS image.

Step 1: Download and install VirtualBox.

VMware Player and Oracle VirtualBox are two virtualization programs that you 
can download and install to support the OS image file. In this lab, you will use the 
VirtualBox application. 

a. Navigate to https://www.virtualbox.org/. Click the download link on this page.

b. Choose and download the appropriate installation file based on your operating 
system. 

c. After the VirtualBox installation file is downloaded, run the installer and accept 
the default installation settings.

Step 2: Download a Linux Image.

a. Navigate to the Ubuntu website at http://www.ubuntu.com. Click the 
Download link on this page to download and save an Ubuntu Desktop image.

Step 3: Create a New Virtual Machine.

a. Click Start and search for Virtualbox. Click Oracle VM VirtualBox to open the 
manager. When the manager opens, click New to start the Ubuntu installation.

b. In the Name and operating system screen, type Ubuntu in the Name field. 
For the Type field, select Linux. In the Version field, select the corresponding 
downloaded version. Click Next to continue.

c. In the Memory size screen, increase the amount of RAM as long as the 
amount of RAM for the virtual machine is in the green area. Going beyond the 
green area would adversely affect the performance of the host. Click Next to 
continue.

d. In the Hard disk screen, click Create to create a virtual hard disk now.

e. In the Hard disk file type screen, use the default file type settings of VDI 
(VirtualBox Disk Image). Click Next to continue.

f. In the Storage on physical hard disk screen, use the default storage settings of 
dynamically allocated. Click Next to continue.

g. In the File location and size screen, you can adjust the hard drive and change 
the name and location of the virtual hard drive. Click Create to use the default 
settings.

h. When the hard drive creation is done, the new virtual machine is listed in the 
Oracle VM VirtualBox Manager window. Select Ubuntu and click Start in the 
top menu.
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Part 2: Install Ubuntu on the Virtual Machine
Step 1: Mount the Image.

a. In the Oracle VM Virtualbox Manager window, right-click Ubuntu and select 
Settings. In the Ubuntu – Settings window, click Storage in the left pane. Click 
Empty in the middle pane. In the right pane, click the CD symbol and select the 
file location of the Ubuntu image. Click OK to continue.

b. In the Oracle VM VirtualBox Manager window, click Start in the top menu.

Step 2: Install the OS.

a. In the Welcome screen, you are prompted to try or install Ubuntu. The try 
option does not install the OS; it runs the OS straight from the image. In this 
lab, you will install the Ubuntu OS in this virtual machine. Click Install Ubuntu.

b. Follow the on-screen instructions and provide the necessary information when 
prompted.

Note: If you are not connected to the Internet, you can continue to install and enable the 
network later.

c. Because this Ubuntu installation is in a virtual machine, it is safe to erase the 
disk and install Ubuntu without affecting the host computer. Select Erase 
disk and install Ubuntu. Otherwise, installing Ubuntu on a physical computer 
would erase all data on the disk and replace the existing operating system with 
Ubuntu. Click Install Now to start the installation.

d. Click Continue to erase the disk and install Ubuntu.

e. In the Who are you? screen, provide your name and choose a password. 
Use iteuser for Your Name and ITEpass! for the password. You can use the 
username generated or enter a different username. If desired, you can change 
the other settings. Click Continue.
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f. The Ubuntu OS is now installing in the virtual machine. This will take several 
minutes. When the Installation is complete message displays, return to the 
Oracle VM Virtualbox Manager window. Right-click Ubuntu and select 
Settings. In the Ubuntu – Settings window, click Storage in the left pane. Click 
the mounted Ubuntu image in the middle pane. In the right pane, click the CD 
symbol and click Remove Disk from Virtual Drive. Click OK to continue.

g. In the Ubuntu VM, click Restart Now.

Part 3: Explore the GUI
In this part, you will install the VirtualBox guest additions and explore the Ubuntu GUI.

Step 1: Install Guest Additions.

a. Log on to your Ubuntu virtual machine using the user credentials created in the 
previous part.

b. Your Ubuntu Desktop window may be smaller than expected. This is especially 
true on high-resolution displays. Click Device > Insert Guest Additions CD 
image… to install the Guest Additions. This allows more functions, such as 
changing the screen resolution in the virtual machine.

c. Click Run to install the additions. When prompted for a password, use the same 
password that you used to log on. Click Authenticate to continue.

d. If the computer was not connected to the Internet during the installation, click 
Devices > Network Settings in the Oracle VirtualBox menu. Enable network 
adapters and configure the proper setting for network connections as necessary. 
Click OK.

e. When the installation of the additions is done, restart the virtual machine again. 
Click the menu in the upper-right corner and click Shut down. Click Restart to 
restart Ubuntu.
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Step 2: Open a web browser.

a. Log on to Ubuntu again. After you are logged on again, you can resize the 
virtual machine window.

b. Open a web browser. Depending on the Linux distribution, you may need to 
search for a web browser, or there is a link to a web browser already on the 
desktop.

c. Locate a terminal emulator to access the command line interface. You will be 
using a terminal emulator in later labs.

d. Explore the installed Linux distribution and locate a few applications that you 
may use.

Reflection
What are the advantages and disadvantages of using a virtual machine?

 

 

With a virtual machine, you are able to test new applications or operating systems without 
affecting your host machine. You are also able to save the current machine state when you 
close the virtual machine. If you have any issues, you have the option to revert the virtual 
machine to a previously saved state. On the other hand, a virtual machine requires hardware 
resources from the host machine, such as hard drive space, RAM, and processing power.
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CHAPTER 10

Windows Installation

The operating system (OS) controls almost all functions on a computer. In this chapter, you review the 
components, functions, and terminology related to the Windows 10, Windows 8.x, and Windows 7 
operating systems.
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Study Guide

Modern Operating Systems
From digital watches to servers, almost all computers require an OS before they can be used.

Operating System Features
One of the main tasks of an OS is to act as an interface between the user and the hardware 
connected to the computer. The OS also controls other functions:

 ■ Software resources

 ■ Memory allocation and all peripheral devices

 ■ Common services to computer application software

The OS boots the computer and manages the file system. Operating systems can support more 
than one user, task, or CPU.

Check Your Understanding—Operating System and Windows Terminology

Match the description on the left with the term on the right next page. This exercise is a 
one-to-one matching.

Description

 a. In Windows, these data files are 
grouped in a directory and organized 
for easy retrieval and use.

 b. This set of guidelines ensures a new 
application is compatible with an OS 
and allows programs to access the 
resources managed by the OS in a 
consistent and reliable manner.

 c. The user types commands at a 
prompt.

 d. This is a cross-platform standard 
specification for multimedia graphics.

 e. This is used by the OS to access and 
communicate with each hardware 
component.

 f. This program can be broken into 
smaller parts that are loaded as needed 
by the operating system. It allows 
different parts of a program to be run 
at the same time.

 g. This OS introduced the Metro user 
interface that unifies the Windows 
look and feel on desktops, laptops, 
mobiles phones, and tablets.

 h. This collection of APIs is related to 
the development of Java programming.

 i. This update was designed for personal 
computers, tablets, embedded devices, 
and Internet of Things devices. This 
version integrated the Cortana virtual 
assistant and the new Microsoft Edge 
Web browser.

 j. This block of related data is given a 
single name and treated as a single 
unit.

 k. The computer is capable of operating 
multiple applications at the same time.

 l. The operating system can support two 
or more CPUs.

 m. This collection of APIs is related 
to multimedia tasks for Microsoft 
Windows.

 n. This OS is an upgrade from Windows 
XP or Vista.

 o. This allows applications from older 
versions of Windows to operate on 
newer versions.

 p. This allows the user to interact with 
menus and icons.

 q. This term refers to two or more users 
who have individual accounts that 
allow them to work with programs and 
peripheral devices at the same time.
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Term

 b. Application programming interface (API)

 c. Command-line interface (CLI)

 e. Device driver

 m. DirectX

 j. File

 a. Folder

 p. Graphical user interface (GUI)

 h. Java APIs

 l. Multiprocessing

 k. Multitasking

 f. Multithreading

 q. Multi-user

 d. Open Graphics Library (OpenGL)

 i. Windows 10

 n. Windows 7

 g. Windows 8

 o. Windows API

Customer Requirements for an Operating System
Understanding how a computer will be used is important when recommending an OS to a 
customer. The OS must be compatible with the existing hardware and the required applications.

Review Windows Minimum System Requirements

Operating systems have minimum hardware requirements that must be met for the OS to install 
and function correctly. In Table 10-1, notice that the minimum system requirements for all 
recent versions of Windows are the same except for the minimum resolution.

Table 10-1 Windows Minimum System Requirements

Component Windows 10 Windows 8 and 8.1 Windows 7

Processor 1 GHz or faster 1 GHz or faster 1 GHz or faster
RAM 1 GB for 32-bit or 

2 GB for 64-bit
1 GB for 32-bit or 
2 GB for 64-bit

1 GB for 32-bit or 
2 GB for 64-bit

Hard drive space 16 GB for 32-bit or 
20 GB for 64-bit

16 GB for 32-bit or 
20 GB for 64-bit

16 GB for 32-bit or 
20 GB for 64-bit

Graphics card DirectX 9 or later with 
WDDM 1.0 driver

DirectX 9 or later with 
WDDM 1.0 driver

DirectX 9 or later with 
WDDM 1.0 driver

Display 800 × 600 1024 × 768 Not specified
Internet connection Necessary to 

perform updates and 
some features

Necessary to perform 
updates and some 
features

Necessary to perform 
updates and some 
features
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Identify the Windows 10 Edition

In Table 10-2, fill in the described Windows edition.

Table 10-2 Windows Edition

Windows Edition Description

Windows 10 Pro A desktop edition for PCs, tablets, and 2-in-1s for small 
businesses that need built-in security, productivity, and 
management features to meet the diverse needs of those 
businesses.

Windows 10 Enterprise An edition for large- to mid-sized organizations with advanced 
security and management needs. It also provides advanced 
capabilities to help protect against the ever-growing range 
of modern security threats targeted at devices, identities, 
applications, and sensitive company information.

Windows 10 Education An edition designed to meet the needs of schools—staff, 
administrators, teachers, and students. This edition is available 
through academic volume licensing.

Windows 10 Home The consumer-focused desktop edition that offers a familiar 
and personal experience for PCs, tablets, and 2-in-1s. 
It includes consumer features such as Xbox One, Cortana, 
and Windows Hello.

Operating System Upgrades
An OS must be upgraded periodically to remain compatible with the latest hardware and 
software. It is also necessary to upgrade an OS when a manufacturer stops supporting it.

Before upgrading the operating system, check the minimum hardware requirements of the new 
OS to ensure that it can be installed successfully on the computer.

The version of an OS determines available upgrade options. For example, a 32-bit OS cannot be 
upgraded to a 64-bit OS. Also, Windows 7 and Windows 8 can be upgraded to Windows 10, 
but Windows Vista and Windows XP cannot.

To upgrade Windows 7 or Windows 8 to Windows 10, use the Windows 10 Update Assistant 
available on Microsoft’s website. The Windows 10 Update Assistant installs and runs directly 
on the computer being upgraded. The tool will walk the user through all the steps in the 
Windows 10 setup process. It is designed to prepare the computer for upgrading by checking 
for compatibility issues and downloading all necessary files to start the install.

Computers running Windows XP or Windows Vista do not have an upgrade path to 
Windows 10 and require a clean installation.
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Check Your Understanding—Windows Upgrades

Match the description on the left with the Windows upgrade utility on the right. This exercise 
is a one-to-one matching.

Description

 a. This command-line utility is designed 
to capture user accounts, files, 
operating system settings, and 
application settings and migrate them 
to a new Windows installation. It is 
ideal for streamlining and simplifying 
large deployments of Windows 
operating systems.

 b. This utility is automatically 
downloaded and installed on 
Windows 7 Service Pack 1. It 
scans the system for hardware and 
software incompatibility issues before 
upgrading to the Windows 10 OS.

 c. This tool is used for transferring 
selected files, folders, profiles, and 
applications from an old Windows PC 
to a Windows 10 PC.

 d. This is used when upgrading from 
Windows 7 and 8 to Windows 8.1. 
It can migrate user’s personal files and 
settings.

 e. This utility installs directly on a 
Windows computer and walks the 
user through the Windows 10 setup 
process. It prepares the computer 
for upgrading by checking for 
compatibility issues and downloading 
all necessary files to start the install.

Windows Upgrade Utility

 b. Get Windows 10 App

 c. PCmover Express

 e. Upgrade Assistant

 a. User State Migration Tool

 d. Windows Easy Transfer

Install Windows
The installation and initial booting of the OS are called the operating system setup. Although 
it is possible to install an OS over a network from a server or from a local hard drive, the most 
common installation method for a home or small business is through external media such as 
DVDs or USB drives.

Disk Management
Before the operating system can be installed, a storage media device must be chosen and 
prepared. Several types of storage devices are available and can be used to receive the new 
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operating system. The two most common types of data storage devices used today are hard 
disk drives and flash memory-based drives such as solid-state hard drives and USB drives.

Review Partition Standards

Two of the most popular partition scheme standards are master boot record (MBR) and 
globally unique identifier (GUID) partition table (GPT). MBR is the older partition standard 
typically used in computers with BIOS-based firmware. GPT is the newer partition standard 
commonly used in computers with UEFI firmware. The features of MBR and GPT are 
compared in Table 10-3.

Table 10-3 MBR and GTP Comparison

MBR GPT

Maximum of 4 primary partitions Maximum of 128 partitions in Windows

Maximum partition size of 2 TB Maximum partition size of 9.4 ZB 
(9.4 × 1021 bytes) 

No partition table backup Stores a partition table backup

Partition and boot data stored in one 
place

Partition and boot data stored in multiple 
locations across the disk

Any computer can boot from MBR Computer must be UEFI-based and run a 
64-bit OS

Review File Systems

Different file systems also differ in properties of speed, flexibility, security, size, and more. The 
five common file systems are as follows:

 ■ File Allocation Table, 32-bit (FAT32)

 ■ New Technology File System (NTFS)

 ■ exFAT (FAT 64)

 ■ Compact Disc File System (CDFS)

 ■ NFS (Network File System)

Check Your Understanding—Disk Terminology

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.
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Description

 a. There can be only one per hard drive, 
but it can be subdivided into smaller 
sections.

 b. This file system was created 
specifically for optical disk media.

 c. This process prepares a file system in a 
partition for files to be stored.

 d. This data storage medium can be 
electrically erased and rewritten.

 e. This is used to boot the computer and 
contains the boot and system files. 
There can be only one of these per disk.

 f. This was created to address some 
of the limitations when formatting 
USB flash drives, such as file size and 
directory size. One of the primary 
advantages is that it can support files 
larger than 4 GB.

 g. This is a section of an extended 
partition.

 h. This network-based file system allows 
file access over the network.

 i. This has the ability to create volumes 
that span across more than one 
disk. The size of the volumes can be 
changed after they have been created.

 j. Used by Windows XP and earlier OS 
versions, this file system supports 
partition sizes up to 2 TB or 2,048 GB.

 k. This uses the technology from both a 
hard drive and a solid-state drive.

 l. This file system is used by Windows 
8.1, Windows 7, and Windows 10 to 
automatically create a partition using 
the entire hard drive unless the user 
creates a custom partition.

 m. This contains the operating system 
files. There can be up to four per hard 
drive, and they cannot be subdivided 
into smaller sections.

 n. This uses high-performance flash 
memory to achieve fast data storage 
without moving parts.

 o. This contains primary and extended 
partitions, as well as logical drives. It 
is limited to four partitions.

Term

 b. Get Windows 10 App

 e. Active Partition

 o. Basic Disk

 b. CDFS

 i. Dynamic Disk

 f. exFAT

 a. Extended Partition

 j. FAT32

 d. Flash Memory

 c. Formatting

 g. Logical Drive

 h. NFS

 l. NTFS

 m. Primary Partition

 n. SSD

 k. SSHD
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Installation and Boot Sequence
This section reviews basic Windows installation, custom installation options, and the Windows 
boot sequence.

Basic Windows Installation
Basic Windows installation is mostly driven by the Window Setup application that will walk 
you through the installation. Be sure to review the following two labs:

 ■ Lab–Windows Installation

 ■ Lab–Finalize the Windows Installation

Review Account Types

In previous versions of Windows, there was a Guest account, but that has been removed with 
Windows 10. Windows 10 offers the following two account types:

 ■ Administrator—Administrator accounts have complete control over a computer. Users 
with this type of account can change settings globally, install programs, and get access 
to administrator rights through the User Account Control (UAC) when elevation to 
perform a task is required.

 ■ Standard User—Standard user accounts have limited control over a computer. Users 
with this type of account can run applications, but they cannot install programs. A 
standard user account can change system settings, but only settings that do not affect 
other user accounts.

Custom Installation Options
Beyond a basic Windows install, you can use a variety of options and tools to customize the 
installation or expedite installation on multiple PCs, including the following:

 ■ Disk cloning

 ■ Microsoft System Preparation (Sysprep)

 ■ Preboot Execution Environment (PXE)

 ■ Remote Installation Services (RIS)

 ■ Unattended installation

 ■ System Image Manager (SIM)

 ■ Windows Advanced Setup Options

Check Your Understanding—Custom Installation

Match the description on the left with the custom installation tool on the right. This exercise is 
a one-to-one matching.
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Description

 a. A file that contains all the data from a 
partition.

 b. A program used to prepare the OS 
with different hardware configurations 
to install and configure the same OS 
on multiple computers.

 c. A tool used to create a setup answer 
file that customizes a standard 
Windows 10 installation during an 
unattended install.

 d. A special environment used to boot 
the computer, connect to the network, 
and communicate with the server to 
begin OS installation.

 e. A software package used to 
communicate with a client and 
provide the necessary instructions for 
the client to download OS setup files 
and begin installation.

 f. A tool that contains an image that can 
be used to restore the computer to its 
original configuration.

 g. A set of tools that allow users to 
troubleshoot, recover, or restore an 
operating system when it cannot boot.

 h. A tool that restores the computer’s 
system software back to its factory 
state without deleting user files or 
removing modern apps.

Custom Installation Tool

 g. Advanced Startup Options

 a. Image

 d. PXE

 f. Recovery Partition

 h. Refresh your PC

 e. RIS

 c. SIM

 b. Sysprep

Windows Boot Sequence
After POST, the BIOS locates and reads the configuration settings that are stored in the CMOS 
memory. The boot device priority is checked to locate the bootable partition. The BIOS boots 
the computer using the first drive that contains a valid boot sector. This sector contains the 
MBR. The MBR identifies the Volume Boot Record (VBR), which loads the Windows boot 
manager, bootmgr.exe.

Review Windows 7 Startup Options

In Windows 7, startup options include the following:

 ■ Safe Mode—A diagnostic mode used to troubleshoot Windows and Windows startup 
issues.

 ■ Safe Mode with Networking—Starts Windows in Safe Mode with networking support.
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 ■ Safe Mode with Command Prompt—Starts Windows and loads the command prompt 
instead of the GUI.

 ■ Last Known Good Configuration—Loads the configuration settings that were used the 
last time that Windows started successfully.

Review Windows 8 and 10 Startup Options

In Windows 8 and 10, use number or function keys F1 through F9 that correspond with the 
desired startup option:

 1. Enable debugging

 2. Enable boot logging

 3. Enable low-resolution video

 4. Enable Safe Mode

 5. Enable Safe Mode with Networking

 6. Enable Safe Mode with Command Prompt

 7. Disable driver signature enforcement

 8. Disable early launch anti-malware protection

 9. Disable automatic restart after failure

Press F10 for more options.

Check Your Understanding—Windows Boot Sequence

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. This diagnostic mode is used to 
troubleshoot Windows and Windows 
startup issues.

 b. This tool opens the Windows 
Advanced Boot Options menu in 
Windows 7.

 c. This tool identifies the VBR, which 
loads the boot manager.

 d. This tool loads the configuration 
settings that were used the last time 
that Windows started successfully.

 e. This locates and reads the 
configuration settings that are stored 
in the CMOS memory.

 f. You can use this menu to select the 
device to boot.

Custom Installation Tool

 e. BIOS

 f. Boot device priority

 b. F8

 d. Last Known Good Configuration

 c. MBR

 a. Safe Mode
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Labs and Activities

Command Reference
In Table 10-4, record the command that fits the description. Include the full path, if necessary, 
to execute the command.

Table 10-4 Commands for Chapter 10, “Windows Installation”

Command Description

C:\Windows\System32\
Sysprep>sysprep.exe

Use this path and command to run 
Microsoft’s System Preparation tool, which 
will allow you to remove undesirable settings 
included in a base installation.

I:\fs:NTFS Use this command to convert the I: drive 
from FAT32 to NTFS without losing data.
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10.2.1.8 Lab–Create a Partition in Windows 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will create a FAT32 formatted partition on a disk. You will convert the partition 
to NTFS. You will then identify the differences between the FAT32 format and the NTFS format.

Recommended Equipment
 ■ Computer running Windows

 ■ Un-partitioned space of at least 1 GB on the hard disk drive

Step 1: Open Disk Management.

Disk Management is located inside the Computer Management utility. Disk 
Management is a utility to manage disk drives installed in the computer, such as 
internal and external hard drives and flash drives.

a. Click Start and navigate to the Control Panel. Select Administrative Tools 
and click Computer Management. You can also right-click Start and select 
Computer Management in Windows 10 and 8.1.

b. In the Computer Management window, click Disk Management in the left 
pane under the Storage menu. You should see the disk drives installed on the 
computer.

Step 2: Create free space as necessary.

If the hard drive does not already have at least 2 GB of unpartitioned space, then 
perform the following steps to create free space, which can be partitioned. In this 
lab, the default C: drive is used as the example.

a. Right-click the C: drive NTFS volume and select Shrink Volume from the menu.

b. In the Shrink C: window enter an amount of 2048 in the Enter the amount of 
space to shrink in MB: box and then click Shrink. You should now see 2 GB of 
Unallocated disk space.

Step 3: Create a new disk volume in the free space.

a. Right-click the block of Free Space or Unallocated space. Click New Simple 
Volume.

b. The New Simple Volume Wizard window opens. Click Next.

c. Type 2048 or all the maximum disk space in the Simple volume size in MB 
field, and click Next.

d. Click the Assign the following drive letter: radio button. Select I from the 
drop-down menu. Click Next to continue.

Note: You may need to substitute different drive letters for the letters shown in this lab.
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e. Click the Format this volume with the following settings: radio button. Select 
FAT32 from the File system drop-down menu and click Next.

f. Click Finish to complete the New Simple Volume Wizard.

g. The Computer Management window will display the status of the NEW 
VOLUME. Close the Computer Management window.

Step 4: Open the This PC window to review information about the new disk partition.

a. Open File Explorer in Windows 10 and 8.1 and click This PC to view the list of 
the devices and drives.

In Windows 7, open Windows Explorer and click Computer to view the list of 
the drives.

b. Right-click on the NEW VOLUME (I:) drive and then select Properties from 
the drop-down menu.

What type of file system is used on the NEW VOLUME (I:)?

 ________________________________________________________________________

The file system is FAT32.

How much free space is shown?

 ________________________________________________________________________

Answers may vary. The drive has about 2 GB free space.

List the tabs found in the NEW VOLUME (I): Properties window.

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary depending on the Windows version. The tabs are General, Tools, 
Hardware, Sharing, Previous Versions, Customize, and ReadyBoost.

c. On the General tab, rename the volume from NEW VOLUME to ITE, and then 
click OK. Click Continue to provide administrator permission.

Step 5: Create a text document and save it to the ITE drive.

a. Double-click on the ITE (I:) disk icon to view the contents of the drive. You 
should see a message in the middle of the screen stating that this folder is 
empty. Right-click anywhere in the white space below that message to bring up 
a drop-down menu. Click New > Text Document.

b. Rename the New Text Document to ITE Test Document and press Enter.

c. Right-click on the ITE Test Document and choose Properties. This opens the 
ITE Test Document Properties window.

What tabs are listed in the ITE Test Document Properties window? 

 ________________________________________________________________________

Answers may vary depend on the Windows version. The tabs are General, Details, 
and Previous Versions.
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d. Click OK to close the ITE Test Document Properties window. Close the 
ITE (I:) window.

Step 6: Convert the ITE volume from FAT32 to NTFS without losing data.

In this step, you will convert the ITE volume from FAT32 to NTFS using the 
command line. The file system conversion can be done using the Disk Management 
tool. Unfortunately, the conversion requires reformatting of the drive and losing all 
the data. By using the command line, the file system can be changed from FAT32 to 
NTFS without losing data.

Note: In a production environment, the data should always be backed up before attempting 
to change the file system to prevent data loss.

a. Click Start, and then type cmd. (The search field will pop up as soon as you 
start typing.) Right-click the Command Prompt program that appears, and then 
click Run as administrator.

b. The User Account Control window opens asking if you want to allow the 
following program to make changes to this computer. Click Yes.

c. In the Administrator: Command Prompt window, type convert I: /fs:NTFS at 
the prompt.

What happens if you do not run as administrator when you open the command 
prompt?

 ________________________________________________________________________

Access will be denied because you do not have sufficient privileges to run the 
command.

d. You will be prompted to enter the current volume label for drive I:. Type ITE 
and press Enter.

e. Review the information displayed by the convert command. When finished, 
enter exit at the prompt to exit the command prompt window.

Step 7: Open the This PC window to work with the ITE Volume.

a. Open File Explorer in Windows 10 and 8.1 and click This PC.

In Windows 7, open Windows Explorer and click Computer.
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b. Right-click the ITE (I:) volume, and select Properties from the drop-down 
menu.

What type of file system is used for the ITE (I:) drive?

 ________________________________________________________________________

NTFS

What are the tabs in the ITE (I:) Properties window?

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary depending on the Windows version. The tabs are General, Tools, 
Hardware, Sharing, Security, Previous Versions, Quota, Customize, and ReadyBoost.

When the volume was FAT32, there were six tabs. What are the names of the new 
tabs that were added after the volume was converted to NTFS?

 ________________________________________________________________________

Security and Quota

c. Click Cancel to close the ITE (I:) Properties window.

Step 8: Display the properties of the ITE Test Document.

a. Open the ITE (I:) drive. Right-click on the ITE Test Document, and then select 
Properties from the drop-down menu.

What are the tabs in the ITE Test Document Properties window?

 ________________________________________________________________________

General, Security, Details, Previous Versions

When the volume was FAT32, there were three tabs. What is the name of the new 
tab that was added after the volume was converted to NTFS?

 ________________________________________________________________________

Security

b. Close all open windows.

Reflection
Why is there an additional Security tab in the Properties window of documents stored on an 
NTFS volume?

 

 

 

 

Answers will vary. NTFS incorporates additional security features and extended attributes. 
The Scurity tab provides a way to display and change permissions of the documents.
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10.3.1.1 Lab–Windows Installation 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will install Windows 10.

Background/Scenario
You may have already installed Windows 10 earlier in the course.

Required Resources
 ■ A computer with a blank hard disk drive

 ■ Windows 10

Instructor Note: Complete an installation before class to ensure that the process goes 
smoothly. If installing from a USB flash drive, copy the Windows install files from an ISO disc 
image to the USB flash drive. Check each student computer to make sure that the BIOS boot 
sequence is set to boot from the DVD or USB first. To set the BIOS boot sequence, enter the 
BIOS using the appropriate key or key combination for your computer while POST is running. 
Use the manufacturer’s documentation to determine how to enter the BIOS. Find the screen 
that displays the boot sequence. If the DVD or USB drive is not listed as the first boot device, 
add it to the list as the first device or move it to the top of the list. Press F10 to save and exit 
the BIOS.

Step 1: Starting the Installation Media

a. Insert the Windows 10 installation DVD into the DVD-ROM drive or plug the 
USB flash drive into a USB port.

b. When the computer starts up, watch for the message Press any key to boot 
from CD or DVD.

If the message appears, press any key on the keyboard to boot the computer 
from the DVD. If the press any key message does not appear, the computer 
should automatically start loading files from the DVD.

Instructor Note: The computer may boot the DVD without this message.

c. The computer starts loading files from the DVD or USB flash drive.

Step 2: Configuring Initial Settings

a. The Windows Setup window opens. Click Next to continue unless you need to 
change the default settings.

b. Click Install now to continue the installation.
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Step 3: Collecting Information

a. In the Enter the product key to activate Windows window, enter the product 
key.

Note: You can find the product key on the case or sleeve in which the Windows DVD was 
packaged, or you can get it from your instructor.

b. The License terms window opens. Read and confirm that you accept the license 
by selecting the box I accept the license terms. Click Next.

c. The Which type of installation do you want? window opens. Click Custom: 
Install Windows only (advanced).

d. The Where do you want to install Windows? window opens. Select the hard 
drive or partition on which Windows will be installed. In this example, click to 
select Disk 0 Unallocated Space. Click Next to continue. Setup has finished 
collecting information for the installation.

Step 4: Installing Windows

a. The Installing Windows window opens. Windows will take some time to copy 
the files and install the OS on your computer. During the setup, the computer 
might restart several times.

b. When the Windows needs to restart to continue window opens, your 
computer will automatically restart, or you can click Restart now.

c. If you get the message Press any key to boot from CD or DVD…, do not 
press any key, and Windows will boot from the internal drive to continue the 
installation.

Step 5: Basics Setup

In this step, you will select your region and your keyboard layer.

Note: The personalization sub-steps may be different depending on your Windows version.

a. Verify the region and select yes. If not, choose your region and select yes.

b. Verify the keyboard layout and select yes. If not, choose your keyboard layout 
and select yes.

c. Click Skip if you are not adding a second keyboard layout. Otherwise, click 
Add layout and answer the prompts to add a second layout.

Step 6: Network Setup

In this step, the installation may continue without your input. If prompted, provide 
the installation with the necessary information.

Select Set up for personal use. Click Next to continue. Your instructor may ask you 
to choose to select Set up for an organization.

Instructor Note: If you do not wish students to use a Microsoft account (due to 
a lack of Internet connection, privacy concerns, etc.), be sure to instruct them to 
create an offline account in the next step.
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Step 7: Account Setup

In this step, you will set up a local account to access the computer. You will not be 
creating a Microsoft account for this exercise. If you already have an account or 
choose to do so, you may use your Microsoft account for this step.

Note: The account setup sub-steps may be different depending on your Windows version.

a. Click Offline account to create a local account. If you already have a Microsoft 
account and choose to use it, enter the required information and click Next to 
continue.

b. Click No to continue using a local account, instead of a Microsoft account.

c. Enter a username and click Next to continue.

d. Create a password and confirm the password when prompted. Click Next to 
continue.

e. Answer all the security questions and click Next to continue.

Step 8: Services Setup

Instructor Note: If you do not wish students to use Cortana (due to a lack of 
Internet connection, privacy concerns, etc.), be sure to instruct them to click No in 
this step.

In this step, you can give permission to use Cortana and select your privacy settings.

a. You can choose to use Cortana as your personal assistant. Click Yes or No to 
continue.

b. Read the privacy settings and click Learn More to find out more details. Then 
decide which features to use and click Accept to continue.

Step 9: Finishing the Installation

a. When you are finished with the installation, Windows continues to finalize 
your settings.

b. After the installation is completed, the desktop displays and you are logged into 
Windows for the first time.
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10.3.1.4 Lab–Finalize Windows Installation 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will add user accounts and finalize an installation of Windows 10.

Background/Scenario
After the initial installation of the Windows operating system, the installation needs to be 
finalized by creating any required additional user accounts, verifying that all hardware is 
installed correctly, and installing service packs, patches, and updates.

Required Resources
 ■ A computer with Windows 10 installed.

Part 1: User Account Creation
Step 1: Create new accounts in Windows 10.

a. In the Windows search box, type settings to open the Windows Settings 
utility and click Accounts.

b. In the Accounts utility, click Family & other Users in the left side pane and 
then click Add someone else to this PC. 

c. When prompted for How will this person sign in, you can choose an email or 
phone number that they already use for other Microsoft products or choose 
I don’t have this person’s sign-in information. In this lab, we will choose the 
second option of not having sign-in information.

d. The next screen asks for a phone number or email address to create a Microsoft 
account for the user. Choose Add a user without a Microsoft account.

e. In the Create an account for this PC window, you will add a username and 
password for the account. There are also three required security questions to fill 
in. When all information is complete, click Next. 

f. You are returned to the Other Users window and should now see the new Local 
account. You can now click the new account to see an option to change the 
account type or remove the account. If you click Change account type, you 
will have the option to change the account to an Administrator account.
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Step 2: Create new local user accounts in Windows 7 and 8.

Windows 7: Start > click Control Panel > click view by Small icons in the Control 
Panel > click User Accounts > click Manage another account > click Create a new 
account > enter the username and account type > click Create Account.

Windows 8.x: Start > click Control Panel > click view by Small icons in the 
Control Panel > click User Accounts > click Manage another account > click 
Add a new user in PC settings > click Add an account > click Sign in without a 
Microsoft account (not recommended) > click Local account > enter the username 
and password, and reenter the password and password hint > click Next > click 
Finish.

Part 2: Finalize the Installation
Step 1: Check for Windows Updates

To update the OS after the initial installation, Microsoft Windows Update is used to 
scan for new software and install service packs and patches.

a. To get to the Windows Update utility, type Update in the Windows search at 
the bottom of the desktop.

b. In the Windows Update window, you can click Check for updates to scan for 
needed Windows updates. Instead of the Check for updates button, you may 
see a list of missing important updates that need to be installed or require a 
restart. You can select the updates to install and click Restart now or Schedule 
the restart to have the computer restart at a later time.

Step 2: Check for Device Problems

After installation, verify that all hardware is installed correctly. The Device Manager 
utility is used to locate device problems and install the correct or updated drivers.

a. Open Device Manager by typing Device Manager in the Windows search. 

b. In Device Manager, you will see a list of device categories. Click a category 
to expand it and see all devices within that category. A yellow triangle with 
an exclamation point indicates a problem with a device. To view a description 
of the problem, right-click the device and select Properties. A gray circle with 
a downward-pointing arrow indicates that a device is disabled. To enable the 
device, right-click it and select Enable.

c. Pick a device inside a category and double-click the device. The device proper-
ties window will open with tabs allowing you to view information about the 
device. Click the Driver tab. From here notice that you have many options, such 
as view driver details, update the driver, or uninstall the device. 

d. What options are available in the Driver tab?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Some of the options are Driver Details, Update Driver, Roll Back 
Driver, Disable Device, and Uninstall Device.
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Reflection
After finalizing the Windows installation, what else can you do to improve your experience?

 

 

 

 

Answers will vary. Some examples are review the advanced options for Windows Update, turn 
on system restore, declutter your taskbar and Start menu, and choose your default browser.
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CHAPTER 11

Windows Configuration

This chapter reviews how to navigate the Windows GUI. You learn how to use the Control Panel 
and other tools to keep Windows operating systems running smoothly. Finally, the chapter reviews 
common and advanced problems and solutions.
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Study Guide

Windows Desktop and File Explorer
This section reviews current Windows versions as well as the Windows desktop, Task Manager, 
and File Manager.

Comparing Windows Versions
Since 1985, over 25 versions, subversions, and varieties of Windows have been released. The 
primary focus of this review is Windows 10. However, you should also be aware of the major 
differences in Windows 8 and Windows 7 when compared to Windows 10.

Table 11-1 compares the current Windows versions. As a technician, you should be aware of 
the important features. Fill in the month and year when support will end for these versions.

Table 11-1 Overview of Windows Versions

Version Release Date Important Features End of Support

10 July 2015  ■ Improved desktop interface 
combines menu entries and 
tiles in the Start Menu.

 ■ Universal apps.
 ■ Windows Action Center 

replaces charms.

Mainstream: October 2020

Extended: October 2025

8.1 October 2013  ■ Start screen more similar to 
Windows 7.

 ■ More interface configuration 
options. 

January 2023

8.0 October 2012  ■ Interface optimized for mobile 
devices.

 ■ Antivirus included.
 ■ File Explorer instead of 

Windows Explorer.
 ■ Unpopular and considered 

hard to learn. 

January 2016

7 October 2009  ■ Improved interface.
 ■ Improved taskbar.
 ■ Libraries.
 ■ Homegroup file sharing. 

January 2020
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Check Your Understanding—Windows Versions

In Table 11-2, indicate which Windows version applies to each description.

Table 11-2 Windows Versions

Description Windows 7 Windows 8 Windows 10

Uses a start screen with tiles instead of a 
Start Menu.

X

Has a start screen with a Start button and 
taskbar like Windows 7.

X

Is the first version in which antivirus was 
integrated into the OS.

X

Introduced Charms. X

Includes nine editions, including support 
for Internet of Things (IoT) devices.

X

Introduced the Microsoft Edge browser. X

Is optimized for use by mobile devices 
instead of desktop devices.

X

Introduced Home Groups for network 
sharing.

X

Offered enhancements over its predeces-
sor, Windows Vista.

X

The Windows Desktop
This section reviews the Windows 10 desktop and compares Windows 7 and Windows 10.

Identify Elements of the Windows Desktop

Match the description on the left with the desktop element on the right. This exercise is a 
one-to-one matching.
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Description

 a. This shows all currently running 
applications in small icons that can 
be selected with the mouse. It also 
shows a history of programs that have 
recently been open and allows cre-
ation of additional desktops.

 b. By default, icons for the Recycle Bin 
and a shortcut to Microsoft Edge 
appear here. Many other applications 
and files can also appear here.

 c. Shortcuts for these elements can 
be pinned to the taskbar or can be 
selected to be shown on the taskbar 
during installation.

 d. This is the Microsoft assistant in 
version 10 that can respond to voice 
commands.

 e. This is useful for finding Windows 
features and files and provides direct 
access to the Bing Internet search 
engine.

 f. This element shows a menu from 
which you can access applications, 
files, and some of the libraries. In 
addition, you can access settings and 
various power options.

 g. This provides access to some running 
processes, settings, and messages. The 
Action Center is also accessed here. 
Moving the mouse to the right edge 
will show the desktop.

 h. This is the work area, which contains 
shortcuts to commonly used applica-
tions and files.

 i. This element provides access to many 
common functions of Windows. It 
contains the Start button, access to 
common and currently running appli-
cations, and notifications and status 
information.

Desktop Element

 c. Application icons

 d. Cortana

 h. Desktop

 b. Desktop icons

 g. Notification area

 e. Search box

 f. Start button

 a. Task view button

 i. Taskbar

Label the Elements of the Windows Desktop

In Figure 11-1, label the Windows desktop elements.
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Figure 11-1 Elements of the Windows Desktop

Figure 11-1a Elements of the Windows Desktop (Answer)

Application Icons

Cortana and Search Box

Start Button Task View Button

Application Icons Notification Area

Desktop
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Windows Task Manager
The Windows Task Manager provides information about all of the applications, processes, and 
services that are running on the computer. It can be used to monitor system resources and the 
programs that are using them. Task Manager can also be used to terminate processes that are 
causing system issues or that have stopped responding to user input. Care must be taken when 
terminating processes because they may be required for system operation.

Task Manager is essentially the same in Windows 10 and Windows 8. However, the Windows 7 
Task Manager has some essential differences.

Identify the Tabs in Windows 10 Task Manager

In Table 11-3, fill in the name of the Task Manager tab that is described in the Function 
column.

Table 11-3 Windows 10 Task Manager Tabs and Function

Tab Function

Process This tab shows a list of processes currently running on the PC. A pro-
cess is a set of instructions started by the user, a program, or the OS. 
Running processes are now categorized as apps, background processes, 
and Windows system processes.

Performance This tab contains dynamic system performance graphs. You can select 
any of the options—CPU, Memory, Disk, Ethernet, and so on—to see 
graphs for each.

App history This tab displays historical resource utilization, such as CPU time, net-
work data usage, and data uploads and downloads. Information is shown 
by date. The data can be cleared and the date reset to the current date. 
This information is available only for installed apps, mostly from the 
Microsoft store, not applications.

Startup This tab shows what processes are automatically started during 
Windows startup. Windows also measures the relative impact each 
process has on the system's overall startup time. To keep a process 
from starting automatically, right-click on the process and disable its 
automatic startup.

Users This tab shows the users who are currently connected to the PC and 
the system resources that they are currently using. The information 
displayed is much like the Performance tab. Users can be disconnected 
from this tab as well.

Details This tab improves the Windows 7 Task Manager Process tab. From this, 
it is possible to tweak the level of CPU priority for a given process. 
It is also possible to specify which CPU a process will use to run (CPU 
affinity). Application icons were added as well.

Services This tab displays all services that are available and their status. It allows 
for easy stopping, starting, and restarting of them. Services are identified 
by their Process ID (PID).
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Identify the Tabs in Windows 7 Task Manager

In Table 11-4, fill in the name of the Windows 7 Task Manager tab that is described in the 
Function column.

Table 11-4 Windows 7 Task Manager Tabs and Functions

Tab Function

Applications This tab shows all running applications. From this tab, you can create, 
switch to, or close any applications that have stopped responding using 
the buttons at the bottom.

Processes This tab shows all running processes. From this tab, you can end 
processes or set process priorities.

Services This tab shows the available services, including their operational status. 
Services are identified by their PID.

Performance This tab shows the CPU and page file usage.

Networking This tab shows the usage of all network adapters.

Users This tab shows all users that are logged on the computer.

Check Your Understanding—Compare Windows Task Manager Versions

In Table 11-5, indicate whether the Task Manager characteristic applies to Windows 7, 
Windows 10, or both.

Table 11-5 Compare Windows 7 and Windows 10 Task Manager

Characteristic Windows 7 Windows 10 Both

Running services are identified by a PID. X

The Users tab only shows who is connected to the 
computer.

X

The Startup tab allows programs that are running 
on system startup to be disabled.

X

The Networking tab shows utilization of active 
network interfaces.

X

The Details tab allows processes to be assigned a 
priority.

X

The Performance tab includes resource utilization 
information for CPU, memory, network, disk, and 
others.

X

Processes or apps that are having problems can be 
terminated.

X

Task Manager can be started from the context 
menu opened by right-clicking the taskbar.

X

The Applications and Processes tabs have been 
combined.

X
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Windows File Explorer
File Explorer is a file management application in Window 8 and Windows 10. It is used to navi-
gate the file system and manage the folders, subfolders, and applications on storage media and 
network locations. You can also preview some types of files. In File Explorer, common tasks, 
such as copying and moving files and creating new folders, can be done using the Ribbon.

Windows Explorer is the name of the file management application in Windows 7 and earlier. 
Windows Explorer performs similar functions to File Explorer but lacks the Ribbon.

In Windows versions 10 and 8.1, the This PC feature allows you to access the various devices 
and drives installed in the computer. In Windows 7, this same feature is called Computer.

In Windows, a directory structure is organized to store system files, user files, and program 
files. The root level of the Windows directory structure is usually labeled drive C. Drive C 
contains a set of standardized directories, called folders, for the operating system, applications, 
configuration information, and data files. In Windows 10, the default limit for a path link to 
any folder or file is 260 characters.

Folder types can be classified into three categories:

 ■ Users Folder—By default, Windows stores most of the files created by users in the 
Users folder, C:\Users\User_name\.

 ■ System Folder—When the Windows OS is installed, most of the files that are used to 
run the computer are located in the folder C:\Windows\system32.

 ■ Program Files Folder—The Program Files folder is used by most application installa-
tion programs to install software. In 32-bit versions of Windows, all programs are 32-bit 
and are installed in the folder C:\Program Files. In 64-bit systems, 64-bit programs are 
installed in the folder C:\Program Files, whereas 32-bit programs are installed in the 
folder C:\Program Files (x86).

Files in the directory structure adhere to a Windows naming convention:

 ■ A maximum of 255 characters is allowed.

 ■ Characters such as the slash and backslash (/ \) are not allowed.

 ■ An extension of three or four letters is added to the filename to identify the file type.

 ■ Filenames are not case sensitive.

These are the most common file attributes:

 ■ R—The file is read-only.

 ■ A—The file will be archived the next time that the disk is backed up.

 ■ S—The file is marked as a system file, and a warning is given if an attempt is made to 
delete or modify the file.

 ■ H—The file is hidden in the directory display.
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Check Your Understanding—File Explorer

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definition

 a. This contains the files that are neces-
sary for the operation of Windows.

 b. This setting allows files and applica-
tions that require higher user privi-
leges to be opened.

 c. This is an ASCII text-only file.

 d. This is a compressed file format.

 e. These folders are created for every 
user by default. They provide storage 
locations for common files and media.

 f. This is created for every account that 
has been configured on a computer.

 g. This is a Microsoft Word document.

 h. This feature provides access to the 
various storage devices available on 
the computer.

 i. This is the archive file attribute.

 j. This is a graphics file format.

 k. This is a Microsoft PowerPoint 
document.

Term

 g. .docx

 j. .jpg

 k. .pptx

 c. .txt

 d. .zip

 i. A

 e. Libraries

 b. Run as Administrator

 a. System Folder

 h. This PC

 f. Users Folder

Configure Windows with Control Panels
This section reviews all the various control panels you can use to view and modify the operat-
ing system, network settings, installed programs, hardware, and peripheral devices.

Control Panel Utilities
Windows 10 offers two ways to configure the operating system. The first is the Settings 
app (see Figure 11-2). It has an interface that follows the modern Windows interface design 
guidelines.
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Figure 11-2 Windows 10 Settings App

The Settings app first appeared in Windows 8, as shown in Figure 11-3. It provided access to 
fewer settings than the Windows 10 version, which has now become robust. Note that a search 
field enables you to find settings without taking a lot of time clicking through menus.

Figure 11-3 Windows 8 Settings App
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In Windows 7, the Settings app was not present. The most efficient way to make system con-
figuration changes was to use the Control Panel, as shown in Figure 11-4. While it appears that 
Microsoft is moving more and more functionality to the Settings app, the Control Panel is still 
present in Windows 8 and 10, and in some cases, it is the only way to make changes to some 
configuration settings. In other cases, especially in regards to Personalization, the Settings app 
provides more configuration options than the Control Panel.

Figure 11-4 Windows 7 Control Panel

This review focuses on the Control Panel in Windows 10. Although Windows 10 usually 
defaults to the Settings app for configuration changes, a PC technician frequently needs more 
configuration. For different Windows versions, you can access the Control Panel by doing the 
following:

 ■ Windows 7—The Control Panel has an entry on the Start Menu.

 ■ Windows 8—You can open the Control Panel by searching for “Control Panel” and 
clicking the results.

 ■ Windows 8.1—You can access the Control Panel by right-clicking the Start button.

 ■ Windows 10—You can type control in the Search box or at the command prompt.

Figure 11-5 shows the Control Panel for a Windows 10 computer. Some settings are specific to 
this computer’s installed applications and hardware.
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Figure 11-5 Windows 10 Control Panel

Check Your Understanding—Control Panel Categories

Match the scenario on the left with the Control Panel category on the next page. This exercise 
is a one-to-one matching.

Scenario

 a. After accidentally visiting a dangerous 
website, a user wants to verify that 
the Windows Defender Firewall is still 
active.

 b. A new printer has been connected 
to the computer, and it requires 
configuration.

 c. An elderly user complains that the 
text in the menus in applications is 
difficult to read.

 d. You want to change which text edi-
tor opens when a text file is double-
clicked in File Explorer.

 e. A new employee will be sharing 
a computer with another user and 
requires an account.

 f. You want to check the status of the 
Ethernet adapter.

 g. A user was exploring the configura-
tion options available on a computer 
and complains that the date is now in 
a different format from what it was.

 h. A user feels that too many fonts are 
available on the computer and wants 
to remove some of them.
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Control Panel Category

 h. Appearance and Personalization

 g. Clock and Region

 c. Ease of Access

 b. Hardware and Sound

 f. Network and Internet

 d. Programs

 a. System and Security

 e. User Accounts

User and Account Control Panel Items
The User Accounts Control Panel item provides options to help you create, change, and delete 
user accounts. It is similar between Windows versions.

Check Your Understanding—User and Account Control Panels

Match the scenario on the left with the term or feature on the right. This exercise is a 
one-to-one matching.

Scenario

 a. An account for a newly hired 
employee needs to be created on a 
shared computer.

 b. A user complains about receiving 
frequent notifications about applica-
tions that are making changes to the 
computer.

 c. These users can only make configu-
ration changes that affect their own 
profile.

 d. A user wants to work on network files 
while offline.

 e. These users can access files from 
other users.

 f. You have forgotten your password for 
a network application.

 g. An employee has recently been pro-
moted to the job of computer techni-
cian and needs to be able to make 
changes to the configuration of his 
computer but is not allowed to do so.

Term or Feature

 e. Administrator

 g. Change account type

 f. Credential Manager

 a. Manage another account

 c. Standard

 d. Sync Center

 b. UAC
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Network and Internet Control Panels
Windows 10 has a new Settings app for network settings. It combines many different functions 
into one high-level app, as shown in Figure 11-6.

Figure 11-6 Windows 10 Network and Internet Control Panel

Identify the Tabs in Internet Properties

Internet Options is used to configure Microsoft Internet Explorer (IE). Search for “Internet 
options” to open the Internet Properties dialog box. In Table 11-6, fill in the name of the 
described tab for the Internet Properties dialog box.

Table 11-6 Internet Properties Dialog Box Tabs

Tab Description

General Configure basic Internet settings, such as selecting the default home 
page, viewing and deleting browsing history, adjusting search settings, and 
customizing the browser appearance.

Security Adjust the security settings for the Internet, local intranet, trusted sites, 
and restricted sites. Security levels for each zone can range from low 
(minimal security) to high (maximum security).

Privacy Configure privacy settings for the Internet zone, manage location services, 
and enable the Pop-Up Blocker.

Content Access Parental Controls, control content viewed on the computer, adjust 
AutoComplete settings, and configure the feeds and web slices that can be 
viewed in IE. Web slices are specific content from websites that allow users 
to subscribe and view the updated content, such as current temperature 
and stock quotes.

Connections Set up an Internet connection and adjust network settings. Dial-up, VPN, 
and proxy server settings can be managed on this tab.
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Tab Description

Programs Make IE the default web browser, enable browser add-ons, select the 
HTML editor for IE, and select programs used for Internet services. 
Hypertext Markup Language (HTML) is a system that tags text files to 
affect the appearance of web pages.

Advanced Adjust advanced settings, and reset IE’s settings to the default state.

Check Your Understanding—Network and Internet Control Panel

In Table 11-7, indicate whether Network and Sharing, Internet Options, or Home Group is 
described.

Table 11-7 Network and Sharing, Internet Options, or Home Group

Description Network and 
Sharing

Internet 
Options

Home 
Group

This feature enables you to reset browser settings 
to the default.

X

This feature enables you to make changes to the 
protocols and services that are configured on an 
adapter.

X

Settings dynamically change depending on the 
type of network.

X

This feature enables you to easily share files and 
devices on a network.

X

This feature was removed from new versions of 
Windows 10.

X

This feature enables you to clear browsing history. X

Display Settings and Control Panel
In Windows 10, much of the appearance and personalization configuration has been moved to 
the Settings app. Open it by right-clicking an empty area of the desktop and selecting Display 
Settings.

Check Your Understanding—Display Features

Match the description on the left with the display setting on the right. This exercise is a 
one-to-one matching.
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Description

 a. A larger desktop can be configured by 
extending the display.

 b. This is either landscape (horizontal) or 
portrait (vertical).

 c. This is the number of times that the 
screen is redrawn per second.

 d. This refers to the bit depth that the 
display is configured to show.

 e. This is the number of pixels displayed 
expressed as a number of horizontal 
and vertical pixels.

 f. A specific monitor can be specified.

Action

 f. Display

 d. Display colors

 a. Multiple displays

 b. Orientation

 c. Refresh rate

 e. Screen resolution

Power and System Control Panels
The Power Options Control Panel item allows you to change the power consumption of certain 
devices or the entire computer. Use Power Options to maximize battery performance or con-
serve energy by configuring a power plan.

Check Your Understanding—Power Options

What happens when the power button is pushed when the different power actions are 
configured? Match the description on the left with the action on the right. This exercise is 
a one-to-one matching.

Description

 a. The computer continues to operate at 
full power.

 b. No files or applications are left open. 
The computer is turned off and must go 
through the boot process to restart.

 c. The computer runs at full power. 
Energy is saved by deactivating the 
display.

 d. Open files and applications are 
retained in RAM. Some power is used 
to enable RAM to retain data. The 
computer resumes operation quickly.

 e. Open applications and files are saved 
into temporary files stored on the 
computer. Resuming operation takes 
a little time. No power is required to 
retain data.

Display Setting

 a. Do nothing

 e. Hibernate

 b. Shut down

 d. Sleep

 c. Turn off display
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The System Control Panel allows all users to view basic system information, access tools, and 
configure advanced system settings. The System Control Panel item is found under the System 
and Security category.

Check Your Understanding—System Properties

When you search for or click Remote Settings or System Protection in the System Control 
Panel, the System Properties opens. Which tab in the System Properties utility should you use 
for each of the following scenarios? Match the scenario on the left with the System Properties 
tab on the right. This exercise is a one-to-one matching.

Scenario

 a. A user reports that his mouse is acting 
strangely. You want to check that the 
driver is working properly.

 b. Users have been having problems 
with software updates that cause sys-
tem crashes. You want to configure 
the computers so that they can be 
restored to a configuration point prior 
to the installation in case the problem 
continues.

 c. A user is working on a project that 
requires a lot of RAM. The user com-
plains about messages that say there is 
insufficient RAM.

 d. A computer has been moved to 
another building. It will need to 
be configured to join a different 
workgroup.

 e. A sales representative for your com-
pany is away on business and is having 
problems with her laptop. You need to 
access the laptop from your office to 
troubleshoot the problem.

Tab

 c. Advanced

 d. Computer Name

 a. Hardware

 e. Remote

 b. System Protection

Hardware and Sound Control Panels
The Device Manager organizes devices by type. Search for “Device Manager” to open it. To 
view the devices, expand the appropriate category. You can view the properties of any device 
in the computer by double-clicking the device name. In Figure 11-7, the Properties dialog box 
for the display adapter is open. The technician clicked the Driver tab to view the installed drive 
version and to check for an update.
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Figure 11-7 Device Manager

Use the Devices and Printers Control Panel for a high-level view of the devices connected to 
a computer, as shown in Figure 11-8. Devices displayed in the Devices and Printers Control 
Panel item are typically external devices you can connect to your computer through a port 
such as USB or a network connection.

Figure 11-8 Devices and Printers Control Panel
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Check Your Understanding—Device Manager Alerts

Match the description on the left with the Device Manager alert icon on the right. This 
exercise is a one-to-one matching.

Description

 a. The device-specific driver for 
the device is not available. 
A compatible driver is in use.

 b. The driver has been manually 
installed.

 c. The device is disabled.

 d. The device has an error. Check the 
device properties for the error code.

Device Manager Alert Icon

 d. 

 c. 

 b. 

 a. 

Clock, Region, and Language
Windows allows you to change the system time, date, and region specifics such as language 
and currency.

Check Your Understanding—Clock, Region, and Language

In Table 11-8, indicate whether the statement is true or false.

Table 11-8 Clock, Region, and Language

Statement True False

The Region Control Panel item allows you to change the format 
of time, date, and currency.

X

The time value displayed in Windows must be manually set 
when time changes occur.

X

Region allows you to change the computer to use the metric 
system if necessary.

X

In Windows 10, Language settings must be changed in the 
Settings app.

X

Cortana can understand languages other than English if the 
language pack is installed.

X

The Date and Time Control Panel item allows you to change 
the time zone of the computer.

X

Programs and Features Control Panels
Use the Program and Features Control Panel items to uninstall a program from your computer 
if you no longer use it or if you want to free up space on your storage drive. From this Control 
Panel, you can also access the Windows Features dialog box where you can turn Windows fea-
tures on and off.
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From the Control Panel Home, click Default Programs to set the following:

 ■ Set your default programs.

 ■ Associate a file type or protocol with a program.

 ■ Change the AutoPlay setting.

 ■ Set program access and computer defaults.

Check Your Understanding—Programs and Features

In Table 11-9, indicate which Control Panel items are described in the scenario.

Table 11-9 Programs and Features

Scenario Programs Windows 
Features

Default 
Programs

Windows allows connections to be made from 
a computer to a Telnet server. However, you 
find that the Telnet client is not working on 
your computer. 

X

A recent Windows update has caused prob-
lems in a computer. You want to uninstall the 
update.

X

A user requires the use of a special program 
for recording and editing audio files. All .wav 
files should open with this program.

X

A program is not working correctly and needs 
to have its installation repaired.

X

Whenever a CD is inserted into a computer, 
Windows asks how to open it. You would like 
CDs to always open in File Explorer.

X

An application is no longer needed and should 
be removed from the computer.

X

Other Control Panels
Other Control Panels include the Troubleshooting, BitLocker Drive Encryption, File Explorer 
Options (Windows 10), and Folder Options (Windows 7 and 8).

Check Your Understanding—Other Control Panels

Check your understanding of other Control Panels by answering the following questions.

 1. What can be done with the BitLocker Control Panel?

 a. Protect emails from being intercepted and read while on the network.

 b. Configure encryption of the data on an entire volume.

 c. Read data belonging to other users.

 d. Prevent storage devices from being lost or stolen.
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 2. What is the purpose of the Troubleshooting Control Panel item?

 a. To find solutions to common Windows problems.

 b. To install Windows patches.

 c. To locate Windows features and components.

 d. To review security logs.

 3. Why is the File Explorer Options Control Panel useful?

 a. You can select which applications open different types of files.

 b. You can show and hide the File Explorer Ribbon.

 c. The language used in filenames can be changed.

 d. The behavior and appearance of File Explorer files and folders can be customized.

Answer: 1-B; 2-A; 3-D

System Administration
This section reviews the Administrative Tools Control Panel, system utilities, and disk manage-
ment. Also, it reviews application installation, configuration, and security.

Administrative Tools
The Administrative Tools Control Panel item is a collection of tools that are used to monitor 
and configure Windows operation. One of the Administrative Tools items is the Computer 
Management Console, which allows you to manage many aspects of your computer and 
remote computers in one tool.

Identify the Event Viewer Message Type

You can view the history of application, security, and Windows system events in Event Viewer. 
These events are stored in log files. In Table 11-10, fill in the name of the Event Viewer message.

Table 11-10 Event Viewer Message Types

Event Viewer 
Message

Description

Information An event has been successful. A driver or program has executed 
successfully. Windows logs thousands of these events.

Warning A potential problem exists with a software component that is not 
functioning ideally.

Error A problem exists, but no immediate action is required.

Critical Immediate attention is required. The issue is usually related to system 
or software crashes or lockups.

Success Audit A security event has been successful. For example, a successful logon 
from a user will trigger an event with this level.

Failure Audit A security event has not been successful. Failed attempts by someone 
attempting to log on to a computer will trigger this event.
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Identify Default Users and Groups

Local Users and Groups allows you to create new users and assign those users to membership 
in groups. Groups have rights and permissions assigned that are suitable for different types 
of users. In Table 11-11, fill in the name of the default user accounts and groups provided by 
Windows.

Table 11-11 Default Local Users and Groups

Default User or Group Description

Administrators This type of user has full control of the computer and access to 
all folders.

Guests This type of user can access the computer through a temporary 
profile that is created at logon and deleted on logoff. These 
accounts are disabled by default.

Users This type of user can perform common tasks such as running 
applications and accessing local or network printers. A profile 
for this type of user is created and persists on the system.

Identify Services Settings

The Services console can be accessed by searching “services” or entering services.msc at the 
command prompt. The Services console allows you to manage all the services on your com-
puter and remote computers. A service is a type of application that runs in the background to 
achieve a specific goal or to wait for service requests. In Table 11-12, fill in the name of the 
setting to control a service.

Table 11-12 Services Settings

Setting Description

Automatic The service starts when the computer is started. This prioritizes 
the most important services.

Automatic (delayed) The service starts after services that are set to Automatic have 
started. 

Manual The service must be started by the user or by a service or 
program that needs it.

Disabled The service cannot be started until it is enabled.

Stopped The service is not running.
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Check Your Understanding—Administrative Tools

Match the scenario on the left with the administrative tool on the right. This exercise is a 
one-to-one matching.

Scenario

 a. A user complains that her computer 
locks up often. You want to determine 
which application or service is causing 
this to happen.

 b. A computer was updated with new 
RAM, and it has become unstable. It 
is not clear whether there is a problem 
with the RAM or Windows.

 c. An administrator needs to access a 
collection of system administration 
utilities that are all assembled in one 
location.

 d. Users are complaining that they can't 
print to the office printer.

 e. A software developer wants to under-
stand how a new COM component is 
configured.

Administrative Tool

 c. Administrative Tools

 e. Component Services

 a. Event Viewer

 d. Print Management

 b. Windows Memory Diagnostics

System Utilities
Administrators can use the System Information tool to collect and display information about 
local and remote computers. It can be opened from the command prompt by typing msinfo32, 
or it can be found in the Administrative Tools Control Panel item. The System Configuration 
tool can be opened from the command prompt by typing msconfig. It can be used to identify 
problems that keep Windows from starting correctly.

Identify the System Configuration Tab

In Table 11-13, fill in the name of the System Configuration tab that is described.

Table 11-13 System Configuration Tool

Tab Description

General This tab displays three startup selections to aid troubleshooting: 
Normal startup, Diagnostic startup, and Selective startup.

Boot This tab enables you to choose the Windows OS version to start if more 
than one is present and show to start up in Safe boot.

Services This tab allows you to not load individual services on boot for trouble-
shooting purposes.

Startup In Windows 7, this tab displays a list of all the applications that run 
automatically when Windows boots. Individual items can be disabled. In 
Windows 8.1 and 10, the user is referred to the same settings in 
Task Manager.

Tools This tab displays a compact and comprehensive list of diagnostic 
programs that can be run to help with troubleshooting.
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Identify the Registry Key

The Windows Registry is a database that contains settings for Windows and for applications 
that use the Registry. The Registry consists of a hierarchical arrangement of keys and subkeys 
that are represented as a tree. There are five top-level, or root, keys. You can open the Registry 
Editor by searching for “regedit” or entering regedit at the command prompt. In Table 11-14, 
fill in the name of the Registry root keys.

Table 11-14 Registry Root Keys

Root Key Contents

HKKEY_LOCAL_MACHINE Information about the physical state of the computer 
including hardware configuration, network logon and 
security information, and Plug and Play information.

HKEY_CURRENT_USER Data about the preferences of the currently logged-on 
user, including Personalization settings, default devices, 
and programs.

HKEY_CLASSES_ROOT Settings about the file system, file associations, and 
shortcuts. Information here is used when you ask 
Windows to run a file or view a directory.

HKEY_USERS All of the configuration settings for the hardware and 
software configured on the computer for all users.

HKEY_CURRENT_CONFIG Information about the current hardware profile of the 
machine.

Review the Microsoft Management Console

Microsoft Management Console (MMC) is an application that allows the creation of custom 
management consoles for collections of utilities and tools from Microsoft or other sources. 
Utilities and tools, known as snap-ins, can be added to the console, as shown in Figure 11-9. 
The console can then be saved and reopened when needed. You can create as many customized 
MMCs as needed, each with a different name. You can open the MMC by entering mmc at the 
command prompt.

Figure 11-9 Microsoft Management Console
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Check Your Understanding—System Utilities

Match the scenario on the left with the system tool on the right. This exercise is a one-to-one 
matching.

Scenario

 a. You are working with technical sup-
port for a software company. One of 
the programs has not installed prop-
erly and will not run. Tech support 
tells you that some Registry keys need 
to be modified.

 b. A user is complaining about problems 
with a computer. As an administra-
tor, you can access his computer 
over the network. You need to find 
out detailed information about the 
computer.

 c. New software was configured on 
a computer. The user is complain-
ing that the computer now locks up 
frequently. You want to start trouble-
shooting by booting the computer 
with a minimal configuration.

 d. You are finding that security issues 
are becoming a big part of your daily 
duties. You would like to assemble 
a group of tools that you can easily 
access to address security issues.

 e. Your company uses a 3D design 
program to provide visualizations of 
facility designs. The program crashes 
when rendering the visualizations.

Administrative Tool

 e. DxDiag

 d. MMC

 a. Regedit

 c. System Configuration

 b. System Information

Disk Management
The Disk Management utility can be used to complete the following tasks:

 ■ Extend and shrink partitions.

 ■ View drive status.

 ■ Assign or change drive letters.

 ■ Add drives.

 ■ Add arrays.

 ■ Designate the active partition.
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Check Your Understanding—Disk Management

Match the scenario on the left with the disk management solution on the right. This exercise is 
a one-to-one matching.

Scenario

 a. This is the process of creating a new 
partition from an existing one. There 
is no way in Disk Management to do 
this directly. Instead, you must shrink 
the existing partition and create a new 
partition from the unallocated space.

 b. A drive has a system partition and a 
data partition. The system partition is 
running out of space.

 c. This allows a user to take a disk image 
and open it like a drive. This capabil-
ity is useful with optical media image 
file formats like ISO and BIN.

 d. A data disk has returned errors when 
opening files.

 e. A user complains that the hard drive 
takes a long time to open large files.

 f. A new disk must be formatted before 
it can be used in Windows. This will 
erase any data that might be on the 
drive.

 g. A user is working on a sensitive 
project. You want to be sure that the 
project files are always backed up by 
mirroring the project drive.

 h. A new partition needs to be created 
on a disk in which the existing parti-
tions take up the entire drive capacity.

 i. Your computer has partitions for 
Windows 8 and 10 so that you can 
support both operating systems. 
You want your computer to boot to 
Windows 8 because a customer has a 
question about that operating system.

 j. A second hard drive has been making 
strange sounds, and now it is no lon-
ger available in File Explorer.

Disk Management Solution

 i. Active partition

 e. Defragment

 d. Error checking

 b. Extend partition

 f. Initialize disk

 c. Mount disk

 h. Shrink partition

 a. Split partition

 g. Storage spaces

 j. Unreadable
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Application Installation and Configuration
Before purchasing or attempting to install an application, you should verify that the system 
requirements are met, which include the following:

 ■ Processor speed—32- or 64-bit, x86 or other

 ■ RAM, sometimes as minimum or recommended capacities

 ■ Operating system and version

 ■ Drive space available

 ■ Software dependencies (Runtime and other frameworks or environments may be required 
to be present in order for the software to run.)

 ■ Graphics and display

 ■ Network access, if any

 ■ Peripheral devices

Identify the Installation Method

In Table 11-15, fill in the installation method that is described.

Table 11-15 Installation Method

Method Description

Attended A user must be present to respond to prompts from the 
installer software.

Silent or unattended No prompts or other information is displayed during 
installation.

Scheduled or automated Installation occurs without being started by a user. Precon-
figured tasks that run according to conditions or timers can 
install software when appropriate.

Clean All components of any previous version of the software have 
been removed prior to installation.

Network The installation packages are available on a server and the 
installation occurs across the network.

Check Your Understanding—Application Installation and Configuration

Match the scenario on the left with the software installation term on the right. This exercise is 
a one-to-one matching.
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Scenario

 a. A user has downloaded an application 
and attempted to install it. The soft-
ware encrypts the user's hard drive, 
which makes the computer useless.

 b. A Microsoft Office application will 
no longer run on a computer. You 
want to solve the problem without 
reinstalling the Office application.

 c. A user attempted to install a program, 
but the installer says the computer is 
incompatible.

 d. A new piece of software needs to 
be installed on all the computers 
in a workgroup at a time when the 
employees are out of the office.

 e. A user needs a program that will allow 
editing of audio files that will be used 
in a presentation. You recommend a 
download from a safe source of free 
software.

 f. A file may have some important infor-
mation in it; however, the application 
that created the file is old and will not 
run properly in Windows 10.

Term

 d. Automated install

 f. Compatibility mode

 a. Malware

 e. Microsoft Store

 b. Repair

 c. System requirements

Command-Line Tools
This section reviews the command-line interface (CLI) tools that are available to complete a 
variety of tasks in the Windows operating system.

Using Windows CLI
Although you can still open the original command-line application by searching for “cmd,” this 
application was replaced with PowerShell.

Check Your Understanding—Basic Command-Line Commands

Match the scenario on the left with the command or keystroke on the right. This exercise is a 
one-to-one matching.

Book 1.indb   302Book 1.indb   302 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 11: Windows Configuration  303

Scenario

 a. The command-line window is full of 
output from other commands and is 
cluttered and hard to read.

 b. You are finished working at the com-
mand line and want to end the session.

 c. You want to find a command to use 
for a specific task and want to see the 
output one screen at a time.

 d. You entered a command incorrectly 
and would like to bring back the 
incorrect command so you can correct 
it and run it.

 e. You want to see all the commands 
available at the command line.

 f. You want to see the options available 
for a command.

 g. You want to see a list of the com-
mands recently executed so you can 
choose one to run again.

 h. A command is generating a lot of 
output and is taking too long to run. 
You want to stop it.

Command or Keystroke

 f. [command]/?

 a. cls

 h. Ctrl+C

 b. exit

 g. F7

 e. help

 c. help | more

 d. up-arrow

File System CLI Commands
Different software vendors and organizations use different conventions to indicate syntax for 
commands. Some of the conventions used by Microsoft for CLI commands are summarized in 
Table 11-16.

Table 11-16 Command Syntax Conventions

Notation Description

Text without brackets or braces Must be typed exactly as shown.

<Text inside angle brackets> Indicates a value that must be supplied.

[Text inside square brackets] Indicates optional input.

{Text inside braces} Indicates a list of items from which one must be 
chosen.

Vertical bar (|) Indicates mutually exclusive items.

Ellipsis (…) Indicates repeatable input.

Check Your Understanding—File System CLI Commands

Match the function on the left with the command on the right. This exercise is a one-to-one 
matching.
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Function

 a. Copy large groups of files and direc-
tory trees; a function recommended 
by Microsoft.

 b. Rename a folder or file.

 c. Display the contents of a text type 
file.

 d. Display the contents of the current 
folder.

 e. Move to a different folder.

 f. Delete a file.

 g. Display the contents of a file one 
screen at a time.

 h. Delete a directory.

 i. Copy a file to a specified destination.

 j. Redirect command output from the 
screen to a file.

 k. Move a file or directory from one 
directory to another.

Command

 j. >

 e. cd

 i. copy

 f. del

 d. dir

 g. more

 k. move

 h. rd

 b. ren

 a. robocopy

 c. type

Disk CLI Commands
You can use commands to perform disk operations similar to those available in the Windows 
Disk Management utility.

Check Your Understanding—Disk Operation Commands

Match the function on the left with the command on the right. This exercise is a one-to-one 
matching.

Function

 a. Prepare a disk with the appropriate 
file system.

 b. Decrease the size of a partition.

 c. Check a disk for errors.

 d. Enlarge a partition by taking over 
unallocated space.

Command

 c. chkdsk

 d. diskpart> extend

 b. diskpart> shrink

 a. format

Task and System CLI Commands
You can use commands to perform tasks similar to those found in the Task Manager utility.
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Check Your Understanding—Task and System Commands

Match the function on the left with the command on the right. This exercise is a one-to-one 
matching.

Function

 a. Mount and configure a disk image 
that will be deployed to other 
computers.

 b. Shut down a process that is running 
on a computer.

 c. Repair or replace protected system 
files that may have been corrupted.

 d. Find out which processes are running 
on a computer.

 e. Manipulate the power state of a 
computer.

Command

 a. dism

 c. sfc

 e. shutdown

 b. taskkill

 d. tasklist

Other Useful CLI Commands
Use the Win+R keys to open the Windows Run utility. From here, you can open a variety of 
utilities including the following:

 ■ EXPLORER—Opens File Explorer or Windows Explorer.

 ■ MMC—Opens Microsoft Management Console (MMC).

 ■ MSINFO32—Opens the System Information window.

 ■ MSTSC—Opens the Remote Desktop utility.

 ■ NOTEPAD—Opens the Notepad basic text editor.

Check Your Understanding—Other Useful CLI Commands

Match the function on the left with the command on the right. This exercise is a one-to-one 
matching.

Function

 a. See the shared network resources 
available to a user.

 b. Check to see what Group Policy is in 
effect for a user.

 c. Ensure that the latest Group Policy is 
present on a computer.

 d. View or edit user account.

Command

 b. gpresult

 c. gpupdate

 a. net use

 d. net user

Windows Networking
Windows networking includes organizing computers on a network into domains or groups. 
Those computers will need to share resources and printers across the network. All the 
devices are attached to the network through a wired or wireless connection. To enable secure 

Book 1.indb   305Book 1.indb   305 01/10/19   9:27 PM01/10/19   9:27 PM



306  IT Essentials Version 7, Labs & Study Guide

connections, remote users connect to the network over a virtual private network (VPN). 
Administrators can access remote devices using Secure Shell (SSH). Administrators can also use 
Remote Desktop and Remote Assistance to access and troubleshoot computers.

Network Sharing and Mapping Drives
All computers on a network must be part of either a domain or a workgroup. When Windows 
is first installed on a computer, it is automatically assigned to a workgroup. In Windows 7 
and 8, computers can belong to a homegroup.

Check Your Understanding—Network Sharing and Mapping Drives

Match the definition on the left with the term on the right. This exercise is a one-to-one 
matching.

Definition

 a. These make any local share name hid-
den when browsing but still accessible 
through the command line.

 b. This group of computers has a com-
mon set of rules and procedures 
administered as a unit.

 c. This protocol allows computers to 
access data directories that are distrib-
uted throughout the network.

 d. This feature is designed to simplify 
secure access to shared resources such 
as folders, pictures, music, videos, and 
printers on a home network. It was 
removed in Windows 10.

 e. These are hidden from users and 
accessible only by members of the 
local administrators’ group.

 f. This determines the resources that will 
be accessible over the network and 
the type of user permissions (read, 
change, full control).

 g. This collection of workstations and 
servers on a LAN is designed to com-
municate and exchange data with one 
another. Each individual workstation 
controls its user accounts, security infor-
mation, and access to data and resources.

 h. This is an easy way for different ver-
sions of Windows to access the same 
network resources.

 i. This specialized server manages all 
security-related aspects of users and 
network resources.

Term

 e. Administrative shares

 a. Dollar sign ($)

 b. Domain

 i. Domain controller

 d. Homegroup

 c. LDAP

 h. Mapping a drive

 f. Network file sharing

 g. Workgroup
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Sharing Local Resources with Others
Windows 10 controls which resources are shared and how they are shared by turning specific 
sharing features on and off. The following items can be controlled:

 ■ Network discovery

 ■ File and printer sharing

 ■ Public folder sharing

 ■ Password-protected sharing

 ■ Media streaming

To enable sharing, open the Network and Sharing Center:

Start > Control Panel > Network and Internet > Network and Sharing Center

Click Change Advanced Sharing Settings and turn on both Network discovery and File and 
printer sharing, as shown in Figure 11-10.

Figure 11-10 Enable Sharing

Printers can be shared in one of two ways:

 ■ Printer Sharing—A printer can be directly attached to a computer via USB or direct net-
work connection. This is considered a “local” printer, and the PC it is attached to acts as 
the print server.
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 ■ Network Printer Mapping—A printer can come with an integrated Ethernet or a Wi-Fi 
network adapter. After the print device is connected to the network, it can be mapped to 
each user’s computer allowing the user to print over the network.

Configure a Wired Network Connection
Windows 10 network settings are managed through the Network & Internet section in the 
Settings app. For wired connections, click Ethernet > Change Adapter Options. Double-click 
the Ethernet adapter to open Ethernet Properties. To check the IPv4 settings, click Internet 
Protocol Version 4 (TCP/IPv4) > Properties. Typically, the addressing is set to Obtain an 
IP address automatically, as shown in Figure 11-11. In this case, a host uses the Dynamic 
Host Configuration Protocol (DHCP) to request IPv4 addressing information from a server.

Figure 11-11 TCP/IPv4 Properties

IPv6 has similar properties. However, an IPv6 host uses Stateless Automatic Address Configu-
ration (SLAAC) to automatically configure IPv6 addressing information.

Various command-line tools help administrators verify and troubleshoot network connections. 
Review these commands in the “Command Reference” section later in this chapter.

Configure a Wireless Network Interface in Windows
Wireless adapters are configured in the same way as wired adapters. However, wireless adapters 
typically authenticate with a wireless access point. You can add wireless networks in Windows 
10 by going to Settings > Network & Internet > Wi-Fi > Manage Known Networks.

There are four security type options:

 ■ No Authentication (Open)—Sends unencrypted data with no authentication.

 ■ WEP—Provides very weak security and should not be relied on for confidentiality.
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 ■ WPA2-Personal—Uses the Advanced Encryption Standard (AES) cipher and a 
Pre-shared Key (PSK) to encrypt communications.

 ■ WPA2-Enterprise—Passes authentication from the access point to a centralized authen-
tication server running Remote Authentication Dial-In User Service (RADIUS).

In Figure 11-12, the administrator is configuring a PC to connect to a network using WPA2 
authentication and encryption.

Figure 11-12 Add a New Wireless Network

Remote Access Protocols
To communicate and share resources over a network that is not secure, a virtual private net-
work (VPN) is used. A VPN connects remote sites or users over a public network, like the 
Internet. The most common type of VPN is used to access a corporate private network.

Remote-access users must install a VPN client on their computers to form a secure connection 
with the corporate private network.

A VPN in Windows 10 can be set up from the Network and Sharing Center, as shown in 
Figure 11-13.
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Figure 11-13 VPN Access in Windows

For remotely accessing computers and devices at the command line, administrators use SSH. 
SSH is a secure alternative to Telnet, an older insecure terminal emulation protocol. SSH uses 
port number 22. Telnet uses port number 23.

There are several methods in which a client can authenticate to an SSH server:

 ■ Username/Password—The client sends credentials to the SSH host, which are then 
verified against a local user database or sent to a centralized authentication server.

 ■ Kerberos—Networks that use the Kerberos authentication protocol, such as Windows 
Active Directory, allow for single sign-on (SSO). SSO allows users to sign in to multiple 
systems with only one username and password.

 ■ Host-Based Authentication—The client requests authentication with a public key. The 
server generates a challenge with this key that the client must decrypt with the matching 
private key to complete the authentication.

 ■ Public Key Authentication—This provides additional protection over host-based 
authentication. The user must enter a passphrase to access the private key. This helps 
prevent the private key from becoming compromised.

Remote Desktop and Assistance
Remote Desktop allows a remote user to take full control of a local user’s desktop, and Remote 
Assistance gives only partial control to the remote user. Be sure to review the video demonstra-
tion in the online course for this topic.
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Common Preventive Maintenance Techniques for 
Operating Systems
Managing Windows configurations includes preventive maintenance techniques and following 
a formal backup and restoration plan.

OS Preventive Maintenance Plan
Preventive maintenance plans should include detailed information about the maintenance of all 
computers and network equipment. The plan should prioritize equipment that would affect the 
organization the most if that equipment fails. Preventive maintenance includes the following 
important tasks:

 ■ Hard drive error checking, defragmentation, and backup

 ■ Updates to the operating system, applications, antivirus, and other protective software

Some programs, such as antivirus scanners and spyware removal tools, do not automatically 
start when the computer boots. To ensure that these programs run each time the computer is 
booted, add the program to the Startup folder of the Start Menu.

In addition to antivirus and protection software, you should regularly check the following 
updates:

 ■ Windows Update—The website is located at update.microsoft.com. Windows can 
browse the update site and select updates for download and installation using the 
Background Intelligent Transfer Service (BITS) protocol.

 ■ Device Driver Updates—Manufacturers occasionally release new drivers to address 
issues with the current drivers. Check for updated drivers when your hardware does not 
work properly or to prevent future problems. It is also important to update drivers that 
patch or correct security problems. If a driver update does not work properly, use the 
Roll Back Driver feature to revert back to the previously installed driver.

 ■ Firmware Updates—Although they are less common than driver updates, manufactur-
ers release new firmware updates to address issues that might not be fixed with driver 
updates. Firmware updates can increase the speed of certain types of hardware, enable 
new features, or increase the stability of a product.

Backup and Restore
Restore points contain information about the operating system, installed programs, and 
Registry settings. If a computer crashes or if an update causes a problem, the computer can 
be rolled back to a previous configuration using a restore point.

As a technician, you should always create a restore point before making changes to a system in 
the following situations:

 ■ When updating the OS

 ■ When installing or upgrading hardware

 ■ When installing an application

 ■ When installing a driver
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To open the System Restore utility in Windows 10, open System Properties and click System 
Restore.

You can use the Microsoft Backup utility to perform backups as required. The backup tool 
included with Windows 7 allowed users to back up files, create and use a system image 
backup, or repair discs. Windows 8 and Windows 10 ship with File History, which can be used 
to back up the files in the Documents, Music, Pictures, Videos, and Desktop folders.

File History in Windows 10 is located in Settings > Update&Security > Backup.

Basic Troubleshooting Process for Windows 
Operating Systems
Troubleshooting Windows operating systems includes applying a troubleshooting process to 
solve for both common and advanced problems.

Applying the Troubleshooting Process to Windows 
Operating Systems
Like troubleshooting other hardware and software, Windows troubleshooting is more efficient 
when you follow a troubleshooting process.

Review the Troubleshooting Process Steps

In Table 11-17, list the six troubleshooting steps.

Table 11-17 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive 
measures.

Step 6 Document findings, actions, and outcomes.

Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the operating system, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or no answer. In Table 11-18, indicate 
whether the technician’s question is open-ended or closed-ended.
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Table 11-18 Open-Ended and Closed-Ended Questions

Question to Identify the Problem Open-Ended Closed-Ended

Can you start the operating system? X

Have you seen any error messages on the computer? X

What problems are you having? X

Has anyone else used the computer recently? X

Have you changed your password recently? X

Has any hardware been added recently? X

What programs have you installed recently? X

What updates have you performed lately? X

Can you start the operating system in safe mode? X

What were you doing when the problem was discovered? X

What operating system is installed on the computer? X

Common Problems and Solutions for Windows 
Operating Systems
Operating system problems can be attributed to hardware, application, or configuration issues, 
or to some combination of the three.

Check Your Understanding—Possible Solutions for Common 

Windows Problems

Check your understanding of common problems and solutions for Windows by choosing the 
BEST answer to the following questions.

 1. The keyboard or mouse does not respond.

 a. Perform a memory check.

 b. Enable the device in BIOS.

 c. Reboot the computer.

 d. Restore Windows using the System Restore tool.

 e. Test the power supply, RAM, hard drive, or motherboard.

 2. The Windows OS is locking up and not responding.

 a. Run the System File Checker (SFC) to replace corrupt operating system files.

 b. Reinstall or roll back the driver.

 c. Replace or reconnect the cable.

 d. Restore Windows using the System Restore tool.

 e. Reconnect the hard drive cables.

 3. The computer displays an “Invalid Boot Disk” error after POST.

 a. Enable the device in BIOS.

 b. Perform a Repair Installation on the operating system.
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 c. Perform a memory check.

 d. Run the System File Checker (SFC) to replace corrupt operating system files.

 e. Change the boot order in BIOS to start with the boot drive.

 4. A device did not start when the computer booted.

 a. Reboot the computer.

 b. Change the input on the KVM switch.

 c. Use the Recovery Environment to perform an Automatic Repair or a System Restore.

 d. Reinstall or roll back the driver.

 e. Perform a memory check.

 5. The computer displays a black or blue screen of death (BSOD).

 a. Reboot the computer.

 b. Perform a memory check.

 c. Remove any newly installed devices.

 d. Use the Recovery Environment to perform an Automatic Repair or a System Restore.

 e. Reinstall or roll back the driver.

Answers: 1-C; 2-A; 3-E; 4-D; 5-B

Advanced Troubleshooting for Windows 
Operating Systems
You will resolve some types of OS problems more often than others. A stop error is a hardware 
or software malfunction that causes the system to lock up. An example of this type of error is 
known as the Blue Screen of Death (BSOD) and appears when the system is unable to recover 
from an error.

The Event Log and other diagnostic utilities are available to research a stop error or BSOD 
error. To prevent these types of errors, verify that the hardware and software drivers are com-
patible. In addition, install the latest patches and updates for Windows. When the system locks 
up during startup, the computer can automatically reboot. The reboot is caused by the auto 
restart function in Windows and makes it difficult to see the error message.

You can disable the auto restart function in the Advanced Startup Options menu.

Check Your Understanding—Possible Solutions for Advanced 

Windows Problems

Check your understanding of advanced problems and solutions for the Windows operating 
system by choosing the BEST answer to the following questions.

 1. The computer displays an "Invalid Boot Disk" error after the POST.

 a. Remove the newly installed device.

 b. Use the bootrec /fixmbr command from the system.

 c. Restore BOOTMGR using the Windows Recovery Environment.

 d. Replace any failing devices with known-good devices.

 e. Scan for and remove the virus.
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 2. A program listed in the Registry is not found.

 a. Reboot the computer.

 b. Boot the computer in Safe Mode and load a restore point.

 c. Scan for and remove the virus.

 d. Restore BOOTMGR using the Windows Recovery Environment.

 e. Use the bootrec /fixmbr command from the system.

 3. The computer continually restarts without displaying the desktop.

 a. Run chkdsk /F /R from the Recovery Environment.

 b. Check and reset the CPU and FSB settings.

 c. Uninstall the software update or perform a System Restore.

 d. Scan for and remove any viruses.

 e. Install the proper drivers.

 4. A device does not start when the computer boots.

 a. Scan for and remove any viruses.

 b. Enable the device in the BIOS settings.

 c. Check and reset the CPU and FSB settings.

 d. Uninstall the software update or perform a System Restore.

 e. Run chkdsk /F /R from the Recovery Environment.

 5. The computer locks up without error messages.

 a. Enable the device in the BIOS settings.

 b. Check and reset the CPU and FSB settings.

 c. Uninstall the software update or perform a System Restore.

 d. Restart the computer.

 e. Scan for and remove any viruses.

Answers: 1-B, 2-C, 3-A, 4-B, 5-B
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Labs and Activities

Command Reference
In Table 11-19, record the command that fits the description. Include the full path, if necessary, 
to execute the command.

Table 11-19 Commands for Chapter 11, “Windows Configuration”

Command Description

control Opens the Control Panel from the command prompt.

services.msc Opens the Services console from the command prompt.

msinfo32 Opens the System Information tool from the command prompt.

msconfig Opens the System Configuration tool from the command prompt.

regedit Opens the Registry Editor from the command prompt.

mmc Opens the Microsoft Management Console at the command 
prompt.

help Lists all the available commands and a brief description of each.

dir /? Provides case-specific help about the options available for the dir 
command.

cls Clears the screen and moves the command prompt to the top of the 
window.

exit Closes the command window.

dir Displays the contents of the current directory.

cd Changes the directory.

md Creates (makes) a new directory.

rd Removes a directory.

move Moves a file or directory from one directory to another.

ren Renames a file or directory.

type Displays the contents of a file.

more Displays the contents of a file one screen at a time.

del Deletes a file or folder.

copy Makes a copy of a file.

xcopy Makes an extended copy used to copy files or entire directory 
trees.

robocopy Enables you to copy files and directories (Microsoft’s 
recommendation).

chkdsk Checks a file system for errors and can repair some errors.

format Creates a new file system for a disk.

diskpart Starts a separate command interpreter with commands for working 
with disk partitions.

tasklist Displays a list of the processes that are currently running.
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Command Description

taskkill Allows a running process to be killed.

dism Starts the Deployment Image Servicing and Management tool that 
can be used to work with system images before they are deployed.

sfc Verifies and repairs Windows system files.

shutdown Manipulates the power state of a local or remote computer.

gpupdate Enables you to update a local machine and verify its Group Policy 
updates.

gpresult Displays the Group Policy settings that are in effect for a currently 
logged-in user.

net use Displays and connects to network resources.

net user Displays and changes information about computer users.

ipconfig Displays basic IP configuration information, which includes the 
IP address, subnet mask, and default gateway for all network adapt-
ers to which TCP/IP is bound.

ipconfig /all Displays additional network configuration information, including 
DHCP and DNS servers, MAC address, NetBIOS status, and 
domain name.

ipconfig /release Releases the IP address learned from the DHCP server resulting in 
the network adapter(s) no longer having an IP address.

ipconfig /renew Forces a DHCP client to renew its DHCP address lease from the 
DHCP server.

ipconfig /
displaydns

Displays the DNS resolver cache that contains host and domain 
names that have been recently queried.

ipconfig /
flushdns

Clears the DNS resolver cache on the host.

ping Tests basic connectivity between devices by using ICMP echo 
request and reply messages.

tracert Traces the route that packets take from your computer to a destina-
tion host. 

nslookup Tests and troubleshoots DNS servers. It queries the DNS server to 
discover IP addresses or host names. 
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11.1.2.10 Lab–Configure the Windows Desktop 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will explore the Windows desktop, Start Menu, and taskbar.

Required Resources
 ■ Windows PC

Step 1: Explore the Windows desktop.

After logging into Windows, you are presented with the Windows desktop.

List some of the icons that are on the desktop.

 ________________________________________________________________________

Answers may vary. An example is the Recycle Bin.

What type of information is available on the desktop and taskbar?

 ________________________________________________________________________

Answers may vary. Example: shortcut to Recycle Bin, stored files on the desktop, 
icon of open application, date and time, network connection, and speaker volume.

Step 2: Explore the Start Menu.

The Start Menu is where you can locate your installed program and find files or 
folders.

 a. Click Start. The images show the differences in the Windows Start Menu in the 
various Windows versions. 
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Name a few applications listed in the Start Menu.

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Some of the examples: Calculator, Command Prompt, and 
Windows Media Player.

 b. Right-click an application or a Windows tile from within the Start Menu. What 
are some of the available options?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Windows 10 and 8.x: Uninstall, Resize, Unpin from Start and 
Pin to taskbar, Windows 7: Open, Run as administrator, Pin to Taskbar, Pin to Start 
Menu, Remove from this list, and Properties.

Step 3: Explore the taskbar.

 a. To search for a program or file, enter the name in the Search bar to the right of 
the Start button. You could also use your voice to ask Cortana to search for the 
desired program or file.

For Windows 7, click Start > enter the name in the Search programs and files 
to search a program or file.

For Windows 8.1, click Start > click the Magnifying glass > enter the name of 
the desired program or file.

 b. Right-click the taskbar to select the Taskbar settings.

Windows 7: Right-click the taskbar > click Properties to select taskbar and 
Start Menu Properties.

Windows 8.x: Right-click the taskbar > click Properties to select taskbar and 
Navigation properties.

What are the available options in the taskbar settings?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Depending on the Windows OS version: Lock the taskbar, 
Auto-hide the taskbar, and Use small icons or Use small taskbar buttons.

 c. Task View is the native virtual desktop feature for Windows 10. This allows you 
to view multiple desktops and used applications at the same time. Click Task 
View. (The icon is normally to the right of the Search bar.)

What are the available options in the Task View settings?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Adding a desktop, moving applications to a different desktop
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 d. In the Task View, create a new desktop.

 e. Navigate to Desktop 1 and open an application in Desktop 1.

 f. Open the same application in Desktop 2 that was opened in Desktop 1. What 
happened?

 ________________________________________________________________________

You are able to have the same application running on each Desktop Task View.

 g. The notification area on the right edge of the taskbar provides system 
information.

List some examples of system information below.

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. System information such as battery levels, network information, 
and volume level.

 h. In Windows 7 and 8.x, you can customize the notification area. Click the 
triangle > Customize or click Start > navigate to Control Panel > Notification 
Area Icons. What are the behavior options for the icons?

 ________________________________________________________________________

 ________________________________________________________________________

The options are: Show icon and notifications, hide icon and notifications, and only 
show notifications.

Click Turn system icons on or off. List the system icons that can be enabled.

 ________________________________________________________________________

Answers may vary. Some of the examples: Clock, Volume, Network, Power, Action 
Center.

In Windows 7, 8.x, and 10, click the triangle, and try to rearrange the icons or 
add/remove icons from the notification area by dragging them from the expand-
ed triangle to the taskbar. For example, you can move the battery icon from the 
expanded triangle to the taskbar.

 i. Action Center is a new feature in the notification center in Windows 10. Click 
the Notification icon in the taskbar > select All settings or click Start > search 
for Settings. Then click System > click Notifications & action.

What can you do in the Notification & actions Settings window?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. In this window, you can add or remove quick actions or even 
rearrange the quick action icons, show / hide notifications, and choose which apps 
can display notifications in the notification area.
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11.1.3.4 Lab–Work with Task Manager 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will explore Task Manager and manage processes from within Task Manager.

Required Resources
 ■ A computer running Windows

Step 1: Applications tab.

 a. Log on to Windows as an administrator.

 b. Open a web browser and a folder.

 c. Click Start and type task manager in the search field. Press Enter to open the 
Task Manager utility.

Note: For Windows 8.x, use the charms menu and then click the search icon. Type task 
manager and press Enter to open the Task Manager utility.

 d. Click Fewer details if available to view the list of open applications.

 e. To force the web browser to close, highlight the browser and click End task.

What happened?

 ________________________________________________________________________

The browser window closed, and it is no longer listed in Task Manager.

 f. Open the web browser again. Right-click the web browser in the Task Manager. 
What options are available?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Windows 7: Switch To, Bring To Front, Minimize, Maximize, 
End Task, Create Dump File and Go To Process. Windows 8.x: Switch to, End 
task, Run new task, Always on top, Open file location, Search online, Properties. 
Windows 10: End task, Run new task, Always on top, Search online.
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Step 2: Services tab.

 a. Click More Details at the bottom-left corner of Task Manager. 

Note: It is not available in Windows 7.

 b. Click the Services tab. Use the scrollbar on the right side of the Services 
window to view all the services listed.

What statuses are listed?

 ________________________________________________________________________

Stopped and Running.

 c. Right-click on one of the services listed. What are the available actions that can 
be taken?

Answers may vary but may include start, stop, restart, open services, search online, 
etc.

Step 3: Performance tab.

 a. Click the Performance tab. Select CPU to view the utilization in the left panel.

Note: There is no CPU option in the Performance tab in Windows 7.

What is the current utilization of the CPU?

 ________________________________________________________________________

Answers may vary. The example displays 23%.

How many streams of instructions (i.e., threads) are currently running?

 ________________________________________________________________________

Answers may vary. The example displays 491.

How many apps, background processes, and Windows processes (i.e., processes) 
are currently running? 

 ________________________________________________________________________

Answers may vary. The example displays 37.

 b. Click on the Memory Chart in the left panel of the Performances tab.

Note: There is no CPU option in the Performance tab in Windows 7.

What is the total physical memory (MB)?

 ________________________________________________________________________

Answers may vary. The example shows 2GB (above memory chart on right).

What is the available physical memory (MB)?

 ________________________________________________________________________

Answers may vary. The example displays 1.3 GB.
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How much physical memory (MB) is being used by the computer?

 ________________________________________________________________________

Answers may vary. 669 MB.

 c. Click the Ethernet Chart in the left panel of the Performances tab. 

Note: There is no Ethernet option in the Performance tab in Windows 7. Click the 
Networking tab in Windows 7 for the Ethernet information.

What is the link speed?

What type of Ethernet adapter is in use on this computer?

 ________________________________________________________________________

Answers may vary. The example shows that it is Ethernet.

What type of network connection (i.e., connection type) is in use?

 ________________________________________________________________________

Answers may vary but can include Ethernet, 802.11a, 802.11b, 802.11g, 802.11n, 
802.11ac, etc.

What is the IPv4 address of the PC?

Note: This information is not available in the Networking tab in Windows 7.

 ________________________________________________________________________

Answers may vary. The example shows 192.168.55.60.

Note: You can click Open Resource Monitor to bring up the Resource Monitor utility from 
the Performance tab in Task Manager to view the individual processes, services, and applica-
tions utilizing system resources.

Step 4: Processes tab.

 a. Click the Processes tab. 

 b. Click the Memory heading. Click the Memory heading a second time.

What effect does this have on the columns?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Clicking the Memory heading causes the processes to be sorted by the amount of 
memory each process is using. Each time you click the Memory heading, it reverses 
the order (largest to smallest, then smallest to largest).
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 c. Right-click on the Memory heading, and then select Resource values > 
Memory > Percents.

Note: Resource values options are not available in Windows 7.

What efect does this have on the Memory column?

 ________________________________________________________________________

The column now displays memory usage in percentage values.

How could this be useful?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Displaying processes in this way can assist an administrator in determining what 
services may be causing memory issues by showing how much available memory is 
being used by each service.

 d. Open a web browser.

 e. Return to the Task Manager. Click the Name heading.

Note: The category options are not available in Windows 7.

The listed processes are divided by categories. What categories are listed?

 ________________________________________________________________________

Answers may vary. The example shows three categories: Apps, Background process-
es, and Windows processes.

 f. Select the web browser, and click End Task.

 g. Close all open windows.

Step 5: Users tab.

 a. Click the Users tab to list the users who are logged into the system.

 b. Right-click a username. What are the available options?

 ________________________________________________________________________

Answers may vary. Windows 7: Send Message, Disconnect, and Log Off. Windows 8.x 
and 10: Expand, Disconnect, and Manage user accounts.

 c. In Windows 8.x and 10, right-click Expand to view all the processes associated 
with this user.

Step 6: Startup, App history, and Details tabs.

Note: These tabs are not available in Windows 7.
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 a. The Startup tab lists the processes that are started automatically during Win-
dows startup. Click the Startup tab. Right-click a process and list the available 
options below.

 ________________________________________________________________________

Answers may vary. Disable, Open file location, Search online, and Properties.

 b. The App history tab lists the historical resources usage. What type of informa-
tion can you get from this list?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. CPU time, network data usage, and data uploads and downloads.

 c. The Details tab displays process information such as process ID (PID), status, 
and memory utilization. Right-click a process and list the available options 
below.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. End task, End process tree, Set priority, Set affinity, Analyze 
wait chain, UAC virtualization, Create dump file, Open file location, Search online, 
Properties, and Go to service(s).

Reflection
Why is it important for an administrator to understand how to work within the Task Manager?

 

 

 

 

Answers may vary. The Task Manager can be a valuable tool for an administrator when trou-
bleshooting problems with a Windows PC. It provides information about CPU, memory, disk, 
and network usage. It also provides a way to end tasks or cancel processes.
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11.1.4.11 Lab–Working with File Explorer 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will explore and use the File Explorer (Windows Explorer) to navigate the 
Windows file system.

Required Resources
 ■ Windows PC

Step 1: Explore File Explorer.

File Explorer is a file management application in Windows 8.x and 10. Windows 7 
has a similar file management application called Windows Explorer. The main 
difference between the two is that Windows Explorer does not have the Ribbon 
menu bar.

In the File Explorer, you could use the Ribbon menu bar to copy, move, delete, or 
create new folders.

 a. Click Start. Search for File Explorer or Windows Explorer. 

 b. Click Desktop on the left panel.

 c. In the right panel, right-click New > Folder to create a new folder on the 
desktop. Name this new folder Folder1.

 d. Create another folder and name it Folder2.

 e. Move Folder2 into Folder1. Click Folder2 and select Move to > Choose 
location in the Ribbon Home menu to move Folder2 into Folder1, or you can 
use your mouse to drag-and-drop Folder2 into Folder1.

What happened with Folder1 and Folder2 on the desktop?

 ________________________________________________________________________

 ________________________________________________________________________

The new folders are displayed on the desktop. After moving Folder2 into Folder1, 
only Folder1 appears on the desktop.

 f. Create a new text document in Folder1. Right-click New > Text Document. 
Name the new text document.

 g. The file extension is hidden by default. In Windows 10 and 8.x, select File 
name extensions in the View tab in the Ribbon in File Explorer. Another way 
to show the file extension is to navigate to the Control Panel. In the small icon 
view, click Folder Explorer Options (Windows 10) or Folder Options 
(Windows 8.x and 7). Click the View tab and unselect Hide extensions for 
known file types. Click OK to continue. 
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What is the file extension for the text document?

 ________________________________________________________________________

The file extension is .txt.

 h. Make a copy of the text document and place it in Folder2. How would you 
do it?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Right-click the text document > click Copy. Open Folder2 and 
right-click Paste. Or click the text document, click Copy to in the Ribbon Home 
menu, click Choose location, and select Folder2.

 i. Right-click the text document > click Properties. Click the Details tab.

What are the attributes associated with this file?

 ________________________________________________________________________

A for Archive.

 j. Now create a folder named Folder3 inside Folder2.

What is the complete path to Folder3?

Hint: One way to find this information is in the folder properties.

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. For example, 10.5 GB free out of 24.4 GB.
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In Windows 8.x and 10, which directories are listed under Folders? 

Note: There is no Folders heading in Windows Explorer.

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. The folders are Desktop, Downloads, Documents, Pictures, 
Music, and Videos.

 k. Navigate to the desktop within File Explorer or Windows Explorer.

 l. Drag and drop Folder1 onto Quick Access (Windows 10) or Favorites 
(Windows 7 and 8.x).

What happened? Why would you want to do this?

 ________________________________________________________________________

 ________________________________________________________________________

The folder is now listed under the headings Quick Access or Favorites. This provides 
a link to the folder and allows for quick access to a nested folder from File Explorer 
or Windows Explorer.

 m. Within the File Explorer or Windows Explorer, navigate to the Local Disk (C:).

What are folders listed in the Local Disk (C:)?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. The listed folders are PerfLogs, Program Files, Program Files 
(x86), Users, and Windows.

 n. Open the Users folder. List all the folders in the directory.

 ________________________________________________________________________

Answers will vary. Public is one of the folders. The rest of the folders should be the 
name of the users on the PC.

 o. Open the folder associated with your username. Were you able to open it? 
Explain.

 ________________________________________________________________________

Yes. You have the permission to access a folder owned by you.

 p. Open the folder associated with another username if it is available on the PC. 
Were you able to open it? Explain. 

Note: Windows 7 does not display other users’ folders.

 ________________________________________________________________________

Answers may vary. If the user account has administrative privileges, you may be able 
to open the user folder of a standard user. A standard user cannot open the folder of 
administrative privileges without the credentials of the administrative user.
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 q. Notice the Public folder. This folder is accessible to any local users on the PC. 
Furthermore, it can be configured to be accessible for networked users.

Open the Public folder. List all the folders in the directory.

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. Some of the folders in the directory are Public Documents, 
Public Downloads, Public Music, Public Pictures, and Public Videos.

Step 2: Windows Libraries

Windows Libraries is a centralized location for related files from different locations 
on the PC or network. For example, the Videos library is a collection of all the 
videos from different locations on your PC and on a network drive. This acts as a 
shortcut to all those videos.

 a. To access the library, click Start. Then open File Explorer or Windows 
Explorer.

 b. For Windows 8.x and 10, right-click the left panel. Click Show libraries.

 c. Expand the Libraries. Which folders or files are listed under the Libraries 
heading?

 ________________________________________________________________________

Answers may vary. Documents, Music, Pictures, and Videos.

 d. A new library can also be created. Right-click Libraries > click New > click 
Library. Provide a name for the new library.

 e. Include Folder1 in the new library. Folder1 on the desktop can be added to 
the Libraries. Navigate to the desktop. Right-click Folder1 > click Include in 
library > select the new library you created.

Select the library you created in the left panel. Click the Library Tools tab and 
select Manage library. 

How would you remove the directory of Folder1 from the library without 
deleting Folder1 and its contents from the computer?

 ________________________________________________________________________

Answers may vary. Select the Folder1 library location and click Remove and then OK.
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11.2.1.5 Lab–Explore Control Panel Categories 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will investigate the options provided in the various commonly used Control 
Panel items.

Background/Scenario
The Control Panel allows you to view and change system settings as necessary. You can add 
and remove hardware and software, modify user accounts, change accessibility options, and 
configure network settings.

Required Resources
 ■ Windows PC

Step 1: Control Panel Views

By default, the Control Panel is divided into categories. Each category controls a 
group of related functions in Windows.

 a. To open the Control Panel, click Start and search for Control Panel.

 b. In the Control Panel, click the View by: drop-down box.

What are the viewing options?

 ________________________________________________________________________

The three viewing options are Category, Large icons, and Small icons.

 c. Select the Categories view as necessary.

Name a few of the Control Panel categories.

 ________________________________________________________________________

The available Control Panel categories are: System and Security, Network and 
Internet, Hardware and Sound, Programs, User Accounts, Appearance and 
Personalization, Clock and Region, and Ease of Access.

Step 2: System and Security

The System and Security category provides computer system information and 
settings and configures the computer security settings.

Navigate to the System and Security category in the Control Panel. Use the 
subcategories to answer the following questions.

Which subcategory would help you troubleshoot common problems?

 ________________________________________________________________________

Security and Maintenance > troubleshoot common computer problems 
(Windows 10), Find and fix problems (Windows 8.1 and 7)
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Which subcategorys allow a program through Windows Firewall?

 ________________________________________________________________________

Windows 10: Windows Defender Firewall > Allow an app or feature through 
Windows Defender Firewall

Window 8.1: Windows Firewall > Allow an app through Windows Firewall

Windows 7: Windows Firewall >Allow a program through Windows Firewall

Step 3: Network and Internet

The Network and Internet category allows you to view the network status and 
configure network-related setting and preferences.

Which subcategory allows you to view the basic network information and set up 
connections?

 ________________________________________________________________________

Network and Sharing Center

Step 4: Hardware and Sound

The Hardware and Sound category allows you to add and configure hardware 
devices including printers and Bluetooth-capable devices, customize power options, 
and adjust sound-related settings.

Which subcategory allows you to choose what happens when you insert media or a 
device?

 ________________________________________________________________________

AutoPlay

Which subcategory allows you to add a printer?

 ________________________________________________________________________

Devices and Printers > Add a printer

Step 5: Programs

The Programs category provides program installation and uninstallation and the 
selection of specific programs that the Windows operating system will use by 
default. This category also allows you to install/uninstall Windows features such as 
remote access and file transfer clients.

Which subcategory would you use to have a specific file type always open in a 
specified program?

 ________________________________________________________________________

Default Programs > set your default programs or Default Programs > Associate a 
file type or protocol with a program 

Which subcategory would you use to uninstall a program?

 ________________________________________________________________________

Programs and Features > uninstall a program
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Which subcategory would you use to install the Windows telnet client?

 ________________________________________________________________________

Programs and Features > Turn Windows features on or off

Step 6: User Accounts (or User Accounts and Family Safety in Windows 8.1 and 7)

The User Accounts category allows you to adjust user settings, such as account 
types, and change passwords.

Which subcategory would you use change the account type from administrator to 
standard?

 ________________________________________________________________________

User Accounts > Change your account type

Which subcategory would you use to view, edit, or remove the web and Windows 
credentials?

 ________________________________________________________________________

Credential Manager

Step 7: Appearance and Personalization

The Appearance and Personalization category allows you to configure the look and 
feel of Windows, such as the taskbar, navigation, and File Explorer options.

Which subcategory would you use to customize the taskbar?

 ________________________________________________________________________

Windows 10 and 8.1: Taskbar and Navigation, Windows 7: Taskbar and Start Menu

Which subcategory would you use to show hidden files and folders?

 ________________________________________________________________________

File Explorer Options in Windows 10 or File Options in Windows 8.1 and 7 > Show 
hidden files and folders > in the View tab, click Show hidden files, folders, or drives

Which subcategory would you use to show extensions for known file types?

 ________________________________________________________________________

File Explorer Options in Windows 10 or File Options in Windows 8.1 and 7 > Files 
and Folders > in the View tab, uncheck Hide extensions for known file types

Step 8: Clock and Region (Clock, Language, and Region)

The Clock and Region category allows you to change the date, time, and region 
settings in Windows 10. In Windows 8.1 and 7, the Clock, Language, and Region 
category allows you to change the language settings in addition to date, time, and 
region settings.

Which subcategory would you use to change the time zone?

 ________________________________________________________________________

Date and Time > Change the time zone
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Which subcategory would you use to change date format?

 ________________________________________________________________________

Region in Windows 10 and 8.1, Region and Language in Windows 7

Which subcategory would you use to synchronize the time on a computer with a 
specific web server on the Internet?

 ________________________________________________________________________

Date and Time > Internet Time > select Change settings

Step 9: Ease of Access

The Ease of Access category allows you to customize the Windows operating 
system for all types of users. This category also provides the configuration of voice 
control of the computer.

Which subcategory would you use to configure the computer to read aloud any text 
on the screen?

 ________________________________________________________________________

Ease of Access Center > Make the computer easier to use > check Turn on Narrator

Which subcategory would you use to improve the computer’s ability to understand 
your voice and improve the dictation accuracy?

 ________________________________________________________________________

Speech Recognition > Train your computer to better understand you
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11.2.2.3 Lab–User Accounts 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will create user accounts in Windows.

Recommended Equipment
 ■ PC with Windows installed

Instructor Note: Provide students with a user account name and password to be created in 
this lab.

Instructions

Part 1: Account Creation
In this part, you will create a new local user account. Windows does allow local account 
creation using online Microsoft accounts, but this will not be done in this lab. After you have 
created the accounts using a version of Windows, go to Parts 2 and 3.

Step 1: Open the User Account tool.

 a. Log on to the computer with an Administrator account.

 b. Click Control Panel. Change to the small icons view in the Control Panel. Click 
User Accounts.

Step 2: Create a local user account in Windows 10.

 a. In the User Accounts window, click Manage another account.

 b. In the Manage Accounts window, click Add a new user in PC settings.

 c. In the Family & other users window, click Add someone else to this PC.

 d. In the How will this person sign in? window, click I don’t have this person’s 
sign-in information.

 e. Click Add a user without a Microsoft account.

 f. In the Create an account for this PC window, enter a username and password 
provided by your instructor in the field. Choose your security questions and 
provide the answer to the selected questions. Click Next to continue.
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Step 3: Create an account in Windows 8.x.

Note: These steps are very similar for both Windows 8 and Windows 8.1. The words “user” 
and “account” are sometimes used interchangeably.

 a. In the User Accounts window, click Manage another account.

 b. In the Manage Accounts window, click Add a new user in PC settings.

 c. In the Manage other accounts window, click Add an account.

 d. In the How will this person sign in? window, click Sign in without a Microsoft 
account (not recommended).

 e. In the Add a user window, click Local account.

 f. In the second Add a user window, type the name provided by your instructor 
in the User name field.

 g. Type in the password provided by the instructor in the Password field.

 h. Re-enter the password in the Reenter password field.

 i. Type a hint to help you remember the password in the Password hint field. 
Click Next.

 j. In the final Add a user window, click Finish.

Step 4: Create an account in Windows 7.

 a. In the User Accounts window, click Manage another account.

 b. In the Manage Accounts window, click Create a new account.

 c. In the Create New Account window, type the name provided by your instruc-
tor in the Name the account and choose an account type field and select 
Standard user as the account type.

Questions:

What can a user do with a limited account?

  ________________________________________________________________________

The user can use most software and change some system settings.

What limitations does this type of an account have?

  ________________________________________________________________________

The user cannot change system settings that affect other users or the security of the 
computer.

 d. Click Create Account to continue.

 e. Click the user account you just created.

 f. In the Make changes to Username’s account? window, click Create a 
password.
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Question:

What information is listed for the new account?

  ________________________________________________________________________

The account name and that the account is a standard user account.

 g. Type in the password and password hint provided by the instructor and then 
click Create password.

Part 2: Change the Account Type
 a. Navigate to the Control Panel. In the small icons view, click User Accounts > 

click Manage another account.

 b. Select the newly created account.

 c. Click Change the account type.

 d. Select Administrator as the account type and click Change Account Type.

Question:

What is the advantage of having most users work within a Standard user account?

 ________________________________________________________________________

A standard user account can prevent users from altering files and settings that may 
affect the computer as a whole or other users.

Part 3: Delete the Account
 a. Navigate to the Control Panel. Change back to the Category view, click User 

Accounts in Windows 10 or User Accounts and Family Safety in Windows 8.1 
and 7.

 b. Click Remove user accounts in Windows 10 and 8.1 or Add or remove user 
accounts in Windows 7.

 c. Select the account to be deleted. Click Delete the account.

 d. For this lab, select Delete Files. 

Question:

What are the other options? When would you choose the other options?

 ________________________________________________________________________

Answers may vary. Keep Files allows you to save the content of a deleted user’s 
desktop and some of the folders in a new folder on your desktop.

 e. Click Delete Account to confirm the account deletion.

 f. Notice the account is no longer listed. Close all open windows.
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Reflection Questions
 1. Why is it important to protect all accounts with strong passwords?

 

No password or a weak password can allow access from almost anyone to steal data or use the 
computer for unauthorized purposes.

 2. Why would you create a user with Standard privileges?

 

The Standard User cannot compromise the security of the computer or the privacy of other 
users.

 3. In what type of situation would an IT administrator delete a user account and choose to 
keep the files of that user account instead of deleting them?

 

Answers may vary. The user account is an employee that is being terminated; the files contain 
required business information and should be retained.
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11.2.3.5 Lab–Configure Browser Settings 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will configure browser settings in Microsoft Internet Explorer.

Recommended Equipment
 ■ A computer with Windows and Microsoft Internet Explorer installed

 ■ An Internet connection

Instructor Note: This lab contains configuration examples from Microsoft Internet Explorer 
version 11. You will need to make the changes necessary if you are using a different version 
or browser in your classroom. If you do not allow students to access the Internet directly, 
perform this lab as a demonstration for the class.

Step 1: Set Internet Explorer as the default browser.

 a. On the Start screen, type www.netacad.com and navigate to the web page.

Which browser was used to open the web page?

 ________________________________________________________________________

Answers may vary. Internet Explorer, Microsoft Edge, or another browser.

If your answer is not Internet Explorer, use the following steps to set Internet 
Explorer as your default browser. Otherwise, go to step b.

 1) Navigate to the Control Panel in small icons view. Select Internet 
Options.

 2) In the Internet Properties window, select the Programs tab and click 
Make Internet Explorer the default browser. (In Windows 7, click Make 
default.)

 3) In the Default apps window in Windows 10, scroll down to the Web 
browser heading. Click the current default web browser and select Inter-
net Explorer to be the default web browser. Click Switch anyway and 
close the Default apps to continue.
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In Windows 8.1 in the Set Default Programs window, click Internet 
Explorer in the left panel to be the default browser. Click Set this pro-
gram as default. Click OK to close the Set Default Programs.

 4) Click OK in the Internet Options window to continue.

 b. Open Internet Explorer. Click the Tools icon (gear shape) > About Internet 
Explorer or click the Help icon (?) > About Internet Explorer. Which version 
of Internet Explorer is installed on your computer?

 ________________________________________________________________________

Answers may vary.

 c. Click Close or OK to continue.

Step 2: Clear temporary Internet files.

 a. Within Internet Explorer, select Tools (gear icon) > Internet options. Click 
Settings in the Browsing history section in the General tab.

 b. For Windows 10 and 8.1, in the Temporary Internet Files tab of the Website 
Data Settings window, click View files to list the temporary Internet files.
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For Windows 7, in the Temporary Internet Files and History Settings window, 
click View files to list the temporary Internet files.

How many temporary Internet files are listed?

 ________________________________________________________________________

Answers may vary.

 c. Close the INetCache or Temporary Internet Files window.

In the Temporary Internet Files tab of the Website Data Settings window in 
Windows 10 and 8.1 or the Temporary Internet Files and History Settings 
window in Windows 7, which setting is configured for Check for newer ver-
sions of stored pages?

 ________________________________________________________________________

Answers may vary. Automatically.

In the History tab in Windows 10 and 8.1 and under the History heading, how 
many days is History set to store a list of visited websites?

 ________________________________________________________________________

Answers may vary. 20.

 d. Click OK to close the Website Data Settings or Temporary Internet Files and 
History Settings.

 e. In the General tab of the Internet Options window, click Delete to remove 
temporary files, history, cookies, saved passwords, and web form information.

Which options are available in the Delete Browsing History for deleting brows-
ing history?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary depending on Windows version: Preserve Favorites website 
data, Temporary Internet files and website files, Cookies and website data, History, 
Download History, Form data, Passwords, InPrivate Filtering data, and Tracking 
Protection, ActiveX Filtering, and Do Not Track.

 f. Uncheck all selected options except for Temporary Internet files. Click Delete 
to remove the temporary files. When completed, Internet Explorer displays 
the message Internet Explorer has finished deleting the selected browsing 
history.

 g. Close all open windows except for Internet Explorer.

Step 3: Clear Internet browsing history.

 a. Open Internet Explorer if it’s closed and visit a few websites using the same tab.

 b. Click the down arrow, at the right end of the URL Address field, to view 
previously visited sites.
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How many sites are listed in the drop-down box? 
_______________________________

Answers may vary.

 c. To clear the browser history, select Tools > Internet options > Delete. Uncheck 
all selected options except for History. Click Delete.

 d. Close all open windows except for Internet Explorer.

 e. When completed, click the down arrow at the right end of the address field to 
view previously visited sites.

How many sites are found in the drop-down box for browsing history? 

None.

Step 4: Configure the security settings.

 a. In Internet Explorer, select Tools > Internet options, and then click the 
Security tab.

 b. Click each of the four zones and describe their security settings.

Internet: ______________________________

For all Internet websites, except those listed in trusted and restricted zones.

Local intranet: ______________________________

For all websites that are found on your intranet.

Trusted sites: ______________________________

Websites that you trust not to damage your computer or your files.

Restricted sites: ______________________________

Websites that might damage your computer or your files.

 c. Click the Custom level… button. In this window, you can select the options in 
the list that you wish to change for a zone. Click Cancel to close this window.

Step 5: Configure privacy settings.

 a. Open Internet Explorer if necessary. Click Tools > Internet options > Privacy 
tab. Click Advanced.

 b. In the Advanced Privacy Settings window, click Override automatic cookie 
handling in Windows 8.1 and 7 to override the settings. Change the setting for 
Third-party Cookies to Prompt. Click OK and close all open windows.
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Reflection
 1. Why would you want to clear temporary Internet files or Internet browsing history?

 

 

 

Answers will vary. Temporary files and browser history could take up quite a bit of space on 
the hard drive with data from websites that you may never visit again. This data could be a pri-
vacy concern if the computer is shared because the data can reveal the 
websites visited in the past.

 2. For Windows 10, the recommended web browser is Microsoft Edge. How would you 
change the default web browser to Microsoft Edge?

 

 

 

Click Start and search for Default apps. Scroll down to Web browser and select Microsoft 
Edge as the default browser.
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11.2.6.2 Lab–Use Device Manager 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will open Device Manager to display devices listed on your computer. You will 
also display the monitor settings.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: The students will be accessing sensitive settings during this lab. Stress the 
importance of following instructions.

Step 1: Open Device Manager.

 a. Log on to the computer as an administrator.

 b. Click Control Panel. In the Small icons view, select Device Manager.

What information is listed in the Device Manager window? Why would you 
use it?

 ________________________________________________________________________

 ________________________________________________________________________

Device Manager lists all the hardware devices installed on your computer. Use the 
Device Manager to view and change the properties of any device.

Browse through the menus displayed at the top of the Device Manager window.  
How would you install driver software for an older device that may not be auto-
matically recognized by the Windows operating system?

 ________________________________________________________________________

 ________________________________________________________________________

Device Manager > Action tab > Add legacy hardware.

Step 2: Display the monitor settings on your computer.

As an administrator, there are times when you will need to resolve hardware issues 
on a computer. Device Manager makes it easy to locate and install new drivers for 
your devices. You will use Device Manager to review the device driver information 
for your computer’s monitor and to review driver options available to you.

Note: Check with your instructor before making any device changes on the computer.
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 a. Click the arrow to the left of Monitors.

 b. Right-click the device, Generic Non-PnP Monitor in the example, and select 
Properties from the drop-down menu.

 c. In the Generic Non-PnP Monitor Properties window, select the Driver tab. 
This window displays the software driver information that is currently installed 
for this monitor.

What additional information does Driver Details provide?

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. Additional information provides the filename of the driver and 
where it is located on the hard disk.

 d. Click Update Driver.

What two options do you have for updating the driver?

 ________________________________________________________________________

 ________________________________________________________________________

You can search automatically, which will search the computer and Internet for the 
latest driver software, or you can browse the computer’s file folders for a driver.

 e. From the Update Driver Software window, click Cancel to return to the 
Monitor Properties window.

What does the Roll Back Driver button do? The Roll Back Driver can be 
grayed out on your computer. Why would it be grayed out?

 ________________________________________________________________________

 ________________________________________________________________________

It allows you to uninstall newly installed driver software and revert back to the 
driver that was used prior to a driver upgrade. The button is grayed out because a 
new driver has not been installed.
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What are the other available options?

 ________________________________________________________________________

 ________________________________________________________________________

The other options are disable device and uninstall devices.

 f. Close all open windows.
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11.2.7.4 Lab–Region and Language Options 

(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will examine region and language options in Windows.

Recommended Equipment
 ■ A computer running Windows

Part 1: Region Options
Step 1: Open the Region Tools.

 a. Log on to the computer.

 b. Click Control Panel and view by Category. Click Clock and Region in 
Windows 10, or Clock, Language, Region in Windows 8.1 and 7.

 c. Click Region in Windows 10 and 8.1. Click Region and Language in 
Windows 7.

Step 2: Explore the Region settings.

 a. In the Formats tab, change the format in the Format: drop-down list. Note the 
examples at the bottom of the screen.

 b. Under the Date and time formats heading, change the format for the Long date 
using the drop-down options. Note the changes in the examples.

 c. Click Additional settings. What can you customize?

 ________________________________________________________________________

Answers may vary. Numbers, Currency, Time Date

 d. Click Cancel to exit the Additional settings window.

Part 2: Language Options
In this part, you will install an additional language on Windows. After you are done with 
the additional language, you will remove it. Furthermore, instructions for different Windows 
versions are included in this part.

Step 1: Windows 10

 a. Click Language preferences in the Region window.
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 b. Click Add a language.

 c. Select the desired language. Click Next to continue.

 d. Notice the language features. Click Install to install the language package. This  
may take a few minutes.

 e. Under the Windows display language drop-down list, verify that the default 
display language is correct. 

Note: Be careful when you choose a foreign language as the default display language.

 f. Close the Language window. Click Cancel in the Region window to continue.

 g. A language bar is now displayed on the taskbar. Click the language button to 
switch the keyboard to the additional language. 

 h. Depending on the additional languages, you will see one of the following 
changes in the taskbar:

 i. If you see both the displayed language and the input keyboard in the taskbar, 
you can toggle between displaying the primary and the additional icons lan-
guage. Click Start and search for the Control Panel by typing Control Panel.

Book 1.indb   347Book 1.indb   347 01/10/19   9:27 PM01/10/19   9:27 PM



348  IT Essentials Version 7, Labs & Study Guide

 j. If only the displayed language icon is shown in the taskbar or you want to 
change the default displayed language to an additional language, click the 
displayed language icon and select Language preferences. In the Settings 
window, under the Windows display language drop-down list, select the 
additional language. Log out and log back into Windows.

Note: If you were logged off the computer and a foreign language became the default 
display language, click the displayed language button in the taskbar. Select the Language 
preference option. Note the symbol associated with the Language preference option.

This will navigate you to the Settings window. Now select a default display 
language that you are familiar with in the drop-down box. Log out and log back 
into the PC.

 k. Click Start > search for Language or click the Language icon in the taskbar, and 
select Language preferences. Restore the default language as necessary. Log 
out and log back into Windows.

 l. Navigate to the language settings and select the additional language and click 
Remove. If you cannot remove the additional language because it is marked 
as the default language, click the down arrow and click Remove to remove the 
language.

Step 2: Windows 8.1

 a. In the Region window, click Language preferences, and then click Add a language.

 b. In the Add languages window, select the desired language. Click Add or Open 
to continue. If there are regional variants in your selected language, select the 
language and click Add to continue.

 c. Close the Language window. Click Cancel in the Region window to continue.

 d. Click the Language bar. Now you can select between the default and additional 
languages.
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 e. Select the keyboard for an additional language. Click Start, and search for the 
Control Panel by typing Control Panel in the search field. The displayed 
language is for the additional language.

 f. The Language window can also be reached by navigating to Control Panel > 
click Clock, Language, and Region > click Language > click Add a language.

 g. Select the additional language that is not selected as the primary language and 
click Remove to remove it from the language list. If you want to remove the 
primary language, select the language and click Move down. Now you will be 
able to remove it.

Step 3: Windows 7

 a. Select the Keyboard and Languages in the Region and Language window.

 b. Click Change keyboards.

 c. Click Add and select a language to add.

 d. Select a keyboard as necessary. Click OK to continue. 

 e. Click the Language Bar tab. Verify that Docked in the taskbar is selected. 
Click OK to exit the Text Services and Input Languages window.

 f. Click OK to exit the Region and Language window.

 g. Right-click the taskbar.

 h. Select Toolbars > Language bar to ensure that the Language bar is shown in 
the taskbar.

 i. To remove the additional language via the Language bar, right-click the 
Language bar and select Settings.

 j. Select one of the installed input languages that is not selected as the default 
input language. Click Remove. Click OK to continue.

Reflection
Why would a user wish to change the input language of the operating system?

 

 

 

Answers may vary. Someone may be bilingual and wish to use a second or third language as 
the primary source of input. Someone also may not understand the primary input language 
and wish to use the one that is native to her.

How would a user easily switch between multiple installed languages within the operating 
system?

 

 

 

Answers may vary. Use the taskbar language button or the Windows display language 
drop-down in Language Preferences.
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11.3.1.11 Lab–Monitor and Manage System 
Resources (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use administrative tools to monitor and manage system resources.

Recommended Equipment
 ■ A computer running Windows with Internet access

Part 1: Event Viewer
In this part, Windows Defender is used to explore the Event Viewer when the status of a 
service changes. Windows Defender is the built-in anti-malware component in Windows.

Step 1: Verify Windows Defender is running.

Note: Some antivirus or antispyware programs must be uninstalled on the computer for 
Windows Defender to work.

 a. Log on to Windows as an administrator.

 b. To determine if Windows Defender service is stopped, click Start, and search 
for Windows Defender.

In Windows 10, click Virus & threat protection. Scroll down to the Virus & 
threat protection settings. Click Manage settings. Under the Real-time 
protection heading, verify that it is On.

In Windows 8.1, in the Home tab, verify that the Real-time protection is On. 
If Windows Defender does not open, navigate to Action Center (click Start > 
search for Action Center. Click Turn on now for Spyware and unwanted 
software protection (Important) and Virus protection (Important).

In Windows 7, you will receive the message This program is turned off in the 
Windows Defender window. Click click here to turn it on in the window and 
click Close to continue.

 c. Keep Windows Defender open.

Step 2: Explore the Services console.

Note: While most of the Windows services can be managed through the Services console, 
it is not possible to stop Windows Defender from the Windows Services console in 
Windows 10 and 8.1.

 a. Click Start > search for Control Panel. In the Control Panel in the Small icons 
view, click Administrative Tools > click Computer Management. In the 
Computer Management window, expand Services and Applications, and select 
Services.
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 b. Scroll to the Computer Management window under the Services heading so 
you see the Windows Defender Antivirus Network Inspection Service 
(Windows 10), Windows Defender Service (Windows 8.1), or Window 
Defender (Windows 7).

What is the status of the service? ____________________________________

In Windows 10 and 8.1: the status is Running. In Windows 7, the status is Started.

 c. Close the Computer Management window. Navigate back to the Windows 
Defender and turn it off.

In Windows 10, click Virus & threat protection. Scroll down to the Virus & 
threat protection settings. Click Manage settings. Under the Real-time protec-
tion heading, click the slider to turn it off. Click Yes to allow this app to make 
changes to the device.

In Windows 8.1, in the Settings tab, select the Settings tab. In the Settings tab, 
select Administrator. Click Turn on this application to turn off Windows 
Defender. Click Save changes to turn off Windows Defender. Click Close in the 
pop-up window as necessary.

In Windows 7, click Tools. Click Options. In the Options window, select 
Administrator > click Use this program. Click Save to stop Windows Defender. 
Click Close to continue when a message informs you that you have turned 
it off.

 d. Navigate back to Services. (Control Panel in Small icons view > Administrative 
Tools > Services). Click Action > click Refresh.

Look for Windows Defender Antivirus Network Inspection Service 
(Windows 10), Windows Defender Service (Windows 8.1), or Window 
Defender (Windows 7). Record the Windows Defender status.

 ________________________________________________________________________

There is no status because it is turned off.

 e. Navigate to the Event Viewer. In the Computer Management window, expand 
System Tools > expand Event Viewer > expand Windows Logs > select 
Application (Windows 10), select System (Windows 8.1 and 7).

 f. In the Application or System pane, you can find the most recent events related 
to Windows Defender. Right-click the interested log, and select Find. Enter 
defender to search Windows Defender-related entries.
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In the General tab, what is listed as the source of the event? What is the severity 
level?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

The severity level is informational for all Windows versions. In Windows 10, the 
source is Security Center. In Windows 8.1, the source is Service Control Manager. In 
Windows 7, the source is Service Control Manager.

 g. Navigate to Windows Defender and turn it on. Close Windows Defender.

 h. Navigate to the Event Viewer to review the most recent event entries that are 
related to Windows Defender.

Part 2: Explore the Impact of Services
In this part, you will stop Print Spooler service to explore the impact in the system. The print 
spooler is responsible for managing the printer jobs and handling the interaction with the 
printer. With this service turned off, you will not be able to print or see your printers.

Step 1: Verify the printing service.

 a. Open Notepad. Click Start and search for Notepad.

 b. In Notepad, click File > Print. Record a listed printer below. 

Note: You do not need to install a physical printer.

 ________________________________________________________________________

Answers may vary. Microsoft XPS Document Writer is a print-to-file driver installed 
by Windows.

 c. Click Cancel to exit the Print dialog.

Step 2: Stop the print spooler.

 a. Open the Services console. (Control Panel > Administrative Tools > Services)

 b. Right-click Print Spooler and select Stop.
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 c. Navigate to Notepad. Attempt to print. What message did you receive? How 
would you fix this?

 ________________________________________________________________________

The message received: Before you can perform printer-related tasks such as page 
setup or printing a document, you need to install a printer. You will need to restart 
the print spooler.

 d. Click OK or No in the message window and click Cancel to exit the Print 
window.

Step 3: Restart the print spooler.

 a. Navigate to the Services console and restart the print spooler. Right-click Print 
Spooler and select Start.

 b. Verify that you can print.

Step 4: Explore the DHCP Client service.

The DHCP Client service registers and updates the IP addresses and DNS records 
for the PC. If this service is stopped, the PC will not receive a dynamic IP address 
and DNS updates.

 a. In the Services console, search for DHCP Client. Right-click DHCP Client and 
select Stop.

When DHCP Client stops, what other services will also be stopped?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. Windows 7: You may not receive information regarding stopping 
other services. Windows 10 and 8.1 could include: IP Helper, WinHTTP Web Proxy 
Auto-Discovery Service, Network List Service, and Network Location Awareness.

 b. Click No in the Stop Other Services window.

Why is it important to exercise care when managing services?

 ________________________________________________________________________

 ________________________________________________________________________

Applications and other services may depend on a given service to work. Stopping a 
service can compromise the operation of other services.

 c. Verify that DHCP Client is still running.
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Part 3: Monitor and Record System Usage with 
Administrative Tools
You will configure advanced Administrative Tool features and monitor the usage of system 
resources of the computer.

Step 1: Create a new data collector set.

 a. Navigate to Control Panel > click Administrative Tools > click Computer 
Management > expand System Tools.

 b. Expand Performance > expand Data Collector Sets > in the left pane, right-
click User Defined > select New > click Data Collector Set.

 c. In the Create new Data Collector Set window, type Memory Logs in the 
Name field. Select Create manually (Advanced) and click Next to continue.

 d. In the What type of data do you want to include? window, select Perfor-
mance counter and click Next.

 e. In the Which performance counters would you like to log? window, click 
Add. From the list of available counters, locate and expand Memory. Select 
Available MBytes > Add and click OK to continue.

 f. Set the Sample interval: field to 4 seconds. Click Next to continue.

 g. In the Where would you like the data to be saved? window, click Browse. 
Select Local Disk (C:) and select PerfLogs. Click OK to continue.

 h. Verify the correct root directory path is displayed (C:\PerfLogs), and click 
Finish to continue.

Step 2: Format the data collector set.

 a. Expand User Defined and select Memory Logs in the left pane. Right-click 
Data Collector01 and right-click Properties.
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 b. In the DataCollector01 Properties window, change the Log format: field to 
Comma Separated.

 c. Click the File tab.

What is the full path name to the example filename?

 ________________________________________________________________________

Answers may vary. For example: C:\PerfLogs\DataCollectionName\
DataCollector01.csv

 d. Click OK to continue to close the Properties window.

Step 3: Collect and view the data.

 a. Select the Memory Logs icon in the left pane of the Computer Management 
window. Right-click Memory Logs and select Start.

 b. To force the computer to use some of the available memory, open and close a 
browser.

 c. Right-click Memory Logs and select Stop to stop the data collection set.

 d. Navigate to Local Disk (C:)\PerfLogs. Click Continue in the Windows warning 
messages.

 e. Open the folder that was created to store the memory log. Click Continue on 
the Windows warning messages. Open the DataCollector01.csv file.

Select Notepad or another program that can read comma-separated files (.csv) 
to open the file if Windows cannot open the file message displayed.

What does the column farthest to the right show?

 ________________________________________________________________________

Available memory in MBytes.

 f. Close the DataCollector01.csv file.

Step 4: Clean up.

 a. Navigate to the Computer Management window. Select Performance > click 
Data Collection Sets > click User Defined. Right-click Memory Logs and 
select Delete. Click Yes to confirm the deletion.

 b. Navigate to the Local Drive C: > PerfLogs folder. Delete the stored memory 
logs folder (folder with the DataCollector01.csv) created from this lab.

 c. Close all opened windows.
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11.3.2.7 Lab–System Utilities 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use Windows utilities to configure operating system settings.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: The students will be accessing sensitive settings during this lab. Stress the 
importance of following instructions. You might want the students to delete their custom con-
sole when they have completed the lab.

Part 1: Custom Management Console
Step 1: Explore the management console.

 a. To open the Microsoft Management Console, click Start, and search for mmc. 
Click Yes to allow Microsoft Management Console to make changes to the 
computer.

 b. In the Console1 - [Console Root] window, you can build a custom console. 
Click File > Add/Remove Snap-In.

 c. In the Add or Remove Snap-Ins window, you can add a folder snap-in. Scroll 
down the Available snap-ins: pane to locate the Folder snap-in. Select Folder 
and click Add>.

 d. To add the Link to Web Address snap-in, scroll down the Available snap-
ins: pane and select Link to Web Address. Click Add>. In the Link to Web 
Address wizard window, enter http://www.cisco.com in the Path or URL: field, 
click Next> to continue.

 e. In the Friendly name for the Link to Web Address snap-in box, enter Cisco 
and click Finish to continue.
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Step 2: Create a custom management console.

 a. To add snap-ins to the folder snap-in, click Advanced.

 b. The Advanced window opens. Select Allow changing the parent snap-in. 
Click OK.

 c. A drop-down menu appears for Parent snap-in. In the Parent snap-in box, 
select Folder.

 d. Add the following snap-ins from the Available snap-ins: pane: Computer 
Management, Device Manager, and Disk Management. In each of the snap-in 
windows, click Finish to select to use the snap-in to manage the Local 
Computer or This computer.

 e. Click OK to continue to exit the Add or Remove Snap-ins window.

 f. In the Console1 window, right-click the Folder icon and select Rename. 
Change the name of the folder to Management Tools.
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 g. To save the custom console, click File > Save As. Change the filename to your 
name. Example: John’s Console. Change the Save in box to Desktop. Click 
Save.

 h. Close all open windows.

 i. On the desktop, double-click the Console icon that contains your name to re-
open the console with your snap-ins. Click Yes to allow this application to make 
changes to your device as necessary.

 j. Review the Management Tools folder by double-clicking on the tools.

 k. Within your custom console, navigate to the Event Viewer.

What was the path you use to navigate to the Event Viewer?

 ________________________________________________________________________

Your console > Management Tools > Computer Management > System Tools > 
Event Viewer

 l. Close the Console window when you finish your review. Click No when 
prompted to save the changes.

Part 2: Registry Editor
Step 1: Change your desktop background settings.

 a. Right-click the desktop > select Personalize.

What is the background picture?

 ________________________________________________________________________

Answers may vary.

 b. In Windows 10, select Solid color in the Background drop-down list. Choose a 
blue background color.

In Windows 8.1 and 7, click Desktop Background. Select Solid Colors in the 
Picture Location drop-down list. Choose a blue background color.

 c. Click Save changes. The computer screen should now have a blue background. 
If not, ask the instructor for assistance.

 d. Close all open windows.

Step 2: Open the registry editor.

 a. To open the Registry Editor, click Start and type regedit. Click Yes to allow 
Registry Editor to make changes to the computer.

Note: Do not make any changes in the Registry Editor without instructor permission.

 b. Select and expand the HKEY_CURRENT_USER entry.

 c. Expand Color Panel. Click Colors. Click Background in the right panel.
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What is the data value of the Background (hint – it has three numbers that 
correspond to red, green, and blue)?

 ________________________________________________________________________

These numbers may vary depending on the blue color that was selected for the 
background color. In the example, the numbers are 0 99 177.

Step 3: Export a registry key.

You will export the HKEY_CURRENT_USER\Control Panel\Colors folder.

 a. In the left pane, select the Colors folder and click File > Export.

 b. Save the file to the desktop with the name BlueBKG.

 c. At the desktop, right-click the BlueBKG.reg icon and select Edit.

 d. Notepad opens displaying the contents of BlueBKG.reg.

What is the data value of the Background?

 ________________________________________________________________________

Answers may vary. 0 99 177 in the example.

 e. Close the BlueBKG.reg – Notepad window.

 f. Open the Personalization window by right-clicking the desktop > Personalize > 
Desktop Background. Select a red background color.

 g. Click Save changes. Close the Personalization window.

 h. The desktop background should be red. Click the Registry Editor window.

 i. On your keyboard, press F5 to refresh the Registry Editor window.

What is the data value of the Background? Compare the new value in the 
Registry to the value saved in BlueBKG.reg.

 ________________________________________________________________________

Answers will vary. The value is for any shade of red.
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Step 4: Import a registry file.

You will import the BlueBKG.reg file to change the desktop background to blue.

 a. Click the Registry Editor window.

 b. Click File > Import. Locate and click the BlueBKG.reg file and then click Open.

 c. The Registry Editor informational message opens letting you know that keys 
and values have been successfully added to the registry. Click OK.

 d. Select the Registry Editor window.

What is the data value of the background? 

 ________________________________________________________________________

Answers may vary. It should be a value that displays a blue desktop.

What is the color of the desktop?_______________________________________

Red

 e. Restart the computer.

What is the color of the desktop? _______________________________________

Blue

 f. Reset Display Properties Background to the original settings.

 g. Close all open windows.

 h. Delete the custom console and BlueBKG file on the desktop.

Reflection
 1. Why would it be beneficial to add snap-ins to the mmc that are for other computers on 

the network?

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

Answers may vary. It would make it easy to configure and monitor other computers that do 
not have monitors, keyboards or mice, or that are not easily accessible.

 2. After restarting the computer, why was the desktop color changed?

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

Importing the registry file modified the registry to contain a value for the desktop that was 
not the same as the current value. When the computer started, this value was read from the 
registry to make the desktop that color.

Book 1.indb   360Book 1.indb   360 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 11: Windows Configuration  361

11.3.2.8 Lab–Manage System Files 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use Windows utilities to gather information about the computer.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: The students will be accessing sensitive settings during this lab. Stress the 
importance of following instructions to avoid damaging the operating system.

Step 1: Review the System Information.

 a. To open System Information, click Start > Run and type in msinfo32.

 b. Click the plus sign next to Hardware Resources, Components, and Software 
Environment. Expand the window as necessary to see all the content.

 c. Under the System Summary heading, locate and list the following:

Processor: _________________

Answers will vary. A sample answer is Intel Core i5-4430 CPU @ 3.00GHz, 3001 
Mhz, 4 Core(s), 4 Logical Processor(s)

BIOS Version/Date: _________________

Answers will vary. A sample answer is AMI 80.07, 6/5/2013.

Total Physical Memory: _________________

Answers will vary. A sample answer is 16.00 GB.

 d. Under the Hardware Resources heading, locate and list the following:

DMA channels and the device using the resources.

 ________________________________________________________________________

Answers will vary. A sample answer:

Channel 4 Direct memory access controller

 e. Under the Components heading, locate and list the following:

Adapter Description: ________________________

Answers will vary. A sample answer is Radeon RX 580 Series.

Adapter RAM: _________________________

Answers will vary. A sample answer is (1,048,576) bytes.
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 f. Under the Software Environment heading, where would you find the applica-
tions that automatically load when the computer boots?

 ________________________________________________________________________

Startup Programs

 g. Close the System Information window.

Step 2: Review the System Configuration.

 a. To open System Configuration, click Start, search for msconfig.

Note: Do not make changes in this utility without instructor permission.

 b. Click the General tab.

What are the startup options?

 ________________________________________________________________________

Normal startup, Diagnostic startup, or Selective startup.

 c. Click the Boot tab. This tab is for modifying boot options.

 d. Click the Services tab. This tab lists the computer’s services and status.

Can you enable and disable services at this tab? ____________________________

Yes

 e. Click the Startup tab.

In Windows 10 and 8.1, this tab indicates that the Task Manager is used 
to manage startup items. There is also a link to the Startup tab of the Task 
Manager on this tab.

In Windows 7, this tab lists the programs that are automatically loaded every 
time you turn on your computer.

 f. Click the Tools tab.

What can you do in this tab?

 ________________________________________________________________________

Launch the Windows built-in utilities.

 g. Click Cancel to close the System Configuration window.

Step 3: Review DirectX Diagnostics.

 a. Open the DirectX Diagnostic Tool by clicking Start, and search for dxdiag.

 b. If you are asked to have DirectX check driver signatures, click No.

When the DirectX Diagnostic Tool first opens, it may take a minute to load all 
information.

 c. Make sure the System tab is active.
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What does this tool report?

 ________________________________________________________________________

Detailed information about the DirectX components and drivers installed on the 
system.

 d. Click Next Page until you are at the Display tab.

What information is listed on this page?

 ________________________________________________________________________

Device, Drivers, and DirectX Features

 e. Click Next Page until you are at the Sound tab.

What information is listed on this page?

 ________________________________________________________________________

Device and Drivers

 f. Click Next Page until you are on the Input tab.

What information is listed on this page?

 ________________________________________________________________________

A list of input devices

 g. List any additional tabs in your DirectX Diagnostic Tool window below. What 
information is listed on these extra tabs?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary.

 h. Click Exit when finished.

Reflection
 1. Why would it be beneficial to turn off a service in the system configuration?

 

 

Answers may vary. It may be beneficial to turn off a service if that service may have become 
unresponsive or if a service is using too many resources.

 2. When would you use the Startup tab of the system configuration tool?

 

 

Answers may vary. There may be programs that you do not wish to start when the computer 
boots.
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11.3.3.8 Lab–Hard Drive Maintenance 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will examine the results of using Disk Check and Disk Defragmenter on a 
hard drive.

Instructor Note: If the hard drive is an SSD, do not let students perform the defragmentation. 
Defragmentation should not hurt the SSD, but it is not necessary with this type of drive.

Recommended Equipment
 ■ A computer running Windows

 ■ Two or more partitions on the hard drive

Step 1: Run the Error-checking tool on a disk volume.

 a. Log on to Windows as an administrator.

 b. In Windows 10 and 8.1, open the File Explorer. In Windows 7, open Windows 
Explorer.

 c. In Windows 10 and 8.1, click This PC. In Windows 7, click Computer. Verify 
that there are at least two partitions on the hard drive.

If there is only one partition on the hard drive, use Disk Management to create 
a second partition with at least 2 GB.

 d. Right-click the volume without an installed Windows OS. Click Properties.

 e. In the Properties window, click the Tools tab. In Windows 10 and 8.1, click 
Check to start the error checking. In Windows 7, click Check Now.

 f. In Windows 10 and 8.1, Windows monitors the drives and runs automatic 
scheduled scans. You may see a message saying that You don’t need to scan 
this drive. Click Scan drive (Windows 10) or Scan and repair drive or Scan 
drive (Windows 8.1).

In Windows 7, click Start to begin to check disk. You can use the default 
choices.

 g. When you receive a message that your drive or disk was successfully scanned, 
click Show details (Windows 10 and 8.1) or See details (Windows 7).

 h. In Windows 10 and 8.1, the Event Viewer opens to display the Chkdsk event. 
Double-click the Information event in the middle pane.
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In Windows 7, the Checking Disk window expands to display the details. The 
details are similar to the information displayed in the Event Viewer in Windows 
10 and 8.1.

How many stages were processed?

 ________________________________________________________________________

Answers may vary. Three stages if no problems occurred during check.

Were any problems found with the volume? If problems were found, what were 
they?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary.

 i. Click Close. Close the Event Viewer as necessary.

Step 2: Use the Disk Defragmenter tool.

Note: Do not perform this step if your computer has an SSD drive. It is unnecessary to 
defragment SSD drives.

 a. Navigate to the Properties window for the drive that does not have a Windows 
OS installation.

 b. In the Properties window, click the Tools tab. In Windows 10 and 8.1, click 
Optimize to start disk optimization. In Windows 7, click Defragment now to 
start defragmentation.

 c. In Windows 10 and 8.1, select the volume without an installed Windows OS. 
Click Analyze in the Optimize Disk window.

In Windows 7, click Analyze disk in the Disk Defragmenter window.

What percentage of the disk is fragmented?

 ________________________________________________________________________

Answers may vary.

 d. Click Optimize to start defragmenting the disk in Windows 10 and 8.1. In 
Windows 7, click Defragment disk.

What is the first process during defragmenting (see Current status or Progress 
column)? 

 ________________________________________________________________________

Analyzed.

What are the four tasks performed for each pass (see Current status or 
Progress column)?

 ________________________________________________________________________

Relocated, defragmented, and consolidated.
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How many passes did it take to defragment the drive?

 ________________________________________________________________________

Answers may vary. Six passes.

 e. When defragmenting is complete, click Close.

 f. Close all windows.

Note: It is not possible to view the detail of the defragmented hard drive through the GUI 
version of Defragmenter.
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11.3.4.6 Lab–Install Third-Party Software 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will install and remove a third-party software application supplied by your 
instructor. You will install the Packet Tracer Windows application.

Note: You can skip this lab if you already did it previously in this curriculum and Packet Tracer is 
currently installed on the PC.

Note: You should skip Part 2 if you are using Packet Tracer later in this curriculum.

Recommended Equipment
The following equipment is required for this exercise: 

 ■ A computer with Windows installed

 ■ A flash drive or CD with the latest Packet Tracer Windows install package

To download the latest version of Packet Tracer software, log in to www.netacad.com. Click 
Resources > Download Packet Tracer. Select the appropriate Packet Tracer version for your 
classroom.

Part 1: Installing Third-Party Software
Step 1: Locate the installer.

 a. Log on to the computer with the Administrator account and use Windows 
Explorer to navigate to the folder where the Packet Tracer installer is located. This 
folder could be on the local hard drive, on an external flash drive, or on a CD.

 b. Unzip the file as necessary. Locate the Packet Tracer application. The filename is 
in the form of PacketTracer??_##bit_setup.exe, where ?? is the version number 
and ## is either 32 or 64.

Step 2: Run the Installer to install Packet Tracer.

 a. Start the installation process of the Packet Tracer application. When prompted, 
click Yes to allow this app to make changes to your device.

 b. The License Agreement window opens. Select I accept the agreement, and 
then click Next.

 c. The Select Destination Location window opens. Keep the default settings and 
click Next.

What is the default installation location for Packet Tracer?

 ________________________________________________________________________

C:\Program Files\Cisco Packet Tracer 7.2. Answers may vary.
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 d. The Select Start Menu Folder window opens. Keep the default settings. 
Click Next.

 e. The Select Additional Tasks window opens. Keep the default settings. 
Click Next.

 f. The Ready to Install window opens. Click Install.

 g. The Installing progress window opens to show the progress of the installation.

 h. If an information window regarding PTSBA opens, click OK to continue.

 i. The Completing the Cisco Packet Tracer Wizard window opens. Click Finish.

 j. Be ready to provide your netacad.com credentials when Packet Tracer opens for 
the first time.

 k. If the You are running Packet Tracer for the first time window appears, click 
OK to continue.

 l. If the Windows Security Alert window opens, click Allow access after verify-
ing that you have selected private networks or domain networks as directed by 
your instructor.

Part 2: Uninstalling Third-Party Software
 a. To uninstall a program, click Control Panel > Programs and Features. Choose 

Cisco Packet Tracer in the list and right-click Uninstall.

 b. The Cisco Packet Tracer Uninstall window opens. Click Yes to confirm the 
removal.

 c. When the successfully removed from your computer message opens, click OK.

 d. Verify the application was removed. After the application removal process, the 
Programs and Features window no longer shows Cisco Packet Tracer in the list. 
Close all open windows.

 e. Future activities in this course will require the use of Packet Tracer. Reinstall 
Packet Tracer.

Reflection
Why does Microsoft recommend using Uninstall or change a program to remove an installed 
application?

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

Sometimes the uninstall software does not fully remove all of the files and settings created by 
the application during installation. The Microsoft Windows Uninstall or change a program util-
ity removes the application completely.
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11.4.1.5 Lab–Work in the Windows Command Shell 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use CLI commands to manage files and folders in Windows.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: The students can complete this lab from any of the four Windows operating 
systems. Also, students may need to change the example directory letter C if a different letter 
is used on the lab computers.

Step 1: Access the Windows command prompt.

 a. Log on to a computer as a user with administrative privileges. The account 
ITEUser is used as the example user account throughout this lab.

 b. To access the Windows command prompt, click Start and type cmd. Select 
Command Prompt or cmd.exe to continue.

Step 2: Display command help from the command prompt.

You can display command line help using the help command. For more information 
on a specific command, type the command followed by /?.

 a. At the command prompt, type help and press Enter. A list of commands is 
displayed.

 b. The results from the help command are too long to display on one page, so you 
can only readily see the last portion. To allow you to see it one page at a time, 
enter the command help | more at the prompt. The more command can pagi-
nate the results of another command when combining with | (pipe) and more.

C:\Users\ITEUser> help | more

For more information on a specific command, type HELP command-name

ASSOC          Displays or modifies file extension associations.

ATTRIB         Displays or changes file attributes.

BREAK          Sets or clears extended CTRL+C checking.

BCDEDIT         Sets properties in boot database to control boot 
loading.

CACLS           Displays or modifies access control lists (ACLs) of 
files.

CALL           Calls one batch program from another.

CD             Displays the name of or changes the current directory.

CHCP           Displays or sets the active code page number.

-- More  --
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 c. To see the next page, press the spacebar. What happens when you press Enter?

 ________________________________________________________________________

It only advances one line at a time.

 d. Press q or Ctrl-C to exit after filling out the functions of the following 
commands:

Command Function

CD Displays the name of or changes the current directory.

CHKDSK Checks a disk and displays a status report.

COPY Copies one or more files to another location.

DEL Deletes one or more files.

DIR Displays a list of files and subdirectories in a directory.

DISKPART Displays or configures Disk Partition properties.

EXIT Quits the CMD.EXE program.

FORMAT Formats a disk for use with Windows.

GPRESULT Displays Group Policy information for machine or user.

MD Creates a directory.

TASKLIST Display all currently running tasks including services.

RD Removes a directory.

ROBOCOPY Advanced utility to copy files and directory trees.

SHUTDOWN Allows proper local or remote shutdown of a computer.

XCOPY Copies files and directory trees.

 e. Type md /? at the prompt to display additional information and switches that 
can be used with this command.

C:\Users\ITEUser> md /?

Creates a directory.

MKDIR [drive:]path

MD [drive:]path

If Command Extensions are enabled MKDIR changes as follows:

MKDIR creates any intermediate directories in the path, if needed.

<some output omitted>

Use the information provided by the Help command about md. How would you 
create these folders C:\Users\ITEUser\a\b\c if your current directory is 
C:\Users\ITEUser?

 ________________________________________________________________________

Either of the following commands would accomplish the task:

C:\Users\ITEUser> md a\b\c

C:\Users\ITEUser> mkdir a\b\c
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What command would you use to verify the creation of the nested directories?

 ________________________________________________________________________

The commands are dir to list the directory and chdir or cd to change the directory.

 f. Clear the screen using the command line. What command did you use?

 ________________________________________________________________________

C:\Users\ITEUser> cls

 g. Press F7 on the keyboard for the command history. What is the last command 
that you have used? Press Esc on the keyboard to exit the dialog box.

 ________________________________________________________________________

It is probably the command cls to clear the screen.

 h. Press the up arrow to display the last command used. What is the last 
command?

 ________________________________________________________________________

It is probably the command cls to clear the screen.

 i. To exit the command prompt, enter exit at the prompt.
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11.4.2.7 Lab–File System Commands 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use CLI commands to manage files and folders in Windows.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: The students can complete this lab from any of the four Windows operating 
systems. Students may need to change the example directory letter C if a different letter is 
used on the lab computers.

Step 1: Access the Windows command prompt.

 a. Log on to a Windows computer. The account ITEUser is used as the example 
user account throughout this lab.

 b. To access the Windows command prompt, click Start and enter cmd. Select 
Command Prompt or cmd.exe to continue.

Step 2: Create and change directories.

In this step, you will use the change directory (cd), make directory (md), and 
directory (dir) commands.

Note: A directory is another word for folder. Directory and folder are used interchangeably 
throughout this lab.

 a. Type cd at the command prompt. What is the current directory?

 ________________________________________________________________________

Answers may vary. The directory C:\Users\ITEUser is used as an example for 
this lab.

 b. Type dir at the command prompt to list the files and folders that are in the 
current folder.

C:\Users\ITEUser> dir

 Volume in drive C has no label.

 Volume Serial Number is 9055-35E9

 Directory of C:\Users\ITEUser

04/27/2019  09:21 AM    <DIR>          .

04/27/2019  09:21 AM    <DIR>          ..

04/25/2019  11:39 AM    <DIR>          3D Objects

04/25/2019  11:39 AM    <DIR>          Contacts

04/26/2019  10:29 AM    <DIR>          Desktop

04/25/2019  11:39 AM    <DIR>          Documents
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04/25/2019  11:39 AM    <DIR>          Downloads

<some output omitted>

               0 File(s)             0 bytes

              15 Dir(s)  32,671,969,280        bytes free

 c. In the current directory, use the md command to create three new folders: 
ITEfolder1, ITEfolder2, and ITEfolder3. Type md ITEfolder1 and press 
Enter. Create ITEfolder2 and ITEfolder3. 

Note: The command mkdir performs the same function as the command md.

C:\Users\ITEUser> md ITEfolder1

C:\Users\ITEUser> md ITEfolder2 ITEfolder3

 d. Type dir to verify that the folders have been created.

 e. Type cd ITEfolder3 at the command prompt and press Enter. Which folder are 
you in now?

 ________________________________________________________________________

Answers may vary. The current directory is C:\Users\ITEUser\ITEfolder3 in 
this example.

 f. Create ITEfolder4 in the current directory. Within the ITEfolder4 folder, 
create a folder named ITEfolder5. Use the dir command to verify the folder 
creation. What command or commands did you use to create the nested 
folders?

 ________________________________________________________________________

 ________________________________________________________________________

This can be accomplished in one or two commands to create the folders:

C:\Users\ITEUser\ITEfolder3> md ITEfolder4\ITEfolder5

Or

C:\Users\ITEUser\ITEfolder3> md ITEfolder4

C:\Users\ITEUser\ITEfolder3> cd ITEfolder4

C:\Users\ITEUser\\ITEfolder3\ITEfolder4> md ITEfolder5

 g. Change the directory as necessary until you are in ITEfolder5.

 h. Type cd .. to change the current directory. Each .. is a shortcut to move up one 
level in the directory tree.

After issuing the cd .. command, what is your directory now?

 ________________________________________________________________________

C:\Users\ITEUser\ITEfolder3\ITEFolder4

 i. What would be the current directory if you issue this command at 
C:\Users\ITEfolder4?

 ________________________________________________________________________

C:\Users\ITEUser\ITEFolder3
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Step 3: Create text files.

 a. Navigate to the C:\Users\ITEUser\ITEfolder1 directory. Type 
cd ..\ITEfolder1 at the prompt.

 b. Type echo This is doc1.txt > doc1.txt at the command prompt. The echo 
command is used to display a message at the command prompt. The > is used 
to redirect the message from the screen to a file. For example, in the first line, 
the message This is doc1.txt is redirected into a new file named doc1.txt. Use 
the echo command and > redirect to create these files: doc2.txt, file1.txt, and 
file2.txt.

C:\Users\ITEUser\ITEfolder1> echo This is doc1.txt > doc1.txt

C:\Users\ITEUser\ITEfolder1> echo This is doc2.txt > doc2.txt

C:\Users\ITEUser\ITEfolder1> echo This is file1.txt > file1.txt

C:\Users\ITEUser\ITEfolder1> echo This is file2.txt > file2.txt

 c. Use the dir command to verify the files are in the ITEfolder1 folder.

C:\Users\ITEUser\ITEFolder1> dir

<some output omitted>

04/29/2019  08:05 AM                19 doc1.txt

04/29/2019  08:06 AM                19 doc2.txt

04/29/2019  08:08 AM                20 file1.txt

04/29/2019  08:08 AM                20 file2.txt

               4 File(s)            78 bytes

               2 Dir(s)  32,625,397,760 bytes free

 d. Use the more or type command to view the content of the newly created text 
files.

C:\Users\ITEUser\ITEfolder1> more doc1.txt

This is doc1.txt

 

C:\Users\ITEUser\ITEfolder1> type doc2.txt

This is doc2.txt

Step 4: Copy, delete, and move files.

 a. At the command prompt, type move doc2.txt C:\Users\ITEUser\ITEfolder2 
to move the file doc2.txt to the C:\Users\ITEUser\ITEfolder2 directory.

C:\Users\ITEUser\ITEfolder1> move doc2.txt 
C:\Users\ITEUser\ITEfolder2

        1 file(s) moved.

 b. Type dir at the prompt to verify that doc2.txt is no longer in the current 
directory.

 c. Navigate to C:\Users\ITEUser\ITEfolder2 to change the directory to 
ITEfolder2. Type dir at the prompt to verify doc2.txt has been moved.

 d. Type copy doc2.txt doc2_copy.txt to create a copy of doc2.txt. Type dir at 
the prompt to verify a copy of the file has been created.

C:\Users\ITEUser\ITEfolder2> dir

<some output omitted>

Directory of C:\Users\ITEUser\ITEfolder2

 

04/30/2019  09:07 AM                19 doc2.txt

04/30/2019  09:07 AM                19 doc2_copy.txt
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               2 File(s)             38 bytes

               2 Dir(s)  31,753,068,544 bytes free

 e. Use the move command to move doc2_copy.txt to ITEfolder1. Type move 
doc2_copy.txt ..\ITEfolder1.

C:\Users\ITEUser\ITEfolder2> move doc2_copy.txt ..\ITEfolder1

        1 file(s) moved.

 f. A copy of the file doc2.txt can be created in a new location using the copy 
command. At the prompt, enter the copy doc2.txt ..\ITEfolder1\doc2_new.txt.

C:\Users\ITEUser\ITEfolder2> copy doc2.txt ..\ITEfolder1\doc2_new.txt

        1 file(s) copied.

 g. The file doc2.txt can also be moved to a new location with a new filename 
using the move command. Type move doc2.txt ..\ITEfolder1\doc2_new.txt at 
the prompt.

C:\Users\ITEUser\ITEfolder2> move doc2.txt ..\ITEfolder1\doc2_move.txt

        1 file(s) moved.

 h. Type dir ..\ITEfolder1 to view the content in ITEfolder1 without leaving the 
current directory.

C:\Users\ITEUser\ITEfolder2> dir ..\ITEfolder1

<some output omitted>

 Directory of C:\Users\ITEUser\ITEfolder1

 

04/29/2019  12:08 PM    <DIR>          .

04/29/2019  12:08 PM    <DIR>          ..

04/29/2019  08:05 AM                19 doc1.txt

04/29/2019  08:06 AM                19 doc2_copy.txt

04/29/2019  08:06 AM                19 doc2_move.txt

04/29/2019  08:06 AM                19 doc2_new.txt

04/29/2019  08:08 AM                20 file1.txt

04/29/2019  08:08 AM                20 file2.txt

               6 File(s)           116 bytes

               2 Dir(s)  31,467,700,224 bytes free

 i. Change the current directory to ITEfolder1. Type cd ..\ITEfolder1 at the 
prompt.

 j. Move file1.txt and file2.txt into ITEfolder3. To move all the files that contain 
the word file into ITEfolder3 with one command, use a wildcard (*) character 
to represent one or more characters. Type move file* ..\ITEfolder3.

C:\Users\ITEUser\ITEfolder1> move file* ..\ITEfolder3

C:\Users\ITEUser\ITEfolder1\file1.txt

C:\Users\ITEUser\ITEfolder1\file2.txt

        2 file(s) moved.

 k. To view the content of the file doc2_new.txt, use the type or more command at 
the prompt.

C:\Users\ITEUser\ITEfolder1> type doc2_new.txt

This is doc2.txt
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 l. Use the ren command to rename doc2_new.txt to doc3.txt. Use the dir 
command to display the content in the directory.

c:\Users\ITEUser\ITEfolder1> ren doc2_new.txt file.log

 m. Use the type or more command to view the content of the newly renamed file 
file.log.

C:\Users\ITEUser\ITEfolder1> more file.log

This is doc2.txt

 n. To delete a file or multiple files, use the del command with the filenames at 
the prompt. What single command would you use to delete all the files with 
doc2 in the filename? Use the command to remove the files with doc2 in the 
filename.

 ________________________________________________________________________

Answers may vary. C:\Users\ITEUser\ITEfolder1> del doc2*

What command would you use to delete all the files in the directory? Use the 
command to remove the files.

 ________________________________________________________________________

Answers may vary. C:\Users\ITEUser\ITEfolder1> del *.*

Step 5: Use the xcopy and robocopy commands.

In this step, the xcopy and robocopy commands are used to copy the content in a 
directory.

 a. View the content of ITEfolder3.

C:\Users\ITEUser\ITEfolder1> dir ..\ITEfolder3

<some output omitted>

 Directory of c:\Users\ITEUser\ITEfolder3

 

04/29/2019  03:11 PM    <DIR>          .

04/29/2019  03:11 PM    <DIR>          ..

04/29/2019  03:05 PM                20 file1.txt

04/29/2019  03:05 PM                20 file2.txt

04/29/2019  03:01 PM    <DIR>          ITEfolder4

               2 File(s)            40 bytes

               3 Dir(s)  31,492,157,440 bytes free

 b. Type xcopy ..\ITEfolder3 . at the prompt to copy the content of ITEfolder3 
to ITEfolder1. Note the . at the end of the command. It is a shortcut for the 
current directory.

C:\Users\ITEUser\ITEfolder1> xcopy ..\ITEfolder3 .

..\ITEfolder3\file1.txt

..\ITEfolder3\file2.txt

2 File(s) copied

 c. At the prompt, type dir to display the content of ITEfolder1. Only the files in 
the ITEfolder3 were copied into ITEfolder1. The directory ITEfolder4 was 
not copied into ITEfolder3.

C:\Users\ITEUser\ITEfolder1> dir

<some output omitted>
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 Directory of C:\Users\ITEUser\ITEfolder1

04/29/2019  03:16 PM    <DIR>          .

04/29/2019  03:16 PM    <DIR>          ..

04/29/2019  03:05 PM                20 file1.txt

04/29/2019  03:05 PM                20 file2.txt

               2 File(s)            40 bytes

               2 Dir(s)  31,491,321,856 bytes free

 d. Use help xcopy or xcopy /? to determine which switch would allow the xcopy 
command to copy all the files and directories.

What option allows you to copy all the files and directories, including the 
empty directories?

 ________________________________________________________________________

The option is /E.

 e. Because ITEfolder4 is a subfolder and ITEfolder5 is both a subfolder and 
an empty folder, /E is needed to copy all the contents of ITEfolder3 and the 
empty subfolder.

Type xcopy /E ..\ITEfolder3 . at the prompt to copy the files. When prompt-
ed, type a to allow overwriting the existing files.

c:\Users\ITEUser\ITEfolder1> xcopy /E ..\ITEfolder3

Overwrite C:\Users\ITEUser\ITEfolder1\file1.txt (Yes/No/All)? a

..\ITEfolder3\file1.txt

..\ITEfolder3\file2.txt

2 File(s) copied

 f. Verify that ITEfolder4 and ITEfolder5 were also copied in ITEfolder1.

c:\Users\ITEUser\ITEfolder1> dir

<some output omitted>

 Directory of c:\Users\ITEUser\ITEfolder1

 

04/29/2019  04:41 PM    <DIR>          .

04/29/2019  04:41 PM    <DIR>          ..

04/29/2019  03:05 PM                20 file1.txt

04/29/2019  03:05 PM                20 file2.txt

04/29/2019  04:41 PM    <DIR>          ITEfolder4

               2 File(s)            40 bytes

               3 Dir(s)  31,493,193,728 bytes free

 

c:\Users\ITEUser\ITEfolder1> dir ITEfolder4

<some output omitted>

 Directory of c:\Users\ITEUser\ITEfolder1\ITEfolder4

 

04/29/2019  04:41 PM    <DIR>          .

04/29/2019  04:41 PM    <DIR>          ..

04/29/2019  03:00 PM    <DIR>          ITEfolder5

               0 File(s)             0 bytes

               3 Dir(s)  31,493,193,728 bytes free
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 g. The robocopy command can also be used to copy the content of a directory 
to a new destination. The robocopy command has more capabilities than the 
built-in Windows copy and xcopy command, such as resume copying after a 
network interruption, skip files that appear to be identical to the files in the 
destination folders, and mirror a directory by keeping the destination directory 
in sync with the source directory.

Copy the ITEfolder4 content to the ITEUser folder using the robocopy command.

C:\Users\ITEUser\ITEfolder1> robocopy /E 
C:\Users\ITEUser\ITEfolder3\ITEfolder4\ C:\Users\ITEUser

Note the information provided by the command during the copying process.

 h. Navigate to C:\Users\ITEUser to verify that the folder ITEfolder5 is copied.

Step 6: Delete directories.

In this step, you will delete an empty and a non-empty directory using the rd 
command.

 a. Use rd ITEfolder2 to delete the empty directory and verify that the 
directory was deleted.

C:\Users\ITEUser> rd ITEfolder2

 b. Navigate to the C:\Users\ITEUser\ITEfolder3 directory.

 c. Use rd ITEfolder1 to delete the directory. Verify the directory removal using 
the dir command.

Were you able to delete the directory? Explain.

 ________________________________________________________________________

You were not able to delete the directory because it was not empty.

 d. Use the rd /? command to determine the switch that allows the deletion of a 
non-empty directory.

c:\Users\ITEUser\ITEfolder3> rd /S ITEfolder1

ITEfolder4, Are you sure (Y/N)? y

 e. Use the appropriate commands to delete all the text files and folders that you 
have created in this lab. Type exit to close the command prompt window.

Reflection
What are the advantages of using CLI vs. GUI?

__________________________________________________________________________________

__________________________________________________________________________________

Answers may vary. For example, the commands in the CLI in Windows have not changed in the 
different Windows versions. The GUI interfaces in different Windows versions have changed 
dramatically.
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 11.4.3.2 Lab–Disk CLI Commands 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will work with disk CLI commands.

Required Resources
 ■ A Windows PC

 ■ An additional partition with an NTFS file system

Part 1: Explore the chkdsk Command
In this step, you will explore the Windows command that allows you to scan and repair disks.

 a. Open a command prompt.

 b. Open the help page the command chkdsk. Enter help chkdsk or chkdsk /? at the 
prompt to answer the following questions:

What is the option to fix errors on the drive? __________________________ /F

What is the option to force the volume to dismount first if necessary? 
__________________________ /X

What is the option to locate bad sectors and recover readable information? 
__________________________ /R

 c. Enter the chkdsk command to check the C:\ drive with the options from the questions in 
the previous step. What happened? Explain.

 

 

Access was denied because you do not have sufficient privileges.

 d. Open a Command Prompt window with elevated privileges. Click Start and search for 
Command Prompt. Within the search results, right-click Command Prompt and select 
Run as administrator.
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 e. In the Command Prompt window with elevated privileges, enter the command 
chkdsk C: /F /X /R to check the status of this drive. Enter y when prompted. 
Note the change in the prompt.

C:\Windows\system32> chkdsk C: /F /X /R

The type of the file system is NTFS.

Cannot lock current drive.

 

Chkdsk cannot run because the volume is in use by another

process.  Would you like to schedule this volume to be

checked the next time the system restarts? (Y/N) y

This volume will be checked the next time the system restarts.

Note that the volume will be checked when the system restarts the next time 
because the volume is in use and it cannot be checked at this time.

What is the file system of the drive?

 ________________________________________________________________________

Answers will vary. The common file systems available in Windows are FAT, FAT32, 
and NTFS.

 f. A second partition was created in a previous lab. You can perform the chkdsk 
command on the second partition. The I: drive will be used in this example.

C:\Windows\system32> chkdsk I: /F /X /R

The type of the file system is NTFS.

Volume label is ITEINFO.

 

Stage 1: Examining basic file system structure ...

  256 file records processed.

File verification completed.

  0 large file records processed.

  0 bad file records processed.

<some output omitted>

Part 2: Create a New Partition Using DiskPart
In this part, you will shrink the second partition on the hard drive and create a third partition.

Note: Please back up any data from the drives before proceeding in this part. A new partition will be cre-
ated by shrinking a volume, and the new partition will be formatted. All data will be erased during the 
formatting process.

Step 1: List the disks, partitions, and volume.

 a. Using a command prompt with elevated privilege, enter diskpart at the prompt.

C:\Windows\system32> diskpart

 

Microsoft DiskPart version 10.0.17763.1

 

Copyright (C) Microsoft Corporation.

On computer: DESKTOP-PUU52R2

 

DISKPART>
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 b. Notice the prompt indicating that you are in the diskpart utility. Enter help at 
the DISKPART> prompt to list the available commands within the diskpart util-
ity. You can also use the help command anytime while you are in the diskpart 
utility. For example, enter help list disk at the prompt to view more information 
about the list disk command.

DISKPART> help list disk

 

    Displays a list of disks.

 

Syntax:  LIST DISK

 

    Displays a list of disks and information about them, such as their

    size, amount of available free space, whether the disk is a basic

    or dynamic disk, and whether the disk uses the master boot record

    (MBR) or GUID partition table (GPT) partition style. The disk 
marked

    with an asterisk (*) has focus.

 c. Enter list disk at the DISKPART> prompt to list all the disks in the PC.

DISKPART> list disk

 

  Disk ###  Status            Size     Free     Dyn  Gpt

  --------  -------------    ------- -------     ---  ---

  Disk 0    Online           50 GB  1024 KB

  Disk 1    Online         5120 MB  1024 KB

Enter list partition to list all the partitions on the disk. How partitions are on 
the disk? 

 ________________________________________________________________________

Answers may vary.

 d. Enter the list partition command to list the partitions on the disk. 

Note: If you only have one disk, the disk is selected by default. If you have more than one 
disk in your PC as listed in the list disk command, you will need to select the desired disk. If 
you are interested in disk 0, enter select disk 0.

DISKPART> select disk 0

 

Disk 0 is now the selected disk.

 e. Enter list partition to list all the partitions on the selected disk.

DISKPART> list partition

  Partition ###  Type               Size  Offset

  -------------  ----------------  -------  -------

  Partition 1    Primary           549 MB  1024 KB

  Partition 2    Primary            47 GB   550 MB

  Partition 3    Primary          2047 MB    47 GB
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 f. Enter list volume to list all the volumes on the computer. This will include the 
volumes on all the disks.

DISKPART> list volume

 

Volume ###  Ltr  Label       Fs     Type        Size     Status    Info

----------  ---  -----------  -----  ----------  -------  ---------  ------

Volume 0       E                       CD-ROM         0 B     No Media

Volume 1           System Rese    NTFS    Partition      549 MB    Healthy   System

Volume 2       C                  NTFS   Partition       47 GB    Healthy   Boot

Volume 3       I    ITEINFO       NTFS   Partition      2048 MB    Healthy

Volume 4       D        SecondDisk     NTFS   Partition      5117 MB    Healthy

 g. Select the volume that will be used to create a new partition in the next step.

DISKPART> select volume 3

 

Volume 3 is the selected volume.

Step 2: Shrink a volume.

 a. Review the shrink command. Enter help shrink at the DISKPART prompt.

DISKPART> help shrink

 

    Reduces the size of the volume with focus by the specified amount. 
Makes

    free disk space available from unused space at the end of the 
volume.

 

Syntax:  SHRINK [DESIRED=<N>] [MINIMUM=<N>] [NOWAIT] [NOERR]

        SHRINK QUERYMAX [NOERR]

<some output omitted>

What option is used to determine the maximum number of bytes that the 
volume can be shrunk by?

 ________________________________________________________________________

QUERYMAX

 b. Use the shrink command with the option querymax to determine the maximum 
number of bytes that the volume can be shrunk by. What is the maximum 
number of reclaimable bytes?

 ________________________________________________________________________

Answers will vary. 

 c. Enter shrink desired=500 to reduce the size of the volume by 500 megabytes.

DISKPART> shrink desired=500

 

The maximum number of reclaimable bytes is:  500 MB

Book 1.indb   382Book 1.indb   382 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 11: Windows Configuration  383

Step 3: Create a new partition.

In the previous step, you have created 973 MB free space on the disk. In this step, 
you will create a primary partition with 500 MB with an NTFS file system.

 a. Enter create partition primary at the DISKPART prompt.

DISKPART> create partition primary

 

DiskPart succeeded in creating the specified partition.

Note: If there are already three primary partitions, you will need to create a logical partition 
instead of primary partitions.

DISKPART> create partition extended

DISKPART> create partition logical

 b. List the partition to verify that you have created a new one. Notice the asterisk 
(*) next to partition 4 to indicate the partition is currently selected.

DISKPART> list partition

 

  Partition ###  Type              Size       Offset

  -------------  ----------------   -------     -------

  Partition 1       Primary             549 MB     1024 KB

  Partition 2       Primary             47 GB      550 MB

  Partition 3       Primary           1548 MB      47 GB

* Partition 4       Primary            501 MB      49 GB

 c. List the volumes to verify that a new volume was created and is automatically 
selected. Note the file system is listed as RAW. 

DISKPART> list volume

 

Volume ### Ltr  Label          Fs     Type          Size     Status         Info

----------  ---  -----------  -----   ----------   -------   ---------  -------

Volume 0       E                         CD-ROM          0 B    No Media

Volume 1           System Rese       NTFS   Partition   549 MB    Healthy         System

Volume 2       C                     NTFS   Partition    47 GB    Healthy         Boot

Volume 3       I         ITEINFO          NTFS   Partition  1548 MB    Healthy

Volume 4       D         SecondDisk   NTFS   Partition  5117 MB    Healthy

* Volume 5                      RAW    Partition   501 MB    Healthy

 d. The new volume needs to be formatted with an appropriate file system before it 
can be used. The new volume will be formatted as NTFS, and it will be labeled 
as new.

DISKPART> format fs=ntfs label=new

 

  100 percent completed

 

DiskPart successfully formatted the volume.

 e. The new volume will be assigned as drive letter w.

DISKPART> assign letter=w

 

DiskPart successfully assigned the drive letter or mount point.
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 f. List the volume to verify the new modification.

DISKPART> list volume

 

Volume ### Ltr  Label               Fs     Type          Size     Status      Info

----------  ---  -----------       -----   ---------   -------    --------     -----

Volume 0         E                       CD-ROM          0 B    No Media

Volume 1            System Rese      NTFS   Partition    549 MB   Healthy     System

Volume 2         C                   NTFS   Partition        47 GB   Healthy     Boot

Volume 3        I           ITEINFO        NTFS   Partition   1548 MB   Healthy

Volume 4         D           SecondDisk        NTFS   Partition   5117 MB   Healthy

* Volume 5         W           new                 NTFS   Partition   501 MB    Healthy

 g. Enter exit at the DISKPART> to exit the DiskPart utility.

Step 4: Format the new volume as a FAT file system.

Formatting can also be done outside of the DiskPart utility.

 a. In an elevated command prompt, enter the format command to reformat w: 
to use a FAT32 file system. When prompted, enter new as the current volume 
label. Enter the NewVol as the new volume label.

C:\Windows\system32> format /fs:fat32 w:

The type of the file system is NTFS.

The new file system is FAT32.

Enter current volume label for drive W: new

 

WARNING, ALL DATA ON NON-REMOVABLE DISK

DRIVE W: WILL BE LOST!

Proceed with Format (Y/N)? y

Formatting 500.0 MB

Initializing the File Allocation Table (FAT)...

Volume label (11 characters, ENTER for none)? NewVol

Format complete.

     496.0 MB total disk space.

     496.0 MB are available.

 

           4,096  bytes in each allocation unit.

      126,975 allocation units available on disk.

 

             32  bits in each FAT entry.

 

Volume Serial Number is 90C2-A65F

 b. Navigate to the newly created W: drive and create folders and files, if desired.
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Part 3: Clean Up
After you have verified that the new partition is working, you will delete the newly created 
volume, and the free space will rejoin the original second partition.

 a. At the elevated command prompt, enter diskpart to return to the DiskPart utitliy.

 b. List all the disks for the computer by issuing the list disk command.

DISKPART> list disk

 

  Disk ###  Status          Size        Free     Dyn  Gpt

  --------  -------------   -------  -------   ---  ---

  Disk 0    Online               50 GB       0 B

  Disk 1    Online         5120 MB  1024 KB

 c. Select the appropriate disk that has the newly created volume.

DISKPART> select disk 0

 

Disk 0 is now the selected disk.

 d. List all the volumes for the computer by using the list volume command.

DISKPART> list volume

 

  Volume ###  Ltr  Label       Fs        Type          Size     Status     Info

  ----------  ---  -----------    ----  ---------   -------    ---------    -------

  Volume 0        E                     CD-ROM          0 B     No Media

  Volume 1           System Rese    NTFS      Partition    549 MB    Healthy     System

  Volume 2        C                  NTFS      Partition         47 GB    Healthy     Boot

  Volume 3        I   ITE         NTFS      Partition   1148 MB    Healthy

  Volume 4        W   NEWVOL      FAT32  Partition    500 MB    Healthy

  Volume 5        D   SecondDisk      NTFS      Partition   5117 MB    Healthy

 e. Select the volume that should be deleted.

DISKPART> select volume 4

 

Volume 4 is the selected volume.

 f. Delete the volume using the delete volume command.

DISKPART> delete volume

 

DiskPart successfully deleted the volume.

 g. Verify that the volume has been deleted by using the list volume command.

DISKPART> list volume

 

  Volume ###  Ltr  Label       Fs        Type          Size     Status     Info

  ----------  ---  -----------    ----  ---------   -------    ---------    -------

  Volume 0        E                     CD-ROM          0 B     No Media

  Volume 1           System Rese    NTFS      Partition    549 MB    Healthy     System

  Volume 2        C                  NTFS      Partition         47 GB    Healthy     Boot

  Volume 3        I   ITE         NTFS      Partition   1148 MB    Healthy

  Volume 4        D   SecondDisk      NTFS      Partition   5117 MB    Healthy
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 h. Now you can recover the free space from the deleted volume 4 by extending volume 3 to 
include the free space. Select volume 3 and use the extend 
command to extend volume 3.

DISKPART> select volume 3

 

Volume 3 is the selected volume.

 

DISKPART> extend

 

DiskPart successfully extended the volume.

 i. Use the list partition command to verify that the newly created partition was deleted 
and the shrunk partition is back to the original capacity.

DISKPART> list partition

 

  Partition ###  Type              Size     Offset

  -------------  ----------------   -------  -------

  Partition 1    Primary            549 MB  1024 KB

  Partition 2    Primary             47 GB   550 MB

  Partition 3    Primary           2049 MB    47 GB

 j. Enter exit at the DISKPART> to exit the DiskPart utility.
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11.4.4.2 Lab–Task and System CLI Commands  

(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will work with task and system CLI commands.

Required Resources
 ■ 1 PC with Windows installed

Part 1: Task CLI Commands
The tasklist command shows the running processes on a computer, while the taskkill command 
terminates running processes. These two commands can be used on a remote computer. These 
commands can be filtered and targeted using the available options for the commands. In this 
lab, the username ITEUser is used in the examples.

Step 1: The tasklist command

 a. Open Notepad. Open Internet Explorer. If Internet Explorer is not available, use 
Microsoft Edge instead.

 b. Open a command prompt. At the prompt, enter the tasklist command.

C:\Users\ITEUser> tasklist

What command would you use to display the results of tasklist one page at a time?

 ________________________________________________________________________

The command would be tasklist | more.

 c. Enter the tasklist help command to review the syntax and options for the 
tasklist command.

C:\Users\ITEUser> tasklist /?

Or

C:\Users\ITEUser> help tasklist

What is the option to list the modules that are associated with a task?   /M

What command would you use if you want to find all the tasks that use the 
module oleaut32.dll? List a few tasks that use oleaut32.dll.

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. The command is tasklist /M oleaut32.dll. Wildcard * can also be 
substituted for part of oleaut32.dll. An example would be tasklist /M ole32*. Some 
of the examples are notepad.exe, explorer.exe, iexplorer.exe, and MicrosoftEdge.exe.
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Using the options available with tasklist, you can filter the tasklist results for 
specific image name, such as notepad.exe for notepad. Record the PID for the 
next step.

C:\Users\ITEUser> tasklist /FI "imagename eq notepad.exe"

Image Name       PID  Session Name       Session#    Mem Usage

=============== ===  ================ =========== ============

notepad.exe       3128 Console          1          14,016 K

What command would you use to find out all the tasks that are associated with 
your username?

_________________________________________________________________________

Answers will vary. In this example, the command would be tasklist /fi "username eq 
iteuser". Substitute your username for iteuser in the example.

What command would you use to find out all the processes that have been run-
ning for more than 1 hour and 40 minutes?

 ________________________________________________________________________

The command is tasklist /FI "cputime gt 01:40:00".

Step 2: The taskkill command

The Task Manager can be used to terminate a process. However, sometimes a rogue 
process may need to be terminated manually using the CLI command taskkill. The 
taskkill command may save you from having to force an unscheduled reboot of the 
system. 

 a. Use the taskkill help command to review the command syntax and the available 
options.

C:\Users\ITEUser> taskkill /?

What command would you use if you wanted to terminate all processes owned 
by a particular user?

 ________________________________________________________________________

Answers may vary. In this example, you would use “taskkill /FI “username eq 
ITEUser”.

Note: If you ran the command from the previous step, reopen Notepad and Internet Explorer. 
Use the tasklist command to list the PID for notepad.exe.

 b. Use the PID for notepad.exe that you have recorded in the previous step. The 
PID 3128 is used in this example.

C:\Users\ITEUser> taskkill /PID 3128

SUCCESS: Sent termination signal to the process with PID 3128.

 c. The Notepad application should be closed. Also, use the tasklist command to 
verify that the process has been terminated.
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 d. Use the /IM option to use the name of the process with the taskkill command 
to end the process. Internet Explorer (iexplore.exe) 

C:\Users\ITEUser> taskkill /IM iexplore.exe

SUCCESS: Sent termination signal to the process "iexplore.exe" with PID 
3916.

SUCCESS: Sent termination signal to the process "iexplore.exe" with PID 
6740.

 e. Depending on the Windows version, Internet Explorer may not be closed. You 
may need to add /T to terminate the associated child process.

C:\Users\ITEUser> taskkill /IM iexplore.exe /T

SUCCESS: Sent termination signal to process with PID 6740, child of PID 
3916.

SUCCESS: Sent termination signal to process with PID 3916, child of PID 
2828.

 f. Sometimes you may have to forcefully terminate a process. To forcibly 
terminate a process, add the /F option to the taskkill command.

C:\Users\ITEUser> taskkill /IM iexplore.exe /T /F

SUCCESS: The process with PID 6740 (child process of PID 3916) has been 
terminated.

SUCCESS: The process with PID 3916 (child process of PID 2828) has been 
terminated.

 g. Verify that Internet Explorer is closed.

Part 2: System CLI Commands
Step 1: The sfc command

When you encounter random errors, issues during boot, or some of the Windows 
components are not working properly, the System File Checker (sfc) can scan the 
integrity of the system and replace any corrupted or missing system files with a 
known good version.

 a. Open a command prompt with administrative privileges.

 b. Review the syntax and options of the sfc command.

C:\Windows\system32> sfc /?

What option would you use if you only wanted to scan the integrity of all the 
protected system files?

 ________________________________________________________________________

/verifyonly

 c. Use the /scannow option when you want to scan and repair all the protected 
system files.

C:\Windows\system32> sfc /scannow

 

Beginning system scan.  This process will take some time.

 

Beginning verification phase of system scan.

Verification 2% complete.

<output omitted>
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Step 2: The dism command

Deployment Image Servicing and Management (DISM) is a Windows command-line 
utility that is used to service and prepare Windows images. For example, you can 
use DISM to manage the information included within the Windows image or service 
the image itself, for example adding or removing drivers or upgrading to a higher 
Windows edition.

In this step, you will be reviewing the options with this command and list all the 
available drivers without making changes to the operating system.

 a. To see the available options for the dism command, enter dism at a command 
prompt with administrative privileges. The available options are different 
depending on your Windows version.

C:\Windows\system32> dism

 

Deployment Image Servicing and Management tool

Version: 10.0.17763.1

 

 

DISM.exe [dism_options] {Imaging_command} [<Imaging_arguments>]

DISM.exe {/Image:<path_to_offline_image> | /Online} [dism_options]

         {servicing_command} [<servicing_arguments>]

<output omitted>

 b. To learn more information about the running operating system, enter dism 
/online /? to see the available options.

C:\Windows\system32> dism /online /?

 c. While using dism, you can learn more information about the third-party drivers 
in the running operating system. Enter dism /online /get-drivers at the prompt.

C:\Windows\system32> dism /online /get-drivers

 d. To see all the drivers, the /all options can be added to the command.

C:\Windows\system32> dism /online /get-drivers /all

 e. To make things easier to read, you can format the output into a table by adding 
the /format:table option.

C:\Windows\system32> dism /online /get-drivers /all /format:table

What would you add to the command so you can view the output one page at 
a time?

 ________________________________________________________________________

Add | more to the end of the command; so the command becomes dism /online /
get-drivers /all /format:table | more

 f. The driver results can be saved to a text file if necessary. Using the >, a new file 
C:\Users\ITEUser\Drivers_Results.txt is created, and the results are written into 
this new file. If you want to append more results to this file, you will replace > 
with >> so the file is not overwritten with new information.

C:\Windows\system32> dism /online /get-drivers /all /format:table > C:\
Users\ITEUser\Drivers_Results.txt
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 g. Use the more or type command to verify the creation of the text file.

C:\Windows\system32> more C:\Users\ITEUser\Drivers_Results.txt

 

Deployment Image Servicing and Management tool

Version: 10.0.17763.1

 

Image Version: 10.0.17763.475

<some output omitted>

Step 3: The shutdown command

If your computer becomes unable to shutdown via the Start Menu, the command-
line shutdown command can come in handy.

 a. In a command prompt, enter shutdown at the prompt. Review the syntax and 
available options for shutting down the computer via the command line.

C:\Windows\systme32> shutdown

Usage: shutdown [/i | /l | /s | /sg | /r | /g | /a | /p | /h | /e | 
/o] [/hybrid] [/soft] [/fw] [/f]

    [/m \\computer][/t xxx][/d [p|u:]xx:yy [/c "comment"]]

<output omitted>

Notice the options to shut down or restart a remote computer, add comments 
regarding the reason for restart or shutdown, and the ability to set a time-out 
period before the shutdown.

Enter the command to log off your computer. Record the command below.

 ________________________________________________________________________

C:\Windows\system32> shutdown /l

 b. Log back into the computer and shut it down in 120 seconds using the com-
mand line. Record the command below. What warning message did you see?

 ________________________________________________________________________

C:\Windows\system32> shutdown /s /t 30. Windows will shut down in 2 minutes.

What command would you use to abort the shutdown?

 ________________________________________________________________________

C:\Windows\system32> shutdown /a
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11.4.5.3 Lab–Other Useful Commands 

(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will work with other useful commands.

Required Resources
 ■ A Windows computer

 ■ A shared network resource and the credentials provided by the instructor

Instructor Note: Please provide a shared network resource the students can access. Please also 
provide the credentials to access the resource.

Part 1: The Group Policy CLI
Step 1: The gpupdate command

The gpupdate command is used to update Group Policies settings.

 a. Open a command prompt. At the prompt, enter gpupdate /? to review the 
syntax and available options.

C:\Users\ITEUser> gpupdate /?

Description:  Updates multiple Group Policy settings.

 

Syntax:  Gpupdate [/Target:{Computer | User}] [/Force] [/Wait:<value>]

     [/Logoff] [/Boot] [/Sync]

 b. By default, the gpupdate command only updates if the group policy has 
changed. To force a background update of all Group Policy settings, regardless 
of if they have changed, use gpupdate /force.

C:\Users\ITEUser> gpupdate /force

Updating policy...

 

Computer Policy update has completed successfully.

User Policy update has completed successfully.

Step 2: The gpresult command

The gpresult command is used to review the Group Policy settings that are in effect.

 a. Open a command prompt. At the prompt, enter gpresult /? to review the syntax 
and available options.

C:\Users\ITEUser> gpresult /?

Book 1.indb   392Book 1.indb   392 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 11: Windows Configuration  393

 b. To display the Resultant Set of Policy (RSoP) summary data, enter the gpresult 
/R at the prompt.

C:\Users\ITEUser> gpresult /R

 

Microsoft (R) Windows (R) Operating System Group Policy Result tool 
v2.0

© 2018 Microsoft Corporation. All rights reserved.

 

Created on 5/10/2019 at 5:04:22 PM

 

 

RSOP data for DESKTOP-PUU52R2\ITEUser on DESKTOP-PUU52R2 : Logging Mode

------------------------------------------------------------------------

 

OS Configuration:            Standalone Workstation

OS Version:                  10.0.17763

Site Name:                   N/A

Roaming Profile:             N/A

Local Profile:               C:\Users\ITEUser

Connected over a slow link?:  No

<output omitted>

 c. If you want to save the report in an HTML format, enter the gpresult /H 
GPReport.html at the prompt. C:\Users\ITEUser\GPReport.html is used as 
an example. If the file already exists, add /F to the command to overwrite the 
existing version.

C:\Users\ITEUser> gpresult /H GPReport.html

 d. To review the HTML version of the file, navigate to the file using Window 
Explorer or File Explorer. Double-click the file to open it.

Part 2: The net Command
The net command is used to manage the network and view its settings. In this part, you will 
only explore the net, net use, and net user commands.

When using the net command by itself, open a command prompt and enter net command to 
review the syntax of the command and to list the subset of commands for the net command.

C:\Users\ITEUser> net

The syntax of this command is:

 

NET

    [ ACCOUNTS | COMPUTER | CONFIG | CONTINUE | FILE | GROUP | HELP |

      HELPMSG | LOCALGROUP | PAUSE | SESSION | SHARE | START |

      STATISTICS | STOP | TIME | USE | USER | VIEW ]
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Step 1: The net user command

The net user command is used to manage the users on a computer. With the options 
of the net user command, you can list the users, review user settings, and add or 
delete user accounts.

 a. Open a command prompt, and enter net user /? at the prompt to review the 
syntax of the command.

C:\Users\ITEUser> net user /?

The syntax of this command is:

 

NET USER

[username [password | *] [options]] [/DOMAIN]

         username {password | *} /ADD [options] [/DOMAIN]

         username [/DELETE] [/DOMAIN]

         username [/TIMES:{times | ALL}]

         username [/ACTIVE: {YES | NO}]

 b. At the prompt, enter net user to list the user accounts on the computer.

C:\Users\ITEUser> net user

 

User accounts for \\DESKTOP-PUU52R2

 

------------------------------------------------------------------------

Administrator               DefaultAccount           Guest

ITEUser                  WDAGUtilityAccount

The command completed successfully.

 c. To view the settings for a specific user, enter net user username, where 
username is the desired username. The user account ITEUser is used in this 
example.

C:\Users\ITEUser> net user ITEUser

User name                     ITEUser

Full Name

Comment

User's comment

Country/region code          000 (System Default)

Account active               Yes

Account expires              Never

 d. With elevated privileges, you can add or remove a user account. For example, 
to add a new user, User1, open a prompt with elevated privileges, and enter the 
command net user User1 ITEPassword /add, where ITEPassword is the pass-
word for the new user.

C:\Windows\system32> net user User1 ITEPassword /add

The command completed successfully.

 e. Use the net user command to verify the user has been created.

When does the password expire?  Answer varies.
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 f. The /delete option can be used to delete the user account.

C:\Windows\system32> net user User1 /delete

The command completed successfully.

Step 2: The net use command

The net use command is used to display information about shared resources on the 
network. This command lists the resources that you are currently connected to; it 
can also connect to new resources and disconnect from connected ones.

 a. In a command prompt, enter net use /? to review the syntax and options 
available.

C:\Users\ITEUser> net use /?

The syntax of this command is:

 

NET USE

[devicename | *] [\\computername\sharename[\volume] [password | *]]

        [/USER:[domainname\]username]

        [/USER:[dotted domain name\]username]

<output omitted>

 b. To view the current network connections, enter net use at the prompt. You will 
receive the following results if you are not connected to network resources.

C:\Users\ITEUser> net use

New connections will not be remembered.

 

There are no entries in the list.

 c. Record the network resource information provided by your instructor.

Network Resource: ______________________________________ Answers may vary.

Username: _____________________________________ Answers may vary.

Password: _____________________________________ Answers may vary.

 d. At the prompt, enter the net user * “Network Resource” \user:username 

password. Replace Network Resource with the information record above. In 
this example, \\ITE-8\Users\ITE is the network resource. The asterisk * allows 
the computer to choose an available drive letter to assign to the resource. The 
username is ITE and the password is ITEPassword.

C:\Users\ITEUser> net use * "\\ITE-8\Users\ITE" /user:ITE ITEPassword

Drive Y: is now connected to \\ITE-8\Users\ITE.

 

The command completed successfully.
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 e. Use the net use command to verify the newly connected resource.

C:\Users\ITEUser> net use

New connections will not be remembered.

 

Status       Local     Remote                    Network

 

--------------------------------------------------------------------

OK           Y:        \\ITE-8\Users\ITE         Microsoft Windows 
Network

The command completed successfully.

What is the local drive letter assigned to the connected resource? 

Answers vary. It is Y: in this example.

 f. At the prompt, navigate to the assigned drive letter. In this example, Y: is the 
assigned drive letter.

C:\Users\ITEUser> Y:

 g. Use the file system CLI command to navigate the directory tree. Navigate back 
to your original directory when done.

 h. To disconnect from the connected resource, enter net use Y: /delete at the 
prompt. The drive letter Y: is used in this example.

C:\Users\ITEUser> net use Y: /delete

Y: was deleted successfully.

If you received the following message, you can reply N to the question, close 
the opened files and directories, and rerun the command. Or you can enter Y 
and force them to close and disconnect from the resource. By forcibly closing a 
network connection, you may lose any unsaved changes.

There are open files and/or incomplete directory searches pending on 
the connection to Y:.

 

Is it OK to continue disconnecting and force them closed? (Y/N) [N]:
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11.5.1.6 Lab–Network Drive Mapping 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will map a network drive provided by your instructor.

Required Resources
 ■ A Windows PC

 ■ A shared network resource provided by the instructor

Instructor Note: Please provide a shared network resource and an administrative network 
resource that the students can access. Please also provide the credentials to access the 
resources.

For the administrative share, right-click the resource to be shared and select Properties. Click 
Advanced Sharing. Click Share this folder and provide a shared name with a $ at the end of 
the share name. Provide the share name and the associated credentials to the students.

Step 1: Record the network resource information.

Record the network resource information provided by your instructor.

Network share: ________________________________ Answer varies.

Username: ____________________________________ Answer varies.

Password: _____________________________________ Answer varies.

Administrative share: ___________________________ Answer varies.

Username: ____________________________________ Answer varies.

Password: _____________________________________ Answer varies.

Step 2: Map a network drive.

 a. In Windows 8.1 and 10, open File Explorer. In Windows 7, open Windows 
Explorer.

 b. Scroll down the left panel to Network. If you are prompted with the message 
that network discovery and file sharing are turned off, click the message and 
select Turn on network discovery and file sharing.

 c. Click the server name in the left panel and right-click the Network share 
recorded in the previous step. Select Map network drive.

 d. In the Map Network Drive, select a different available drive letter in the drive 
drop-down list if desired. Verify the Folder field is the same as the \\server\share 
recorded above. Click Reconnect at sign-in if desired. Click Finish.

 e. Enter the username and password recorded in the previous step. Click 
Remember my credentials if desired. Click OK to continue.

Book 1.indb   397Book 1.indb   397 01/10/19   9:27 PM01/10/19   9:27 PM



398  IT Essentials Version 7, Labs & Study Guide

What is the local drive letter assigned to the connected resource? 
_____________________________ Answers vary.

 f. If it is successful, File Explorer or Window Explorer opens and displays the 
content of the newly connected resource.

Step 3: Map an administrative share.

 a. In Windows 8.1 and 10, open File Explorer. Right-click This PC and select Map 
network drive. In Windows 7, open Windows Explorer. Right-click Computer 
and select Map network drive.

 b. In the Map Network Drive, select a different available drive letter in the drive 
drop-down list if desired. Enter the name of the network resource recorded in 
the previous step in the form of \\server\share. Click Reconnect at sign-in if 
desired. Click Finish.

 c. Enter the username and password recorded in the previous step. Click Remem-
ber my credentials if desired. Click OK to continue.

What is the local drive letter assigned to the connected resource? 
_____________________________ Answers vary.

 d. If it is successful, File Explorer or Window Explorer opens and displays the 
content of the newly connected resource.

 e. To disconnect the resource permanently, right-click the resource and select 
Disconnect.
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11.5.2.4 Lab–Share Resources (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will work with another student. You will create and share a folder. You will also 
set permissions for the share so your partner will only have read access.

Recommended Equipment
 ■ Two Windows computers on the same local network

Instructions

Part 1: Verify Network Settings for Sharing
In this part, you will set up the Windows computer for sharing. In order for the computer to 
share its resources using the default sharing setting provided by Windows, the network 
settings need to be set to private network. 

 a. Navigate to the Control Panel. In the Small icons view, select Network and Sharing 
Center.

 b. Under the View your active networks heading, verify that the network is listed as private. 
For Windows 7, it should be listed as Home network.

  If the network is not listed as private or Home network:

  Windows 10: Click Start, and search for Settings. In the Settings window, select Net-
work & Internet > Ethernet. In the Ethernet window, select the desired connected net-
work. Under the network profile, select Private.

  Window 8.1: Click Start, and search for PC Settings. In PC Settings, click 
Network. In the Ethernet window, select the desired connected network. In the Find 
devices and content section, make sure On is selected.

  Windows 7: In the Network and Sharing Center window, click Public network or 
Work network. Select Home network and click Close. Verify that the 
network location is set to Home network.

Note: If the Create a Homegroup window displays, click Cancel. A homegroup will not be used in 
this lab.

 c. In the left panel, click Change advanced sharing settings. Verify that Network 
discovery and File and printer sharing are turned on in the Private profile. 

 d. In Windows 8.1 and 10, expand the All Networks profile as necessary. Select Turn off 
password protected sharing. Click Save changes to continue.

  For Windows 7, under the Home or Work profile, turn on Turn off password protected 
sharing. Click Save changes to continue.
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Part 2: Sharing Resources
In this part, you will prepare a folder to be shared on the local network. The other users, for 
example, your partner, on the local network will only have read access to your shared folder.

Step 1: Prepare to share a folder in Windows.

 a. Click Start > Control Panel > Folder Options.

 b. Click the View tab. Uncheck the Use Sharing Wizard (Recommended) check 
box, and then click OK.

Step 2: Create the folder to be shared.

 a. Right-click any empty area on the desktop, and then choose New > Folder to 
create a new folder on the desktop.

 b. Name the folder ShareXX, where XX are your initials. Create a text file named 
Brief.txt in the folder with the following text: This is an example document.

Step 3: Share the folder.

 a. Right-click the ShareXX folder, and then choose Properties > select the 
Sharing Tab > click Advanced Sharing.

 b. Select the Share this folder check box, and then click OK. Click Close to close 
the ShareXX Properties window.

 c. Click Start > Control Panel > System.

Questions:

What is the name of your computer? Provide your computer name and shared folder 
name to your partner.

  ________________________________________________________________________

Answers may vary.

What is the name of your partner’s computer and shared folder from your 
partner?

 ________________________________________________________________________

Answers may vary.

Step 4: Access a shared folder on a remote computer.

 a. Click Start > enter the shared folder name, for example, \\PartnerComputer\
ShareXX. Notice that PartnerComputer is the name of your partner’s computer 
and ShareXX is the name of the shared folder.

When you have successfully accessed the resource, the content in the folder 
ShareXX is displayed.

Questions:

Can you open the Brief file?

  ________________________________________________________________________

Yes
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Can you delete the Brief file? What happens?

  ________________________________________________________________________

No. Access is denied.

 b. Click Cancel to continue.

Step 5: Change the permissions of a shared folder.

 a. Right-click the ShareXX folder, and then choose Properties > select the 
Sharing tab > click Advanced Sharing > click Permissions.

Questions:

What are the default permissions?

  ________________________________________________________________________

Everyone has Read permissions.

What needs to be changed to allow any remote users to make changes in the 
ShareXX folder?

  ________________________________________________________________________

Everyone should also have Change and Full Control permissions.

 b. Allow Everyone to change the contents of the ShareXX folder by checking the 
box on the Allow column and Change row. Click OK to close the Permissions 
window. Click OK to close the Advanced Sharing window. Click Close to exit 
the Example Properties window.

 c. After your partner has made the same permission changes for his shared folder, 
navigate to the ShareXX folder again using the same path.

Questions:

Can you open the Brief file?

  ________________________________________________________________________

Yes

Can you delete the Brief file? What happens?

  ________________________________________________________________________

Yes. Access is granted this time.

What can you do to assign a drive letter to your partner’s shared folder?

  ________________________________________________________________________

Map the shared folder to a drive letter using Map network drive.

 d. Delete the shared folder ShareXX and close all the open windows.
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11.5.4.2 Lab–Connect and Test the Wireless 
Connection (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you and your partner will connect your computers to a wireless router and test the 
wireless connection.

Required Resources
 ■ Wireless router

 ■ Two Windows computers

 ■ Internet access

Instructor Note: Depending on the available class time, you may want to configure the wire-
less routers and provide the students with wireless router settings for step 1, instead of the 
students configuring the wireless router with default settings.

Step 1: Configure the wireless router as necessary.

If the wireless router has been restored to default factory settings, you and your 
partner should configure the wireless router with the settings provided by your 
instructor. If not, record the information provided by your instructor and go to the 
next step.

Router IP address/Subnet:   

DHCP Server Starting IP address/Maximum number of users:   

Router Administrative Username/Password:   

Router Username/Password:   

Your Assigned SSID:   

Wireless Security Option and Passphrase:   

Note: Only use configurations assigned by the instructor.

Step 2: Connect your Windows computer to the router wirelessly.

 a. Disconnect the Ethernet cable from your computer.

 b. Click the network icon in the system tray. You will see a list of wireless net-
works that are broadcasting their SSIDs within the range of your computer.

 c. Select your assigned SSID. Select Connect automatically if you are planning to 
connect to it again.

 d. Click Connect and provide the passphrase when prompted.

 e. After you have successfully connected to the wireless network, determine and 
record your IP address and the default gateway.

 ________________________________________________________________________
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Answers will vary. The IP address and the default gateway should be in the same 
network.

 f. Provide your IP address to your partner.

 g. Open a command prompt, and ping 127.0.0.1 to test the loopback.

How many replies did you receive? ______________________________ 4

Why would you perform this test?

 ________________________________________________________________________

This test is performed to make sure the network card itself is working properly.

 h. Ping the default gateway. It should be successful if you are connected to your 
wireless router.

 i. Attempt to ping your partner’s computer. It should be successful. If it is not 
successful, the Windows Firewall may have prevented the ICMP traffic.

Step 3: Disable SSID broadcast on the wireless router.

You can disable the SSID broadcast on your wireless router. This could prevent 
unauthorized users from connecting to the wireless network, but it is not a security 
feature.

 a. Log into the wireless router.

 b. Navigate to the wireless settings and search the page for disabling SSID broad-
cast for your wireless router. SSID broadcast is usually enabled by default. Refer 
to the manufacturer’s documentation as needed.

 c. Change the SSID so you are required to connect to a new wireless network. 
Record the new SSID.

 ________________________________________________________________________

Answers will vary.

 d. Verify that the settings have been saved.

Step 4: Connect to the hidden wireless network.

Now that the SSID is no longer broadcast, it will not show in the list of wireless net-
works. You will need to manually set up a new wireless connection.

 a. Navigate to the Control Panel. In the Small icon view, select Network and 
Sharing Center.

 b. Click Set up a new connection or network. Select Manually connect to a 
wireless network. Click Next.

 c. Select the wireless adapter if you have more than one. Click Next to continue.

 d. Provide the network name (SSID), the security type, the encryption type, and 
the security key.

 e. If you would like to start this connection automatically, select the check box.

 f. Select Connect even if the network is not broadcasting so your computer can 
connect to the hidden network.

 g. Click Next to continue. Click Close.
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 h. After you are connected to the hidden wireless network, verify your IP address 
has not changed. If it was changed, provide this information to your partner. 
Then verify that you can ping your partner and the wireless router.

 i. Restore the wireless router to the previous state or as directed by your 
instructor.

Step 5: Connect to a wireless network with Internet access.

In this step, you will connect to a wireless network with Internet access. If you 
cannot do it wirelessly, you can connect via an Ethernet cable for this step.

 a. Use the tracert command to Cisco Networking Academy website. At the 
prompt, enter tracert www.netacad.com.

C:\Users\ITEUser> tracert www.netacad.com

 

Tracing route to user-att-99-118-152-0.e7792.dsca.akamaiedge.net 
[2600:1417:4:19a::1e70]

over a maximum of 30 hops:

 

  1     *        *         *         Request timed out.

  2     *        *         *         Request timed out.

  3    24 ms    21 ms    29 ms  2001:506:6000:11d:75:29:8:133

  4    43 ms    90 ms    58 ms  sl9mo404me3.ipv6.att.net 
[2001:1890:ff:ffff:12:122:126:13]

  5    59 ms    29 ms    21 ms  2001:1890:fff:2130:12:120:34:194

  6    28 ms    33 ms    31 ms  2001:1890:1ff:2a30:12:120:168:64

  7    21 ms    21 ms    26 ms  g2600-1417-0004-019a-0000-0000-
0000-1e70.deploy.static.akamaitechnologies.com [2600:1417:4:19a::1e70]

 

Trace complete.

What IP address was returned?

 ________________________________________________________________________

Answers may vary. It may be an IPv4 or an IPv6 address.

How many devices (hops) are displayed?

 ________________________________________________________________________

Answers may vary. There is a maximum limit of 30.

Why would you perform this test?

 ________________________________________________________________________

This test shows that you have a connection all the way to the Internet destination.

If you would like the tracert to display the results with IPv4 addresses only, 
what tracert options would you use in the command?

 ________________________________________________________________________

The option -4 would be added to the command, so the command becomes tracert 
-4 www.netacad.com in this example.

 b. Use the nslookup command with the IP address you just discovered. For this 
example, enter nslookup 2600:1417:4:;19a::1e70 at the prompt.
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What name was returned?

 ________________________________________________________________________

Answers may vary. Deploy.static.akamaitechnologies.com

Why would you perform this test?

 ________________________________________________________________________

This test shows that DNS is working.

Step 6: Test your Internet connection.

In this step, you will navigate to the Cisco website if you have Internet access.

 a. Open a web browser.

 b. Enter www.cisco.com in the Address field.

 c. Navigate to the Control Panel > click Network and Sharing Center > select 
Change adapter settings.

 d. Right-click the Wireless Network Connection > select Status.

What is the state of the media?

 ________________________________________________________________________

Enabled

What is the signal quality?

 ________________________________________________________________________

Answer vary. Five bars

 g. Click Close.

Reflection
 1. What information does a positive response from the default gateway provide for you 

when the computer has no Internet connection?

 

 

This indicates that there are no problems on the network between your computer and the 
default gateway.

 2. If you receive a positive response from the default gateway, but you have no Internet 
access, where is the problem?

 

 

The problem is either with your equipment between your router and the ISP, or with the ISP 
itself.
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11.5.5.3 Packet Tracer–Using Telnet and SSH 

(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will use Packet Tracer to establish remote sessions to two routers using Telnet 
and SSH. You may also install a third-party terminal emulation program and access a dedicated 
SSH server provided by your instructor.

Required Resources
 ■ Windows computer

 ■ Cisco Packet Tracer

Optional Resources
 ■ PuTTY, Tera Term, or other terminal emulation programs

 ■ An SSH server for students to access

Instructor Note: OpenSSH server can be installed in Linux for students to access via SSH. 
User accounts are needed for student access.

Part 1: Simulated Remote Access Using Packet Tracer
Step 1: Telnet access to East

In this step, you will access the command line of the router East.

 a. Open PC0. Navigate to the Desktop tab.

 b. Select Command Prompt.

 c. Enter telnet 209.165.200.225 at the prompt, where 209.165.200.225 is the 
IP address of the router East.

 d. When prompted for the credentials, enter ITEUser for the username and 
ITEPassword as the password.

 e. After your credentials are validated, you will be at prompt of the router East.

 f. Enter exit to exit the East router.

Step 2: SSH

In this step, you will access the command line of the router West.

 a. Enter ssh –l ITEUser 209.165.200.226 at the prompt, where 209.165.200.226 
is the IP address of the router West and ITEUser is the username for access. 

Note: The syntax of the SSH could depend on the type of server.

 b. When prompted for the password, enter ITEPassword.

Book 1.indb   406Book 1.indb   406 01/10/19   9:27 PM01/10/19   9:27 PM



Chapter 11: Windows Configuration  407

 c. After your credentials are validated, you will be at prompt of the router West.

 d. Enter exit to quit the session.

Part 2: SSH Using Physical Equipment (Optional)
Step 1: Prepare for SSH.

 a. Install a third-party terminal emulation program, such as PuTTy, as instructed 
by your instructor.

 b. Record the IP address, user credentials and other settings as necessary for 
SSH access.

IP Address:    Answers will vary.

Username:   Answers will vary.

Password:   Answers will vary.

Other settings:   Answers will vary.

Step 2: Remote Access

In this step, PuTTy is used as an example.

 a. Open PuTTy.

 b. In the Host Name (or IP address) field, enter the IP address recorded above.

 c. Verify that the connection type is SSH. Verify the port number for SSH. 
Change as necessary with the Other settings recorded above.

What is the default port for SSH? _____________________________________ 22
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11.5.6.2 Lab–Windows Remote Desktop and 
Assistance (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will partner with another student so you can configure a Remote Desktop 
connection for your partner and invite your partner to provide assistance on your computer via 
a Remote Assistance connection.

Required Resources
 ■ Two Windows computers on the same local network

Instructions

Part 1: Windows Remote Desktop
Windows Remote Desktop is a feature that allows a remote user to initiate a connection at any 
time and sign on to a local machine using an authorized account. This allows the user to work 
as if physically connected to the local machine. Remote Desktop can be useful for someone 
working from home who needs to access files and resources on the computer at work.

Step 1: Enable Remote Desktop.

There are a number of ways to access the Remote Desktop utility. In Windows 10, 
you can type remote desktop settings in the Windows search bar or right-click 
Start and choose Settings from the list, as demonstrated in the Remote Desktop and 
Remote Assistance video.

For Windows 10:

 a. Click Start and search for remote desktop settings.

 b. Click the Enable Remote Desktop button to the On position. You may be 
prompted with a message to confirm enabling Remote Desktop. Click Confirm. 
When Remote Desktop is enabled, you will have access to more settings related 
to Remote Desktop connections.

 c. Scroll down to How to connect to this PC.

Question:

Record the name of this computer.

 ________________________________________________________________________

Answers will vary.
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 d. Click Advanced settings.

Question:

What is the current Remote Desktop Port?

 ________________________________________________________________________

The default port is 3389.

For Windows 7, 8.1, and 10:

You can also use the Control Panel to access the Remote Desktop settings.

 a. Click Start and open the Control Panel. In the small icons view, select System. 
Click Remote settings.

 b. For Windows 8.1 and 10, in the Remote tab, select Allow connections only 
from computers running Remote Desktop with Network Level Authentica-
tion (recommended).

For Windows 7, in the Remote tab, select Allow connections only from 
computers running Remote Desktop with Network Level Authentication 
(more secure).

Note: If you are unsuccessful with Remote Desktop connection with Windows 7 as the 
server, you may need to change the Remote Desktop settings in Windows 7 to Allow con-
nections from computers running any version of Remote Desktop (less secure).

 c. You can also use this computer’s IP address for a Remote Desktop connection. 
Record the IP address.

Question:

What CLI command would you use to get the IP address?

 ________________________________________________________________________

The IP address will vary. The CLI command is ipconfig.

Step 2: Add a user that can remotely access the computer.

In this step, you will add a user account that will be authorized to access this 
computer through Remote Desktop.

Add a local user to your computer using your preferred method based on the 
Windows version. This new user will not be associated with online Microsoft 
accounts. Create a username and password combination and record it below:

Username:

 ________________________________________________________________________

Answers will vary.

Password:

 ________________________________________________________________________

Answers will vary.
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For Windows 10:

 a. Return to the Remote Desktop window and click Select users that can 
remotely access this PC under User Accounts. This opens the Remote 
Desktop Users window.

 b. Click the Add button and type in the name of the new user account you 
created in the Enter the object names select box and then click OK.

For Windows 7, 8.1, and 10:

You can also use the Control Panel to access the Remote Desktop settings.

 a. Click Start and open the Control Panel. In the small icons view, select System. 
Click Remote settings.

 b. In the Remote tab, click Select Users.

 c. Click the Add button and type in the name of the new user account you 
created in the Enter the object names select box, and then click OK. Your 
computer is now ready for Remote Desktop access. 

Step 3: Connect to your partner’s computer using Remote Desktop.

In this step, you will switch computers with your partner. You will need to take 
turns to log into your computer using your partner’s computer.

 a. Click Start and search for Remote Desktop Connection.

 b. In the Remote Desktop Connection window, enter the host name or IP address 
of the computer you recorded in a previous step, and then click Connect.

 c. In the Windows Security window, enter the username and password for the 
account created in a previous step. If you are prompted with a certificate 
warning message, click Yes.

 d. You will also be prompted with a message if another user is currently logged 
into the computer. The message will let you know another user is signed onto 
the computer and the user will be disconnected. Do you want to sign in? 
Click Yes.

Question:

What message is displayed on the remote computer, and how much time is 
mentioned?

 ________________________________________________________________________

The user on the remote computer has 30 seconds to deny the Remote Desktop 
connection or approve it. If the user on the remote computer does nothing, the 
Remote Desktop is allowed after 30 seconds.

The Remote Desktop connection should now be established. You will have full 
control of your computer as if you are physically using that machine.
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Step 4: End the Remote Desktop connection.

End the Remote Desktop connection by either clicking on the “x” at the top of 
the Remote Desktop screen or clicking the Windows power button on the Remote 
Desktop and select Disconnect.

Part 2: Remote Assistance
Windows Remote Assistance allows a user to invite someone she trusts, such as a 
technician or a coworker, to access her computer remotely to help fix a problem. 
The helper can connect and join a session with the user. This session can include 
an interactive desktop, so the helper can control the user’s computer. Remote 
Assistance assigns a port dynamically, which can make it difficult to configure 
through firewalls and is thus best suited for local network support.

Step 1: Enable Remote Assistance.

You and your partner will enable Remote Assistance and send your partner an 
invitation to Remote Assistance sessions.

 a. Navigate to the Control Panel. Select System in the Small icon view. Click 
Remote settings.

 b. In the Remote tab, select Allow Remote Assistance connections to this 
computer.

 c. Click Advanced. The default amount of time invitations can be increased to is 
as many as 99 days or as little as 1 minute.

Question:

What is the default amount of time Remote Assistance invitations remain open?

 ________________________________________________________________________

The default is 6 hours.

 d. Click Cancel to return to the Remote tab, and then click OK.

 e. In Windows 8.1 and 10, navigate to the Control Panel. Search for remote assis-
tance in the Search Control Panel field in the upper right-hand corner of the 
Control Panel. Select Invite someone to connect to your PC and help you, or 
offer to help someone else.

In Windows 7, click Start and search for Windows remote assistance.

 f. In the Windows Remote Assistance window, select Invite someone you trust to 
help you.
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 g. Click Save this invitation as a file. Save the file in a directory of your choice. 
After the file is saved, a Windows Remote Assistance pop-up window will open 
with the invitation password to give to your trusted helper.

Question:

What are the ways to send an invitation to a trusted person with Remote 
Assistance?

 ________________________________________________________________________

A saved invitation file, via an email invitation, or using Easy Connect.

 h. Email the invitation file and password to the trusted person.

Note: This is a single-use invitation. A new invitation and password are needed for a new 
Remote Assistance session.

Step 2: Use Remote Assistance.

You and your partner will take turns being the helper.

 a. Open the email containing the Remote Assistance invitation from your partner.

 b. In the Remote Assistance window, enter the password that was also sent in the 
email to connect to the remote computer, and click OK.

 c. A pop-up Windows Remote Assistance window on your partner’s computer 
prompts your partner to allow the remote connection. Click Yes to allow remote 
assistance.

 d. Remote Assistance is now working, and the partner’s desktop should appear on 
your computer.

Note: Unlike Remote Desktop, with Remote Assistance, both users are logged onto the same 
computer at the same time, and both can see the desktop.

 e. Currently, you can see your partner’s computer and can observe your partner’s 
actions on her computer. Control must be requested before you can perform the 
functions on your partner’s computer via Remote Assistance.

On your computer, click Request Control in the top-left corner of the 
Windows Remote Assistance window. A pop-up window will appear on your 
partner’s computer asking to allow your partner to share control of the desktop. 
Your partner must click Yes.

Test control of your partner’s computer from your computer. From your 
computer, you should be able to launch programs and new windows.

 f. Either user can terminate the Remote Assistance session by closing the Win-
dows Remote Assistance window on the corresponding user’s computer.

 g. Exchange your roles and repeat this step.
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Reflection Questions
 1. What type of scenarios are most appropriate for Remote Assistance in contrast with 

Remote Desktop?

 

Answers may vary but should include that Remote Assistance is best suited in helping a user 
troubleshoot issues on his computer. Remote Desktop is best suited for a user who needs to 
remotely connect to a different computer to access resources.

 2. How many simultaneous users can access a Windows computer at a single time?

 

Only one user can access the Windows desktop at a time. If a local user is on a computer, he 
is disconnected. If the local user returns, the Remote Desktop connection is disconnected.

 3. What type of security components are implemented with Windows Remote Desktop?

 

Answers may vary but should include authentication and encryption.

 4. How could Remote Desktop be used as a beneficial technology in the workplace?

 

Answers will vary but may include remote connectivity to control a computer/server at a 
remote site or room.
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11.6.1.2 Lab–Manage the Startup Folder 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will customize the Startup Folder and the Run Key in the Registry to manage 
what applications are started automatically when Windows starts. You will also use the Startup 
tab to manage the programs already added to the Startup Folder.

Recommended Equipment
 ■ A computer running Windows

Instructor Note: Make sure there is a Run key in the following Registry location. Click 
Search, type regedit, and press Enter. Expand the following key: HKEY_CURRENT_USER > 
Software > Microsoft > Windows > CurrentVersion. To create a Run Key, right-click the 
CurrentVersion key, click New > Key, type Run, and press Enter.

Instructions
Step 1: Customize the Startup folder.

 a. To add a program to the Startup folder, you must first locate it and create 
a shortcut. Open File Explorer and navigate to C:\Program Files\Internet 
Explorer.

 b. Locate the Internet Explorer executable file, iexplorer.exe. Right-click the 
iexplorer.exe file, click Send to, and select Desktop (create shortcut). This will 
create a shortcut to Internet Explorer on the desktop.

Note: Depending on your computer settings, the file extension may not be shown.

 c. Close the File Explorer window.

 d. To access the Startup folder in Windows, click Search, type run, and press 
Enter.

 e. The Run window opens. Type shell:startup and press Enter.

 f. The Startup window opens. Move the Internet Explorer shortcut, previously 
created on the desktop, to the Startup folder by dragging it from the desktop to 
the Windows Explorer window.

Question:

Now that the Internet Explorer shortcut has been added to the Startup folder, what 
should happen after the computer is rebooted?

 ________________________________________________________________________

The Internet browser should automatically run after you log on to the computer.
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 g. Restart the computer. 

Question:

Did Internet Explorer automatically open after the boot process was complete?

 ________________________________________________________________________

Yes, the browser should automatically run after you log on to the computer.

 h. Close Internet Explorer.

Step 2: Review computer settings in Task Manager.

 a. Open the Task Manager by right-clicking the taskbar at the bottom of the 
desktop. Select Task Manager from the menu. 

Note: Only desktop applications can be added to the Startup tab. Windows Modern UI apps 
(Windows Apps) are not allowed to start automatically with Windows.

 b. To access more features, click More details at the bottom of the Task Manager 
window. You should see the Processes tab of Task Manager. 

 c. Click the Startup tab. A list of applications is displayed that will be started 
automatically when Windows starts. Notice that Internet Explorer is listed.

 d. Close all windows.

Step 3: Manage startup applications using the Windows Registry.

The Windows Registry is a tree-like structure that can be used to configure many 
different aspects of Windows. 

 a. To edit the Registry, open regedit. Click Search, type regedit, and press Enter. 

 b. The Registry Editor window opens. Expand HKEY_CURRENT_USER > 
Software > Microsoft > Windows > CurrentVersion > Run.

Note: Incorrect changes to the Registry can cause computer errors or instability.

 c. Right-click anywhere in the white space in the right pane of the Registry Editor 
window.

 d. Select New and click String Value.

 e. A new String Value is created. 

 f. Click anywhere in the white space of the window. Right-click New Value #1, 
and select Rename.

 g. Type Notepad for the new name and press Enter.

 h. Right-click Notepad and select Modify…. 

 i. Type C:\Windows\System32\notepad.exe in the Value name: field and 
click OK.
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 j. Close the Registry Editor window.

 k. Restart the computer.

Question:

What happens when you log in?

 ________________________________________________________________________

Internet Explorer and Notepad start automatically.

 l. Close all open Windows.

Step 4: Remove applications from Startup.

You can use the Startup tab to manage what applications continue to run automati-
cally in future reboots. 

 a. Right-click the taskbar and select Task Manager. 

 b. Click More details and select the Startup tab. The Startup tab now shows 
Internet Explorer and Notepad.

 c. Stop Internet Explorer from automatically starting after reboots by right-
clicking Internet Explorer and selecting Disable. While Internet Explorer is still 
listed under the Startup tab, it will no longer be automatically started after a 
reboot.

 d. Do the same for Notepad by right-clicking Notepad and selecting Disable.

Question:

What does the Startup impact column indicate?

 ________________________________________________________________________

It indicates the level of impact the program will have on the startup process.

Reflection Question
Why would a user want to stop programs from starting automatically?

 

Some programs add themselves to the Startup folder upon installation. Having too many pro-
grams starting automatically can slow down the computer, delaying the boot process. As it can 
be seen in the Startup tab, Windows displays the impact level of the programs added to the 
Startup folder to help users decide what programs should be automatically started after boot.
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11.6.1.5 Lab–Schedule a Task Using the GUI and the 
Command Line (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will schedule a task using the Windows Task Scheduler utility. You will then 
make changes to your task and test your task by running it.

Recommended Equipment
 ■ A computer running Windows

Instructions

Part 1: Schedule a Task Using the GUI
Step 1: Open the task scheduler utility.

 a. Log on to Windows as an administrator.

 b. Click Control Panel > System and Security > Administrative Tools > Task 
Scheduler.

Step 2: Run the Create Basic Task Wizard.

 a. Click Create Basic Task in the Actions pane.

 b. On the Create a Basic Task screen of the Create Basic Task Wizard window, 
type Disk Cleanup in the Name: field, and then click Next.

 c. On the Task Trigger screen, select the Weekly radio button. Click Next.

 d. On the Weekly screen, use the scroll buttons in the Start: field to set the time 
to 6:00:00 PM. Set the Recur every _ weeks on: field to 1. Check the Friday 
check box. Click Next. 

 e. On the Action screen, make sure Start a program is selected. Click Next.

 f. On the Start a program screen, click Browse.

 g. Type cle in the File name: field, select cleanmgr.exe, and click Open.

 h. The Start a Program screen re-opens with C:\Windows\System32\cleanmgr.
exe added to the Program/script: field. Click Next.

 i. Review the Summary screen and click Finish.

Step 3: Review and make changes to your scheduled task.

 a. In the left pane of the Task Scheduler window, select Task Schedule Library. 

Note: You may need to click Refresh to see the new Disk Cleanup task you created.
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 b. Select the task Disk Cleanup and then click Properties in the right pane.

 c. The Disk Cleanup Properties (Local Computer) window opens. In the 
Configure for: drop-down menu, select Windows 10.

 d. Click the Actions tab. Select the Start a program row, and then click Edit.

 e. In the Edit Action window, type /d c: in the Add Arguments (optional): field. 
Click OK.

The /d c: argument tells the cleanmgr.exe program to clean the C: drive.

 f. To close the Disk Cleanup Properties (Local Computer) window, click OK.

Step 4: Run the scheduled task now.

 a. Select the Disk Cleanup task and click Run in the right pane of the Task 
Scheduler window.

 b. Click the Disk Cleanup icon that appears on the taskbar.

 c. The Disk Cleanup window is brought to the foreground. This window displays 
the status of the Disk Cleanup process.

Note: It may take a few minutes for Disk Cleanup to complete.

 d. Once the Disk Cleanup process completes, the Disk Cleanup for Local Disk 
(C:) window opens. Click Cancel.

Note: Clicking OK will delete the files selected in the Files to delete: box. Check with your 
instructor before clicking OK. Clicking OK will open the Disk Cleanup verification window 
asking if you are sure you want to permanently delete these files. It is not necessary to delete 
these files to complete this lab. If you are sure you want to delete these files permanently, 
click Delete Files.

Step 5: Delete a scheduled task.

 a. To delete the Disk Cleanup task you created, select the Disk Cleanup task and 
click Delete in the right pane of the Task Scheduler window. 

 b. The Task Scheduler verification window opens asking if you want to delete this 
task. Click Yes.

 c. Verify the Disk Cleanup task you created is removed from the Task Scheduler 
window. Close Task Scheduler.

Part 2: Schedule a Task Using the CLI
Step 1: Schedule a task.

 a. Open the command prompt. In the Windows search, type cmd to open the 
command prompt.

The syntax for creating a task in the CLI is as follows:

SCHTASKS /CREATE /SC DAILY /TN "FOLDERPATH\TASKNAME" /TR 
"C:\SOURCE\FOLDER\APP-OR-SCRIPT" /ST HH:MM
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 b. Type the following command to create a daily task to run an app at 11:00 a.m.

SCHTASKS /CREATE /SC DAILY /TN "MyTasks\Notepad task" /TR 
"C:\Windows\System32\notepad.exe" /ST 11:00

Note: The folder path before the task name, under the /TN option, is not a requirement, but 
it will help keep tasks separate. If no path is specified, the task will be created inside the Task 
Scheduler Library folder. 

Question:

When might it be useful to use the CLI to schedule a task rather than the GUI?

 ________________________________________________________________________

Answers may vary but could include instances when an administrator needs to 
speed up the process creating the same task on multiple computers.

Step 2: Run the scheduled task.

To start a scheduled task immediately, use the schtasks /run /tn <TaskName> 
command. The run operation ignores the schedule.

SCHTASKS /RUN /TN "MyTasks\Notepad task"

Step 3: Change a scheduled task.

 a. Open the command prompt. In the Windows search, type cmd to open the 
command prompt. 

 b. Type the following command to change the daily task to run an app at 9:00 a.m. 
instead of 11:00 a.m.

SCHTASKS /CHANGE /TN "MyTasks\Notepad task" /ST 09:00

Step 4: Delete a scheduled task.

 a. Open the command prompt. In the Windows search, type cmd to open the 
command prompt. 

 b. Type the following command to delete the daily task.

SCHTASKS /DELETE /TN "MyTasks\Notepad task"

Reflection Question
What other weekly tasks would be useful to run in Task Scheduler?

 

Answers will vary. A good weekly task would be to back up personal files to another disk. 

Note: This may be a good classroom discussion question. It might be useful to inform the 
students that many system tasks, like defrag, are already configured by default in the Task 
Scheduler. These tasks can be reviewed by clicking on the arrow to the left of the Task 
Scheduler Library folder in the left pane of Task Scheduler. 
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11.6.2.4 Lab–System Restore and Hard Drive 
Backup (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will create a restore point and use it to restore your computer. You will also 
configure a hard drive backup.

Recommended Equipment
 ■ A computer running Windows

 ■ A second partition to store backup or an external drive

Part 1: System Restore
Step 1: Create a restore point.

 a. Open Control Panel > select System > select System Protection. 

 b. In the System Protection tab, click Create. 

 c. Click the System Protection tab in the System Properties window and then 
click Create.

 d. In the Create a restore point window, enter Application Installed and click 
Create.

 e. You will be notified in the Systems Protection window when the restore point 
has been created successfully. Close the message window when done.

 f. Click OK to close the System Properties window.

Step 2: Work in the System Restore utility.

 a. In the Control Panel, select Recovery. Click Open System Restore. 

 b. The System Restore window opens. Click Next.

 c. A list of restore points is displayed in the System Restore window. Search for 
the one named Application Installed if there is more than one in the list.

What type of restore point did you create in the previous step?

 ________________________________________________________________________

A manual restore point.

 d. Close all open windows.
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Step 3: Enable Windows web server.

In this step, you will enable the Windows web server, Internet Information Services.

 a. Open the Control Panel. In the Small icon view, select Programs and Features. 
Click Turn Windows features on or off in the left panel to access Windows 
Features.

 b. In the Windows Features window, select Internet Information Services. Click 
OK to continue.

 c. When the message displays Windows completed the requested changes, click 
Close.

 d. Close all remaining open windows.

 e. Open a web browser. Navigate to http://localhost. The IIS default page will 
open.

 f. Close the browser.

Step 4: Verify that you successfully installed the IIS service.

 a. Click Control Panel > Administrative Tools > Internet Information Services 
(IIS) Manager.

 b. If the Internet Information Services (IIS) Manager window opens asking Do 
you want to get started with Microsoft Web Platform to stay connected with 
the latest Web Platform Components? click No.

 c. Close all open windows.

Step 5: Save a new document in the Documents folder.

 a. Create a text document with the following text: This is a test for a Restore 
Point.

 b. Save the document as Restore Point Test file in the Documents folder.

Step 6: Restore the computer back to the restore point you created in a previous step.

 a. Click Control Panel > click Recovery > click Open System Restore.

 b. In the System Restore window, select the Application Installed restore point 
that was created in step 1 and click Next.

 c. The Confirm your restore point window opens. Click Finish.

 d. A warning message window opens telling you that the System Restore process 
should not be interrupted once it begins, and asks if you want to continue. 
Click Yes to start the system restore process.

Note: Windows will restart the computer to complete the System Restore process. 
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Step 7: Verify that the System Restore process completed successfully.

The operating system restores to the point before the IIS application was installed. 
This can take several minutes to complete.

 a. Log on to the computer if required.

 b. Click Close when the System Restore window opens to inform you that the 
System Restore completed successfully.

 c. From the Control Panel, click Administrative Tools.

Is the IIS Manager application listed?

 ________________________________________________________________________

No, IIS Manager is no longer available.

 d. Open a web browser and navigate to http://localhost.

Did the IIS Server page display?

 ________________________________________________________________________

No, the IIS Server is no longer installed on the computer.

 e. Close the web browser.

 f. Open File Explorer or Windows Explorer, and navigate to the Documents 
folder.

Is the Restore Point Test File.txt in this folder? If so, are the contents the same 
in this document? Why?

 ________________________________________________________________________

Yes, the txt document should be in the Documents folder, and it should still contain 
the sentence that was saved in the previous step. The system restore process does 
not affect user documents.

 g. Close all open windows.

Part 2: Hard Drive Backup (Windows 8 and 10)
Microsoft introduced a new way to protect your data files in Windows 8 called File 
History. File History supersedes the Backup and Restore features of Windows 7 and 
functions similarly to Apple’s Time Machine application, where it periodically 
(hourly by default) scans the file system and copies any changed files to another 
partition or external drive. Over time, a complete history of file changes can be 
viewed and restored, using the new Restore personal files utility. In this lab, you will 
turn on the File History utility and allow it to back up your data files. You will then 
use the Restore personal files utility to restore some of your data files.

Step 1: Open the File History tool.

 a. Log on to the computer as an administrator.

 b. Navigate to the Control Panel. In the Small Icon view, click File History. (In 
Windows 10, Settings > Update & Security > Backup)
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 c. In the File History window, click Turn on to turn on File History. File History is 
turned off by default.

Where will File History save files?

 ________________________________________________________________________

Answers will vary. The data files in this lab will be saved to a second partition on 
the hard drive.

 d. Note the options that are available on the left side of the window. In Windows 
10, these options are also available: Backup > More options.

File History will save your data files when you turn it on. It displays a time-
stamp of the save in the File History is on box. You can click Run now, at any 
time, to have File History save your files immediately.

Step 2: Create and save two text files on the desktop.

 a. Save a text file with the text This is the original text in file one on the desktop 
named File One.

 b. Save a text file with the text The text in this file will be changed on the desk-
top named File Two.

Step 3: Run File History a second time.

 a. Navigate to File History. (Control Panel > in Small icon view, click File 
History.)

 b. Click Run now to create a backup of the newly created files.

Step 4: Use the Restore personal files utility to view File History.

 a. In the File History window, click Restore personal files.

 b. The Home – File History window displays the date and time of the last backup, 
along with file folder and library icons to navigate the backup locations. There 
are also file history navigation controls at the bottom of the window. Double-
click on the Desktop folder.

 c. The Desktop – File History window displays the two text files that you saved 
to the desktop. Notice at the top of the window, to the right of the date and 
time of the backup, it displays 2 of 2. These numbers are telling you that this 
is the second backup of two. Click the left arrow icon on the bottom of the 
window.

 d. Notice the timestamp changes to an earlier date and time, and the numbers to 
the right of the timestamp change to 1 of 2. You are now looking at the first 
backup, made immediately after you turned on File History. File One and File 
Two are no longer showing.

Why are the two text files missing from the Desktop folder of the first backup?

 ________________________________________________________________________

The text files had not been created yet. This view is showing what files were avail-
able at the timestamp listed.

 e. Close the Desktop – File History window.
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Step 5: Make changes to the text files on the desktop and create another backup history.

 a. Right-click File One and select Delete. To delete it permanently, empty the 
Recycle Bin.

 b. Edit File Two by adding the following text: This was added in step 5 of the 
lab. Save your changes.

 c. Navigate to the File History window and click Run now to create another save 
to the File History.

Step 6: Open the Restore personal files utility to review the File History.

 a. In the File History window, click Restore personal files. Navigate to the 
Desktop folder.

What files are shown in the Desktop folder for the most recent backup?

 ________________________________________________________________________

Just File Two. File One was deleted from the desktop prior to the last save.

 b. Click the Previous version icon at the bottom of the screen to view the way the 
desktop looked before the last save.

Step 7: Restore user files.

 a. Select File One from the 2 of 3 File History window, and then click the green 
Restore icon at the bottom-center of the window.

 b. When the Desktop window opens, notice that File One is back on the desktop. 
Close the Desktop window.

 c. Navigate back to the Desktop – File History window, and select and restore 
File Two. In the Replace or Skip Files window, click Replace the file in the 
destination.

 d. The Desktop window opens with File Two highlighted. Close all open windows.

 e. You should be able to locate both File One and File Two on your desktop. Open 
File Two.

 f. Notice that the second line that you added to File Two is now missing.

How would you use File History to restore the second line back into File Two?

 ________________________________________________________________________

 ________________________________________________________________________

Answers may vary. All that you would need to do is use the Restore personal files 
option in the File History utility, make sure the 3 of 3 save is selected, select File 
Two, and click Restore.

 g. Close all open windows.

Step 8: Delete text files and turn off File History.

 a. Delete File One and File Two from the desktop.

b. Turn off File History. (Control panel > File History)
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Part 3: Hard Drive Backup (Windows 7)
Step 1: Create backup files.

 a. Log on to the computer as an administrator. 

 b. Create a text file on the desktop called Backup File One with the following 
text: The text in this file will not be changed.

 c. Create another text file on the desktop called Backup File Two with the 
following text: The text in this file will be changed.

Note: Remove all extra folders and files from the computer's desktop. This will help to reduce 
the length of time to complete the backup for this lab.

Step 2: Open the Backup and Restore tool.

 a. Navigate to the Control Panel > in Small icon view, click Backup and Restore.

 b. Click Set up backup to start a new backup or click Change settings to edit the 
settings. Select the location where the backup will be stored. Click Next.

Note: If you are using the second partition, you will receive a warning message about using 
the same physical disk. You can ignore the message for the purpose of this lab. This is not a 
recommended practice outside of the classroom.

 c. Select Let me choose on the What do you want to back up? screen. Click Next 
to continue.

 d. Expand the current user account so you can view the different libraries that you 
can back up. Click What files are excluded by default from the backup? and 
list the excluded files.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Program files, files stored on a FAT file system, Files in the Recycle Bin, and 
Temporary files on a drive smaller than 1 GB.

 e. Close the Windows Help and Support window.

 f. Expand Additional Locations and make sure only Desktop is selected. Make 
sure no other location is selected. Remove the check mark from Include a 
system image of drives. Click Next to continue.

 g. In the Review your backup settings screen, click Change schedule.

 h. In the How often do you want to back up? screen, select Run backup on a 
schedule (recommended). Set the following conditions and then click OK to 
continue.

How often: Daily

What day: blank

What time: 2:00 AM
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Which files will be backed up? 

 ________________________________________________________________________

New files that have been added to the desktop and existing desktop files that have 
been changed.

Step 3: Run the backup.

 a. To test the backup configuration, click Back up now. To view the progress of 
the backup, click View Details. The Windows Backup is currently in progress 
screen is displayed. When the Windows Backup has completed successfully 
message appears, click Close.

 b. Review the information beneath the Backup section of the Backup and Restore 
window. When will the next backup take place?

 ________________________________________________________________________

Answers will vary; it will likely be 2:00 AM tomorrow.

What is the state of the schedule?   On

Step 4: Delete and restore files.

 a. Navigate to the desktop and delete Backup File One and Backup File Two 
permanently by emptying the Recycle Bin.

b. Navigate back to the Control Panel > click Backup and Restore. Under the 
Restore heading, click Select another backup to restore files from.

 c. In the Select the backup that you want to restore files from screen, select the 
location where the files are stored. Click Next to continue.

 d. In the Browse or search your backup for files and folders to restore screen, click 
Browse for files.

 e. In the Browse the backup for files window, click the current user’s backup. 
Open the Desktop folder and locate the files Backup File One and Backup File 
Two. Select both files and click Add files.

 f. Verify that the two files are listed for restoration. Click Next to continue.

 g. In the Where do you want to save the restored files? screen, select In the origi-
nal location. Click Restore to continue. Review the message in the Your files 
have been restored screen, and click Finish.

 h. Navigate to the desktop. Are the two files restored to the desktop? Yes

Step 5: Modify, back up, delete, and restore a file.

 a. Edit file Backup File Two. Add the following text More text added. to the file. 
Save the file.

 b. Navigate back to the Backup and Restore window and click Back up now.

 c. Permanently delete Backup File Two from the desktop.
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 d. Navigate back to the Backup and Restore window and click Select another 
backup to restore files from to restore Backup File Two. Refer to the previous 
step as needed.

Navigate to the desktop. Open file Backup File Two. What text is in the file?

 ________________________________________________________________________

The text in this file will be changed. More text added.

Step 6: Clean up.

 a. Delete the files Backup File One and Backup File Two.

 b. Perform a System Restore using the saved restored point from a previous part in 
this lab.

Reflection
 1. When would be a good time to create a manual restore point? Why?

 

Answers will vary. A good time to create a restore point is before installing new software on 
the computer. If the software has an adverse effect on the computer, you can use System 
Restore to revert to the way it was before installing the software without losing any changes 
to documents made after the restore point was created.

 2. When File History has been activated, how often does it automatically save your data 
files?

Hourly.

 3. How would you change the default save settings in File History?

You can change the default save settings by clicking on Advanced settings in File History. The 
Advanced Settings window allows you to change how often save copies of files are made. You 
can also change how long files are kept.
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11.7.3.2 Lab–Troubleshoot Operating System 
Problems (Instructor Version)

Introduction
In this lab, you will diagnose the cause of various operating system problems and solve them.

Recommended Equipment
 ■ A computer with Windows installed

 ■ Windows installation media

Scenario
You must solve operating system problems for a customer. Make sure you document and solve 
the problems, and then document the solutions.

There are several possible errors. Follow through the lab, solving one problem at a time until 
you can successfully start the computer, the desktop contains the appropriate open programs, 
and the display is set to the native resolution or the resolution given to you by your instructor.

Lab Setup

Note: Set up a computer with one or more of the problems in the list below.

List of Problems:

 1) The computer will not boot.

 2) The display resolution is not correct for the monitor.

 3) Change mouse to left-handed setting.

 4) Increase or decrease mouse speeds or keyboard repeat speeds.

 5) Change keyboard input language settings to a different language.

 6) Provide student with incorrect standard user account information. However, provide 
correct information for an account with administrative privileges.

Note: Students may not solve problems in the same order shown in the instructor document. 
Students might notice more than one problem at a time while troubleshooting. Remind 
students to correct and document one problem at a time.

Problem 1: Unable to boot into Windows

Delete bootmgr from the 100 MB System Reserved partition:

To delete the file bootmgr, you must assign a drive letter to the 100 MB System Reserved 
partition, unhide the file, take ownership of the file, and change the permission settings of 
the file.
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 a. Assign a drive letter to the 100 MB System Reserved partition. Start > select Control 
Panel > select Administrative Tools > click Computer Management > click Disk Manage-
ment > right-click the System Reserved partition > click Change Drive Letter and Paths > 
click Add > assign a letter to the System Reserved partition, such as the letter S > click OK. 
Close the Computer Management window.

 b. Click Start > Control Panel > click File Explorer Options or Folder Options > click 
View tab. Select the radio button Show hidden files, folders, and drives.

 c. Uncheck the box next to Hide protected operating system files (Recommended) and 
then click Yes when prompted with the Warning window.

 d. Click OK to accept all changes and close the File Explorer Options or Folder Options 
window.

 e. Navigate to the System Reserved (S:) window so it is active. Right-click bootmgr > 
Properties.

 f. Select the Security tab > Advanced.

 g. In Windows 10 and 8.1, click Change. Enter the user you are logged on as > click OK > 
click OK.

  In Windows 7, select the Owner tab > Edit. Select the user you are logged on as > 
click OK > click OK.

 h. Click OK to close all open windows.

 i. Navigate to the System Reserved (S:) window. Right-click bootmgr > select Properties > 
Security tab > Edit.

 j. Select the user you are logged on as > click in the Full control box > OK > OK.

 k. Right-click bootmgr > select Delete. Click Yes if prompted.

 l. Restart the computer.

Restore bootmgr in Windows 7:

Start the computer with the Windows installation media and run the Startup Repair to replace 
missing startup files.

 a. Insert the Windows installation media in the optical drive and restart the computer.

 b. Make sure that the optical drive is set as the first boot device.

 c. Press any key when you are asked to Press any key to boot from CD or DVD. 

 d. Click Next at the Install Windows window.

 e. Click Repair your computer.

 f. Select the operating system you wish to repair in the System Recovery Options and 
click Next.

 g. Click Startup Repair.

 h. Click Finish when the Restart your computer to complete the repairs window appears.

 i. The computer should now successfully boot to Windows 7.
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Restore bootmgr in Windows 8

 a. Start the computer and press F8 to access the boot options. Alternatively, open the 
Settings charm and click the Power button. Hold the Shift key and click Restart.

Note: If the Windows installation media is available, insert the installation media in the optical 
drive and restart the computer. Make sure that the optical drive is set as the first boot device. 
Press any key when you are asked to Press any key to boot from CD or DVD. Click Next at 
the Install Windows window. Click Repair your computer.

 b. Click Troubleshoot.

 c. Click Advanced options.

 d. Click Startup Repair in Windows 10 and 8.1. In Windows 8.0, select Automatic Repair.

 e. Select the target operating system.

 f. When prompted, choose the account to repair and enter the password.

 g. The computer should now successfully boot to Windows 8.

Problem 2: Undesired display resolution:

Decrease the resolution of the monitor to the lowest possible setting in the list of available 
resolutions.

 a. Right-click the desktop and select Display Settings or Screen resolution.

 b. Decrease the screen resolution to the lowest possible setting.

 c. Click OK > Keep changes.

 d. Close the Personalization window.

Restore the desired screen resolution:

 a. Right-click the desktop and select Screen resolution.

 b. Increase the screen resolution to the native resolution or the original resolution of your 
monitor and click OK > Keep changes.

Problem 3: Left-handed mouse settings:

In the Control Panel, select Mouse > select Switch primary and secondary button settings.

Problem 4: Keyboard or mouse speed settings:

In the Control Panel, select Mouse or Keyboard. Decrease mouse motion speeds or decrease 
keyboard repeat rate.
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Problem 5: Keyboard language:

Windows 10: In the Control Panel, select Region. Click Add a language > select the desired 
language. Verify the desired language is displayed in the drop-down list. Restart the PC or 
sign out and log back in. Depending on the chosen language, the keyboard and display 
language may behave differently.

Windows 8.1: In the Control Panel, select Language. Click Add a language > select the 
desired language > click OK. From the taskbar, select the keyboard for the desired language.

Windows 7: In the Control Panel, select Region and Language. Select Keyboards and Lan-
guages tab > Change keyboards. Select a different language and apply a different language for 
the keyboard to use.

Problem 6: Incorrect standard user account information:

In the Control Panel, select User Accounts. Create a normal user account with a password. 
Provide the student with an incorrect password.

Step 1: Start the computer.

 a. Start the computer.

Does the computer boot properly? ____________________ Answers may vary.

 b. If the computer started Windows, log on to the computer using a Standard 
User account provided by your instructor.

Were you able to log in? ____________________________ Answers may vary.

If you are unable to log in, log in as an administrator and change the credentials 
of the standard user.

Step 2: Troubleshoot the operating system problems.

 a. If the computer did not start Windows, troubleshoot the operating system until 
the computer successfully boots. Because all hardware is correctly connected, 
you do not need to troubleshoot hardware in this lab.

 b. If the operating system is missing the required files to boot the computer, you 
can replace these files by booting the computer with the Windows installation 
media or the F8 key. Use the Startup Repair option to replace any missing files.

 c. Is the mouse working properly? ____________________ Answers may vary.

If the mouse is not working properly, modify the mouse settings so that it 
works correctly.

 d. Is the keyboard working properly? __________________ Answers may vary.

If the keyboard is not working properly, modify the keyboard settings so that it 
works correctly.

 e. Is the resolution of the screen the native resolution, or is the resolution chosen 
by your instructor?

 ________________________________________________________________________

Answers may vary.
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If the screen resolution is not native or the resolution is chosen by your instruc-
tor, configure Windows to display the desktop at the native resolution of the 
monitor or the resolution chosen by your instructor.

 f. What problems did you find?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Answers may vary, for example: The computer does not boot.

 2) Answers may vary, for example: The display settings are not optimized for the 
monitor.

 3) Answers may vary, for example: The mouse does not function properly.

 4) Answers may vary, for example: The mouse or keyboard is over-reactive. 

 5) Answers may vary, for example: When typing, letters for a different language 
are shown.

 6) Answers may vary, for example: Cannot log on as a normal user.

 g. What steps did you take to determine the problems?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Turn the computer on.

 2) After logging in, the desktop items are very large.

 3) Used the mouse.

 4) Used the mouse or keyboard for a few tasks.

 5) Typed text.

 6) Tried to log in as a standard user.

 h. What is causing the problems?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________
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 1) Bootmgr is missing from the root directory of the C: drive.

 2) The display settings have been changed to lower settings.

 3) Incorrect mouse settings.

 4) Incorrect mouse or keyboard settings.

 5) Keyboard input language settings are set to a different language.

 6) Incorrect standard user credentials.

 i. List the steps taken to fix the problems.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 1) Start the computer with the Windows 7 or Vista installation media and run the 
Startup Repair to replace missing startup files. For Windows 8, use F8 to reach 
the Startup Repair menu.

 2) Change the display settings to the native resolution of the monitor or the 
resolution chosen by your instructor.

 3) Change the mouse settings to right-handed.

 4) Decrease the mouse or keyboard speeds.

 5) In Windows 10, open Region. Reset the default language to the proper language 
and restart the computer or sign out and log back in. In Windows 8.1 and 7, 
open the Region and Language window. Reset the default input language to the 
proper language and save the settings. Remove other languages not wanted.

 6) Log on as an administrator, reset the user password, and then log back on as the 
user.
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CHAPTER 12

Mobile, Linux, and macOS Operating Systems

Like desktops and laptops, mobile devices use an operating system (OS) to run software. This chapter 
focuses on the two most commonly used mobile operating systems: Android and iOS. Android is 
developed by Google, and iOS is developed by Apple.
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Study Guide

Mobile Operating Systems
The most popular mobile operating systems are the Android OS and Apple iOS. However, 
Windows 10 Mobile also shares some of the mobile operating system market.

Android vs. iOS
Android is an open-source Linux-based smartphone/tablet operating system developed by the 
Open Handset Alliance, primarily driven by Google. Because Android is open and customizable, 
programmers can use it to operate devices like laptops, smart TVs, and e-book readers.

Apple’s iOS is a closed-source Unix-based operating system for iPhone and iPad devices. 
Copying, modifying, or redistributing iOS requires permission from Apple.

Microsoft also created a version of Windows for its mobile devices. This includes Windows 
CE, Windows Phone 7, and Windows Phone 8. With the development of Windows 10 Mobile, 
Microsoft provides a similar user interface and use of code on all of its devices. This includes 
the Windows 10 Mobile phones and tablets developed under the name Surface.

Apps are the programs executed on mobile devices. Apps for the Apple iOS are available 
in Apple’s App Store. Apps for the Android OS are available in the Google Play store and 
other third-party sites. For the Android OS, users can directly install apps using the Android 
Application Package (.apk) file.

Check Your Understanding—Compare Android and iOS

In Table 12-1, indicate whether the mobile platform feature applies to Android or iOS.

Table 12-1 Compare Android and iOS

Mobile Platform Features Android iOS

Platform requires permission to copy, modify, or redistribute. X

Third-party or custom programs are installed directly using an .apk file. X

This is a Linux-based operating system. X

Source code is not released to the public. X

Platform uses walled garden model for apps. X

Platform developed by Open Handset Alliance. X

This is a closed-source operating system. X

The operating system has been customized for use in a wide variety of devices. X

Apps are developed using Xcode and Swift programming languages. X

Apps are developed using a Java-based Software Development Kit (SDK). X

Android and iOS Touch Interfaces
Familiarity with the Android and iOS interfaces is crucial to the technician’s job. Be sure to 
review these two labs:

Lab–Working with Android

Lab–Working with iOS
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Common Mobile Device Features
Mobile devices have a number of features in common, including screen orientation, screen 
calibration, global positioning system (GPS), Wi-Fi calling, Near Field Communication (NFC) 
payments, virtual private networks (VPNs), and virtual assistants.

Match the description on the left with the mobile device feature on the right. This exercise is a 
one-to-one matching.

Description

 a. This provides accurate movement 
readings that allow a device to be 
used as a control mechanism for 
certain applications.

 b. This navigation system determines the 
time and geographical location of the 
mobile device.

 c. These are programs like Siri, Google 
Now, and Cortana that use artificial 
intelligence, machine learning, and 
voice recognition technology to 
understand conversational-style voice 
commands.

 d. This sensor inside a mobile device 
detects the orientation.

 e. This is the process of using an access 
point to avoid cellular charges or 
where cellular access is not available.

 f. The mobile device accesses a remote 
site over the Internet using an 
encrypted connection.

 g. This feature can determine a device 
location by triangulating its proximity 
to other radio signals, such as Wi-Fi 
access points.

 h. This orientation allows for a wider 
viewing mode where the keyboard is 
wider and larger.

 i. Lowering this level helps conserve 
battery power.

 j. This wireless technology is used 
for payments in physical store 
transactions where the mobile device 
is passed over the payment system.

Mobile Device Feature

 d. Accelerometer

 i. Brightness

 b. GPS

 a. Gyroscope

 g. IPS

 h. Landscape

 j. NFC

 c. Virtual Assistants

 f. VPN

 e. Wi-Fi calling
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Methods for Securing Mobile Devices
Mobile devices are particularly vulnerable to physical threats such as being lost or stolen. In 
addition, data can be stolen without the user knowing it if the device is left unattended and 
unlocked. Mobile devices include a variety of security features to protect data, including 
screen locks, biometric authentication, cloud services to save data, and software security.

Screen Locks and Biometric Authentication
In Table 12-2, indicate whether the statement is true or false.

Table 12-2 Screen Locks and Biometric Authentication

Statement True False

Some mobile devices can be unlocked by scanning a user’s facial features. X

Requiring the user to draw a pattern on the screen with a finger is a feature 
of the fingerprint lock.

X

Passcode locks are the most common method to lock mobile devices. X

The swipe lock is considered the most secure method of preventing 
unauthorized access to a mobile device.

X

iOS devices store passcodes in plain text in flash memory. X

Swipe lock and pattern lock are available on many Android devices. X

The iOS Erase Data feature will delete all data on the devices after three 
failed passcode attempts.

X

Cloud-Enabled Services for Mobile Devices
Remote backup, locator applications, remote lock, and remote wipe help protect your data 
when a device is lost or stolen.

Check Your Understanding—Cloud-Enabled Services

Match the scenario on the left with the security feature on the right. This exercise is a 
one-to-one matching.

Scenario

 a. Remotely lock an Android device 
using a passcode.

 b. Find a mobile device that has been 
lost or stolen.

 c. Remotely lock an iOS device using a 
passcode.

 d. Store iOS backups on a local PC.

 e. Delete all data on an Android device 
and return it to a factory state.

 f. Store mobile device data in the cloud.

Mobile Device Feature

 e. Erase

 d. iTunes

 b. Locator app

 a. Lock

 c. Lost mode

 f. Remote backup

M12_Johnson_C12_435_484.indd   438M12_Johnson_C12_435_484.indd   438 08/10/19   4:32 PM08/10/19   4:32 PM



Chapter 12: Mobile, Linux, and macOS Operating Systems  439

Software Security
Because iOS mobile devices use a closed operating system, some users will use jailbreaking 
techniques to remove restrictions and gain access to the kernel. Similarly, on Android devices, 
rooting techniques are used to gain superuser access. Antivirus apps are available for both iOS 
and Android. Both platforms should be regularly checked for the latest updates to verify that 
known security vulnerabilities are patched.

In Table 12-3, indicate whether the statement is true or false.

Table 12-3 Mobile Device Software Security

Statement True False

Running apps in a sandbox helps mitigate damage to mobile devices by 
malicious software.

X

Rooting is a method for removing restrictions on modifying code on an 
iOS device.

X

Updates and patches for Android devices are not released as one package 
for all devices.

X

Jailbreaking exploits vulnerabilities on iOS devices and is completely 
reversible.

X

iOS allows both automatic and scheduled antivirus scans. X

Linux and macOS Operating Systems
Linux and macOS are two popular operating systems that share the same command-line 
interface (CLI) commands.

Linux and macOS Tools and Features
Linux operating systems are used in a variety of computing devices including PCs, laptops, 
servers, networking devices, cellphones, smartwatches, and more. There are many different 
distributions (distros) of Linux.

Unix is a proprietary operating system based on the Berkley Standard Distribution (BSD). 
The operating system for Macintosh computers, macOS, is developed from the Unix kernel.

Commands are compatible between Unix, Linux, and macOS.
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Check Your Understanding—Linux and macOS

In Table 12-4, indicate whether the statement refers to Linux or macOS.

Table 12-4 Compare Linux and macOS

Statement Linux macOS

The OS includes the Disk Utility to back up disks and perform image 
recovery to disk from image files.

X

The OS does not have a built-in backup tool. X

The OS supports the popular terminal emulator, Gnome-terminal. X

The OS uses the popular boot manager Grub. X

Apps and desktop are organized through Mission Control. X

Closed-source OS is developed by Apple. X

The OS can be customized by the user installing and removing software 
packages.

X

The OS is open source and independently developed. X

Linux and macOS Best Practices
As a technician, you should follow best practices to manage and maintain devices that use the 
Linux and macOS.

Check Your Understanding—Best Practices

Match the description on the left with the feature on the right. This exercise is a one-to-one 
matching.

Description

 a. Software providing low-level 
functionality for a device.

 b. A service that can be used to schedule 
tasks on Linux and macOS.

 c. OS updates released periodically by 
the OS vendor to address new known 
vulnerabilities.

 d. The security credentials manager for 
macOS.

 e. The security credentials manager for 
Linux.

 f. A sample of code used by viruses and 
malware.

Feature

 b. Cron

 a. Firmware

 e. Gnome-Keyring

 d. Keychain

 c. Patches

 f. Signature
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Basic CLI Commands
The Unix-like command line offers a wealth of power at your fingertips. However, it is difficult 
to remember all the commands and options. The inline resource that can inform you of the 
commands and options is the manual pages, or man pages for short. Use man pages to review 
basic CLI commands for Unix-like operating systems.

Note: This topic includes a number of commands. Review those commands in the “Command Reference” 
section of this chapter.

Identify Parts of the ls -l Command

Consider the following command:

-rw-rw-r-- 1 allan admin 202730 Jun 23  2019 Software and hardware list.pdf

In Table 12-5, enter the part of the command that equates to its description.

Table 12-5 Command Structure for ls -l

Description Command Part

Date or Time Jun 23 2019

File Name Software and hardware list.pdf

File Size 202730

Group admin

Link 1

Permission -rw-rw-r--

User allan

Identify the Permission Type

Table 12-6 lists a summary of the file and directory permission octal codes. Enter a description 
for each permission.

Table 12-6 File and Directory Permissions Summary

Binary Octal Permission Description

000 0 --- No access

001 1 --x Execution only

010 2 -w- Write only

011 3 -wx Write and Execution

100 4 r-- Read only

101 5 r-x Read and Execution

110 6 rw- Read and Write

111 7 rwx Read, Write, and Execution
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Identify the Octal Value and Permissions

In Table 12-7, record the octal value and permissions setting for each of the described 
permissions.

Table 12-7 Octal Value and Permissions

Octal Permission Description

777 rwxrwxrwx There are no restrictions on permissions. Anybody may do anything—
read, write, or execute. This setting is generally not desirable.

755 rwxr-xr-x With this permission, only a file's owner may read, write, and execute 
the file. All others may only read and execute the file. This setting is 
common for programs that are used by all users on the system.

700 rwx------ The file's owner may read, write, and execute the file. Nobody else has 
rights. This setting is useful for programs that only the owner may use 
and must be kept private from others.

666 rw-rw-rw- All users may read and write the file, but no users can execute the file.

644 rw-r--r-- Only the file owner may read and write a file, while all others on the 
system may only read the file. A common setting for data files that all 
the users may read, but only the owner may change.

600 rw------- The owner may read and write a file. All others cannot read, write, or 
execute the file. The settings are used when the owner wants to keep 
the data file private.

Basic Troubleshooting Process for Other 
Operating Systems
Similar to Windows, troubleshooting Linux and macOS operating systems includes applying a 
troubleshooting process to solve problems.

Applying the Troubleshooting Process to Other 
Operating Systems
Like troubleshooting other hardware and software, Linux and macOS troubleshooting is more 
efficient when you follow a troubleshooting process.

Review the Troubleshooting Process Steps

In Table 12-8, list the six troubleshooting steps.

Table 12-8 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive measures.

Step 6 Document findings, actions, and outcomes.
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Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the operating system, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or no answer. In Table 12-9, indicate 
whether the technician’s question is open-ended or closed-ended.

Table 12-9 Open-Ended and Closed-Ended Questions

Question to Identify the Problem for Mobile Devices Open-Ended Closed-Ended

What apps have you installed recently? X

Is your mobile device under warranty? X

Does the mobile device connect to the Internet? X

Has anyone else used the mobile device? X

Have you modified the operating system on the mobile device? X

What service provider do you have? X

What is the problem you are experiencing? X

Have you installed any apps from an unapproved source? X

What is the version of the mobile OS you are using? X

Has this problem happened before? X

Question to Identify the Problem for Linux and macOS Open-Ended Closed-Ended

What programs or drivers have you installed recently? X

What is the problem you are experiencing? X

What version of Linux or macOS is it running? X

Does the computer connect to the Internet? X

Is your computer under warranty? X

What is the make and model of your computer? X

What OS updates have you installed recently? X

Has this problem happened before? X

Has anyone else used the computer? X

What system configurations have you changed recently? X

Common Problems and Solutions for Other 
Operating Systems
Operating system problems can be attributed to hardware, application, or configuration issues, 
or to some combination of the three.
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Check Your Understanding—Possible Solutions for Common Problems 

in Other Operating Systems

Check your understanding of common problems and solutions for other operating systems by 
choosing the BEST answer to the following questions.

 1. The mobile device will not connect to the Internet.

 a. Enable Bluetooth on the mobile device.

 b. Turn off Airplane mode.

 c. Uninstall unnecessary apps.

 d. Restart the device.

 2. An app fails to respond.

 a. Enable Bluetooth on the mobile device.

 b. Turn off Airplane mode.

 c. Uninstall unnecessary apps.

 d. Restart the device.

 3. A mobile device cannot pair with wireless headphones.

 a. Enable Bluetooth on the mobile device.

 b. Turn off Airplane mode.

 c. Uninstall unnecessary apps.

 d. Restart the device.

 4. The power of a mobile device is draining more quickly than normal.

 a. Use a VPN connection.

 b. Scan for and remove malware from the device.

 c. Turn off unnecessary radios.

 d. Change your grip on the device.

 5. A directory appears to be empty on Linux or macOS.

 a. Update all device drivers from the manufacturer’s website.

 b. Restart the device.

 c. Use the show hidden files in the file browser.

 d. Turn on the backup application.

Answer: 1-B, 2-C, 3-A, 4-C, 5-C
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Labs and Activities

Command Reference
In Table 12-10, record the command that fits the description. Include the full path, if necessary, 
to execute the command.

Table 12-10 Commands for Chapter 12, “Mobile, Linux, and macOS Operating Systems”

Command Description

apt-get Is the Ubuntu Linux package manager and is used to install, configure, 
and remove packages on Ubuntu.

chmod Modifies file and directory permissions.

chown Changes the ownership of a file.

dd Copies data from an input to an output.

ifconfig Displays or configures network-card-related information.

iwconfig Displays and configures wireless network-card-related information.

kill Sends a signal to a process.

passwd Changes a user password.

ps Lists the process currently running in the system.

shutdown Shuts down the system.

su Simulates a login as another user or to become a super-user.

sudo Runs a command as another user.
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12.1.2.2 Lab–Working with Android 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will place apps and widgets on the home screen and move them between 
different screens. You will also create folders. Finally, you will install and uninstall apps from 
the Android device.

Recommended Equipment
 ■ Android tablet or smartphone running Android version 7.0

Instructor Note: This lab must be completed by students even if the recommended equipment 
is not available. This lab is designed to provide students with familiarity with the Android OS 
and manipulating of home screen items.

Instructor Note: Due to the variety of Android devices and operating systems, some of the 
paths and locations of items may be different from those in this lab. Consult the manual of 
the Android device used to determine the correct instructions for your device.

Instructions

Part 1: Apps and Widgets
In this part, you will place apps and widgets on the home screen. Because there are a variety of 
Android devices and operating system versions, consult the manual of the Android devices to 
determine the correct instructions for the device.

Step 1: Gain access to the device.

Turn on the device and log in with the password, PIN, or other passcode, if necessary.
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Step 2: Add app shortcuts to the home screen.

 a. On the home screen, apps can be installed using the All Apps icon. Touch the 
All Apps icon.

 b. The All Apps screen displays the available apps. Touch and hold any app icon to 
create a shortcut to it on the home screen.

As the app icon is held, the home screen and possible locations for the shortcut 
become visible in the background. The image below shows the home screen and 
a possible location for a shortcut as the Calculator app icon is held.

 c. Drag the app icon to any empty space and release it.
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Step 3: Add widgets to the home screen.

Widgets are apps that display information dynamically on the home screen. 
Different from app shortcuts represented by a single icon, widgets usually occupy a 
larger area of the screen and can be installed directly from a screen.

 a. To add a widget to a screen, touch and hold a blank area of a screen. The screen 
will reduce in size, and a three-icon menu will appear.

 b. Touch the Widgets icon. A list of installed widgets appears.
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 c. Touch and hold a widget. Similarly to adding an app, the home screen will 
become visible, allowing you to choose a location for the widget. Drag the 
widget to any empty space and release it. In the image below, the Google Fit 
Widget is being placed on the home screen.

Note: Widgets and apps must be installed before they can be added to screens. Widgets and 
apps can be installed from the Google Play Store.

Step 4: Move apps between screens.

You can move apps to other screens.

 a. Touch and hold any app icon. Drag the app to the edge of the screen.
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 b. Drag the app icon to any empty space and release it.

Note: Widgets can be moved to other screens in the same manner as apps.

Step 5: Remove apps or widgets from the home screen.

Apps and widgets can be removed from the home screen. In this example, you will 
remove the Drive app from the home screen.

 a. Touch and hold the Drive app icon. As you hold the icon, the search box on the 
top of the screen is replaced by the Remove link. Drag the Drive icon onto the 
Remove link and release the app.
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 b. The app is now removed from the home screen.

Note: Widgets can be removed from the home screen in the same manner.

Note: The method shown in this step simply removes the app shortcut from the home screen. 
The app is still installed on the device and can be easily brought back to the home screen, as 
seen in Step 2 of this lab. App uninstallation is covered later in this lab.

Part 2: Managing Folders
Step 1: Create a folder.

Apps can be grouped to create folders by simply dragging an app on top of another.

 a. Add another app to the screen. You must have at least two apps to create a 
folder. In the image below, the Calculator and Photos apps are used as examples.
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 b. Touch and drag one of the app icons onto the other.

 c. Release the app. A folder is created containing both the Calculator and 
Photos apps.
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Step 2: Rename a folder.

Folders can be named to describe the contents.

 a. Touch the folder.

 b. Touch the words Unnamed folder.

 c. Type the name ITE Apps Folder for the folder name.

 d. Touch anywhere outside the folder to close it.
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Step 3: Remove apps from a folder.

Apps can be removed from folders.

 a. Touch and hold any app within the folder.

 b. Drag the app to an empty area of the home screen.

 c. Release the app.

Question:

After Photos is removed from the folder, what happened to the folder and the 
Calculator app?

 ________________________________________________________________________

The folder was deleted, and the Calculator app was placed on the home screen.
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Part 3: Managing Apps
Step 1: Install apps.

 a. Open the Google Play Store app.

 b. Search and install LastPass, a free password manager for Android.
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 c. Touch LastPass Password Manager to see details about LastPass.

 d. Touch INSTALL and then ACCEPT on the App Permissions window.

 e. When the installation process finishes, the app is installed and available under 
All Apps.
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Step 2: Uninstall apps.

 a. Navigate to the home screen. Touch the All Apps icon.

 b. Touch and hold the LastPass icon (i.e., the app you just installed in the 
previous step).

 c. An app menu appears. Drag the LastPass icon to the Uninstall link.

 d. Confirm you want to uninstall LastPass by touching OK.

 e. The app is now uninstalled from the device.
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12.1.3.2 Lab–Working with iOS (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will place apps on the home screen and move them between different home screens. 
You will also create folders. Finally, you will install an app on the iOS device and then uninstall it.

Recommended Equipment
 ■ iOS tablet or smartphone running iOS version 10.0 or higher

Instructor Note: This lab must be completed by students even if the recommended 
equipment is not available. This lab is designed to provide students with familiarity of iOS and 
manipulating of home screen items.

Instructor Note: Due to the variety of iOS devices and operating systems, some of the paths 
and locations of items may be different from those in this lab. Consult the manual of the iOS 
device used to determine the correct instructions for your device.

Instructions

Part 1: Apps and the Home Screen
In this part, you will access the iOS device and rearrange the apps on the home screen.

 a. Turn on the device and log in with the password, PIN, or other passcode, if necessary.

 b. On the home screen, touch and hold any app icon until it starts to shake. An X appears 
next to each icon to delete the app if desired.
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 c. To move an app icon to a different location, touch and hold the icon and drag it to the 
desired location.

 d. In this example, we will move the Contacts app icon to a different home screen page. 
Touch and hold the icon until it starts to shake.

 e. Drag the Contacts app icon to the edge of the screen on the right to place it on a differ-
ent home screen. This operation will also create a new home screen page if there are no 
other home pages.

 f. Press the Home button when the Contacts app is in the desired location.

Part 2: Managing Folders
Step 1: Create a folder.

Apps can be grouped to create folders. A folder can be created by dragging an app 
icon on top of another icon.
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 a. Touch and drag the Stocks app onto the Calendar app.

 b. iOS will create a folder containing both apps. Release the app when the folder 
is created. The default folder name is determined by the types of apps placed in 
the folder.

Question:

What is the name that was assigned to the new folder?

 ________________________________________________________________________

Answers may vary. In this example, the folder name was Productivity.

Instructor Note: The system will assign a name to the folder representative of which 
types of applications you put into it.  In the case of this screenshot, the name was 
Productivity, but it may be something different on student devices.

 c. Press the Home button to exit the folder editing creation mode.

Step 2: Rename folders.

Folders can be renamed to better describe their contents.

 a. Open the new folder created in the previous step by tapping it.
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 b. Touch and hold the folder’s name until the apps begin to shake. Notice the 
cursor is now next to the folder’s name.

 c. Delete the name and rename it ITE Folder.

 d. Touch anywhere outside the folder or press the Home button to close the folder.

Step 3: Remove apps from folders.

 a. Touch the ITE Folder to open it.
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 b. Touch and hold the Calendar app icon within the folder. Drag the app to an 
empty area of the home screen outside of the folder.

 c. Release the icon. The Calendar app icon is now outside the folder.

 d. Go back to the ITE Folder and remove Stocks.

Question:

What happens to the folder?

 ________________________________________________________________________

The folder disappears from the home screen.

Part 3: Installing Apps
To install apps on an iOS device, you must use the App Store app. To install an app on iOS, 
follow these steps:

 a. Touch the App Store app icon to open it.

 b. Touch the Search tool icon at the bottom of the screen to access the app search 
functionality.

 c. In the search box, type LastPass, a free password manager for iOS.
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 d. Touch LastPass to see details about the LastPass app.

 e. Touch Get and then touch Install to start the installation process.

 f. To begin the download, provide your Apple account password if prompted.

 g. When the download and installation are finished, the progress indicator will turn into a 
button that reads Open.

 h. Press the Home button to return to the home screen and verify the app has been 
installed.

Note: You must set up an Apple account before you can install apps on iOS devices. This is a 
requirement put in place by Apple and is necessary even for free apps, such as LastPass.
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Part 4: Uninstalling Apps
In this section, you will uninstall LastPass, but the process is the same for any iOS app.

 a. Touch and hold the LastPass icon until the apps begin to shake. Notice that the icon has 
a gray circle with a black X in the upper-left corner of the icon. Apps without the X are 
default apps and cannot be uninstalled.

 b. Confirm the deletion by touching Delete. The app is deleted from the device.
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12.1.4.4 Lab–Mobile Device Features 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will set the autorotation and brightness and turn GPS on and off.

Recommended Equipment
 ■ Android tablet or smartphone running Android version 5.0 or higher.

 ■ iOS tablet or smartphone running iOS version 7.0 or higher.

Note: If the recommended equipment is not available, Android or iOS emulators can provide some 
familiarity with Android and iOS devices. Search the Internet to find Android and iOS emulators.

Instructor Note: This lab must be completed by students even if the recommended equipment 
is not available. This lab is designed to offer students familiarity with Android and iOS 
features.

Instructor Note: Due to the variety of Android and iOS devices and operating systems, some 
of the paths and locations of items may be different from those in this lab. Consult the man-
ual of the Android and iOS device used to determine the correct instructions for your device. 
Encourage students to search the Internet for instructions.

Part 1: Auto-Rotation
Auto-rotation is a common feature found on modern mobile devices. It allows the screen 
format to switch automatically between landscape and portrait modes, depending on how 
the user is holding the device. This section examines how to turn auto-rotation on or off on 
Android and iOS devices.

Step 1: Auto-Rotation on Android

 a. Turn on the device and log in with the password, PIN, or other passcode, if 
necessary.

 b. Go to All Apps > Settings > Display (under the Device category).

 c. Touch When the device is rotated and select Stay in current orientation.

 d. Rotate the device 90 degrees clockwise. What happens to the screen?

 ________________________________________________________________________

The screen remains in the same orientation.
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 e. Rotate the device 90 degrees counter clockwise.

 f. Touch When the device is rotated again and select Rotate the contents of the 
screen.

 g. Rotate the device 90 degrees clockwise again. What happens to the screen?

 ________________________________________________________________________

The screen rotates to match the orientation of the device.

 h. Touch the Home button to return to the home screen.

Step 2: Auto Rotation on iOS

 a. Turn on the device and log in with the password, PIN, or other passcode, if 
necessary.

 b. Swipe up from the bottom of the screen to access Control Center.

 c. Touch the auto-rotation lock icon to enable auto-rotation lock; it is the fifth 
icon in the row of icons and represented by a circular arrow going around a 
lock.

 d. Open the Calculator app.

 e. Rotate the device 90 degrees clockwise. What happens to the screen?

 ________________________________________________________________________

The screen remains in the same orientation.

 f. Swipe up from the bottom of the screen to access the Control Center again.

 g. Touch the auto-rotation lock icon again to deactivate it.

 h. Press the Home button.

 i. Open the Calculator app.

 j. Rotate the device 90 degrees clockwise. What happens to the screen?

 ________________________________________________________________________

The screen rotates to match the orientation of the device.

 k. Click the Home button to return to the home screen.

Part 2: Brightness
Step 1: Adjust the brightness on Android.

 a. Go to All Apps > Settings > Display (under the Device category).

 b. Touch Brightness level. A brightness slider appears.

 c. Move the slider all the way to the right. What happens?

 ________________________________________________________________________

The screen gets brighter.
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 d. Touch the Adaptive brightness toggle to enable it. The Adaptive brightness 
toggle is located right below the Brightness level.

What happens when Adaptive brightness is enabled?

 ________________________________________________________________________

Answers may vary. The brightness of the screen should adjust itself based on the 
amount of environmental light.

 e. Touch the Adaptive brightness checkbox.

 f. Move the slider all the way to the left. What happens?

 ________________________________________________________________________

The screen gets darker.

 g. Touch the Home button to return to the home screen.

Step 2: Adjust the brightness on iOS.

 a. Go to Settings > Display & Brightness. The Display & Brightness screen 
appears.

 b. Turn off Auto-Brightness by moving the Auto-Brightness toggle to the off 
position.

 c. Move the slider all the way to the right. What happens?

 ________________________________________________________________________

The screen gets brighter.

 d. Turn on Auto-Brightness. What happens?

 ________________________________________________________________________

Answers may vary. The screen should become much darker unless the room is very 
bright.

 e. Turn off Auto-Brightness.

 f. Move the slider all the way to the left. What happens?

 ________________________________________________________________________

The screen gets darker.

 g. Turn on Auto-Brightness. What happens?

 ________________________________________________________________________

Answers may vary. The screen should become much brighter unless the room is very 
dark.
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Part 3: GPS
Another common feature on modern mobile devices is GPS or Location Services. By using 
Global Positioning System signals, mobile devices are able to learn and inform the user about 
the current location with accuracy.

Step 1: Use GPS on Android.

 a. Go to All apps > Settings > Location (under Personal). The Location screen 
appears.

 b. Turn off Location by moving its toggle to off.

 c. Touch the Home button.

 d. Open the Maps app by going to All apps > Maps.

How is the device able to determine the location?

 ________________________________________________________________________

Depending on the device, the wireless network function can provide an approximate 
location.

Force Maps to locate you with more accuracy by touching the crosshair icon. 
What happens?

 ________________________________________________________________________

Because Location is turned off, Android asks permission to turn it on.

 e. Allow Android to turn on Location by touching YES. Your device should now 
have an accurate representation for your current location.

 f. Touch the Home button.

Step 2: Use GPS on iOS.

 a. Go to Settings > Privacy > Location Services. The Location Services screen 
appears.

iOS allows the user to decide what apps have access to the GPS. What apps are 
using Location Services on your device?

 ________________________________________________________________________

Answers may vary.

 b. Turn Location Services off. A warning message may appear stating that the 
Location Services will be disabled.

 c. Press the Home button.

 d. Touch the Maps app icon to open Apple Maps.

Note: You may be asked to allow Maps to use Location Services. If this happens, touch 
Allow to add Maps to the list of apps that can use Location Services.
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 e. Touch the Current Location icon.

What happens?

 ________________________________________________________________________

The Turn On Location Services message appears.

 f. Touch Settings in the warning box to open the Location Services setting 
screen. Alternatively, press the Home button and go to Settings > Privacy > 
Location Services.

 g. Turn Location Services on.

 h. Touch the Home button.

 i. Touch the Maps app icon.

 j. Touch the Current Location icon again. Was iOS able to locate you and the 
device?  

 k. Click the Home button.
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12.2.1.2 Lab–Passcode Locks 
(Instructor Version)
Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
For most users, these Android or iOS devices are on the go with the users, and they are usually 
powered on all the time. If the device is lost or stolen, the passcode can prevent unauthorized 
access.

In this lab, you will set a passcode lock, change a passcode lock, and fail passcode 
authentication. You will also configure the device to use your fingerprints if it has biometric 
capability. Finally, you will remove the passcode and biometric locks.

Recommended Equipment
 ■  Android tablet or smartphone running Android version 7.0 or higher

 ■  iOS tablet or smartphone running iOS version 10.0 or higher

Instructor Note: This lab must be completed by students even if the recommended equipment 
is not available. This lab is designed to provide students with familiarity of Android and iOS 
features.

Instructor Note: Due to the variety of Android and iOS devices and operating systems, 
some of the paths and locations of items may be different from those in this lab. Consult the 
support pages of the Android and iOS device used to determine the correct instructions for 
your device.
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Instructions

Part 1: Passcode Lock on Android
Step 1: Configure the asscode lock on an Android device.

Instructor Note: The device should have no passcode lock configured.

 a. With the device powered on, navigate to the home screen.

 b. Go to Apps or All apps > touch Settings > touch Security. There are other 
names for Security depending on your device. The following are some samples: 
Lock screen and security, Lock screen, and Security & location. Security will 
be used throughout this lab.
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 c. Touch Screen lock or Screen lock type to choose a method for unlocking the 
screen.

Question:

What are the unlocking methods available on your device?

 ________________________________________________________________________

Answers vary depending on the Android versions and device / carrier model. Some 
of the methods are None, Swipe, Pattern, PIN, Password, and biometrics that could 
include face, iris, or fingerprints.

 d. Touch PIN to set a PIN for unlocking the screen.

 e. If the Encryption screen appears, Android asks if you want to use the PIN to 
encrypt the device. Touch No thanks and then touch CONTINUE to continue.

This is useful because the device’s filesystem will be encrypted based on PIN, 
making it unreadable until the PIN is provided. While this feature increases 
security, it is out of the scope of this lab.

 f. In the Choose your PIN or Set PIN screen, enter 123456. Touch CONTINUE.

 g. Type 123456 to confirm the PIN. Touch OK to confirm.

 h. Depending on your device, you may be prompted with other questions, such as 
Backup your PIN and Show all notification content. Consult your instructor as 
necessary.
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 i. In the Secure Lock Settings, enter the PIN when prompted. Enable Lock 
instantly with power key.

Note: This option may not be available on all device models/versions.

Step 2: Use the PIN to unlock the screen.

 a. Press the Home button to return to the home screen.

 b. Press the Power button briefly to lock the screen. The device will go into sleep 
mode, and the screen will go dark.

 c. Press the Power button briefly to wake up the device. Notice that the device 
will now require the PIN before allowing access. Enter 123456, the previously 
configured PIN. Touch the check mark or OK on the number pad.

Question:

What happens?

 ________________________________________________________________________

Answers may vary depending on what application was left running at the time the 
device was locked. The device unlocks and the home screen appears.

 d. Press the Power button briefly to lock the device.

 e. Press the Power button briefly to wake up the device. Swipe as necessary to see 
the prompt to enter the PIN.

 f. Enter 654321. Notice this is not the correct PIN that was configured on the 
device.

Question:

What happens?

 ________________________________________________________________________

The screen remains locked, and a message indicates that an incorrect PIN has been 
entered.

 g. Enter the incorrect PIN a few more times. 

Question:

What happens?

 ________________________________________________________________________

You will receive a message indicating that you can try again in 30 seconds.

Repeatedly entering incorrect PINs is an indicator that someone is trying to 
guess the PIN. As a security measure, Android forces the user to wait 
30 seconds before attempting another guess.

 h. Touch OK when 30 seconds have passed. Notice that Android will keep a 
countdown in the background.

 i. After 30 seconds, enter the correct PIN to unlock the device.
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Step 3: Use fingerprint lock if it’s available.

For some of the newer Android devices, fingerprints can be used to unlock the 
devices. In this step, you will configure the device so you can use your fingerprint 
to unlock it. The PIN configured in a previous step is used as the backup unlock 
option in the event that the fingerprint scanner is not working or after a restart of 
the device.

 a. Navigate back to Security. (Apps > Settings)

 b. Locate the option that allows you to configure a fingerprint to unlock the 
device. The options can be Nexus imprint, Pixel imprint, or Biometrics and 
security > Fingerprint. Provide the PIN when prompted.

Note: If the PIN is not configured in the previous step, you will be prompted to configure a 
backup unlock option, such as a PIN, passcode, or pattern.

 c. Verify that the fingerprint is allowed to unlock the device.

 d. Depending on your device, you can configure the device to require a PIN, 
password, or pattern to start the device or how you want notifications to show 
when the device is locked.

 e. Locate the imprint or fingerprint sensor on your device. Follow the directions 
provided by your device to capture and add your fingerprint. Touch done when 
you’re finished adding fingerprints.

 f. Lock the phone and use your fingerprint to unlock your device.

Step 4: Use face lock if it’s available.

On some of the newer Android devices, your face can be used to unlock the device. 
The PIN configured in a previous is the backup unlock method.

 a. Navigate back to Security or Security & Location. (Apps > Settings)

 b. Locate the option that allows you to configure your face to unlock the device. 
The options can be Biometric and security > Facial Recognition or Smart 
Lock > Trusted face. Enter the PIN when prompted.

 c. You will need to position your face in the on-screen circle and follow the 
on-screen instructions to register your face.

 d. Verify that the Face Lock is working, lock the device, and attempt to unlock 
using your face. After the device recognizes your face, swipe to unlock the 
device.
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Step 5: Clean up.

 a. Navigate to Security and locate the options to configure fingerprints. Enter the 
PIN if prompted.

 b. Tap the fingerprints and select Delete or Remove.

 c. Remove the trusted face.

 d. Navigate back to Screen lock type. (Apps > Settings > Security)

Question:

What happens? Explain.

 ________________________________________________________________________

The user is asked to enter the PIN to prevent unauthorized users from changing or 
removing the PIN.

 a. Enter the correct PIN. Touch None.

 b. Press the power button briefly to lock the screen.

 c. Press the power button briefly to unlock the screen.

Question:

What happens?

 ________________________________________________________________________

The device wakes up without the need for a PIN. Also, the Screen lock type can be 
accessed without a PIN.

 a. Navigate to Screen lock settings (Apps > Settings > Lock Screen). Disable 
Lock instantly with power key.

Question:

What are other security settings are available on your device?

 ________________________________________________________________________

Answers will vary depending on the Android version and model. Some of the exam-
ples are Lock automatically, Auto factory reset, and Lock network and security.
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Part 2: Passcode Lock on iOS
Step 1: Configure Passcode Lock on an iOS device.

Instructor Note: The device should have no passcode lock configured.

 a. Turn on the device and navigate to Settings.

 b. Depending on your iOS version, touch Face ID & Passcode, Touch ID & 
Passcode, or Passcode.

 c. Touch Turn Passcode On.
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 c. Enter 123456 as the passcode if allowed by the device. Otherwise, use 1234 
as the passcode for the rest of this lab.

 d. Re-enter 123456 to confirm the passcode.

 e. Verify that Require Passcode is set to Immediately.

Step 2: Use the passcode to unlock the screen.

 a. Press the Power button briefly to lock the device.

 b. Slide to unlock the device. Enter the passcode 123456 when prompted.

Question:

What happens?

 ________________________________________________________________________

The screen is unlocked and the home screen appears.

 c. Press the Power button briefly to lock the device.

 d. Press the Power button briefly to unlock the device.

 e. Type 654321. Notice this is not the passcode configured in the device.

 f. Touch OK.

Question:

What happens?

 ________________________________________________________________________

The device vibrates, indicating a wrong PIN was provided. The screen remains locked.
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 g. Enter the incorrect PIN five more times.

Question:

What happens?

 ________________________________________________________________________

A message iPhone is Disabled, try again in 1 minute is displayed.

 h. After 1 minute, enter the correct passcode.

Step 3: Configure Touch ID.

If your device supports Touch ID, you can use your fingerprint to unlock the device. 

Note: A passcode needs to be configured prior to configuring Touch ID.

 a. Touch Settings > tap Touch ID & Passcode. Enter the passcode when 
prompted.

 b. Touch Add a Fingerprint. Follow the directions provided by the device. Touch 
the Home button as you hold the device normally.

 c. Lock the device and verify that you can unlock the device using fingerprints.

Step 4: Configure Face ID.

If the iOS device supports Face ID, you can use facial recognition rather than 
a password to unlock your device. A passcode configured in a previous step is 
necessary to complete the following exercise.

 a. On the iPhone, tap Settings > Face ID & Passcode. If prompted, enter your 
passcode.

 b. Tap Set Up Face ID, and then position your face in front of your device.
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 c. Touch Get Started, and look straight into your iPhone. Make sure to place your 
face in the circle at the center of the screen.

 d. Slowly move your head to complete the circle. This ensures that your face is 
scanned from all angles. When you finish the first Face ID scan, tap Continue. 
Follow the on-screen instructions.

 e. Touch Done when the setup is complete.

 f. Lock your device as necessary.

 g. Hold your device in portrait orientation. Make sure that nothing is covering the 
camera.

 h. Look briefly at the screen. The lock icon should change from locked to 
unlocked.

 i. As soon as the lock icon changes, swipe from the bottom of the screen to 
unlock the device.

Step 5: Clean up.

 a. Go to Settings > Passcode, Touch ID & Passcode, or Face ID & Passcode.

Question:

What happens? Explain.

 ________________________________________________________________________

The user is asked to enter the passcode to prevent unauthorized users from changing 
or removing the passcode.

 b. Type the correct PIN when prompted.

 c. In the Face ID & Passcode screen, touch Reset Face ID and, as necessary, 
touch Turn Passcode Off.

In the Touch ID & Passcode screen, remove the fingerprints and touch Turn 
Passcode Off as necessary.

In the Passcode Lock window, touch Turn Passcode Off.

 d. Press the Power button briefly to lock the device.

 e. Press the Power button briefly to unlock the device.

Question:

What happens?

 ________________________________________________________________________

The set tings screen is displayed without entering a passcode.
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12.4.2.4 Lab–Troubleshoot Mobile Devices 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will analyze scenarios involving common problems for mobile devices and 
identify the solutions. You have been provided with a list of solutions for common problems. 
Each solution may be used more than once.

After the solutions have been identified, you will research and list the steps for implementing 
them.

Recommended Equipment
 ■ Android tablet or smartphone running Android version 7.0 or higher

 ■ iOS tablet or smartphone running iOS version 10.0 or higher

Instructor Note: This lab must be completed by students even if the recommended equipment 
is not available. This lab is designed to provide students with familiarity of Android and iOS 
features.

Instructor Note: Due to the variety of Android and iOS devices and operating systems, some 
of the paths and locations of items may be different from those in this lab. Consult the man-
ual of the Android and iOS device used to determine the correct instructions for your device.

Troubleshooting Mobile Devices

Solutions for Common Problems

Perform a hard shutdown Pull the battery Complete a factory 
restore/reset

Force the app to close Replace the SIM card Reconfigure network settings

Insert or replace the 
memory card

Delete unnecessary files or 
uninstall apps

Clean the phone

Select one solution from the box above for each common problem listed below. Each solution 
may be used more than once.

 a. You have been using a social networking app on your phone without problems. Suddenly 
the application freezes up while trying to upload a photo.

  Which solution should be used to solve this problem? Explain your answer.

 

Force the app to close.
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Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 b. The passcode, or passcode pattern, has been forgotten. 

  Which solution should be used to solve this problem? Explain your answer.

 

Complete a factory restore/reset.

  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 c. A phone has been powered on, but it proceeds to loop through the startup process 
repeatedly.

  Which solution should be used to solve this problem? Explain your answer.

 

 

Perform a hard shutdown, pull the battery, or complete a factory restore/reset.

  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.
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 d. You have had your Android smartphone for five months and have not experienced any 
problems. Suddenly, a “No SIM Card” message begins appearing regularly. You check 
your SIM card, and there are no problems with the contacts on the SIM card, and the 
SIM card is locked into place.

  Which solution should be used to solve this problem? Explain your answer.

 

 

Replace the SIM card, perform a hard shutdown, complete a factory restore/reset, or pull the 
battery

  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 e. Friends and family have recently begun complaining about how hard it is to hear you 
during calls. You have already tried a hard reset for your phone, but that has not solved 
the problem.

  Which solution should be used to solve the problem? 

 

Clean the phone.

  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 f. The phone is entirely unresponsive.

  Which solution should be used to solve the problem? 

 

Force the app to close, perform a hard shutdown, pull the battery, or complete a factory 
restore/reset.
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  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 g. The mobile device cannot send or receive email.

  Which solution should be used to solve the problem?

 

Reconfigure network settings.

  Research and list the steps for implementing the solution.

 

 

 

 

Answers will vary.

 h. The phone cannot install additional apps or save photos.

  Which solution should be used to solve the problem?

 

Delete unnecessary files, uninstall apps, or insert or replace the memory card.

  Research and list the steps for implementing the solution. 

 

 

 

 

Answers will vary.
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CHAPTER 13

Security

This chapter reviews security threats and the procedures to mitigate devices and the data they contain. 
This includes a review of securing Windows and wireless local-area networks (WLANs). Finally, the 
chapter reviews troubleshooting security.
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Study Guide

Security Threats
This section reviews malware, a variety of network attacks, and social engineering attacks.

Malware
Malware is typically installed on a computer without user knowledge. Once a host is infected, 
the malware could do the following:

 ■ Change the computer configuration.

 ■ Delete files or corrupt storage drives.

 ■ Collect information stored on the computer without the user’s consent.

 ■ Open extra windows on the computer or redirect the browser.

Check Your Understanding—Malware

Match the description on the left with the malware on the next page. This exercise is a 
one-to-one matching.

Description

 a. Malware that typically displays 
annoying pop-ups to generate revenue 
for its author.

 b. Malware that executes arbitrary code 
and installs copies of itself in the 
memory of the infected computer. 
The main purpose of this malware is 
to automatically replicate from system 
to system across the network.

 c. Malware that attempts to convince 
people to divulge sensitive 
information.

 d. Malware that includes scam software 
that uses social engineering to shock, 
create anxiety, or cause the perception 
of a threat. It is generally directed at 
an unsuspecting user.

 e. Malicious software that executes a 
specific, unwanted, and often harmful 
function on a computer.

 f. Malware that slows or halts network 
activity.

 g. Malware used to gather information 
about a user and, without the user's 
consent, send the information to 
another entity.

 h. Non-self-replicating type of malware. 
It often contains malicious code that 
is designed to look like something 
else, such as a legitimate application 
or file. It attacks the device from 
within.

 i. Malware that denies access to the 
infected computer system and 
demands a person be paid in order for 
the restriction to be removed.

 j. Malware that is installed on a 
compromised system and provides 
privileged access to the hacker.

 k. Malware that steals confidential 
information by recording keystrokes.
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Malware

 a. Adware

 f. Denial of Service (DoS)

 k. Keylogger

 c. Phishing

 i. Ransomware

 j. Rootkit

 d. Scareware

 g. Spyware

 h. Trojan horse

 e. Virus

 b. Worm

Preventing Malware
Anti-malware programs are the best line of defense against malware because they continuously 
look for known patterns against a database of known malware signatures. Anti-malware programs 
are available for Windows, Linux, and macOS by many reputable security organizations such as 
McAfee, Symantec (Norton), Kaspersky, Trend Micro, Bitdefender, and more.

Order the Steps for Updating Anti-Malware

In Table 13-1, indicate the number of the step in updating an anti-malware signature file.

Table 13-1 Steps for Updating a Signature File

Step Number Description

Step 3 Click the Update button.

Step 1 Create a Windows Restore Point in case the file you load is corrupt. 

Step 2 Open the anti-malware program. 

Step 5 Set the anti-malware program to automatically update its signature file 
and scan your computer on a regular basis.

Step 4 Use the program to scan the computer and then check the report for 
viruses or other problems.
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Check Your Understanding—Preventing Malware

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. These programs are designed to 
invade privacy, steal information, 
damage the computer, or delete 
corrupt data.

 b. Antivirus programs are commonly 
referred to as this because many 
of them can also detect and block 
Trojans, rootkits, ransomware, 
spyware, keyloggers, and adware 
programs.

 c. Many anti-malware programs allow 
you to start in this mode. This 
prevents most drivers from loading.

 d. To avoid creating too much traffic at 
a single website, some manufacturers 
distribute their signature files for 
download to multiple download sites.

 e. You should always download these 
from the manufacturer’s website to 
make sure the update is authentic and 
not corrupted by malware.

Term

 b. Anti-malware

 a. Malware

 d. Mirrors

 c. Safe mode

 e. Signature files

Network Attacks
Networks and the devices connected to them are vulnerable to a variety of attacks. A threat 
actor typically begins with a reconnaissance attack to gather information about the target.

In Table 13-2, fill in the type of reconnaissance attack that is described.

Table 13-2 Reconnaissance Attacks

Reconnaissance Attack Description

Perform an information query 
of a target

Attacker is looking for network information about a 
target using various tools, including Google search, an 
organization’s website, whois, and more.

Initiate a ping sweep of the 
target network

Attacker sends packets to discover the target’s public 
network address and determine which IP addresses are 
active.

Initiate a port scan of active 
IP addresses

Attacker determines which services are available using tools 
such as Nmap, SuperScan, and more.

Run vulnerability scanners Attacker attempts to discover the type and version of the 
application and operating system running on the target host 
using tools such as Nipper, Secuna PSI, and more.

Run exploitation tools Attacker attempts to discover vulnerable services using tools 
such as Metasploit, Core Impact, and more.
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Check Your Understanding—TCP/IP Attacks

The TCP/IP protocol suite is vulnerable to a variety of different attacks. Match the description 
on the left with the TCP/IP attack on the right. This exercise is a one-to-one matching.

Description

 a. Data transmissions are intercepted 
and recorded by an attacker. They are 
then sent to the destination computer. 
The destination computer handles 
these transmissions as though they are 
authentic.

 b. An attacker intercepts communications 
between computers to steal information 
transiting through the network.

 c. This amplified attack uses many 
infected hosts called zombies to 
overwhelm a target.

 d. A computer uses a forged IP or MAC 
address to pretend to be a trusted 
computer to gain access to resources.

 e. This attack randomly opens TCP ports 
at the source of the attack with a large 
number of false SYN requests. This 
causes sessions to be denied to others.

 f. This type of attack creates a large 
number of requests from a single 
source, aiming to overwhelm the 
destination device.

 g. An attacker successfully infects a 
target to accept false records that 
point to a malicious server.

TCP/IP Attack

 c. DDoS

 g. DNS Poisoning

 f. DoS

 b. Man-in-the-Middle

 a. Replay

 d. Spoofing

 e. Syn Flood

Identify the Security Device or Service

Protecting against network attacks includes using a defense-in-depth approach in which a 
combination of a number of network devices and services work together in a layered approach 
to security.
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In Table 13-3, fill in the name of the security device or service that matches the description.

Table 13-3 Security Devices and Services

Security Device or Service Description

Email security appliance (ESA) This device filters spam and suspicious emails. The web 
security appliance filters known and suspicious Internet 
malware sites.

Virtual private network (VPN) This service provides a secure connection between 
remote sites over encrypted tunnels.

Web security appliance (WSA) This device filters known and suspicious Internet 
malware sites.

Intrusion Prevention System (IPS) This device monitors incoming and outgoing traffic 
looking for malware, network attack signatures, and 
more. If it recognizes a threat, it can immediately stop it.

Adaptive Security Appliance 
(ASA) Firewall

This dedicated device provides stateful firewall services. 
It ensures that internal traffic can go out and come back, 
but external traffic cannot initiate connections to inside 
hosts.

Authorization Accounting 
Auditing (AAA) Server

This server contains a secure database of who is 
authorized to access and manage network devices. 
Network devices authenticate administrative users using 
this database.

Social Engineering Attacks
Social engineering is likely the single most serious threat to a well-configured and well-secured 
network.

Cybercriminals use social engineering techniques to deceive and trick unsuspecting targets 
to reveal confidential information or violate security gain information. Social engineering is 
an access attack that attempts to manipulate individuals into performing actions or divulging 
confidential information.

Check Your Understanding—Social Engineering Attacks

Social engineers prey on people’s weaknesses and often rely on human nature and people’s 
willingness to be helpful. Match the description on the left with the social engineering attack 
on the right. This exercise is a one-to-one matching.
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Description

 a. In this type of attack, sometimes 
called “Quid pro quo,” an attacker 
requests personal information from a 
party in exchange for something such 
as a gift.

 b. In this type of attack, an attacker 
pretends to be someone else 
(for example, a new employee, 
a fellow employee, a vendor, or a part-
ner company employee) to gain the 
trust of a victim.

 c. An attacker creates a targeted 
phishing attack tailored specifically 
for an individual or organization.

 d. An attacker pretends to need personal 
or financial data in order to confirm 
the identity of the recipient.

 e. An attacker quickly follows an 
authorized person into a secure 
location.

 f. In this in-person type of attack, an 
attacker rummages through trash bins 
to discover confidential documents.

 g. An attacker stands behind a victim to 
attempt to gain login credentials.

 h. An attacker sends fraudulent email 
disguised as being from a legitimate, 
trusted source to trick the recipient 
into installing malware on his or her 
device or to share personal or financial 
information (for example, bank 
account number and access code).

 i. This unsolicited email often contains 
harmful links, malware, or deceptive 
content.

 j. An attacker leaves a malware-infected 
flash drive in a public location 
(for example, a corporate washroom). 
A victim finds the drive and 
unsuspectingly inserts it into a 
corporate laptop, unintentionally 
installing the malware.

Social Engineering Attack

 j. Baiting

 f. Dumpster diving

 b. Impersonation

 h. Phishing

 d. Pretexting

 g. Shoulder surfing

 a. Something for something

 i. Spam

 c. Spear phishing

 e. Tailgating
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Security Procedures
Security procedures include establishing a security policy, protecting physical access to 
equipment, protecting data—both at rest and in motion—and establishing procedures for 
destroying data when it is no longer needed.

Security Policy
A security policy is a constantly evolving document that specifies the security of a network, 
the data, and the computers in an organization. It is up to the IT staff to implement security 
policy specifications in the network.

Identify the Security Policy Category

Table 13-4 describes the items that are typically included in a security policy. Fill in the name 
for each item.

Table 13-4 Security Policy Category

Security Policy Category Description

Identification and 
Authentication Policies

Specifies authorized persons who can have access to network 
resources and outlines verification procedures.

Password Policies Ensures passwords meet minimum requirements and are 
changed regularly.

Acceptable Use Policies Identifies network resources and usages that are acceptable to 
the organization. It may also identify ramifications if this policy 
is violated.

Remote Access Policies Identifies how remote users can access a network and what is 
accessible via remote connectivity.

Network Maintenance 
Policies

Specifies network device operating systems and end-user 
application update procedures.

Incident Handling Policies Describes how security incidents are handled.

Protecting Physical Equipment
Physical security involves securing the following:

 ■ Access to an organization’s premise

 ■ Access to restricted areas

 ■ The computing and network infrastructure

Book 1.indb   492Book 1.indb   492 01/10/19   9:28 PM01/10/19   9:28 PM



Chapter 13: Security  493

Identify the Lock Type

The level of physical security implemented depends on the organization because some have 
higher physical security requirements than others. In Table 13-5, identify the described lock 
type.

Table 13-5 Type of Secure Locks

Lock Description

Conventional lock Unlocked by entering the required key into the door handle mechanism.

Deadbolt lock Unlocked by entering the required key into a lock separate from the 
door handle mechanism.

Electronic lock Unlocked by entering a secret combination code or PIN into the keypad.

Token-based lock Unlocked by swiping a secure card or by using a near proximity reader 
to detect a smart card or wireless key fob.

Biometric lock Unlocked by using a scanner such as a thumbprint reader. Other 
scanners include voice print or a retina scanner.

Multifactor lock A lock that uses a combination of mechanisms. For example, a user must 
enter a PIN and then scan his or her thumb.

Protecting Data
Data is likely to be an organization’s most valuable asset. Data can be lost or damaged in 
circumstances such as theft, equipment failure, or disaster. Data loss can negatively affect an 
organization in multiple ways, including the following:

 ■ Brand damage or loss of reputation

 ■ Loss of competitive advantage

 ■ Loss of customers

 ■ Loss of revenue

 ■ Legal action resulting in fines and civil penalties

 ■ Significant cost and effort to notify affected parties

 ■ Significant cost and effort to recover from the breach

Data loss prevention (DLP) is preventing data loss or leakage. DLP software uses a dictionary 
database or algorithm to identify confidential data and block the transfer of that data to 
removable media or email if it does not conform to predefined policy.

Review the video and lab about BitLocker and BitLocker To Go.

Data Destruction
Protecting data also includes removing files from storage devices when they are no longer 
needed. Simply deleting files or reformatting the drive may not be enough to ensure your 
privacy.
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Check Your Understanding—Data Destruction

Match the description on the left with the data destruction tool on the right. This exercise 
is a one-to-one matching.

Description

 a. This device creates a very powerful 
electromagnetic field to destroy all 
data on a magnetic drive in seconds.

 b. These software tools are used 
to perform a secure erase that is 
designed to overwrite existing data 
multiple times, rendering the data 
unreadable.

 c. This creates the tracks on a hard 
disk and is usually performed at the 
factory where the drive is assembled.

 d. This creates the boot sector and file 
allocation table on a drive.

 e. This powerful magnet must be 
held over hard drive platters for 
approximately 2 minutes.

Data Destruction Tool

 b. Data wiping software

 e. Degaussing wand

 a. Electromagnetic degaussing device

 c. Low-level format

 d. Standard format

Securing Windows Workstations
IT technicians are often tasked with configuring password management, local security policies, 
users and groups, Windows Firewall, and web security utilities.

Securing a Workstation
To prevent unauthorized users from stealing or accessing local computers and network 
resources, lock your workstation, laptop, or server when you are not present. This includes 
physical security as well as password security.

Identify the Type of Password Protection

In Table 13-6, identify the type of password protection.

Table 13-6 Three Workstation Password Types

Type Description

BIOS Prevents the operating system from booting.

Login Prevents unauthorized access to the local computer.

Network Prevents unauthorized personnel from connecting to other computers or servers.
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Password guidelines are an important component of a security policy. The following is an 
example of strong guidelines for creating passwords.

 ■ Minimum length—Make a password eight characters or more.

 ■ Complexity—Include letters, numbers, and symbols.

 ■ Variety—Never use the same password twice.

 ■ Expiration—Change passwords on a regular basis.

Check Your Understanding—Workstation Security

Match the description on the left with the workstation protection tool on the right. 
This exercise is a one-to-one matching.

Description

 a. You choose an image or gestures to 
use with the image to create a unique 
password.

 b. This clear plastic panel attached to 
the computer only permits the user 
directly in front of the computer to 
see the information displayed.

 c. This feature enables you to use facial 
recognition or use your fingerprint to 
access Windows.

 d. You can enter this preconfigured 
number to access Windows.

 e. These are used to deter theft of a 
computer in an open public area.

 f. This feature makes Windows lock 
when a pre-paired device such as a cell 
phone goes out of range of the PC.

Workstation Protection Tool

 e. Cable locks

 f. Dynamic lock

 a. Picture password

 d. PIN

 b. Privacy screen

 c. Windows Hello

Windows Local Security Policy
For standalone computers that are not part of an Active Directory domain, the Windows Local 
Security Policy can be used to enforce security settings, such as password policies, audit 
policies, user rights policies, and security policies.

An administrator may need to implement the same extensive local policy for user rights and 
security options on multiple systems. To help simplify this process, the Local Security Policy 
can be exported and copied to other Windows hosts.

Review the Lab–Configure Windows Local Security Policy.
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Managing Users and Groups
Users can be grouped by job requirements and given access to files according to group 
permissions. This process helps manage user access to the network. Temporary accounts can 
be set up for users who need short-term access. Close management of network access can 
help to limit areas of vulnerability that might allow a virus or malicious software to enter the 
network.

Review the Lab–Configure Users and Groups in Windows.

Check Your Understanding—Managing Users and Groups

Match the description on the left with the user and group management term on the right. This 
exercise is a one-to-one matching.

Description

 a. Employees may be allowed to log in 
only during specific hours, such as 
7 a.m. to 6 p.m.

 b. Members of this group can perform 
common tasks, such as running 
applications, using local and network 
printers, and locking the computer.

 c. This feature will automatically log the 
user out and lock the screen after a 
specified period of time.

 d. Members of this group have full 
control of the computer and can 
assign user rights and access control 
permissions.

 e. Members of this group have a 
temporary profile created at logon, 
and when the member logs off, the 
profile is deleted.

User and Group Management

 d. Administrator

 e. Guest

 c. Idle Timeout and Screen Lock

 a. Track Login Times

 b. Users

Windows Firewall
A firewall protects computers and networks by preventing undesirable traffic from entering 
internal networks. A software firewall, such as Windows Firewall, is a program that provides 
firewall services on a computer to allow or deny traffic to the computer.

Review the Lab–Configure Windows Firewall.
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Check Your Understanding—Firewalls

Match the description on the left with the firewall term on the right. This exercise 
is a one-to-one matching.

Description

 a. This network-based solution is 
used for small- to medium-sized 
organizations. These devices use 
advanced features to filter packets.

 b. These rules are applied to incoming 
Internet traffic and traffic leaving your 
computer going to the network. They 
can specify ports, protocols, programs, 
services, users, or computers.

 c. This term refers to using software 
such as Windows Defender Firewall.

 d. These rules ensure secure traffic 
between two computers. They require 
that both computers have the same 
rules defined and enabled.

 e. This is a network-based solution 
using a home or small office wireless 
router. These devices not only provide 
routing and Wi-Fi services but also 
provide NAT, DHCP, and firewall 
services.

Term

 a. ASA firewall

 d. Connection security rules

 c. Host-based

 b. Inbound and outbound rules

 e. SOHO router

Web Security
Web browsers are used not only for web browsing but also now to run other applications 
including Microsoft 365, Google Docs, the interface for remote-access SSL users, and more. To 
help support these additional features, browsers use plug-ins to support other content. How-
ever, some of these plug-ins may also introduce security problems.

Check Your Understanding—Web Security

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. This feature detects phishing websites, 
analyzes websites for suspicious items, 
and checks downloads against a list 
that contains sites and files that are 
known to be malicious.

 b. This enables a user to limit or prevent 
most of the windows that appear 
without your permission while 
browsing the web.

 c. All web browsers provide the ability 
to browse the web anonymously 
without retaining information.

 d. This may degrade performance or 
introduce security risks.
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Term

 d. ActiveX Controls

 c. InPrivate mode

 b. Pop-Up blocker

 a. SmartScreen Filter

Security Maintenance
Devices often come with security features that are not enabled or the security features left to 
their defaults. The problem is that the default permissive settings leave many devices exposed 
to attackers.

It is your responsibility to secure devices and configure restrictive settings whenever possible.

Check Your Understanding—Security Maintenance

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. This ensures that any packet not 
explicitly permitted is denied.

 b. Windows clients use this to determine 
when media is inserted and which 
types to run automatically.

 c. This enables access through all ports, 
except those explicitly denied.

 d. These are updates that manufacturers 
provide to prevent a newly discovered 
virus or worm from making a 
successful attack.

Term

 b. AutoPlay

 d. Patches

 c. Permissive settings

 a. Restrictive setting

Wireless Security
Wireless security involves configuring wireless access points with features to authenticate 
users and encrypt traffic.

Configure Wireless Security
Radio waves used to transmit data in wireless networks make it easy for attackers to monitor 
and collect data without physically connecting to a network. Attackers gain access to an 
unprotected wireless network simply by being within range of it. When installing wireless 
services, apply wireless security techniques immediately to prevent unwanted access to the 
network.
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Check Your Understanding—Wireless Security

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. This uses a mathematical function to 
create a numeric value that is unique 
to the data in a message.

 b. This is the original 802.11 
specification for securing WLANs.

 c. This physical filtering component 
inspects data packets before they 
reach computers and other devices on 
the network.

 d. This standard uses WEP but secures 
data with the Temporal Key Integrity 
Protocol (TKIP) algorithm.

 e. This is the name of the wireless 
network that is broadcasted by default 
so that devices can detect the wireless 
network.

 f. This requires a public key that is 
widely distributed and a private key 
kept by an individual or device and 
not disclosed to any other party.

 g. This automatically configures wireless 
security but is not recommended and 
should be turned off.

 h. This protocol enables devices to 
dynamically forward traffic through 
network ports without the need for 
user intervention or configuration, but 
it is not secure.

 i. This allows the router to temporarily 
forward data to a specific device.

 j. This requires both sides of a 
conversation to use the same 
encryption key.

 k. This is the current industry standard 
for securing WLANs and uses the 
Advanced Encryption Standard (AES) 
algorithm.

Term

 f. Asymmetric encryption

 c. Hardware firewall

 a. Hash encoding

 i. Port triggering

 e. Service Set Identifier (SSID)

 j. Symmetric encryption

 h. Universal Plug and Play (UPnP)

 d. Wi-Fi Protected Access (WPA)

 g. Wi-Fi Protected Setup (WPS)

 b. Wired Equivalent Privacy (WEP)

 k. WPA2
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Basic Troubleshooting Process for Security
Troubleshooting security implementations includes a troubleshooting process to solve 
problems.

Applying the Troubleshooting Process to Security
Like troubleshooting other hardware and software, Windows troubleshooting is more efficient 
when you follow a troubleshooting process.

Review the Troubleshooting Process Steps

In Table 13-7, list the six troubleshooting steps.

Table 13-7 The Troubleshooting Process

Step 1 Identify the problem.

Step 2 Establish a theory of probable cause.

Step 3 Test the theory to determine the cause.

Step 4 Establish a plan of action to resolve the problem and implement the solution.

Step 5 Verify full system functionality and, if applicable, implement preventive measures.

Step 6 Document findings, actions, and outcomes.

Check Your Understanding—Identify the Problem

The first step in the troubleshooting process is to identify the problem. During this step, gather 
as much information as possible from the customer and from the computer. Asking the right 
questions, testing the operating system, and examining the right data help you understand the 
problem and form a proposed solution.

Open-ended questions allow customers to explain the details of the problem in their own 
words. Closed-ended questions generally require a yes or no answer. In Table 13-8, indicate 
whether the technician’s question is open-ended or closed-ended.

Table 13-8 Open-Ended and Closed-Ended Questions

Question to Identify the Problem Open-Ended Closed-Ended

When did the problem start? X

Have you changed your password recently? X

Have you shared your password? X

Is your security software up to date? X

What websites have you visited recently? X

What security software is installed on your computer? X

Have you scanned your computer recently for viruses? X

Did you open any attachments from a suspicious email? X

What problems are you experiencing? X

Who else has used your computer recently? X
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Common Problems and Solutions for Security
Security problems can be attributed to a number of reasons. You will resolve some types 
of security problems more often than others.

Check Your Understanding—Possible Solutions for Security Problems

Check your understanding of common problems and solutions for security by choosing the 
BEST answer to the following questions.

 1. An unauthorized wireless access point is discovered on the network.

 a. Install/update antivirus software or email antispam software.

 b. Disconnect and confiscate the unauthorized device.

 c. Contact security or the police.

 d. Upgrade to WPA encryption.

 2. System files have been renamed, applications crash, files are disappearing, or file 
permissions have changed.

 a. Remove the virus using antivirus software.

 b. Use the System Restore to restore the system.

 c. Enable the Windows Firewall.

 d. Download an update and install it.

 3. Your wireless network is compromised even though 128-bit WEP encryption is used.

 a. Change the wireless password.

 b. Contact security or the police.

 c. Use WPA2 encryption.

 d. Scan for malware.

Answer: 1-B, 2-A, 3-C
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Labs and Activities

Command Reference
Chapter 13, “Security,” does not include new commands.
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13.2.3.7 Lab–BitLocker and BitLocker To Go 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
Encryption can protect the data on your device by making it only accessed by people who 
have authorization. If device encryption is not available on your device, you might be able to 
turn on standard BitLocker encryption instead.

Note: BitLocker is only available on these Windows versions:

■ Ultimate and Enterprise editions of Windows 7

■ Pro and Enterprise editions of Windows 8 and 8.1

■ Pro, Enterprise, and Education editions of Windows 10

In this lab, you will enable BitLocker encryption on a removable data drive and on the 
computer system drive.

Recommended Equipment
 ■ PCs running Windows

 ■ A removable USB storage drive

Part 1: Use BitLocker To Go
In this part, you will use BitLocker To Go to encrypt a removable storage drive.

Step 1: Encrypt the removable drive.

 a. Insert a removable drive, such as a USB drive, into the computer.

 b. BitLocker is off by default and must be turned on for each drive that needs 
encryption. To turn on and configure BitLocker, navigate to Control Panel > in 
Small icons view, click BitLocker Drive Encryption.

 c. Under Removable data drives, expand the list as needed. Select Turn on 
BitLocker for the desired removable drive.

 d. In the Choose how you want to unlock this drive window, check the Use a 
password to unlock the drive and then enter a password. Click Next to continue.

 e. In How do you want to back up your recovery key, select either Print or Save 
to a file and then click Next.

 f. In the Choose how much of your drive to encrypt window, select Encrypt 
entire drive and click Next.

 g. If you are prompted with the Choose which encryption mode to use window, 
select Compatible mode and click Next to continue.

 h. In the Are you ready to encrypt this drive window, click Start encrypting.

 i. After a few minutes, the removable drive will be encrypted. It can now be removed.
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Step 2: Access the encrypted drive.

 a. Insert the removable drive previously encrypted in the previous step into the 
USB port on the computer.

 b. Navigate to the USB drive in File Explorer or Windows Explorer and open the 
USB drive. (If you are unable to open the USB drive, right-click the encrypted 
drive, and click Unlock Drive.)

 c. Click the More options button. Notice there is an option to enter the recovery 
key. If the password is forgotten, the saved or printed recovery key from the 
previous step can be used to unlock the drive.

Why is it important to save a BitLocker recovery key?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

The recovery key is needed for you to gain access to the computer in the event 
the password is forgotten, or in the event of certain hardware problems, such as 
a motherboard replacement or hard drive crash, or even after performing a BIOS 
update. Without it, there is no way to access your data.

 d. Enter the password to unlock the USB drive. Now you are able to access the 
content on the encrypted drive.

Step 3: Decrypt the drive.

 a. Navigate to the Control Panel > in Small icons view, click BitLocker Drive 
Encryption.

 b. Select the encrypted removable drive. If the drive is locked, enter the password 
to unlock it. Click Turn off BitLocker.

 c. Click Turn off BitLocker when the message appears notifying you that the 
decryption process could take some time. Note the warning message so you do 
not damage the content on the drive.

 d. Click Close when the decryption process is done.

Part 2: Encrypt the Operating System Drive
In this part of the lab, you will use BitLocker to encrypt the operating system drive.

Step 1: Turn on BitLocker.

 a. Return to Control Panel > System and Security > BitLocker Drive Encryption 
to turn on BitLocker for the operating system drive.

 b. Under Operating system drive, select Turn on BitLocker.
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Note: If an error message appears stating the device cannot use a Trusted Platform Module, 
some additional steps must be taken to allow additional authentication at startup. Click 
Cancel and perform these additional steps:

 1) Type gpedit.msc in the Windows search to open the Local Group Policy Editor.

 2) Expand Administrative Templates in the left pane and click Windows 
Components.

 3) In the Windows Components list, select BitLocker Drive Encryption. Select 
Operating System Drives. Select Require additional authentication at startup.

 4) Inside the Require additional authentication at startup window, select the 
Enabled button, and then click Apply and OK to close the window.

 5) Close Local Group Policy Editor to return to the BitLocker Drive Encryption 
window and click Turn on BitLocker.

 c. The Choose how you want to unlock this drive window will open. In this 
window check the Use a password to unlock the drive, select Enter a 
password, and then enter a password and click Next.

 d. In How do you want to back up your recovery key, select either Print or Save 
to a file and then click Next.

 e. In Choose how much of your drive to encrypt window, select Encrypt used 
disk space only and click Next.

 f. In the Choose which encryption mode to use window, select New encryption 
mode and click Next.

 g. In the Are you ready to encrypt this drive window, make sure the Run 
BitLocker system check box is selected and click Continue. A message stating 
the computer must be restarted will appear.

 h. Click Restart now to restart the computer.

 i. When the computer restarts you will be prompted to enter your password to 
unlock the computer.

What is the function of a TPM in relation to BitLocker?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Trusted Platform Module (TPM) can be used to store the disk encryption key so it 
can tie use of the disk to a specific computer.

Step 2: Turn off BitLocker.

 a. To turn off BitLocker, return to Control Panel > System and Security > 
BitLocker Drive Encryption and select Turn off BitLocker.

 b. Click Turn off BitLocker to decrypt the drive. This process may take a while 
depending on the size of the drive.
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13.3.2.5 Lab–Configure Windows Local 
Security Policy (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will configure Windows Local Security Policy. Windows Local Security Policy 
is used to configure a variety of security requirements for stand-alone computers that are not 
part of an Active Directory domain. You will modify password requirements, enable auditing, 
configure some user rights, and set some security options. You will then use Event Manager to 
view logged information.

Recommended Equipment
 ■ A computer with Windows installed

Note: Accessing the Local Security Policy tool is slightly different, depending on the version of 
Windows. But after it is open, the configurations are the same for the remaining steps in this lab.

Step 1: Review the security requirements.

A customer needs to have six stand-alone Windows computers at a branch office 
configured according to the security policy for the organization. These computers 
are not part of an Active Directory domain. The policies must be manually 
configured on each computer. 

The security policy is as follows:

 ■ Passwords must be at least 8 characters.

 ■ Passwords must be changed every 90 days.

 ■ A user may change her password once a day.

 ■ A user must use a unique password for at least eight changes of the password.

 ■ A password must consist of three of the following four elements:

 ■ At least one lowercase alpha character.

 ■ At least one uppercase alpha character.

 ■ At least one numerical character.

 ■ At least one symbol character.

 ■ Users are locked out of the computer after five attempts to enter the correct 
password. A user must wait 5 minutes for the lookout counter to reset.

 ■ Each security setting for Audit Policy should be enabled.

 ■ After 30 minutes of inactivity, the user will be automatically logged out. 
(Windows 8.1 and 8.0 only)

 ■ Users must log in before removing a laptop from a docking station.
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 ■ At login, users should be presented with the following title and text: 

 ■ Title: Caution: 

 ■ Text: Your activity is monitored. This computer is for business use only.

 ■ Users will receive a reminder to change the password 7 days before it expires.

The Windows Local Security Policy tool provides many more settings that are 
beyond the scope of this course.

Step 2: Open the Windows Local Security Policy tool.

 a. To access Local Security Policy in Windows 10, you can use the following two 
paths:

Administrative Tools > Local Security Policy

Or, Search > secpol.msc and then click secpol.

 b. The Local Security Policy window opens. This lab will focus on the Account 
Policies and Local Policies, as highlighted in the figure below. The rest of the 
Security Settings are beyond the scope of this course.

Step 3: Configure the Password Policy security settings.

The first six requirements of the company’s security policy are configured in the 
Account Policies section of the Local Security Policy tool.

 a. Click the arrow next to Account Policies to expand it, and then click Password 
Policy. Six policies are displayed in the right panel with their associated default 
security settings.

 b. The first policy, Enforce password history, is used to set the number of 
unique passwords the user must enter before being allowed to reuse a password. 
According to the organization’s security policy in Step 1, the security setting 
for this policy should be 8. Double-click Enforce password history to open the 
Enforce password history Properties window. Set the value to 8.

 c. Using the security policy requirements in Step 1, fill in the values you should set 
in Local Security Policy for the remaining Password Policy security settings.

Policy Security Setting

Enforce password history 8

Maximum password age 90

Minimum password age 1

Minimum password length 8

Password must meet complexity requirements Enabled

Store passwords using reversible encryption Disabled

Note: The Store passwords using reversible encryption security setting should always be 
disabled. Storing passwords using reversible encryption is essentially the same as storing 
plaintext versions of the passwords. For this reason, this policy should never be enabled 
unless application requirements outweigh the need to protect password information.

 d. Double-click on each of the policies and set the values according to your entries 
in the table above.
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Step 4: Configure the Account Lockout Policy security settings.

 a. According to the security policy in Step 1, how many times is a user allowed to 
attempt to log in before the account is locked?

 ________________________________________________________________________

Five attempts

 b. How long should the user have to wait before attempting to log back in?

 ________________________________________________________________________

5 minutes

 c. Use the Account Lockout Policy security settings in Local Security Policy to 
configure the policy requirements.

Hint: You will need to configure the Account lockout threshold first.

Step 5: Configure the Audit Policy security settings.

 a. In Local Security Policy, expand the Local Policies menu, and then click 
Audit Policy.

 b. Double-click Audit account logon events to open the Properties window. Click 
the Explain tab to learn about this security setting.

 c. Click the Local Security Setting tab, and then click the check boxes for Success 
and Failure. Click OK to close the Properties window and apply the security 
settings.

 d. Continue modifying the rest of the Audit Policy security settings. Click the 
Explain tab for each and read what it does. Click the Success and Failure check 
boxes in each Properties window.

Step 6: Configure additional Local Policies security settings.

 a. In Local Security Policy, click User Rights Assignment under Local Policies to 
view the security settings.

 b. Although none of the security settings need to be modified to meet the 
security policy requirements, spend some time viewing the default settings. Are 
there any you would recommend changing? Why?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. The student may not understand all the settings. However, the 
student should be able to provide at least one example of a User Rights Assignment 
security setting that should be changed. Although the computer is stand-alone, 
this does not mean that it is not on a network. Stand-alone, in this case, means the 
computer is not a part of an Active Directory domain. Therefore, many of the User 
Rights Assignment settings could be changed to better protect the computer on the 
LAN. For example, the Access this computer from the network security setting 
defaults to allow everyone network access. The student might recommend that only 
the Administrator group be allowed access.
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 c. In Local Security Policy, click Security Options under Local Policies to view 
the security settings.

 d. For the remaining security policy requirements in Step 1, list the policy and 
security setting values you need to change in Security Options in the table 
below. The first one is done for you. 

Policy Security Setting

Interactive logon: Machine inactivity limit 1800 seconds

Devices: Allow undock without having to log on Disabled

Interactive logon: Message title for users attempting 
to log on

Caution:

Change the Interactive logon: Message text for users 
attempting to log on

Your activity is monitored. This 
computer is for business use only.

Interactive logon: Prompt user to change password 
before expiration

7 days

Step 7: Test the password policy security settings.

 a. Test your password policy security settings by attempting to change the 
password. Try a new password that does not meet the length or complexity 
requirements.

Control Panel > User Accounts > Make changes to my account in PC settings > 
Sign-in options, and then click Change under Password.

You should be presented with a message that your new password does not meet 
password policy requirements.

Step 8: Export and import security policy settings.

The customer has another five stand-alone computers that must meet the same 
security policy requirements. Instead of manually configuring the settings on each 
computer, export the settings on this computer.

 a. From the menu bar in Local Security Policy, click Action > Export policy...

 b. Choose a name for the .inf file and save it to a location of your choice. 

 c. Copy the security policy .inf file to a flash drive. Take the flash drive to another 
computer. Insert the flash drive, open Local Security Policy, and click 
Action > Import Policy... Locate the .inf on the flash drive and open it to apply 
the security policy to the new computer.
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13.3.3.6 Lab–Configure Users and Groups 
in Windows (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will create users and groups and delete users using the Local Users and Groups 
Manager. You will also assign group and user permission to folders.

Recommended Equipment
 ■ A computer with Windows installed

Instructions

Part 1: Create New Users
New users can be created individually, or you can create a list of new users and groups with 
the Local Users and Groups Manager.

Step 1: Access Local Users and Groups Manager.

In this step, log on to the computer using an account with administrative privi-
leges provided by the instructor. In this lab, the initial user ITEUser is used, and 
Studentxx and Staffxx accounts will be created.

 a. Click Control Panel > in the small icons view, click Administrative Tools > 
click Computer Management. Click Local Users and Groups.

 b. In the Local Users and Groups Manager, select the Users folder.

Question:

What are the names of the accounts listed?

 ________________________________________________________________________

Answers will vary. The Administrator and Guest accounts are included in all the 
answers.

 c. Select the Groups folder.

Question:

Name five groups from the list.

 ________________________________________________________________________

Answers will vary. Some of the groups in the list are: Administrators, Backup 
Operators, Guests, Power Users, and Users.
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 d. Click the Users folder. Right-click your account and select Properties. Click the 
Member Of tab. 

Question:

Which group does your account belong to?

 ________________________________________________________________________

Answers will vary. The account should be a member of the Administrators Group 
because the user is logged into an account with administrative privileges.

 e. Click OK to close the Properties window.

Step 2: Create new users.

In this step, you will create a few more local users using the Local Users and 
Groups Manager.

 a. In the Local Users and Groups window with the Users folder selected, click 
Action > New User.

 b. In the New User window, enter Student01 as a new username and cisco12345 
as the password. If desired, provide a full name and description for the user. 
Click Create.

Question:

What is Student01 required to do when logging in the first time?

 ________________________________________________________________________

Change password.

 c. Create users Student02, Staff01, and Staff02 or a list of usernames provided 
by the instructor. Use cisco12345 as the password for these users. Unselect 
User must change password at next logon for each user. Click Close when 
finished creating all the users.

 d. Double-click Student01. Unselect User must change password at next logon.

Question:

What group does User01 belong to?

 ________________________________________________________________________

Users.
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 e. Click OK.

 f. Click the Groups folder. Double-click the Users group.

Question:

From the description, can the members of the Users group make systemwide chang-
es? What can the Users group do on the computer?

 ________________________________________________________________________

The members of the Users group cannot make systemwide changes, but they can 
run most applications on the local computer.

Question:

Who are the group members?

 ________________________________________________________________________

In this example, Student01, Student02, Staff01, Staff02, and two built-in members 
are part of the Users group.

 g. Click OK to continue.

Step 3: Verify user and group permissions.

The permission for the Users group allows the members to run most applications on 
the local computer. The group member inherited the permission when they joined 
the group during the creation of the account. These members cannot make system-
wide changes. In this step, you will try to create another new user as a member of 
the Users group and use Internet Explorer to navigate to www.cisco.com.

 a. Log off the computer.

 b. Log on as any member of the Users group.

 c. Navigate to the Local Users and Groups Manager. Click Users.

 d. Create a new user account using the name Test and password cisco12345.

Question:

Were you successful in creating the new account? Explain.

 ________________________________________________________________________

Access is denied. As a member of the Users group, you cannot create a new user 
account because the creation of user account affects the entire computer.

 e. Navigate to www.cisco.com using a web browser.

Question:

Were you able to navigate to www.cisco.com? Explain.

 ________________________________________________________________________

Yes. You can run most applications as allowed by the permissions for a member of 
the Users group.
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Part 2: Create New Groups
In this part, you will create new groups named ITEStudent and ITEStaff and add members to 
the group. You will also create folders and assign permissions.

Step 1: Create new groups.

 a. Log off the computer. Log on to the computer using an account with 
administrative privileges. In this example, the account ITEUser has 
administrative privileges.

 b. Navigate to the Local Users and Groups Manager.

 c. Right-click the Groups folder and select New Group.

 d. Enter ITEStaff as the group name. Click Add to add users to this group.

 e. In the Select Users window, enter Staff01 under the heading Enter the object 
names to select. Click Check Names to verify the object was entered correctly. 
Click OK to add Staff01 to the group ITEStaff. Repeat this procedure to add 
Staff02 to the group ITEStaff.

 f. Click Create to complete the group creation process.

 g. Repeat the same procedure to add users Student01 and Student02 to the group 
ITEStudent. Click Create. Click Close when finished with new group creation.

 h. Click Users and double-click each of the four users and verify they are 
members of the correct groups by clicking the Member Of tab. Click Cancel to 
close each user after verification.
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Step 2: Assign group permissions to folders.

 a. Create folders named Staff and Students in the C:\ drive.

 b. Select and then right-click the Students folder and select Properties.

 c. Select the Security tab. Click Edit to change the permission for this folder.

 d. Click Add to add group permission to this folder.

 e. In the Select Users or Groups window, enter ITEStaff under the heading Enter 
the object names to select. Click Check Names for verification. Click OK to 
continue.

Question:

With the group ITEStaff highlighted, what can the members do in this folder?

 ________________________________________________________________________

The members of the ITEStaff group have read & execute, list folder contents, 
and read permissions.

 f. Repeat the same procedure to add permissions for the group ITEStudent. In 
addition, the members of this group should have full control of this folder.

Question:

Which additional checkbox would you select?

 ________________________________________________________________________

You would select the Full Control checkbox.

 g. Click OK to continue. Click OK to close the Properties window.

 h. Select the Staff folder. Right-click the folder and select Properties.

 i. Click the Security tab to add group permission as follows:

 ■ Allow the group ITEStaff Full control.

 ■ Deny Full control for the group ITEStudent.

 j. Click OK. Click Yes when prompted to deny permission to a group.

 k. Click OK to close the Properties window.
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Part 3: Modify User and Group Permissions
In this part, you will verify the results of the group permission on the folders Staff and 
Students. You will also modify user and group permissions.

Step 1: Verify and modify folder permissions.

 a. Log off the computer. Log on the computer as Student02.

 b. Navigate to the folder C:\Students. Create a folder named Student02 and create 
a text document in the folder.

Question:

Were you successful? Explain.

 ________________________________________________________________________

Yes. As a user in the group ITEStudent, Student02 has full control in this folder.

 c. Navigate to the folder C:\Staff. Create a folder named Student02 and place a 
text file in the folder.

Question:

Were you successful? Explain.

 ________________________________________________________________________

No. As a user in the group ITEStudent, Student02 has no permission to access this 
folder. A user with administrative privilege needs to grant you access to this folder.

 d. Now log off the computer and log on as Student01.

 e. Navigate to C:\.

Question:

Can you place a text file in the Staff folder? Can you modify the text file in folder 
Student02? Explain. 

Note: A reboot may be necessary for Windows 8.1 to enable the change in file and folder 
permission.

 ________________________________________________________________________

No and Yes. As a user in the group ITEStudent, Student01 has no access to the 
Staff folder, but the user has full control in the Students folder, including files and 
folders created by other group members.

 f. Create a new folder named Student01 in the folder C:\Students and create a 
text document in the folder.

 g. To prevent the user Student02 and other ITEStudent group members from 
modifying this folder and its content, right-click the folder Student01 and select 
Properties.

 h. In the Security tab, click Edit.

 i. Add the user Student01 with Full control permission to this folder. Select Full 
Control under the Allow column.
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 j. Select the group ITEStudent. Select the Modify checkbox under the Deny 
column to prevent other ITEStudent group members from modifying this folder 
and its content. Click OK. Click Yes in the Windows Security window when 
prompted. Click OK to close the Properties window.

 k. Log off the computer and log on as Student02.

 l. Navigate to the folder C:\Students.

Question:

Are you able to access the content in the Student01 and Student02 folders? 
Explain.

 ________________________________________________________________________

No and Yes. As a user in the group ITEStudent, Student02 still has access to the 
Student02 folder, but there is no access to the Student01 folder.

 m. Log off the computer and log on as Staff01.

 n. Navigate to the folder C:\.

Question:

Were you able to access the content in the folders Staff, Student\Student01, and 
Student\Student02? Explain.

 ________________________________________________________________________

Yes. As a user in the group ITEStaff, Staff01 has all the content in C:\Staff and 
C:\Student. The group permission did not deny write access to the Student folders.

Step 2: Disable a user account.

At this time, the user account Staff02 is not being used. In this step, you will 
disable this account.

 a. Log off the computer and log on as ITEUser or an account with administrative 
privileges.

 b. Navigate to the Local Users and Groups Manager. 

 c. Select the Users folder. Double-click Staff02.

 d. Check that Account is disabled.

 e. Click OK to continue.

 f. Log off the computer.

Question:

Can you log on as Staff02? Explain.

 ________________________________________________________________________

No. Because the account has been disabled, Staff02 is not listed and you are unable 
to log on as Staff02.
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Step 3: Clean up.

In this step, you will delete the users, groups, files, and folders created in this lab.

 a. Log on using an account with administrative privileges.

 b. Navigate to C:\ and delete the folders Staff and Student.

 c. Navigate to the Local Users and Groups Manager.

 d. Select Users.

 e. Right-click Staff01 and select Delete. Click Yes to confirm the user deletion. 
Repeat this for Staff02, Student01, and Student02.

 f. Select Groups.

 g. Right-click ITEStaff and select Delete. Click Yes to confirm the group deletion. 
Repeat this for ITEStudent.

Reflection Questions
 1. How would you give administrative privileges on the local computer to all the members 

of ITEStaff?

 

The members of the group ITEStaff inherit local administrative privileges when it is added to 
the built-in group Administrator. To change group permission, navigate to Control Panel > 
Administrative Tools > Computer Management > Local Users and Groups > right-click Add 
to Group. Click Add to add ITEStaff to the group Administrator.

 2. How would you deny access to a file for everyone except the owner?

 

In the File Properties window, give full control to the owner and explicitly deny all access to 
other groups and users.
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13.3.4.6 Lab–Configure Windows Firewall 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will explore the Windows Firewall and configure some advanced settings. 

Recommended Equipment
 ■ Two Windows PCs directly connected or connected over the network

 ■ Computers in the same workgroup and network

Instructor Note: Set the following computer configurations:

 ■ Turn on Network Discovery for both computers.

 ■ Create User accounts on PC-1 and PC-2 and add them both to the Administrators 
group. For example: on PC-1 and PC-2, create ITEuser accounts on both PCs. Make 
sure to assign a password to the accounts.

 ■ On PC-2, turn off Use Sharing Wizard (Recommended).

 ■ Windows 8.1 and 10: Open File Explorer > click View > click Options > click 
Change folder and search options > View tab, and then uncheck Use Sharing Wizard 
(Recommended) > click OK.

 ■ Windows 7: Click Start > click Computer > click Tools > click Folder Options > View 
tab, and then uncheck Use Sharing Wizard (Recommended) > click OK.

Step 1: Create and share a folder on PC-1.

 a. Log on to PC-1 as a member of the administrator group. Ask your instructor for 
the username and password.

 b. Verify that you can ping PC-2.

 c. On PC-1, right-click the desktop, select New > Folder. Name the folder Cisco.

 d. Right-click the Cisco folder, and then select Properties > Sharing > Advanced 
Sharing. The Advanced Sharing window opens. Click Share this folder and use 
the default name Cisco. Click OK. Close the Cisco Properties window.

Step 2: Use File Explorer or Windows Explorer to view PC-1’s shared folder.

 a. Log on to PC-2 as a member of the administrator group. Ask your instructor for 
the username and password.

 b. Open File Explorer or Windows Explorer. In the left pane, under Network, 
expand PC-1.

Under PC-1, are you able to see the shared folder Cisco?   Yes

Note: If you answered no, ask the instructor for help.

 c. Close File Explorer or Windows Explorer.
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Step 3: Open Windows Firewall on PC-1.

Note: Use PC-1 for the rest of the lab unless otherwise stated.

 a. To open the Windows Firewall window, click Control Panel > System and 
Security > Windows Defender Firewall or Windows Firewall.

 b. The normal state for the Windows Firewall is On. 

What are the benefits of Windows Firewall?

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Windows Firewall can help prevent hackers or malicious software from gaining 
access to your computer through the Internet or a network. 

Step 4: Investigate the Windows Firewall Allowed Programs feature.

 a. Click Allow an app or feature through Windows Defender Firewall or Allow 
apps to communicate through Windows Firewall.

 b. The Allowed apps window opens. Programs and services that Windows Fire-
wall is not blocking will be listed with a check mark. Click What are the risks 
of allowing an app to communicate? or What are the risks of allowing a 
program to communicate?

Note: You can add applications to this list. This may be necessary if you have an application 
that requires outside communications, but for some reason the Windows Firewall cannot 
perform the configuration automatically.

Creating too many exceptions in your Programs and Services file can have 
negative consequences.

Describe a negative consequence of having too many exceptions. 

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. Exceptions for a program to communicate through the Windows 
Firewall are like opening a hole in the firewall. Attackers use software that scans the 
Internet looking for computers with many exceptions and open ports.

 c. Close the Windows Help and Support window.

Step 5: Configure the Windows Firewall Allowed apps feature.

 a. In the Allowed apps window, click Change settings. Remove the check mark 
from File and Printer Sharing. Click OK.

 b. On PC-2, using File Explorer or Windows Explorer, attempt to open the 
network connect to PC-1.

Can you connect to PC-1 and view the Cisco shared folder?   No
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Did you receive an error message on PC-2? If so, what was the error message?

 ________________________________________________________________________

Yes. Windows cannot access \\PC-1.

 c. Close all open windows on PC-2.

 d. On PC-1, add a check mark to File and Printer Sharing. Click OK.

Note: You should be able to add the check mark without needing to click Change settings.

 e. On PC-2, reopen File Explorer or Windows Explorer and attempt to connect 
to PC-1. 

Can you connect to computer 1? Explain.

 ________________________________________________________________________

Yes, because PC-1’s File and Printer Sharing is not being blocked by the firewall any 
longer.

 f. Close all open windows on PC-2 and log off.

 g. Close all windows on PC-1.

Step 6: Explore Advanced Security features in Windows Firewall.

Note: Use PC-1 for the rest of this lab.

 a. Click Control Panel > in Small icons view, Administrative Tools > Windows 
Defender Firewall with Advanced Security or Windows Firewall with 
Advanced Security.

 b. In the left panel of the Windows Defender Firewall with Advanced Security 
or Windows Firwall with Advanced Security window, you can select items to 
configure Inbound Rules, Outbound Rules, or Connection Security Rules. You 
can also click Monitoring to view the status of configured rules. Click Inbound 
Rules.

 c. In the middle panel, scroll down until you find the inbound rule named Files 
and Printer Sharing (Echo Request – ICMPv4-In). Right-click the rule and 
select Properties, and then select the Advanced tab.

 d. The Advanced tab displays the profile(s) used by the computer. Click 
Customize in the Interface Types area of the window.

 e. The Customize Interface Types window displays the different connections 
configured for your computer. Leave All interface types selected, and then 
click OK.

 f. Click the Programs and Services tab. In the Services section, click Settings....

List the short name of four services that are available in the Customize Service 
Settings window.

 ________________________________________________________________________

Answers will vary. AeLookupSvc, Appinfo, ALG, AppMgmt, etc.
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 g. Click Cancel to close the Customize Service Settings window.

 h. Click the Protocols and Ports tab.

Note: There are many applications that users do not normally see that also need to get 
through the Windows Firewall to access your computer. These are the network-level 
programs that direct traffic on the network and the Internet. 

 i. For the ICMP settings, click Customize.

 j. The Customize ICMP Settings window opens. Allowing incoming echo 
requests is what allows network users to ping your computer to determine if it is 
present on the network.

List four of the specific ICMP types.

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Answers will vary. Packet Too Big, Destination Unreachable, Source Quench, 
Redirect, etc.

 k. Close all open windows on PC-1.

 l. Right-click the Cisco folder on the desktop, and then select Delete.

Reflection
What are some possible reasons you may need to make firewall changes?

 

 

 

 

Answers will vary.  By default, most apps are blocked by Windows Firewall. You may be 
required to make firewall changes to allow some apps to function correctly. Other times, you 
might need to open a specific port to get an app to function correctly. For example, to play a 
multiplayer game with friends online, you might need to open a port for the game so that the 
firewall allows the game information to reach your PC.
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13.4.1.10 Packet Tracer–Configure Wireless 
Security (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this activity, you will configure the wireless router to:

 ■ Use WPA2 Personal as the security method

 ■ Rely on MAC filtering to increase security

 ■ Support Single Port Forwarding

Step 1: Connect to the wireless router.

 a. From the Desktop tab on PC0, click Web Browser.

 b. Type in the IP address of the wireless router 192.168.0.1 and press Enter. You 
may get a Request Timeout message while the network converges. Press Enter 
again.

 c. When prompted for credentials, enter the default username and password, 
admin.

Step 2: Configure WPA2 security on the wireless router.

 a. Click Wireless > Wireless Security. For each of the radios, 2.4 GHz, 5.1 GHz -1, 
and 5.1 GHz -2, change Security Mode to WPA2 Personal. AES is currently the 
strongest encryption protocol available. Leave it selected.

 b. Configure the passphrase for each as aCompWiFi. Scroll down the page and 
click Save Settings.

Step 3: Configure Laptop0 as a wireless client.

 a. From the Desktop tab on Laptop0, click PC Wireless. You should see the 
message No association with access point.

 b. Click the Connect tab. Allow a few seconds for the SSID broadcasted by WRS1 
to appear. You should see three SSIDs starting with aCompany listed under the 
Wireless Network Name column.

 c. Select the SSID named aCompany, and then click Connect.

 d. In the Security field, choose WPA2-Personal. Enter the password for the 
wireless network, aCompWiFi, and then click Connect.

 e. Laptop0 should now be associated to WRS1.

 f. Close the PC Wireless window and click Command Prompt.

 g. Type ipconfig /all and take note of the IP address and MAC addresses.

Packet Tracer 

  Activity
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Step 4: Configure WRS1 to support MAC filtering.

 a. Click PC0. If necessary, reopen the Web Browser and connect to WRS1 again.

 b. Navigate to Wireless > Wireless MAC Filter.

 c. Select Enabled and Permit PCs listed below to access wireless network.

 d. Type in the MAC address for Laptop0 in the MAC 01: field. Notice the MAC 
address must be in the XX:XX:XX:XX:XX:XX format.

 e. Scroll down the page and click Save Settings.

 f. Because Laptop0’s MAC address is the only one specified, Laptop0 is the only 
wireless device currently capable of associating to WRS1. Test connectivity 
through the Telco Cloud.

 g. From the Desktop tab on Laptop0, click Command Prompt.

 h. Test connectivity to RemotePC by issuing the ping 209.165.201.2 command. 
The first few pings may fail while the network converges. Issue the command 
again if you did not get successful replies.

 i. From the Desktop tab on RemotePC, click Web Browser and type the address 
of the internal web page hosted at Server0, which is www.acompany.com. 
A Request Timeout message should display. A webpage request from RemotePC 
to Server0 is not successful because WRS1 does not know which internal 
device should get it. In order to accomplish that, port forwarding must be 
configured.

Step 5: Configure WRS1 to forward a single port to Server0.

 a. Click PC0. If necessary, reopen the Web Browser and connect to WRS1 again.

 b. Navigate to Application & Gaming > Single Port Forwarding.

 c. From the left-hand menu, choose HTTP from the first combo box. Then change 
the IP address to match the Server0 IP address, 192.168.0.2. Also check the 
Enabled checkbox at the end of that same row.

 d. Scroll down the page and click Save Settings.

 e. You should now be able to reach the webpage hosted on Server0. Open the 
Web Browser on RemotePC. In the address bar, type in www.acompany.com. 
You should now see the web page hosted by Server0.
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13.5.2.2 Lab–Document Customer Information 
in a Work Order (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
As a help desk technician, it is your job to gather data from the customer to begin the 
troubleshooting process. As a Level 1 technician, you do not have administrative rights 
to the customer’s computer. Issues that require administrative rights must be escalated to a Level 2 
technician. Use the Customer Information sheet on page 2 or one provided by your instructor to 
document the customer’s problem in the work order below. Assign a case number of your choice 
and set the Priority as a P2 (Significant Issue). Describe the problem and recommend a solution.

Work Order

Technician Sheet 

Company Name: Organization of Associated Chartered Federations, Inc.

Contact: Braxton Jones

Company Address: 123 E. Main Street

Company Phone: 480-555-1234

Generating a New Ticket

Category: Security Status: Open Escalated: Yes

Business Impacting? (Yes / No)  
Summary User is not able to log in.

Case ID #:  Priority:  
User Platform: Windows 7

Problem Description
 

The user cannot log in on multiple computers on the network. The user’s password has 
probably expired.

Problem Solution
 

Escalate the problem to a Level 2 administrator with the rights to reset user passwords.

Instructor Note: This customer information is just an example. Generate additional scenarios 
that the student can use to practice filling out work orders. Or divide the students into pairs. 
Have one student come up with a scenario and the other student document the customer 
information. Then have the students switch roles.
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Customer Information
Use the contact information and problem description below to report the following 
information to a level-one technician.

Contact Information
Company Name:  Organization of Associated Chartered Federations, Inc.

Contact:  Braxton Jones 

Note: Braxton contributes significantly to the organization’s daily operations.

Company Address: 123 E. Main Street

Company Phone:  480-555-1234

Category: Security

Problem Description
I am not able to log in. I was able to log in yesterday and all days previously. I tried to log in 
with a different computer but was unsuccessful there also. I received an email last week about 
changing my password, but I have not changed my password yet. 

Additional Information
 ■ Windows 7
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CHAPTER 14

The IT Professional

This chapter reviews the roles and responsibilities of the IT professional, including good 
communication skills, dealing with legal and ethical issues, and the call center environment.
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Study Guide

Communication Skills and the IT Professional
This section reviews the communications skills that are vital for the IT professional to master.

Communication Skills, Troubleshooting, and Professional 
Behavior
Speaking directly with the customer is usually the first step in resolving a computer problem. 
To troubleshoot a computer, you need to learn the details of the problem from the customer. 
Establishing a good rapport with the customer is vital to obtaining the information that you 
need to determine the source of the problem and then fix it.

If you are talking with a customer in person, that customer can see your body language. If you 
are talking with a customer over the phone, that customer can hear your tone and inflection.

Successful technicians control their own reactions and emotions from one customer call to the 
next.

Working with a Customer
One of your first tasks as a technician is to identify the customer’s computer problem. The key 
words know, relate, and understand can help guide you in this process:

 ■ Know—Call customers by their preferred name.

 ■ Relate—Find a way to develop a one-to-one connection with the customer.

 ■ Understand—Determine the customer’s level of knowledge about the computer 
problem.

To better enable you to determine the customer’s problem, practice active listening skills. Allow 
the customer to tell the whole story. For example, after you have assured the customer that 
you understand the problem, you will probably have to ask some follow-up questions. Make 
sure that these questions are pertinent. Do not ask questions that the customer has already 
answered while describing the problem. Follow-up questions should be targeted, closed-ended 
questions based on the information that you have already gathered.

Tips for using active listening with a customer include the following:

 ■ Do allow the customer to tell the problem.

 ■ Do occasionally interject some small word or phrase such as “I understand,” “Yes,” 
“I see,” or “Okay” to let the customer know that you are listening.

 ■ Do summarize the customer’s problem when he is done so that you both are certain that 
you understand.

 ■ Do ask clarifying questions.

 ■ Do not interrupt the customer the moment you realize you have a question.
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Check Your Understanding—Closed-Ended and Open-Ended Questions

In Table 14-1, indicate whether the question is open-ended or closed-ended.

Table 14-1 Closed-Ended and Open-Ended Questions

Question Open-Ended Closed-Ended

Is your computer running Windows 10? X

What have you already tried to do to fix this problem? X

How long have you had this laptop? X

Can you tell me what you were doing when the problem 
first occurred?

X

Professional Behavior
The following list describes things that you should not do when talking with a customer:

 ■ Do not minimize a customer’s problems.

 ■ Do not use jargon, abbreviations, acronyms, or slang.

 ■ Do not use a negative attitude or tone of voice.

 ■ Do not argue with customers or become defensive.

 ■ Do not make culturally insensitive remarks.

 ■ Do not disclose any experiences with customers on social media.

 ■ Do not be judgmental or insulting or call customers names.

 ■ Avoid distractions, and do not interrupt when talking with customers.

 ■ Do not take personal calls when talking with customers.

 ■ Do not talk to coworkers about unrelated subjects when talking with customers.

 ■ Avoid unnecessary holds and abrupt holds.

 ■ Do not transfer a call without explaining the purpose of the transfer and getting cus-
tomer consent.

 ■ Do not use negative remarks about other technicians to customers.

When on a telephone, make sure that you know how to place a customer on hold, as well as 
how to transfer a customer without losing the call.

 ■ Do not interrupt the customer.

 ■ Do not put a customer on hold or transfer the call without an explanation.

 ■ Do not put a customer on hold or transfer the call without the customer’s consent.

 ■ Do not assume that your time is more valuable than the customer’s.
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Check Your Understanding—Netiquette

In Table 14-2, indicate whether the statement is true or false.

Table 14-2 Netiquette

Netiquette Statement True False

Be pleasant and polite. X

Begin emails with an appropriate greeting, except within a thread. X

Chain letters are all right to send in email. X

Do not send anger-filled, accusatory emails, called “flames.” Do not 
reply to flames.

X

Use all uppercase if that is quicker. X

Check grammar and spelling before you send an email or text. X

Be ethical. X

Never email or text anything you would not say to someone’s face. X

The Customer Call
These practices make the best use of your time and the customer’s time:

 ■ Use proper language—Be clear, and avoid technical language that customers might not 
understand.

 ■ Listen and question—Listen carefully to customers and let them speak. Use open- and 
closed-ended questions to learn details about the customers’ problems.

 ■ Give feedback—Let customers know that you understand the problem, and develop a 
friendly and positive conversational manner.

Replay the following videos in the online curriculum to review strategies for dealing with 
different types of difficult customers.

Video—The Talkative Customer

Tips for helping a talkative customer:

 ■ Do allow the customer to talk for about one minute.

 ■ Do gather as much information about the problem as possible.

 ■ Do politely step in to refocus the customer. This is the one exception to the rule of never 
interrupting a customer.

 ■ Do ask as many closed-ended questions as you need to after you have regained control 
of the call.

 ■ Do not encourage non-problem-related conversation by asking social questions such as 
“How are you today?”
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Video—The Rude Customer

Tips for helping a rude customer:

 ■ Do listen very carefully, as you do not want to ask the customer to repeat information.

 ■ Do follow a step-by-step approach to determining and solving the problem.

 ■ Do try to contact the customer’s favorite technician, if she has one, to see if that 
technician can take the call.

 ■ Do apologize for the wait time and the inconvenience, even if there has been no wait time.

 ■ Do reiterate that you want to solve the problem as quickly as possible.

 ■ Do not ask the customer to do any obvious steps if there is a way you can determine the 
problem without that information.

 ■ Do not be rude to the customer, even if he is rude to you.

Video—The Knowledgeable Customer

Tips for helping a knowledgeable customer:

 ■ Do consider setting up a call with a level two technician if you are a level one technician.

 ■ Do give the customer the overall approach to what you are trying to verify.

 ■ Do not follow a step-by-step process with this customer.

 ■ Do not ask to check the obvious, such as the power cord or the power switch.

Video—The Angry Customer

Tips for helping an angry customer:

 ■ Do let the customer tell the problem without interrupting, even if he is angry.

 ■ Do sympathize with the customer’s problem.

 ■ Do apologize for the wait time or inconvenience.

 ■ Do not, if at all possible, put this customer on hold or transfer the call.

 ■ Do not spend the call time talking about what caused the problem.

Video—The Inexperienced Customer

Tips for helping an inexperienced customer are the same as for a talkative customer:

 ■ Do allow the customer to talk for about one minute.

 ■ Do gather as much information about the problem as possible.

 ■ Do politely step in to refocus the customer. This is the one exception to the rule of never 
interrupting a customer.

 ■ Do ask as many closed-ended questions as you need to after you have regained control 
of the call.

 ■ Do not encourage non-problem-related conversation by asking social questions such as 
“How are you today?”
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Operational Procedures
This section reviews operational procedures including documentation, change management, 
and disaster prevention and recovery.

Documentation
Documentation is the main way of communicating processes and procedures to employees, 
customers, suppliers, and others. Updates to policies and procedures are inevitable, especially 
in the constantly changing environment of information technology. Establish a standard time 
frame for reviewing documents, diagrams, and compliance policies to ensure that the correct 
information is available when it is needed.

Check Your Understanding—Documentation

In general, IT documentation falls into four broad categories. Match the description on the left 
with the type of documentation on the right. This exercise is a one-to-one matching.

Description

 a. Searchable knowledgebase articles and 
FAQs.

 b. Security policies that outline all 
aspects of information security, 
including password policies and 
security incident response methods.

 c. Inventory management, including 
hardware and software inventories, 
licenses, and management methods, 
such as the use of asset tags and 
barcodes.

 d. Logical and physical network 
topology diagrams, equipment 
specifications, and device 
configurations.

Type of Documentation

 c. Operation and planning documents

 b. Policy documents

 d. Project documents

 a. User documentation

Change Management
A good change management process can prevent business functions from being negatively 
impacted by the updates, upgrades, replacements, and reconfigurations that are a normal part 
of IT operations. Change management usually starts with a change request from a stakeholder 
or from within the IT organization itself.

Change Management Process Review

Most change management processes include the following:

 ■ Identification—What is the change? Why is it needed? Who are the stakeholders?

 ■ Assessment—What business processes are impacted by this change? What are the costs 
and resources necessary for implementation? What risks are associated with making (or 
not making) this change?
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 ■ Planning—How long will this change take to implement? Is there downtime involved? 
What is the rollback or recovery process if the change fails?

 ■ Approval—Who must authorize this change? Has approval to proceed with the change 
been obtained?

 ■ Implementation—How are stakeholders notified? What are the steps to complete the 
change, and how will the results be tested?

 ■ Acceptance—What are the acceptance criteria, and who is responsible for accepting the 
results of the change?

 ■ Documentation—What updates are required to change logs, implementation steps, or IT 
documents because of this change?

Disaster Prevention and Recovery
A disaster recovery plan is a comprehensive document that describes how to restore operation 
quickly and keep critical IT functions running during or after a disaster occurs.

Check Your Understanding—Disaster Recovery Plan

There are five major phases of creating and implementing a disaster recovery plan. Match the 
description on the left with the type of plan on the right. This exercise is a one-to-one matching.

Description

 a. Determine the availability of backup 
routers, switches, and other network 
devices should they fail.

 b. Practice disaster recovery exercises.

 c. Develop a budget to implement the 
disaster recovery plan.

 d. After implementation for a specified 
period of time, review the plan.

 e. Verify cost estimates of inventory and 
used services.

Disaster Recovery Plan Phases

 c. Approval and Implementation

 e. Inventory and Documentation

 a.  Network Design and Recovery 
Strategy

 d. Review

 b. Verification

Ethical and Legal Considerations
The IT professional must always act in accordance with ethical standards and the law.

Ethical and Legal Considerations in the IT Profession
Computers and monitors are property, but property also includes any information or data that 
might be accessible, for example:

 ■ Emails

 ■ Phone lists and contact lists

 ■ Records or data on the computer

 ■ Hard copies of files, information, or data left on a desk

Before accessing computer accounts, including the administrator account, get the permission of 
the customer.
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Review Types of PII

Take particular care to keep personally identifiable information (PII) confidential. PII is any 
data that could potentially identify a specific individual. Examples of PII include but are not 
limited to

 ■ Names, such as full name, maiden name, mother’s maiden name, or alias

 ■ Personal identification numbers, such as Social Security number (SSN), passport 
number, driver’s license number, and taxpayer identification number

 ■ Financial account or credit card number

 ■ Address information, such as street address or email address

 ■ Personal characteristics, including photographic images, fingerprints, handwriting, or 
other biometric data

Protected Health Information (PHI) is a form of PII. It includes patient names, addresses, 
dates of visits, telephone and fax numbers, and email addresses. Electronic Protected Health 
Information (ePHI) is also regulated. Penalties for breaches of PHI and ePHI are very severe 
and regulated by the Health Insurance Portability and Accountability Act (HIPAA).

Review of Legal Considerations

It is not permissible to do any of the following:

 ■ Make any changes to system software or hardware configurations without customer 
permission.

 ■ Access a customer’s or coworker’s accounts, private files, or email messages without 
permission.

 ■ Install, copy, or share digital content in violation of copyright and software agreements 
or the applicable law.

 ■ Use a customer’s company IT resources for commercial purposes.

 ■ Make a customer’s IT resources available to unauthorized users.

 ■ Knowingly use a customer’s company resources for illegal activities.

 ■ Share sensitive customer information.
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Check Your Understanding—Licensing

A software license is a contract that outlines the legal user, or redistribution, of that software. 
Match the description on the left with the type of licensing on the right. This exercise is a 
one-to-one matching.

Description

 a. Typically, with this type of license, 
the company pays for its employees to 
use the software. This software does 
not need to be registered every time 
it is installed on another employee’s 
computer.

 b. Some examples of this type of license 
software are Linux, WordPress, and 
Firefox.

 c. Most of these types of software 
licenses allow you to run the program 
on only one machine. Some will 
allow you to copy the software onto 
multiple computers. These licenses 
usually specify that the copies cannot 
be used at the same time.

 d. If a person uses software to make 
money, that person would pay for this 
type of license.

 e. In addition to licensing, there is soft-
ware that helps to control the illegal 
use of software and content. The pur-
pose for using this is to prevent copy-
righted content from being copied 
freely.

Type of Licensing

 d. Commercial software license

 e. Digital rights management

 a. Enterprise license

 b. Open source licenses

 c. Personal license

Legal Procedures Overview
Data from computer systems, networks, wireless communications, and storage devices may 
need to be collected and analyzed in the course of a criminal investigation. Cyber laws explain 
the circumstances under which data (evidence) can be collected from computers, data storage 
devices, networks, and wireless communications. First response is the term used to describe 
the official procedures employed by those people who are qualified to collect evidence. First 
responders want to know what you have done and what you have not done. Your documenta-
tion may become part of the evidence in the prosecution of a crime. You must be able to prove 
how evidence was collected, where it has been physically stored, and who has had access to it 
between the time of collection and its entry into the court proceedings.
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Check Your Understanding—Legal Procedures Overview

Match the description on the left with the term on the right. This exercise is a one-to-one 
matching.

Description

 a. Consistent naming conventions should 
be used for forensic tool output. You 
should stamp logs with the time, date, 
and identity of the person performing 
the forensic collection. These best 
practices provide an audit trail for the 
information collection process.

 b. These explain the circumstances under 
which data (evidence) can be collected 
from computers, data storage 
devices, networks, and wireless 
communications.

 c. This is the collection and analysis of 
computer or network data during the 
course of a criminal investigation.

 d. This is the term used to describe 
the official procedures employed by 
those people who are qualified to 
collect evidence.

 e. RAM, cache, registries, and data in 
transit between a storage medium and 
a CPU are this type of data.

 f. A system administrator may testify 
about the evidence that was collected. 
But the administrator must also be 
able to prove how this evidence was 
collected, where it has been physically 
stored, and who has had access to it 
between the time of collection and its 
entry into the court proceedings.

 g. This data is stored on a local drive, 
such as an internal or external hard 
drive, or an optical drive.

Term

 f. Chain of custody

 c. Computer forensics

 b. Cyber laws

 a. Documentation

 d. First response

 g. Persistent data

 e. Volatile data

Call Center Technicians
People who respond to calls from customers are typically level one or level two technicians.
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Level One and Level Two Technicians
The typical workflow of a call center starts with calls from customers displayed on a callboard. 
Level one technicians answer these calls in the order that the calls arrive. If the level one 
technician cannot solve the problem, it is escalated to a level two technician.

Review Level One Technician Responsibilities

The primary responsibility of a level one technician is to gather pertinent information from the 
customer. The technician has to accurately enter all information into the ticket or work order. 
Following are examples of the type of information collected:

 ■ Contact information

 ■ Manufacturer and model of computer

 ■ OS the computer is using

 ■ Power state of the computer

 ■ Network information, including wired or wireless connection

 ■ Specific application used when the problem occurred

 ■ Any new drivers or updates installed recently and what they are

 ■ Description of the problem

 ■ Priority of the problem

Review Level Two Technician Responsibilities

The level two technician is usually more knowledgeable and experienced than the level one 
technician. The level two technician receives escalated work orders from level one technicians 
with the description of the problem and then calls the customer back to ask any additional 
questions and resolve the problem.

Level two technicians can also use remote access software to connect to the customer’s 
computer to update drivers and software, access the operating system, check the BIOS, 
and gather other diagnostic information to solve the problem.

Basic Script and the IT Professional
A script file is a simple text file written in a scripting language to automate processes and 
tasks on various operating systems. A script file might be used to automate the process of 
performing a backup of a customer’s data or run a list of standard diagnostics on a broken 
computer. The script is designed to be executed line by line using a command-line interpreter 
in order to perform various commands. The script can be created using a text editor.
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Identify the Script File Extension

In Table 14-3, fill in the extension for a script file in the specified language. The Windows .bat 
extension is already filled in for you.

Table 14-3 Script File Extension

Scripting Language Extension

Windows Batch File .bat

PowerShell .ps1

Linux Shell Script .sh

VBScript .vbs

JavaScript .js

Python .py

Identify the Windows and Linux Commands

In Table 14-4, fill in the command for the equivalent commands in Windows and Linux. The 
dir and ls commands are already filled in for you.

Table 14-4 Windows and Linux Commands

Windows Command Linux Command Command Output

dir ls View the contents of the current directory.

cd cd Change directories.

mkdir mkdir Make a directory.

cls clear Clear the screen.

date date Display or set the date.

copy cp Copy a file.

Identify the Data Type

Variables are designated places to store information within a computer. Scripting languages 
typically require variables to be defined as a specific data type. In Table 14-5, fill in the data 
type for each description and example.

Table 14-5 Data Types

Data Type Description Example

int Integer numbers 2, 3, 54, –123, 0

float Numbers with decimals 1234.5768

char A single character S

string Multiple characters He770!

bool True or False True
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Identify the Relational Operator

Conditional statements are needed for scripts to make decisions. For these statements to make 
a decision, a mathematical comparison is made using relational operators. In Table 14-6, fill in 
the missing operators.

Table 14-6 Relational Operators

Operator Windows Batch Windows PowerShell Linux Bash Python

Equal == EQU -eq -eq ==

Not Equal != NEQ -ne -ne !=

Less Than -lt -lt <

Greater Than >GTR -gt -gt >

Less Than or 
Equal To

<=LEQ> -le -le <=

Greater Than or 
Equal To

>=GEQ -ge -ge >=

Identify the Type of Loop

Loops can be used to repeat commands or tasks. In Table 14-7, fill in the type of loop based 
on the description.

Table 14-7 Loop Types

Type of Loop Description

For loop Repeats a section of code a specified number of times.

While loop Checks the Boolean value of a specified value before repeating a section 
of code.

Do-while loop Repeats a section of code and then checks a variable’s Boolean value.
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Labs and Activities

Command Reference
Chapter 14, “The IT Professional,” does not include new commands that are not already 
covered in the Study Guide portion of this chapter.
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14.1.1.2 Lab–Technician Resources 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

In this lab, you will use the Internet to find resources for a specific computer component. 
Search online for resources that can help you troubleshoot the component. In the table 
below, list at least one website for each of the following types of resources: FAQs, manuals, 
troubleshooting/help site, and blogs. Give a brief description of the content on the site. 
Be prepared to discuss the usefulness of the resources you found.

Choose a component or components for your students to research. Alternatively, you may 
divide your class into small groups. Give each group a different component to research. The 
example answers below are for the EVGA 02G-P4-2966-KR GeForce GTX 960 2 GB video 
card. The GeForce chip and some other components are supplied by Nvidia to many different 
companies for them to make video cards. Nvidia is chosen as a sample resource because 
Nvidia products are used in many PC.

Component to research:   EVGA 02G-P4-2966-KR

Type of Resource Website Address

FAQ http://www.evga.com/support/knowledgebase/

A list of questions asked and answered by EVGA support

Manual http://www.evga.com/support/manuals/files/EVGA_Graphics_Manual_
English.pdf 

Owners manual

Online 
troubleshooting 
site

https://secure.evga.com/US/
login.asp?id=C900693B111D438A92C636EA877C617F

Log in to create troubleshooting support ticket

Blog http://blogs.nvidia.com/blog/2015/01/22/maxwell-sweetspot-gtx-960/

Blog about the GeForce 960

Online help site https://forums.geforce.com/default/board/155/ 

Suggested solution to problems from GeForce 900 series owners 
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14.3.1.5 Lab–Investigate Breaches of PII, PHI, PCI 
(Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will investigate breaches of PII, PHI, and PCI by searching the Internet and 
then recording your findings.

Background/Scenario
Personal information, including health and financial data, is compromised by both human 
carelessness and sophisticated computer attacks. This compromised data can affect millions, 
and often the attacks go undetected for some time.  

As an IT professional working with devices and personal data, it is important to be aware of 
the wide range of attacks and vulnerabilities that have occurred and what may have helped 
prevent them.

Required Resources
 ■ PC or mobile device with Internet access.

Part 1: Research a PII Breach
Step 1: In this part of the lab, you will research and describe three breaches that have 

occurred recently.  Include at least one PCI and one PHI. Use the following steps:

 a. Launch your favorite web browser and go to your favorite search engine, such as 
Google.com. What key terms will you use to search for recent breaches?

 ________________________________________________________________________

 ________________________________________________________________________

 b.  Go through the results and find the most interesting breaches that have 
occurred within the last 5 years. 

 c.  Choose three different breaches to document in this lab.  

 d.  Describe the breaches in detail. Make sure you answer the following questions: 

 1) What was the name of the company or organization? 

 2) What was targeted? 

 3) Who was affected?

 4) How did the attack occur? Describe the details of what happened. 

 5) What is the source of your information? Include the URL.

 6) What steps could have been taken to prevent the breach?
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Breach #1:  _______________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Breach #2: _______________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

Breach #3:  _______________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________

 ________________________________________________________________________
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14.4.1.4 Lab–Remote Technician–Repair 
Boot Problem (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will gather data from the customer and then instruct the customer to fix a 
computer that does not boot. Document the customer’s problem in the work order below. 

Instructor Note: In this lab, one student will play the role of a customer, while another 
student plays the role of a technician. The goal is to demonstrate the special skills needed 
to help a customer fix a computer remotely. Begin this first remote technician lab with a 
demonstration so that students can understand how these types of labs are conducted:

 1) Select two students who are willing to participate and have good troubleshooting skills.

 2) Position the students back-to-back so that the students cannot see each other or the 
other student’s computer.

 3) The student playing the role of the customer must behave like an inexperienced user.

 4) During the demonstration, ask the class questions about the troubleshooting procedure. 
For example, “Is there a better way to phrase that question?”, “Is the student technician 
skipping any steps?”, or “What would you do differently?”

 5) If at any time the students are unable to proceed, allow the student customer to make 
suggestions for the student technician. Allow the other students to make suggestions, 
as well.

 6) After a successful demonstration of the process, send each team of students to their 
computers to complete the lab. The students in each team can reverse the roles of 
customer and technician in later labs so that all students experience both sides of the 
exercise.

Instructor Note: Make one or more of the following hardware changes to each lab computer 
prior to class, depending on time limits:

 ■ Switch the mouse and keyboard connections (PS2) where hardware is available.

 ■ Unplug the power cable from the optical drive.

 ■ Unplug the data cable for the hard drive from the motherboard.

 ■ Eject the memory completely from the memory bank(s) and place it at the bottom 
of the case. 

 ■ Unplug the front panel power on switch cable from the motherboard.
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Student Technician Sheet

Company Name: JH Travel, Inc.

Work Order
Contact: Dan Handy

Company Address: 204 N. Main Street

Company Phone: 1-866-555-0998

Generating New Ticket

Category: Hardware Closure Code: N/A Status: Open

Type: N/A Escalated: Yes Pending: N/A

Item: N/A Pending Until Date: N/A

Business Impacting? X Yes O No

Summary The computer will not turn on or the computer beeps constantly.

Case ID#: 47 Connection Type: N/A

Priority:  2 Environment: N/A

User Platform: Windows 10

Problem Description
 

 

 

 

Computer will not boot. Customer does not know the manufacturer of the BIOS. Customer 
cannot identify error from beep sequence. Customer did not hear strange sounds from the 
computer. Customer does not smell smoke or burning electronics.

Problem Solution
 

 

 

 

Verified external cable connections. Mouse and keyboard connections were reversed 
(if applicable). Connections were corrected. Internal hardware and cable connections were 
verified. RAM was not installed. Customer installed RAM. Optical drive power cable 
was disconnected. Optical drive power cable was reconnected. Hard drive data cable 
was disconnected from the motherboard. Hard drive data cable was reconnected to the 
motherboard. Computer displayed “Non-system disk or disk error” upon reboot. Computer 
was shut down and rebooted to confirm the solution. Front panel power on switch cable was 
unplugged from the motherboard. Front panel power on switch cable was reconnected to the 
motherboard.
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Student Customer Sheet
Use the contact information and problem description below to report the following 
information to a level-two technician:

Contact Information
Company Name: JH Travel, Inc.

Contact: Dan Handy

Company Address: 204 N. Main Street

Company Phone: 1-866-555-0998

Problem Description
I work with cars all the time and I know how they work, but I do not know how my computer 
works. This morning it was pretty slow because I guess more and more people are using those 
Internet travel sites. So, after my morning coffee, I decided to figure out what makes my 
computer work. I opened the case and just started looking at the different things inside. When 
I put everything back together, everything seemed to fit, and I didn’t see any leftover parts. 
Now it does not work at all. It beeps at me all the time.

Note: After you have given the level-two tech the problem description, use the Additional Information to 
answer any follow-up questions the technician may ask.

Additional Information
 ■ Windows 10

 ■ The computer has no new hardware.

 ■ The computer has not been moved recently.

 ■ Except for the beeping, I did not hear any other strange sounds from the computer.

 ■ I do not smell electronics burning or see any smoke.

 ■ The computer looks the same as it did yesterday.
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14.4.1.5 Lab–Remote Technician–Fix an Operating 
System Problem (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will gather data from the customer and then instruct the customer to fix a 
computer that does not connect to the network. Document the customer’s problem in the work 
order below.

Instructor Note: In this lab, the goal is to demonstrate the special skills needed to help a 
customer fix a computer remotely.

Lab Setup
 ■ Create a restore point on each computer that will have the problem.

 ■ Boot one of the computers in each student group into safe mode.

 ■ Use the Control Panel to find the name and location of the driver files used by the NIC.

 ■ Back up the NIC driver to the USB flash drive. Delete the files from C:\Windows\
System32\Drivers.

 ■ Restart the computer normally and cancel driver installation for the NIC.

 ■ Turn off the wireless routers in the classroom.

Student Technician Sheet
Company Name: Main Street Stoneworks

Work Order
Contact: Karin Jones

Company Address: 4252 W. Main Street

Company Phone: 1-888-774-4444

Generating a New Ticket

Category: Operating System Closure Code: N/A Status: Open

Type: N/A Escalated: Yes Pending: N/A

Item: N/A Pending Until Date: N/A

Business Impacting? X Yes O No

Summary Customer cannot connect to the network or the Internet.

Case ID#: 78 Connection Type: Ethernet

Priority:  2 Environment: N/A

User Platform: Windows 10
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Problem Description
 

 

 

 

Computer boots correctly. Network cable connected. Link lights not working. Network icon 
not visible in tray.

Problem Solution
 

 

 

 

 

No network connections shown with ipconfig. No network connections shown in Control 
Panel Network Connections section. Device manager shows only a wireless NIC. Scanned 
computer for hardware changes. NIC detected. Drivers not available. Used system restore to 
return computer to the last restore point before today. Restarted user’s computer. Network 
functioning normally. Shut down user’s computer and restarted user’s computer. User now 
able to connect to the Internet and send/receive email.

Student Customer Sheet
Use the contact information and problem description below to report the following 
information to a level-two technician:

Contact Information
Company Name: Main Street Stoneworks

Contact: Karin Jones 

Company Address: 4252 W. Main St.

Company Phone: 1-888-774-4444

Problem Description
When I came into the office today, I could not get my email. The Internet does not work either. 
I tried to restart my computer, but that did not help. None of the files that I need are available 
to me either. It is like someone pulled the plug, but the plug is still there. I need to get some 
files from my folder that I was working on yesterday. It is very important for me to get my files 
so that I can send them to my client. I do not know how to get the files or send them because 
my computer cannot find them. What do I do?
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Note: After you have given the level-two tech the problem description, use the Additional Information to 
answer any follow-up questions the technician may ask.

Additional Information
 ■ Windows 10

 ■ The computer has not had new hardware installed recently

 ■ There is no wireless network available at work

 ■ The computer detected new hardware at boot-up

 ■ The computer could not install new hardware
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14.4.1.6 Lab–Remote Technician–Fix a Network 
Problem (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
In this lab, you will gather data from the customer and then instruct the customer to fix a 
computer that does not connect to the network. Document the customer’s problem in the work 
order below.

Lab Setup

Instructor Note: In this lab, the goal is to demonstrate the special skills needed to help a 
customer fix a computer remotely.

 ■ On the wireless router, set the “Maximum Number of Users” setting for DHCP to one 
less than the number of computers connected to the wireless router with Ethernet patch 
cables.

Example: If you connect four student computers to each wireless router with Ethernet 
patch cables, set the “Maximum Number of DHCP Users” to 3. This setting is found 
under Setup > Basic Setup on the wireless router.

 ■ Clear the DHCP table on the wireless router so that each computer or mobile device 
needs to renew the IP address assigned by DHCP.

 ■ Renew the IP addresses of all the computers connected to the wireless router except for 
the computer that will be broken. Validate that the IP addresses fall in the DHCP range 
of the wireless router.

 ■ Renew the IP address of the “broken” computer. It will receive a 169.254.x.x address 
because the DHCP server has no more addresses to assign.
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Student Technician Sheet

Company Name: JH Paint Supply

Work Order
Contact: Jill Henderson

Company Address: 114 W. Main Street

Company Phone: 1-888-555-2143

Generating a New Ticket

Category: Network Closure Code: N/A Status: Open

Type: N/A Escalated: Yes Pending: N/A

Item: N/A Pending Until Date: N/A

Business Impacting? X Yes O No

Summary One computer cannot connect to the Internet, network shares, or network printers.

Case ID#: 50 Connection Type: Wireless

Priority:  2 Environment: N/A

User Platform: Windows 10

Problem Description
 

 

 

 

All computers boot up properly. Computer does not connect to shares or the Internet. 
Computer has not been moved. Cables are securely connected. Link lights are blinking.

Problem Solution
 

 

 

 

Verified IP addresses on all computers. Renewed IP address on problem computer. Computer 
receives a 169.254.x.x IP address. Restarted computer. Restarted wireless router. Verified 
wireless router settings. Wireless router did not have enough IP addresses allocated to the 
wireless network in the DHCP scope to accommodate all clients. Changed the DHCP setting 
on the router back to the default of 50 IP addresses. Computer was shut down and rebooted. 
Confirmed IP address was in range. Verified connection to shares and Internet.
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Student Customer Sheet
Use the contact information and problem description below to report the following 
information to a level-two technician:

Contact Information
Company Name: JH Paint Supply

Contact: Jill Henderson

Company Address: 114 W. Main Street

Company Phone: 1-888-555-2143

Problem Description
Well, the problem does not always seem to be there. Typically, not all computers on the 
network are used all the time, so everything seems to be fine. On some busy days, every 
computer is being used, and there is always one computer that cannot connect. I cannot figure 
out what the problem is because it is not usually on the same computer. When a computer 
cannot make connectivity, I check to make sure all cables and connections are fine.

Note: After you have given the level-two tech the problem description, use the Additional Information to 
answer any follow-up questions the technician may ask.

Additional Information
 ■ Windows 10

 ■ The computer has no new hardware

 ■ The computer has not been moved recently

 ■ An extra computer was added to the network recently

 ■ The computer looks the same as it did yesterday

Book 1.indb   552Book 1.indb   552 01/10/19   9:28 PM01/10/19   9:28 PM



Chapter 14: The IT Professional  553

14.4.1.7 Lab–Remote Technician–Fix a Security 
Problem (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Introduction
You will gather data from the customer to begin the troubleshooting process. You will 
document the customer’s problem and the possible solution in the work order.

Lab Setup

Instructor Note: You must prepare a wireless router for this activity by modifying a MAC 
address in the MAC address filter table and then saving the incorrect configuration. The 
instructions for modifying a MAC address in the filter table are below.

 a. Ensure that all computers can connect to the wireless router with basic security and with 
MAC address filtering configured.

 b. Connect an Ethernet cable from an Ethernet port on the wireless router to the computer 
that manages the router (known as the management computer for the purposes of this 
lab).

 c. On the management computer, open a web browser and connect to http://192.168.1.1. (or 
the administration address of your wireless router) and log in. The management interface 
should display in the browser.

 d. Navigate to the wireless settings to access the wireless MAC filter.

 e. Locate in the table the MAC address of the computers you wish to deny access. Remove 
the MAC address from the filter list for all lab computers. This will prevent the lab com-
puter from connecting to the wireless router.

 f. Save the settings.
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Student Technician Sheet

Company Name: Smith Lumber Supply

Work Order
Contact: James Smith

Company Address: 1234 S. Main Street

Company Phone: 801-555.1212

Generating a New Ticket

Category: Security Closure Code: N/A Status: Open

Type: N/A Escalated: Yes Pending: N/A

Item: N/A Pending Until Date: N/A

Business Impacting? X Yes O No

Summary Customer cannot use laptop wireless connection at work.

Case ID#: 102 Connection Type: Wireless

Priority:   2 Environment: N/A

User Platform: Windows 10

Problem Description
 

 

 

 

 

Customer’s wireless connection does not work in any location at the workplace. 
The customer can use a wireless connection at home and other places. 

Problem Solution
 

 

 

 

 

 

The access point is working correctly. The customer’s network login is working correctly. 
The customer’s wireless card is operating properly. The configuration of the new wireless 
router must be verified. The MAC address of the customer’s computer is verified with the 
command “ipconfig /all”. The MAC address filter has incorrect settings for the customer’s 
computer. The customer’s MAC address has been added to the MAC address filter list on the 
wireless router and settings have been saved. The customer can now connect wirelessly.
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Student Customer Sheet
Use the contact information and problem description below to report the following 
information to a level-two technician:

Contact Information
Company Name: Smith Lumber Supply

Contact: James Smith

Company Address: 1234 S. Main Street

Company Phone: 801-555-1212

Category: Security

Problem Description
You are unable to use your laptop’s wireless connection while at work. The wireless connection 
works fine at home and the coffee shop downstairs, but for some reason, it will not connect to 
the wireless anywhere in the office. Since you are unable to access the wireless connection, you 
have been using the Ethernet cable connection instead. The cable connection is working fine.

Note: After you have given the problem description, use the Additional Information to answer any 
follow-up questions your lab partner may ask.

Additional Information
 ■ Windows 10

 ■ The wireless client can see the wireless network.

 ■ My wireless connection worked yesterday at work.

 ■ I can connect using an Ethernet cable.

 ■ My wireless account is in good standing.

 ■ Wireless connection works for other employees.

 ■ I have not made changes to my wireless security settings.

 ■ A new wireless router was installed on the network yesterday.
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14.4.2.7 Lab–Write Basic Scripts in Windows 
and Linux (Instructor Version)

Instructor Note: Red font color indicate text that appears in the instructor copy only.

Objectives
In this lab, you will write basic scripts in different scripting languages to help understand how 
each language handles automating tasks.

Background/Scenario
Writing scripts to automate common administration functions saves time and gives the 
administrator flexibility to perform other tasks. In the lab, you will write three types of 
scripts that will perform similar tasks. Compare the different languages as you automate some 
simple task.

Required Resources
 ■ Windows PC

 ■ VM running a Linux distribution

Instructions
Step 1: Create a Windows batch script.

 a. In a text editor, such as Notepad, save a text file named info.bat in your home 
directory (C:\Users\yourusername) with the following text:

@echo off

echo Computer Name is: %computername%

echo Windows version is: 

ver

echo CPU is: %PROCESSOR_IDENTIFIER% 

echo Total memory is:

rem Windows Management Instrumentation Command (WMIC) is a command line 
utility that can retrieve information about local or remote computers. 
For more inline information, enter help wmic or wmic /? at the command 
prompt.

wmic ComputerSystem get TotalPhysicalMemory

echo The disks that are installed and their freespace:

wmic logicaldisk get size,freespace,caption

echo All the %computername% IP addresses

rem netsh is a command line scripting utility that allows the users to 
view or modify the network configurations of a running computer. For 
more inline information, enter nesh /? at the command prompt.

rem findstr is used for searching for a text string in files. For more 
inline information, enter findstr /? at the command prompt.

netsh interface ip show address | findstr "IP Address"
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 b. Open a command prompt and navigate to your home directory.

 c. List the content of your home directory and verify that the file info.bat is saved 
with the correct file. If not, rename the file, for example, rename info.bat.txt 
info.bat.

 d. At the prompt, enter info.bat to run the script.

Questions:

What was the output?

 ________________________________________________________________________

Answers will vary.

Computer Name is: KDV-PC

Windows version is:

Microsoft Windows [Version 10.0.17763.437]

CPU is: Intel64 Family 6 Model 61 Stepping 4, GenuineIntel

Total memory is:

TotalPhysicalMemory

17091084288 

The disks that are installed and their freespace:

Caption  FreeSpace     Size

C:       212692340736  997923037184 

All the KDV-PC IP addresses

    IP Address:                           192.168.56.1

    IP Address:                           169.254.45.2

    IP Address:                           169.254.126.64

    IP Address:                           192.168.159.1

    IP Address:                           192.168.181.1

    IP Address:                           192.168.1.40

    IP Address:                           127.0.0.1

What are the %name% characters used for in the script?

 ________________________________________________________________________

Answers will vary. These are environment variables that hold values set by the oper-
ating system.

Identify what the following commands do in the script: (Note: 

echo:

 ________________________________________________________________________

Displays on the screen whatever comes after it

findstr: 

 ________________________________________________________________________

Look for a string of characters.
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netsh:

 ________________________________________________________________________

Network shell allows you to display and modify network settings.

ver:

 ________________________________________________________________________

Gives the current OS version.

wmic:

 ________________________________________________________________________

Windows management interface allows an administrator to view or modify settings.

Step 2: Create a PowerShell ISE script.

 a. Click Start, Search for PowerShell ISE and right-click the selection, and click 
Run as an administrator.

 b. Verify that you are in your home directory: PS C:\Users\YourUsername

 c. To allow the script to run, enter Set-ExecutionPolicy RemoteSigned at the 
prompt. Click Yes to allow the script to run. The settings can be changed back 
to No after the script is complete.

PS C:\Users\YourUsername> Set-ExecutionPolicy RemoteSigned

 d. Choose File -> New and create a new script.

 e. Enter the following text into the Untitled.ps1 window and save it as info.ps1 in 
your home directory.

Write-Output "Computer name is:"

get-content env:computername

Write-Output "Windows version is:"

(Get-WmiObject -class Win32_OperatingSystem).Caption

Write-Output "CPU is:"

Get-WmiObject Win32_Processor | findstr "Name"

Write-Output "Total Memory is:"

[Math]::Round((Get-WmiObject -Class win32_computersystem -ComputerName 
localhost).TotalPhysicalMemory/1Gb)

Write-Output "The Disks that are installed and their freespace:"

Get-WmiObject -Class Win32_logicaldisk -Filter "DriveType = '3'"

Write-Output "IPv4 addresses"

Get-NetIPAddress -AddressFamily IPv4 | Sort-Object -Property 
InterfaceIndex | Format-Table 

Note: The command Get-NetIPAddress is not available in Windows 7.

Note: Within PowerShell ISE, you can press F1 or select Help > Windows PowerShell ISE 
Help to get more information.
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 f. To see the functions of each command, click Add-ons, and verify that 
Command is checked. In the Command tab, enter the name of the command in 
the Name field. Select the desired command and click the ? for more informa-
tion regarding the desired command.

In Windows 7, click Help > select Windows PowerShell Help. Select Windows 
PowerShell Cmdlet Help Topics. Search for the desired command.

 g. Enter .\info.ps1 at the PS prompt. Note: Make sure you are using the correct 
slash.

PS C:\Users\YourUsername> .\info.ps1

Question:

What is the output of the script?

 ________________________________________________________________________

Answers will vary.

PS C:\> .\info.ps1

Computer name is:

KDV-PC

Windows version is:

Microsoft Windows 10 Education

CPU is:

Name: Intel(R) Core(TM) i5-5200U CPU @ 2.20GHz

Total Memory is:

16

The Disks that are installed and their freespace:

DeviceID : C:

DriveType : 3

ProviderName : 

FreeSpace : 212635987968

Size : 997923037184

VolumeName : Windows 

IPv4 addresses 

ifIndex IPAddress   PrefixLength PrefixOrigin SuffixOrigin AddressState  PolicyStore 

------- ---------   ------------ ------------ ------------     -------------  ------------

1 127.0.0.1  8 WellKnown WellKnown Preferred ActiveStore

3 169.254.220.156 16 WellKnown Link Tentative ActiveStore

5 192.168.159.1 24 Manual Manual Preferred ActiveStore

7 169.254.160.146 16 WellKnown Link Tentative ActiveStore

11 192.168.56.1 24 Manual Manual Preferred ActiveStore

15 169.254.45.2 16 WellKnown Link Preferred ActiveStore

17 192.168.1.40 24 Dhcp Dhcp Preferred ActiveStore

24 169.254.2.220 16 WellKnown Link Tentative ActiveStore

25 169.254.126.36 16 WellKnown Link Tentative ActiveStore

29 169.254.18.19 16 WellKnown Link Tentative ActiveStore

39 192.168.181.1 24 Manual Manual Preferred ActiveStore

73 169.254.126.64 16 WellKnown Link Preferred ActiveStore 
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Compare the two scripts. Match the batch command to the PowerShell commands 
below:

Windows Batch Command PowerShell Command

echo Computer Name is: 
%computername%

Write-Output "Computer name is:" 

get-content env:computername

echo Windows version is:

ver

Write-Output "Windows version is:"

(Get-WmiObject -class Win32_OperatingSystem).
Caption

echo CPU is: 
%PROCESSOR_IDENTIFIER%

Write-Output "CPU is:"

Get-WmiObject Win32_Processor | findstr "Name"

echo Total memory is: Write-Output "Total Memory is:"

wmic ComputerSystem get 
TotalPhysicalMemory

[Math]::Round((Get-WmiObject -Class 
win32_computersystem -ComputerName 
localhost).TotalPhysicalMemory/1Gb)

echo The disks that are installed and 
their freespace:

Write-Output "The Disks that are installed and 
their freespace:"

wmic logicaldisk get 
size,freespace,caption

Get-WmiObject -Class Win32_logicaldisk -Filter 
"DriveType = '3'" 

echo All the %computername% IP 
addresses

Write-Output "IPv4 addresses"

netsh interface ip show address | findstr 
"IP Address"

Get-NetIPAddress -AddressFamily IPv4 | Sort-
Object -Property InterfaceIndex | Format-Table

Step 3: Create a BASH script.

A text editor is used to create an executable script. One of the text editor tools, 
vi, or the improved vi version, vim, is based on letter and number-based commands 
to modify text. For example, dd will delete the whole line on which the cursor is 
placed. 5dd would delete five lines. When vi is in command mode, input is inter-
preted as a command.

To enter insert mode at the current cursor position, type i. To append text at the 
end of the current line, type a. To insert text on a new line below the current line, 
type o. Use the Esc key to exit out of insert mode to command mode.

To save a file in the vi editor, use :w from command mode. To save and quit, type 
:wq. To quit without saving, type :q!.

Depending on your version of Unix-like OS, you may find other text editor tools, 
such as nano, pico, and gedit. The text editing tools, such as vi, nano, and pico, are 
accessible through the command line, while the GUI-based text editors, like gedit, 
may be located via the application menu or the command line.

 a. Start up a Linux computer or VM.
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 b. Use a text editor tool and create a file named info.sh in your home directory 
with the following text:

#!/bin/bash

echo "Computer name is: "  $HOSTNAME

echo "Operating System is:"

cat /etc/os-release | grep PRETTY_NAME

echo "CPU is"

lscpu | grep "Model name:" | sed -r 's/Model name:\s{1,}//g'

echo "Total Memory is"

cat /proc/meminfo | grep  "MemTotal"

echo "The disks that are installed and their freespace"

df -h

echo "All the" $HOSTNAME "IP addresses"

hostname -I

 c. Open a terminal and navigate to your home directory. To make the script 
executable, enter chmod 755 info.sh at the prompt.

 d. At the prompt, enter ./info.sh to execute the script.

Question:

What is the output of the script?

 ________________________________________________________________________

Answers will vary.

Computer name is:  KDV-PC

Operating System is:

PRETTY_NAME="Ubuntu 16.04.5 LTS"

CPU is

Intel(R) Core(TM) i5-5200U CPU @ 2.20GHz

Total Memory is

MemTotal:       16690512 kB

The disks that are installed and their freespace

Filesystem      Size  Used Avail Use% Mounted on

rootfs          930G  732G  198G  79% /

root            930G  732G  198G  79% /root

home            930G  732G  198G  79% /home

data            930G  732G  198G  79% /data

cache           930G  732G  198G  79% /cache

mnt             930G  732G  198G  79% /mnt

none            930G  732G  198G  79% /dev

none            930G  732G  198G  79% /run

none            930G  732G  198G  79% /run/lock

none            930G  732G  198G  79% /run/shm

none            930G  732G  198G  79% /run/user

C:              930G  732G  198G  79% /mnt/c

All the KDV-PC IP addresses

192.168.56.1 192.168.159.1 192.168.181.1 169.254.45.2 169.254.126.64 
192.168.1.40
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Questions:

What does “#!/bin/bash” mean at the beginning of the script?

 ________________________________________________________________________

It tells the script which interpreter to use for the code.

What command would you use to learn more about the df and lscpu commands?

 ________________________________________________________________________

Use the man command to learn more. At the prompt, enter man df and man lscpu.
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